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Welcome to Panorama!

Congratulations! You are about to get acquainted with Panorama, a powerful tool for organizing and under-
standing information. With Panorama you can store, retrieve, categorize, summarize, chart, merge and print
your information.

This book explains how to use Panorama. It assumes that you are already familiar with the basics of operat-
ing your computer. You should be familiar with pointing, clicking and dragging with the mouse, copying
files, choosing commands from pull down menus, using scroll bars and editing text. If you are not familiar
with these topics please review the training material that came with your computer.

What is a Database?

The right knowledge at the right time can advance a career, a company, a civilization. Obtaining the right
information at the right time is not often an easy task, especially when you are confronted with large
amounts of data. Data that is arranged randomly (for example a pile of receipts) won’t do you much good.
When a collection of data is organized it is called a database. A computer program for entering and manipu-
lating the information in a database is called a database program or a database management program.

records

fields
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Every database— whether on paper or in a computer — is composed of records. A record contains a collec-
tion of information about a particular person, company or entity. For example, each record in a mailing list
database would contain the name and address of a particular person, while each record in an invoice data-
base would contain all of the information collected for a single order. To learn more about records see
“Records” on page 187.

Each record is divided into fields. A field contains a single piece of information about the subject of the
record, for example a name, a street address, a phone number, etc. Fields are what make a database more than
a hodgepodge of random information. Each field appears in the same place within every record in the data-
base. To learn more about fields see “Fields” on page 193.

A database program like Panorama helps you design, manage and use data that is structured into records
and fields. Before you begin you must tell the database program how you want the fields to be set up. As you
enter new data Panorama helps make sure that everything goes in the right place and the structure remains
intact. Once data is entered, Panorama can quickly scan the data to find the information you need, or catego-
rize and summarize the information you need for a report. Panorama can also re-organize the data (for exam-
ple, sorting) or even change the database field structure as your needs change — without having to start over
from scratch. Virtually any job that can be done manually with a filing cabinet, card file or paper list can be
done faster and more efficiently with a computerized database program like Panorama.

A Brief History of Database Technology

The need for data organization goes back long before computers. Before computers data was usually orga-
nized with paper forms and filing cabinets. Unfortunately, the information in a row of filing cabinets is
hardly at your fingertips — at best an item might be located in a minute or two, while at worst a misfiled item
might never be found at all.

In the 1960’s and 1970’s disk based database systems revolutionized the collection and storage of data.
Instead of storing the data in a filing cabinet it is stored on a spinning magnetic disk (hard drive). Depending
on how the information is filed an item can be located in as little as a second. Today’s popular database pro-
grams, including Access and FileMaker, are based on this hard drive technology that was originally devel-
oped 30 to 40 years ago.
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Storing information on a spinning disk is a fantastic improvement over filing cabinets, but it still relies on a
mechanical system. Although disk drives have become faster and faster over the years, the speed of rotation
and the movement of the head over the disk platter are still a bottleneck, just as feet, hands and fingers were
a bottleneck when accessing data in a filing cabinet. Fortunately, there is an alternative. Besides the hard
drive, your computer contains a large internal electronic memory bank (RAM) that allows the computer to
work with large quantities of information at pure electronic speeds. In the past this electronic memory was
too small for large databases, but today’s computers have enough RAM for all but the largest database tasks.

As you have probably guessed by now, Panorama is designed to leapfrog existing disk based database soft-
ware by using your computers electronic memory for ultra fast operation, making Panorama faster, easier to
use, and more powerful than any other database software previously available. Panorama uses the hard
drive only for permanent data storage. Searching, sorting, summarizing and other data processing tasks are
performed entirely in RAM.

If you’re worried about the safety of a RAM based database, Panorama’s unique Total Recall feature has you
covered. Total Recall allows Panorama to fully recover after a crash -- whether due to a power outage, hard-
ware problem, system crash, or Panorama bug (never!). When Panorama is relaunched after a crash it gives
you the option to automatically restore everything just as you left it -- all open files, open windows, etc. Only
the last few seconds of work will be lost. It's almost as if nothing has happened at all — you can just continue
with your work as if nothing had happened. See “Total Recall (Auto-Save/Crash Recovery)” on page 66 to
learn more.
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What is Panorama?

In addition to its blazing RAM based speed, Panorama includes a number of unique capabilities that set it
apart from other database programs. Panorama is easy to learn and use, is blazingly fast, has powerful tools
for analyzing financial data, and is powerful enough for even the most demanding database jobs.

Super Fast Searching and Sorting

Panorama’s RAM based speed makes searching and sorting faster and more flexible than ever before (see
“Sorting” on page 323 and “Searching and Selecting” on page 331). Searching is not limited to full word or
begins with matches — you can search for data that contains a word or phrase or even perform formula
based searches (for example “find all names longer than 12 characters” or “find all invoices where shipping is
more than 10% of the order total”. The search results are updated “live” as you type, allowing you to quickly
focus on just the information you are looking for.

Phonetic Searching

Panorama’s “sounds like” option allows you to search for data phonetically (see “The Find/Select Dialog” on
page 336). For example a search for “sounds like Alan” will turn up anyone named Alan, Allan, or Allen.

Easy Set-Up

Simple step-by-step dialogs make it easy to define database fields (see “Adding New Fields” on page 198),
print mailing labels (see “Labels” on page 1169), and print custom reports (see “Custom Reports” on
page 1061).

Crosstabs

Panorama’s crosstab feature allows it to quickly and automatically convert raw data into a tabular summary;
for instance turning raw checkbook data into a monthly budget. Crosstabs are one of the most powerful tools
yet for analyzing financial data (see “Crosstabs” on page 415).
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Data Outlines

Panorama’s outlining feature is another powerful tool for analyzing financial data, and goes much further
than ordinary subtotal calculations (see “Summaries and Outlines” on page 365). You can hide and reveal dif-
ferent levels of subtotals, identify problems or opportunities and then zoom in on specific details. You can
also perform further operations or calculations on subtotals as if they were data.

Data Entry Shortcuts

Panorama’s data entry shortcuts reduce keying errors and data entry errors (see “Data Entry & Editing” on
page 265). Panorama’s unique Clairvoyance® feature automatically finishes typing for you (see “Clairvoy-
ance®” on page 284). Auto-capitalization, data entry buttons, smart defaults, and optional spelling checker
and zip code lookup save even more time.

Smart Dates™

Panorama understands dates the way you do—as part of weeks, months, quarters, or years (see “Entering
Dates” on page 255). You can easily locate or summarize information by any of these date periods.

Smart Program Recorder

Panorama’s program recorder allows you to record multi-step operations and play them back later with a
single click or keystroke. It’s as easy to use as a cassette recorder—just start the recorder then do your work
(see “Creating a Procedure with the Recorder” on page 212). The recorder doesn’t just record mouse clicks
and keystrokes as is, but automatically converts them into simple English-like commands that can be edited
later if necessary.

Formulas

Panorama can perform simple and complex calculations on numbers, text, and dates, and includes a wizard
to help you build and test formulas (see “Formulas” on page 19).

Compact Storage

Panorama uses up to 85% less disk space than other database programs for the same data.
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Charts

Panorama’s built in charts (bar, line, area, pie, and scatter) can visually reveal trends and relationships that
are often hidden in a conventional report (see “Charts” on page 993).

Relational Links

Panorama can relate the information in two or more databases, insuring consistency and simplifying com-
plex tasks like order entry, billing, payroll, sales lead tracking, and more (see “Linking With Another Data-
base” on page 131).

Internet Content

Panorama includes built-in access to web content, including maps, phone and zip code information, fedex
tracking and more. If data is on the web, you can access it with Panorama. See “White Pages” on page 73,
“Address Info” on page 65, “Fedex Tracking” on page 70 and “Basic Web Access” on page 607.
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Map, Phone, Email and VCard Support

Based on information in your databases Panorama can automatically display maps, dial the phone, send e-
mail and drag and drop between Panorama and any other VCard enabled application (like Address Book).

Sending Email

Panorama can send e-mail to individual or bulk recipients. You can program e-mail transmission into your
own database (for example setting up an invoice database to automatically e-mail a copy of each invoice) or
use the Bulk Email wizard. This wizard makes it easy to send and keep track of bulk emails. It keeps all of
the previous e-mails you've sent organized, and can automatically extract e-mail addresses from one or more
other databases. The wizard has two primary windows. The Bulk Email window displays a single e-mail
message, and allows you to configure and modify that message. The History window displays a list of the
previous e-mails. For more details about this wizard see “Bulk Email” on page 68.

Recent Database Wizard

The Recent Database Wizard makes it easy to keep all of your databases at your fingertips (see “The Recent
Databases Wizard” on page 44).
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Advanced Graphic Tools

Panorama’s graphic capabilities build on standard Macintosh drawing features and add special tools and
dialogs that are designed specifically for creating and modifying tables within forms and reports (see
“Graphic Design” on page 491).

Mail Merge and Labels

Panorama’s built-in mail merge can produce all the components of a direct mailing—including custom form
letters, mailing labels, and postcards or envelopes (see “Labels” on page 1169 and “Custom Reports” on
page 1061). Panorama includes a built-in word processing program, reducing both the complexity and time
required to put together a direct mailing (see “Word Processor SuperObject” on page 673).

Database Publishing

Panorama can automatically create complex database reports including catalogs, directories, bibliographies,
and more. Reports can include both fixed and variable height elements (including images), and Panorama
can automatically control page and column breaks to eliminate widows and orphans (see “Custom Reports”
on page 1061).

View-As-List Forms

Panorama allows you to display forms as separate pages, or as a continuous sheet (see “View-As-List Forms”
on page 899).
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Elastic Forms

Elastic forms adjust intelligently when the window containing the form is resized or zoomed. When the form
is designed, you decide how the individual elements will expand or shift as the form changes size (see “Elas-
tic Forms” on page 922).
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Matrix Display

Panorama matrix object makes it easy to create repeating grids including calendars, catalogs and invoices
(see “Super Matrix Objects” on page 939).
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Images and Movies

A Panorama form can display images and movies from a wide variety of sources (see “Images & Movies” on
page 741). An image may be fixed (for example a logo or background) or variable (changing from record to
record - for example personnel photos or maps associated with individual records). Variable images may be
included in the database or (more commonly) displayed directly from files on the disk. With the optional
enhanced image pack Panorama can display nearly two dozen different image formats, including JPEG, TIFF,
PNG, PCX and TARGA.
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High Speed Import

Panorama can import data at rates approaching 1000 records per second. Importing data from mainframe or
minicomputer systems is fast and convenient (see “Importing a Text File” on page 82).

Flexible Text Export (including HTML)

Panorama can export text files in tab separated, comma separated or HTML table formats. When exporting
HTML you can choose fonts, colors, column widths and titles (see “Exporting a Text File” on page 105).

Data Transformation

Panorama can quickly transform large amounts of data. Examples include re-arranging characters or words,
capitalizing, and transformations based on patterns in the data (see “Transforming Selected Data” on
page 433).

Select/Remove Duplicates

Scan even the largest databases for duplicate information with the Select Duplicates command (see “Select
Duplicates” on page 362). Duplicates can also be removed automatically based on rules set up in advance
(see “Using UnPropagate to Eliminate Duplicates” on page 470).

Wizards

Panorama’s Wizard menu contains pre-built databases for automating common tasks and enhancing produc-
tivity when using Panorama (see the separate Wizards & Demos PDF file). General productivity wizards
include databases for organizing your contacts, calendar, correspondence and tracking your time. Panorama
also includes wizards for importing and exporting data, arranging windows, locating favorite files, creating
new databases and much more.
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Panorama Enterprise Server

The Panorama Enterprise Server introduces a revolutionary new system for sharing database information.
Unlike traditional client/server databases that sequester all of the data on a central server, the Panorama
Enterprise system distributes complete copies of shared databases across all clients. Essentially each client
caches the entire database for better performance, and lower network and server load. The Panorama Enter-
prise server acts like a traffic cop, managing record locking and updating clients as necessary.

RAM Based Server. The Panorama Enterprise Server is RAM based for blazing speed, but it also keeps a disk
based transaction journal for full data recovery after any kind of system interruption (power failure, etc.). The
journal is a simple sequential file with minimal impact on performance.

RAM Based Client. Each client keeps a full copy of each open database in RAM for fast searching, sorting,
reports, etc. The server only gets involved when data is modified, managing record locking and updating cli-
ents as necessary. This increases performance two ways:

•Sorting, searching, summaries and reports are done locally in the client's RAM. You'll feel like your data-
bases have broken the sound barrier!

•Network traffic and server load are dramatically reduced. Panorama clients don’t access the network at
all when browsing, sorting, etc.

Offline Roaming. Traditional client/server systems are completely inoperable
without a network connection. Panorama gives you the option of roaming off-
line while still retaining access to your databases for browsing, reports and even
modification and updates. In other words, users can view and edit databases
even when they don't have a network connection -- ideal for road warriors.
Offline changes are automatically synchronized with the server when the client
re-connects to the network. Because both client and server are RAM based this
synchronization is extremely fast. If there are any synchronization conflicts
(same record edited both offline and by another user) they can be resolved automatically or manually on a
field-by-field basis.

Web Database Publishing. Panorama's WYSIWYG form
design tools can automatically build HTML/CSS forms for
database web access and upload them to the server. Many
common web database applications can be built with no

programming at all. For fully customized applications, Panorama provides a comprehensive programming
language that includes rich text and tag manipulation capabilities. Server side programs are automatically
uploaded to the server and a built in simulator/debugger allows developers to debug programs on their
development machine before they are uploaded.
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Managing Web Content. Database changes made on any client (for example price list changes)
immediately show up on the web server, while changes made via the web (for example incom-
ing shopping cart orders) automatically show up on client desktops. No extra programming for
database maintenance is required — authorized users work with Panorama's intuitive user
interface to edit web published databases just as if they were on their local computers.

“Cloned” Web Sites. The Panorama Enterprise Server makes it easy to manage
"cloned" web sites with identical design and programming. A typical example of
this feature is managing identical test and production servers. When tests on a new
feature are complete the live production server is automatically updated with the
changes made on the test server (while keeping the data completely separate).

Easy Server Administration. All Panorama Server configuration and maintenance is managed
remotely from the Panorama client software. Built in server backup automatically backs up "live"
databases without shutting down the server. The server can be configured to automatically send
an e-mail to the server administrator if any problems occur.

Industrial Strength. When publishing database content on the web the Panorama Server
works as a back end to the built-in industrial strength Apache server included with OS X
and OS X Server. No modifications to the Apache configuration files are required. (You can
also use any other UNIX web server that supports Apache style CGI's.)

Connect and Synchronize Mode. Panorama Enterprise databases can be configured to oper-
ate primarily offline. This is similar to the way e-mail works - users perform data entry
offline, then press "Submit" or "Connect" to submit their data and receive updates. The con-
nection lasts only long enough to transfer the data. Before Panorama Enterprise, applications
that worked like this had to be built from scratch, but the Panorama Enterprise server allows

this type of operation with little or no custom programming.

Built-in Backup. The Panorama Enterprise Server's built-in backup system provides automatic
daily backup of "live" databases without shutting down or interrupting the server.

Remote Server Administration. All server configuration and maintenance can be managed
remotely from any Panorama client — once the server is installed you'll never need to touch it
again.

This system is documented in the separate Panorama Enterprise Handbook.

Complete Programming Language and Development Tools

If Panorama doesn’t have a feature already, you can add it yourself with Panorama’s built in programming
language (see “Writing a Procedure from Scratch” on page 216). Panorama includes powerful programming
features like variables (both local and global), if-then-else, case switching, loops, subroutines and a built in
interactive debugger. You can even extend Panorama’s programming language with your own custom state-
ments and functions or embed programs written in Perl, Ruby, Python or PHP (see “Working With Alternate
Programming Languages” on page 745).

Custom Menus, Buttons, and Dialogs

Panorama gives you the capability to create your own custom menus (see “The Action Menu” on page 355
and “Live Menus” on page 362), buttons (see “Buttons & Widgets” on page 823) and dialogs (see “Dialogs”
on page 480), making professional quality custom applications possible.
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Seamless Cross Platform Operation

Panorama databases are 100% compatible with both the Windows or MacOS platforms and may be trans-
ferred back and forth freely between the two platforms. You can even share databases on a single server
across a cross platform network.

Videos & Screencasts

If you are just getting acquainted with Panorama, be sure to check out the guided tour screencasts (movies)
included on the CD (or if you downloaded Panorama you can watch the screencasts directly from the
www.provue.com web site). Just sit back and relax while we show you Panorama’s unique tools for organiz-
ing information. All of the movies are recorded digitally and allow you to pause, back up, or skip ahead to
the topics that most interest you (see “Screencasts” on page 49 of the Wizards & Demos PDF file).
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For more videos see http://youtube.com/provuedevelopment

Be sure to subscribe or check back often as we frequently add new videos to this site.



              
Chapter 1: Files and Memory

Panorama databases are permanently stored in files on a disk drive. (In fact, you’ll often find that the words
database and file are used interchangeably.) Each Panorama file contains all the components needed to use
the database.

Files, Icons and the Desktop

Before you begin to use Panorama you should be familiar with the basic operation of your computer.
Whether you are using a Macintosh or a Windows based computer, files appear in a “desktop” environment
that allows them to be located, moved, copied and opened. On the Macintosh this desktop environment is
called the Finder. On Windows computers this is simply called the desktop, which you can view with My
Computer or using the Windows Explorer. Here are two typical views of folders full of files on the desktop.
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There are three different kinds of Panorama icons: databases, file sets, and the Panorama application itself.

You can manipulate these icons on the desktop any way you like, just like any other files. (However, you
should avoid moving or copying the Panorama application itself. Although your disk may contain many
database files for different tasks, there should only be one copy of the Panorama program itself.)

Launching Panorama

To launch Panorama you can either double click on the Panorama application itself or double click on the
icon for any Panorama database or file set. If you double click on the Panorama application itself the New
Database wizard will appear.

This is the icon for a single Panorama database. On Windows 
machines, these files have the extension .pan. Double click on this icon 
to open the database.

This is the icon for a set of Panorama databases (called a file set). On 
Windows machines, these files have the extension .pnz. Double click 
on this icon to open the entire set of databases at once.

This is the icon for the Panorama application itself, which is usually 
called Panorama (Mac) or Panorama.exe (Windows). You can double 
click this application when you want to create a new database without 
opening an existing database first.
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This wizard can be used to create new databases (see “Using the New Database Wizard” on page 50), but it
can also be used as a handy “command post” for Panorama using the icons in the top right corner.

Changing the Default Launch Action

When you double click on the Panorama application icon Panorama normally opens the New Database wiz-
ard automatically. You can change this, however, by clicking on the Preferences tool in this wizard.

Click here to open the Recent Databases wizard. This wizard makes it easy to re-open data-
bases that were recently opened. See “The Recent Databases Wizard” on page 44 for more 
information.

Click here to open the Help & Documentation wizard. This wizard gives you rapid access to 
the various PDF files, on-line references and screencasts (movies) provided with Panorama. 
See “Help & Documentation” on page 45 of the Wizards & Demos PDF file for more infor-
mation.

Click here to change the preferences for this wizard, including controlling what happens 
when you double click on the Panorama application icon (see below).
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You have five different choices of what action Panorama will take when you double click on its icon:

There is also a sixth choice, Custom. This choice is a pop-up menu allowing you to pick any wizard as the
startup window.

Opening a Database

Before you can work with a database you have to open it. From the desktop the quickest way to do this is to
simply double click on the file’s icon. Or you can select the icon and choose Open from the desktop’s File
Menu.

If Panorama is already running you can use the Open File command (File Menu) to open the file. Simply
locate the file you want to open and double click on it. Or select the file and press the Open button.

This dialog has several additional buttons for importing, combining and creating new databases. For now
you can simply ignore these options.

You can also open a database using the Recent Databases and Favorite Databases wizards, described later in
this chapter (see “The Recent Databases Wizard” on page 44 and “Advanced Database Opening Techniques”
on page 47).

Open the New Database wizard (see “Using the New Database Wizard” on 
page 50). This is the default when Panorama is first installed.

Open the Recent Databases wizard (see “The Recent Databases Wizard” on 
page 44).

Open the Open Wizard wizard (see “Open Wizard” on page 17 of the Wizards & 
Demos PDF file).

Open the Open File dialog. This is the same dialog that appears when you choose 
Open File from the File menu, and was the action always taken by previous ver-
sions of Panorama when it was double clicked.

Do nothing at all. Only the Panorama menus appear, allowing you to use the File 
and Wizard menus to choose your next action.
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Databases and RAM

When a database is opened, Panorama copies the information from the disk into the computer’s internal elec-
tronic memory (RAM). Everything you do to a file takes place in RAM; including data entry, sorting, calculat-
ing, and drawing. If you want to store your work permanently, you must save it from RAM back to the disk
using the Save command.

Most database programs don’t take the extra step of copying the database from the disk into RAM before
working with it. Since your computer can access data in RAM hundreds or even thousands of times faster
than data on the disk, bringing the data into RAM makes Panorama much faster than most other database
programs. If you’ve used other database programs you’ll immediately notice how much “zippier” Panorama
is compared to the programs you are used to.

If your computer has enough RAM available, you can open several Panorama databases at the same time. For
more information about working with multiple files see “Opening Multiple Files” on page 74.

If your files are very large you may need to tell Panorama to use more memory. See “Monitoring Memory
Usage” on page 137 for more information on this topic.

The Wizard Menu

Panorama includes a number of pre-built databases that you can use as is, modify for your own purposes, or
simply use as learning tools. With only a few exceptions these pre-built databases are completely accessible
so that you can not only use them as is but also take them apart and see how they work. All of these data-
bases can be opened with the Wizards menu and its submenus.
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Many of these wizards are described throughout this manual. You can also find a complete description of
every wizard in the separate Wizards & Demos PDF file.

The Recent Databases Wizard

This wizard makes it easy to re-open recently opened databases. It can be opened by choosing Recent Data-
bases from the File menu. The wizard lists the databases that have been opened recently.

To re-open a database simply double click its name on the list. You can also open the first nine items simply
by pressing the 1 thru 9 keys on your keyboard. There’s no need to press Return, Enter, or anything else,
just press the number and the database will open.

To search for a particular database simply type into the search box at the top of the wizard.

At any time you can press the 1 thru 9 keys to re-open a database. For example type boo1 to open the
Checkbook database, boo2 to launch the Phone Book database, etc. You can re-open any previously opened
database with just a few keystrokes.
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The Prefs dialog allows you to exclude specified folders and files from the list of recent databases. By default
wizards are excluded.

If you want to include other folders or files simply list them in the dialog, one per line. You can use the ∂ sym-
bol (Option-D) to specify the current Panorama folder.

With the setting shown above any databases in the Accounting folder will be excluded.

The Favorites Menu

In addition to recent databases, which are handled automatically, you can also designate a list of favorite dat-
bases. To access a favorite, click on the yellow star and choose from the pop-up menu, which opens the
requested favorite.
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To modify the list of favorites, choose Edit Favorites from the pop-up menu.

To delete a favorite, press the corresponding - button. To add a new favorite, press the Add to Favorites but-
ton at the bottom of the dialog. Panorama will ask you to locate the database you want to add to the favorites
list. Press Choose to add the database to the list.

If a database is currently open there is a second way to add it to the list. Start by choosing Database Informa-
tion from the Setup menu. When the dialog appears, check the Add To Favorites option.

Press Ok to add the database to the list of favorites.
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Advanced Database Opening Techniques

The standard techniques for opening a database (double clicking, Open File dialog, Favorite Databases, etc.)
will work fine in 99,999 of 100,000 cases. Sometimes, however, you may need to use a more specialized tech-
nique to open a database. For example, if a database has lost its MacOS type/creator information (perhaps by
sending it through an e-mail client that doesn’t properly support this information, a common problem) the
standard techniques will not work. In this section we’ll describe the advanced techniques for these very
unusual cases.

Opening a Database With Incorrect Type/Creator Information

On MacOS systems each type of database is identified by special “type and creator” codes that are kept in the
disk directory. Panorama normally sets up these codes when a database is first created so you never have to
worry about them. However, if you transfer a Panorama database from a PC computer it will not have the
correct “type and creator” codes. These codes can also become missing or corrupted when transferring a file
via some e-mail programs. (To avoid this, we recommend compressing the database into a .zip file before
sending it via e-mail.)

Note: If the database name ends with .pan, the type and creator code are not necessary, and you can skip this
section. So for maximum compatibility with both Mac’s and PC’s, give your databases names like Con-
tacts.pan, Checking.pan, Sales.pan, etc.

If you have a file that you know is a Panorama database, but the type and creator codes are missing or wrong,
you can still open the database. To do this, open the Open Database wizard (in the Utilities submenu). This
wizard has a single window with three icons:

To open the database, simply drag it over the icon on the left (labeled Normal). If the type and creator infor-
mation are Ok, the database will simply open (just as if you had double clicked on it). If the type and creator
information are missing or corrupted, a warning dialog will appear:
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If you are sure that this file is a Panorama database (unlikely in the example above) go ahead and press the
Yes button. The wizard will set the type and creator codes to indicate that this is a Panorama database and
then it will go ahead and open the file. The next time you need to open this file you should be able to do so
normally.

Opening a Database Without Normal Initialization

When Panorama opens a database it normally performs an initialization process. If the window positions
were saved (see “Saving Window Positions” on page 64) Panorama will open any windows that were open
the last time the database was saved (forms, procedures, etc.) In addition, Panorama will run any custom ini-
tialization program that you have set up for this database (see “.Initialize” on page 382 of Formulas & Pro-
gramming).

In certain rare instances you may want Panorama to skip this initialization process. The most common reason
for doing this is if you have made a mistake in the custom initialization program that you have set up. If this
mistake prevents the database from opening properly, you can’t even get the database open to change the
program. Quite a pickle! Fortunately the Open Database wizard can handle this situation. Simply drag the
database onto the Data Sheet Only icon.

The database will open, but Panorama will skip the normal initialization process, and only the data sheet
window will open (no forms).

Opening a Database with No Windows

To open a database with no windows at all, drag it onto the No Windows icon in the Open Database wizard.
(This opens a database with no windows once. If you want a database to always open with no window use
the Save As command, see “Saving with No Windows” on page 149).

Opening with Multiple Copies of Panorama on Your System

In most cases you’ll have only one copy of Panorama on your computer, and you can simply skip this section.
However, on MacOS (either OS 9 or OS X) it is possible to have multiple copies of Panorama installed at once.
Unless you have a special need, we recommend that you install only one copy of Panorama on your com-
puter and remove all others. (For example, the technical support staff here at ProVUE has both Panorama 5.5
and Panorama 6 installed at the same time, and the programming staff has additional development versions
installed.) However, if you do have a special need to use multiple copies of Panorama you’ll want to control
which copy of Panorama you are using at different times.

The simplest method to control which version of Panorama is in use is to locate the Panorama application
you want to use, double click on it, then use the Open File dialog (see above) to open the database you want
to use. If you are using OS X you can put multiple copies of Panorama in the dock, and click on the one you
want to use, then use the Open File dialog to open each database.
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Using the Open File dialog is a bit awkward. Another method for opening a database with a specific copy of
Panorama is to drag the database onto the actual specific Panorama icon itself (or onto the dock icon for that
copy of Panorama).

If you are going to use one copy of Panorama most of the time you can tell Mac OS X to open that version
automatically when you click on any database. To set this up, click once on the icon of any Panorama data-
base, then choose Get Info from the File menu. This opens an Info window for that database.

As shown in the illustration above, you can use the Open with: pop-up menu to select which version of Pan-
orama you want to launch when you double click on this database. Press the Change All button if you want
this copy of Panorama to launch when you click on any Panorama database.

use pop-up menu to select specific
copy of Panorama you want to use

Click here to make this the default
version of Panorama when double
clicking on any database.
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Creating a New Database

Panorama has two ways to create a new database — using the New Database wizard and using the Open
File dialog.

Using the New Database Wizard

To help make creating new databases easier Panorama includes “wizard” for creating new databases.

If Panorama is already open you can choose New File from the File menu to open this wizard. (You can also
use the Wizards menu to open the New Database Wizard.)
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Creating a Database with the Wizard

To create a database start by typing in the name of the first field. You can also click on the yellow star to
choose from a list of common field names.

To add a second field, press the + button and fill in the field name, like this:

There’s a shortcut if you’re creating a field with a common name — right click on the + button (or Control-
Click), then choose the field name from the pop-up menu.

Type here, or...

choose here
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Once all of the fields have been added, press the Make New Database button.

Panorama automatically sets the width of each field. See “Changing the Width of a Field” on page 199 to
learn how to manually adjust the width of a field. Before you continue you should save your new database
(see “Saving a Database” on page 63).
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Creating Numeric and Date Fields

In Panorama, all data is not the same. To get the most out of a database, Panorama needs to know what type
of data you intend to store in each field — text, numbers or dates (see “Data Types” on page 245). The New
Database Wizard normally creates fields designed for holding text. If a field will contain numbers or dates
use the pop-up menu to designate the data type. 

Numeric data can be stored in either fixed point or floating point format. If you choose fixed point you have
a choice of 0, 1, 2, 3, or 4 digits after the decimal point (the Money type is also fixed point, 2 digits).

You may wonder why there are so many choices for storing numeric data. After all, a number is a number—
right? Not quite. By choosing different numeric storage formats you are making a trade-off between space,
speed, accuracy, and range.

Number of 
Digits After 

Decimal Point
Example Largest Value Smallest Value Typical Uses

0 93842 2,100,000,000 1 Quantities, Part Numbers

1 73.1 210,000,000 0.1 Rarely Used

2 253.22 21,000,000 0.01 Money (Dollars, Pounds, etc.)

3 0.447 2,100,000 0.001 Rarely Used

4 929.1123 210,000 0.0001 Rarely Used

Float 1.46e-12 1.7•10308 2.3•10-308 Scientific Data
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Storing numbers using floating point gives you the most accuracy and numeric range. Floating point allows
you to store extremely large or small values with up to 16 digits of accuracy. If you are in doubt, go ahead and
pick floating point format.

Fixed point storage is more limited. The accuracy is only about 9 digits. The largest number that can be stored
is about 2 billion (2•109) while the smallest fixed point number is 0.0001 (10-4). Trying to store larger or
smaller values using fixed point storage will result in errors.

On the other hand the space required for fixed point storage is up to 8 times smaller than floating point for
the same number, and Panorama can perform fixed point arithmetic somewhat faster than floating point. You
should use fixed point numeric storage whenever possible. Check the table above to see if the numbers you
will be using fit in one of the fixed point numeric ranges. (With today’s modern computers, you may not need
to worry about performance or memory usage in most applications, and it’s usually ok to use floating point
for most applications.)

Money. Usually the best way to store monetary values is using either 2-digit fixed point or Panorama’s spe-
cial Money format. The money format is the same as 2-digit fixed point but automatically enters the decimal
point for you during data entry. This table below shows how Panorama interprets data you enter into a
money field.

Both the 2-digit and money formats allow you to store monetary values up to 21 million dollars, pounds,
francs, etc. (If your business deals with values greater than 21 million you should use floating point numeric
storage.)

Default Values

You can assign a default value to any field (see “Default Values” on page 296). To default to a fixed value,
simply enter the value.

When you 
enter… it becomes

87204 872.04

3267 32.67

14 0.14

2 0.02

42. 42.00

15.4 15.40

156.78 156.78
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To repeat the previous value in this field (ditto) use the " symbol. When the defaults are set up as shown
below, a new record will automatically contain the same date and city as the previous record.

To automatically increment a numeric or date field use plus followed by a number (+1, +2, +5, etc.), like this.
When creating a new record, Panorama will take the value in the current record, increment it as specified,
and put the new number into the specified field.

You can also use the + symbol by itself. In that situation, Panorama uses an internal counter. The counter is
increased each time a new record is added. The counter can also be changed manually if necessary, see “Man-
ually Changing the Record Number Counter” on page 301.

To default to today's date use today. (This option only works for date fields).

Automatic Capitalization

When you are creating text fields you can enable automatic capitalization, either for all characters, by word or
by sentence.

Clairvoyance®

Another option for text fields is Clairvoyance®. When enabled, Panorama will auto-complete text entry for
you based on previous entries in the database. For more information, see “Clairvoyance®” on page 284.
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Rearranging Fields

To re-arrange fields before you create the database, just drag on the double arrows on the right side of the
windows.

Note: Fields cannot be dragged when you are importing data (see “Creating a Database from a Text File” on
page 59), only when creating an empty new, database.

Field Name Warnings and Errors

The New Database wizard will warn you if you create a field name that is improper or that will require spe-
cial handling in formulas. There are two types of improper field names — a blank field name, or a duplicate
field name. If you create an improper field name Panorama will display a red background behind the field
line, with a red alert icon. Click the red alert icon to see a description of the problem.
p

The New Database wizard will not allow you to create the database until the improper field names have been
fixed.
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Field names that will require special handling in formulas are flagged with a yellow background and a yel-
low alert triangle.

Unlike improper field names, the New Database Wizard will allow you to create the database without chang-
ing the field names, though it will warn you when you actually create the database. It’s simply up to you to
make sure any formulas you create have the special handling necessary (see “Fields” on page 50). If you
enable the Ignore Warnings option then Panorama will not display any warnings or yellow icons, though it
does still show a yellow background for these fields.
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Favorites

Panorama comes pre-equipped with a set of templates for creating new databases. To choose one of these,
simply click on the yellow Favorites star.

You can add your own templates at any time (and remove the standard templates as well). The first step is to
set up the fields in the proper configuration, then click on the Favorites star and choose Add to favorites.

The wizard will ask for a name for the new favorite.
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That’s all there is to it! The new favorite now appears in the menu (in alphabetical order).

To rename or remove a favorite, first select it from the menu. Then open the menu again and choose Remove
or Rename.

Creating a Database from a Text File

The New Database Wizard usually creates an empty database, but it can also create a database from a text
file and automatically import the text (see “Importing a Text File” on page 82). There are four possible ways
to start this process.

1) Drag a tab or comma delimited text file onto the wizard.

2) Drag data directly from a spreadsheet, word processor or text editor onto the wizard (Mac only), as shown
below.

3) Click on the Choose Import File button, then select a text file containing tab or comma delimited text.

4) Copy tab or comma delimited text into the clipboard, then press the Import from Clipboard button.
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Whatever process you choose, the wizard will use the first line of the imported data as the initial field names.

You can make adjustments to the database design before actually creating the database, including changing
the field names and types, setting up defaults, auto capitalization and Clairvoyance®. You cannot, however,
add, remove or re-arrange fields (of course this can be done later, once the database is set up).

When everything is ready press the Make New Database button. Panorama creates the new database and
brings in the data.

The new database is ready to save and use.

new field names automatically set up for you (you can change if needed)

source of imported data shown here
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New Database Options (Font, Windows, Save As)

Click the Prefs icon (on the upper far right) to change the preferences for creating a new database.

You can specify any font and size you want for your new data sheets. (Of course you can change this at any
time later with the Font menu.) If you want your database to be saved automatically at regular intervals you
can select this here (see “Auto-Save” on page 65 to learn how to change this later. Finally you can choose
whether you want Panorama to save your window positions when you save the database (see “Saving Win-
dow Positions” on page 64).

Creating a New Database with the Open File dialog

The Open File dialog also provides a simple method for creating a new Panorama database. Simply choose
Open File from the File Menu, then press the New button.

click to create new database



Page 62 Panorama Handbook
A new database created this way has ten fields and is called Untitled. These fields are named alphabetically:
A through J (You can change the names later). You can start entering data right away or you can change the
fields before you begin (See “Fields” on page 193).

Closing Panorama

When you are finished with Panorama, use the Quit command (File Menu) to return to the desktop. If you
have not saved your work, Panorama will display an alert and ask if you would like to save the work now.

Simply press the Save button to permanently save the database on the disk and return to the desktop.
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Saving a Database

You can save your work permanently on the disk at any time with the Save, Save As, or Save a Copy As
commands in the File menu. The Save command saves the database permanently on the disk, then allows
you to continue with your work. You should save your work often.

The Save A Copy As command makes a copy of the database under a new name. It leaves the original copy
in memory so you can continue to work on it. This command is like duplicating a sheet of paper and then
continuing to work on the original.

The Save As command also makes a copy of the database under a new name. The Save As command, how-
ever, leaves the new copy in memory—not the original. This command is like duplicating a sheet of paper
and then working on the copy while setting the original aside.
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The Save As command allows you to choose the location where you want to save the file, the name of the
new file, and several file options.

On Windows computers all Panorama database names end with .pan. This is called the extension, and it tells
the system that this file is a Panorama database. You should not type the extension into the Save As dialog
box—Panorama will automatically add the extension for you.

You can save the database as a regular Panorama file, as a text only file (see “Exporting a Text File” on
page 105), or create a file set (see “File Sets” on page 75). You can also use the Save As command to turn on
the Save Window Positions, Auto-Save and Keep Backup Copy options described later in this chapter.

Saving Window Positions

If you check the Save Window Positions option, Panorama will save the positions of each open window that
belongs to the file being saved (if the database is created with the New Database Wizard this option will
already be checked the first time you save). The next time the file is opened, Panorama will automatically
open the same windows in the same positions. Each time you save the file, Panorama will save the new win-
dow positions. (Note: Starting with Panorama 5.5, Panorama no longer remembers the positions of any pro-
cedure windows that are open. Only data sheet and form windows will be opened automatically.)

It is also possible to lock in window positions so that they will always be open in the same positions, even if
you move the windows and save again. To do this, first choose Save As and check the Save Window
Positions option. Move the windows into the desired positions and then choose Save from the File Menu.
Now, open the File Privileges dialog and change from Author to User or Custom level. (To open this dialog
on a Macintosh computer, hold down the Command or Option key and choose About Panorama from the
Apple menu. To open this dialog on a Windows system, hold down the Control or Alt key and choose About
Panorama from the Help menu. See “The Privilege Dialog” on page 184 for details on this command.) Close
the dialog, and choose Save again. The window positions are now locked in place. To unlock them, switch
back to Author mode.

Type in name of file

Choose type of file



Chapter 1:Files and Memory Page 65
Obsolete Save Options

The Save-As dialog options described below are now obsolete, and if you are using them on existing data-
bases, we recommend you turn them off. Auto-save of individual files is now replaced by Total Recall (see
“Total Recall (Auto-Save/Crash Recovery)” on page 66), and the .b Backup file option is now superseded by
Time Lapse (see “Time Lapse” on page 67).

Auto-Save

If you wish, you can ask Panorama to automatically save your file every few minutes. To turn on this feature,
choose Save As, then check the Automatic Save option and enter how often you want Panorama to save the
file. When you are done, press the Save button. (If you are using a Macintosh computer and you have saved
this file before, Panorama will ask you if you want to replace the existing file. Press Yes).

Once you have turned on the Automatic Save option it remains on unless you Save As again and turn it off.

Pitfalls of Auto-Save. If you think you might need to use Revert to Saved, you should not use auto-save.
When you are using auto-save keep in mind that you no longer control when the file will be saved. This lack
of control can cause problems if Panorama saves the file when you didn’t want it to. In particular, if you have
deleted items from your database you won’t be able to get them back using Revert to Saved once the file has
been automatically saved.

Because they can remove large amounts of data from your database, the Remove Unselected and Remove
Detail commands are especially dangerous with auto-save. To help reduce this danger, these commands give
you the option to temporarily suspend auto-save. Once you have suspended auto-save it will remain off until
you manually save the file (with the Save command).

Backup Files

Like most programs, Panorama normally stores only one copy of each database on the disk. If you wish,
however, you can tell Panorama to keep a second copy of a database. This extra backup copy can help protect
you from mistakes.

The backup copy of a database is a copy of what was saved the second to the last time. Having a backup copy
of the database means that if you make a mistake and save when you didn’t mean to, you can still get back to
the previous version of the database.

The backup copy of the file has the same name as the original with.b added. On Macintosh computers the.b is
added at the end of the filename (for example the backup file for Checkbook is Checkbook.b). On Windows
computers the .b is added just before the .pan extension (for example the backup file for Contacts.pan is Con-
tacts.b.pan).

Macintosh computers are limited to 32 character file names. Because of this limitation, the original filename
cannot exceed 29 characters if the Keep Backup option is used. (If the filename is more than 29 characters,
Panorama will ignore the Keep Backup option.)

To tell Panorama to keep a backup copy, use the Save As command to save the file and check the Keep
Backup Copy of Database option. Once this option is checked, Panorama will keep a backup copy whenever
the file is saved.

Opening Backup Files

You can open a backup file by double clicking on it, just like any other Panorama database. On the Macintosh
however, you cannot open backup files with the Open File command, because the backup files are not dis-
played in the dialog.
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Total Recall (Auto-Save/Crash Recovery)

Total Recall allows Panorama to fully recover after a crash -- whether due to a power outage, hardware prob-
lem, system crash, or Panorama bug (never!). When Panorama is relaunched after a crash it asks you if you
want to start over or resume where you left off.

If you press Resume Previous Session Panorama automatically restores everything just as you left it -- all
open files, open windows, etc. Only the last few seconds of work will be lost. It's almost as if nothing has hap-
pened at all — you can just continue with your work as if nothing had happened.

Total Recall does not affect normal file saving, so if you have unsaved changes when the crash occurs, they
will still be unsaved when Panorama is restored (in other words, Revert to Saved can still be used after the
crash/restore cycle). Panorama will even restore any work you've done in a new database that has never
been saved!

Setting the Total Recall Save Frequency

Total Recall works by periodically saving all of Panorama's RAM to disk. It uses the fastest possible tech-
nique for this, so in most cases you'll never even notice this is happening. To adjust how often periodic saves
occur, open the Preferences window and choose Total Recall.

Simply drag the slider to set the time, or to turn the feature completely off.
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Rolling Back Database Changes

As you’ll learn in the following chapter, Panorama is a powerful tool for working with and manipulating
data, it’s an incredible power tool for your data. Unlike a real power tool, however, you don’t have to worry
about safety or about accidentally destroying data by improper use of the tool. Even if you accidentally
deleted all of your data, Panorama’s capability for rolling back changes will protect you. You can work confi-
dently in the knowledge that your previous work is always safe.

Revert to Saved

Panorama’s first level of rollback is the Revert to Saved command (File Menu). This command recopies the
original file from the disk into RAM. This will undo all the changes made since the last time the file was
saved. By all changes we mean all changes: data entry, sorting, formulas, graphic editing, creating/deleting
forms, crosstabs or procedures—every single thing you’ve done to this database since the last time you
saved. Before Panorama actually goes ahead with this command it asks you to verify that you really want to
do this.

If you press Revert then Panorama will discard all of the changes made since the last time you saved the data-
base.

Time Lapse

Panorama's Time Lapse feature is like Revert to Saved on steroids. With Time Lapse you can roll back to pre-
vious versions of your database made earlier today or at various times in the past. In addition to doing a full
revert, you can also selectively revert only the data, only the procedures, or only the forms. You can also open
previous versions of the database (called “slices”) in separate windows so that you can compare them with
the current database or even copy and paste data, code or form objects between versions.

Each time you save a database Panorama also makes another copy (“slice”) for the Time Lapse feature. By
default Panorama keeps up to 25 slices of previous versions of the database (more on how Panorama eventu-
ally determines how to “thin out” the slices in a moment.)
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To see the previous slices that have been saved for the current database choose Time Lapse from the File
menu. The slices are displayed in a monthly calendar format.

Choose the year, month and day of the slice you are interested in (it defaults to today). (Note: The 1) Years
and 2) Months lists show the number of slices available in the year and month.) Then choose the exact slice
you are interested in from the list on the right. For each slice the list shows the date and time it was saved, the
number of records, and the contents of the current record at the time the slice was saved.

Once you've selected a slice you can use the tools across the top to work with that slice:
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Open Slice Data Sheet —  Click here to open the slice in a separate window. When opening a previous slice
this way Panorama always opens just the data sheet. Panorama ignores any saved window positions, it does
not run any .Initialize procedure, and if this is a shared database it does not connect the database to the server
or try to synchronize the database. The title of the window shows the database name and the date and time
the slice was saved (the original database name may be truncated if necessary).

As you can see above, the data is all displayed in gray rather than black, and you cannot edit the data. You
can copy it to the clipboard, however.

Though the slice always opens using the data sheet, you can use the View menu to open forms or procedures.
If you try to save the slice Panorama will prompt you for a new file name/location. This makes the slice into
a new, separate database that has no connection with the original database.

Revert Database — Click here to revert the current copy of the database to this previous version. All of the
data, forms, procedures, permanent variables, print settings, etc. are all reverted back to the older version of
the database.

Note: Reverting to a previous slice doesn't prevent you from later reverting to a more recent slice. You can
easily move back in forth in time. Be careful, though, it can get confusing if you don't keep track of what you
are doing.

Revert Data — Click here to revert the just the data to this previous version. All forms, procedures, perma-
nent variables, print settings, etc. are undisturbed. (Essentially Panorama imports the data from the previous
slice into the current copy of the database.)

Revert Procedures — Click here to revert just the procedure code to this previous version. Everything else is
undisturbed. For example, suppose you had made changes to procedures that didn't work out. You could
simply revert the procedures back to the previous code, while keeping all of the updated data, forms, etc. (If
you want to revert just a single procedure, open the previous slice with the Open Slice Data Sheet tool, open
the procedure with the View menu and then manually copy the procedure code.)

Revert Forms — Click here to revert just the procedure code to this previous version. Everything else is
undisturbed.

More Info — Click here to display more information about this saved slice, including a list of the forms, pro-
cedures and crosstabs in the database at the time the slice was saved.
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Right Click/Context Menu — In addition to the tools across the top of the window you can also right click on
a slice for a list of operations that can be performed on that slice.

The first six options in this menu are the same as the tools on the top of the window. The last two options
allow you to manually delete saved slices.

Delete — Choose to delete this particular slice.

Delete Before — Choose this to delete all slices saved before this slice. Note: We mean all slices, including
slices saved on previous days, months, and years.
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Time Lapse Preferences

By default Panorama keeps up to 25 “slices” of each database, and it tries to keep slices from a range of peri-
ods, not just the most recent. While in the Time Lapse window you can use the Setup->Global Preferences
dialog to adjust how Panorama decides which slices to keep.

If necessary, you can override the preferences for a specific database. For example, if you have an extra-
important database you may want to keep 50 copies instead of 25. Use the Setup->Preferences Override dia-
log to customize Time Lapse for a particular database.

Important Note: Time Lapse only works with database files that are inside the current users folder. Time
Lapse slices will not be saved if the database is outside this folder (on an external drive, for example).

On the Importance of Backing Up

You’ve heard it before, you’ll hear it again—there’s no substitute for regular backups. Panorama’s Time
Lapse option is great for recovering from your mistakes, but it won’t do you any good if your hard disk fails,
or even gets stolen. Yes, it can happen to you! To protect from fire or theft you should keep your backups at a
separate location. Any experienced user will tell you that “Having good backups means never having to say
you’re sorry!”

Of course some of you will ignore this advice until it happens to you. We get too many sad calls from people
who have lost thousands of records due to a hardware failure. Don’t take a chance on being one of them.
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Finding a Database on the Hard Disk

To find the location of the current database on the hard drive simply choose the Reveal in Finder command
from the File menu.

This will open the folder containing the database and highlight the database file.

Note: This feature is only available in Mac OS X.
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Viewing and Modifying Database Metadata

Metadata is defined as data that describes other data. The Database Information wizard allows you to view
and modify descriptive information about any database: the title, author name, description, keywords, etc.

The Database Information wizard always works with whatever database is displayed in the topmost win-
dow. To view or modify the descriptive information simply choose Database Information from the Wizard
menu. Unlike most wizards, this one opens a dialog window which displays the metadata information.

The Database and Location fields are always filled in for you, and cannot be changed. You can modify all of
the other fields to contain any text you like. When you press the Ok button the metadata is stored in the data-
base itself (in this case inside the Conference Registration database). Warning: Just like other database infor-
mation, the metadata isn’t saved permanently until you use the Save command.
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Working with Multiple Databases

Panorama can work with several databases at the same time. The databases can be independent, or they may
contain related information. 

As you use Panorama, you’ll probably encounter many tasks that require working with several databases at
once. For example, when you are working with an invoice database, you may need to have the customer and
price list databases available. As you are working with a checkbook database, you may need to access infor-
mation in vendor and accounts payable databases. When you are working with a class scheduling database,
you may also need the course catalog and student registration databases. Panorama can handle all these
tasks.

Opening Multiple Files

You can open multiple files all at once using the desktop (Explorer), or one at a time after Panorama is open.
From the desktop, first select the files and then double click on one of them. (To select several files, either hold
down the Shift key as you click on each file, or drag the mouse around the files.)

select the files you want to open and then double click on one of them



Chapter 1:Files and Memory Page 75
Panorama will open all of the databases you have selected.

To open an additional file from inside Panorama, use the Open File command in the File Menu. You can con-
tinue to open files until you run out of memory. (You are also limited to 64 open windows.)

File Sets

If you plan to use a group of files together, you can create a special document that represents the entire group.
This special document is called a File Set. File Sets have their own unique icon.

When you double click on a file set icon, Panorama will automatically open all the files included by the set.
For example, you could create an Order Entry file set that automatically opens three databases—Invoice,
Customer List, and Price List. A file set can also be opened with the Open File dialog.
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To create a file set, first open the databases you want to include in the set. (Make sure that no other files that
you don’t want included in the set are open. Every open file will be included in the set. If you are not sure
what files are currently open you can use the Memory Usage command to find out — see “Monitoring Mem-
ory Usage” on page 137.) Then use the Save As command in the File menu. Type in the name of the file set. If
you are using a Macintosh computer check the Set radio button.
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If you are using a Windows PC computer use the combo box to choose the Panorama File Set {*.pnz} option

Press the Save button to create the file set document.

All the databases in a file set must be in the same folder as the file set itself. The files will be opened in the
same order that they were originally opened when you created the set. If you want to make sure that the files
open in a certain order, you should open the files manually (with the Open File command) in that order
before saving the file set.

A file set cannot be edited or changed once it is created. To change a file set, you must use Save As to create it
over again.

Tip: It’s important to realize that the file set document does not contain the actual databases themselves—the
databases are still in separate files. If you copy the file set to another folder or disk, you also need to copy the
actual database files.

Tip: You cannot save the window positions associated with a file set. Instead, you must save the window
positions of each individual database within the set. See “Saving Window Positions” on page 64 for more
information on saving window positions.

The AutoLoad File Set

Panorama allows you to create a special file set that loads automatically when Panorama is launched. This
file set must be called either AutoLoad (Macintosh) or AutoLoad.pnz (Windows PC) and must be in the same
folder as the Panorama application itself. However, this file set only loads automatically if no other database
is opened. In other words, if you double click on the Panorama application itself, the AutoLoad file set will
open, but if you double click on a Panorama database or file set, the AutoLoad file set will not open. The
AutoLoad file set will also open automatically if Panorama is launched automatically (for example from the
Startup Items folder, an AppleScript or by configuring a CD to automatically run Panorama from the CD
when the disk is entered).

The AutoLoad file set must be in the same folder as Panorama. If that is not possible, you can create an alias
(Mac) or shortcut (Windows PC) to the AutoLoad file set and move the alias into the Panorama folder. The
alias/shortcut must be named AutoLoad, not AutoLoad alias or any other name.
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Saving Multiple Files

The Save command only saves one file at a time—the file associated with the top window. To save all the
open files, use the Save All command. (Note: Only databases that have actually been changed will be saved.)

When you use the Quit command, Panorama will check each open database to see if it has been modified.
Panorama will ask you if you want to save your changes before shutting down Panorama.

Appending One Database to Another

To append a database to the end of the current database, use the Append To Current Database option in the
Open File dialog.

When you press the Open button the data in the selected file is appended to the end of the current file. (Only
the data is appended, not the forms, procedures, crosstabs, or Flash Art.)

If the Match Fields by Name option is checked Panorama will examine the two databases and look for fields
with the same names. Only the data in these fields will be appended. For example if both databases contain
fields named Address, City, State and Zip then the information in these fields will be appended. However if
one database has a field named Zip and the other has a field called PostalCode, the data in these fields will
not be appended. The field names must match exactly — Company and COMPANY will not match.
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If the Match Fields by Name option is not checked Panorama will append fields according to their order. In
other words, the first field of the second database will be appended to the first field of the current database,
the second field to the second field, etc. Usually appending two databases this way makes sense only if both
databases have the same fields in the same order. If they don’t, you can open the second database, re-arrange
the fields and then append (see below).

If the Match Fields by Name option is not checked and the database being appended has more fields than the
current database, the extra fields will be ignored. If the data types in the two files are incompatible, some data
may be lost. For example, data will be lost if you try to append text into a numeric field. Panorama will alert
you if this happens, but it cannot tell you exactly what data has been lost.

After the append is finished, Panorama positions the database at the first new record. All the records above
this position are part of the original file. All the records at and below this position are part of the new
appended data.

Appending an Open Database

Panorama can append a database that is already open. Panorama will append the copy of the database that is
open in memory, not the original on disk. This is handy if you want to modify a file before you append it.

Panorama can also append a database to itself. In this case Panorama will append the original copy of the
database on disk. For example if you open a database with 1,000 records, delete 500 records without saving,
and then append the database to itself, you will wind up with 1,500 records.

Appending Imported Data

By checking the OverVUE or Import radio buttons (PC) or selecting the Text Files (Import) option from
Enable pop-up menu (Macintosh) in the Open File dialog, you can import data and append it to the current
database in a single step. Either tab or comma delimited TEXT files can be appended. The data being
imported should contain the same fields in the same order as the current database. If the fields do not match,
some data may be lost. For a complete discussion of importing data into Panorama, see “Importing a Text
File” on page 82. 

original data

new appended data



Page 80 Panorama Handbook
Replacing Obsolete Data

Another Open File dialog option is Replace Current Database.

This option allows you to completely replace the data in the current database with the data in another data-
base. This is useful if the current database contains obsolete data, but has forms or procedure you want to
use.

Depending on whether or not the Match Fields by Name option is checked the new data should either have
the same field names as the old database or it should have the same fields in the same order as the current
database. If the fields do not match, some data may be lost. The Replace Current Database option works
exactly like the Append option, except that Panorama removes all the data in the current database before
appending the data.

You can also replace the current data with imported data—just check the Replace Current Database option
and also check OverVUE or Import (PC) or select Text File (Import) from the Enable pop-up menu. The data
being imported should contain the same fields in the same order as the current database. If the fields do not
match, some data may be lost.
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Importing and Exporting Data

Panorama allows you to freely exchange information between it and other applications. The common terms
for these exchanges are importing and exporting. 

Importing means to transfer information from another program or computer into a Panorama file. The data
can then be manipulated using Panorama’s menu commands and tools. Panorama’s import capabilities allow
you to take advantage of databases that have already been keyed in or databases on other computers (for
instance, on minicomputers or electronic bulletin boards). See “Importing a Text File” on page 82.

Exporting is the exact opposite of importing. To export data from Panorama means to take data from a Pan-
orama file and make it accessible to another “foreign” program. For example, Panorama data can be exported
to Excel so that it can be included in a spreadsheet. See “Exporting a Text File” on page 105.

In addition to the manual techniques described in this chapter it is also possible to set up a procedure to auto-
matically import or export data. To learn more about this see “Importing Text Files” on page 409 and
“Exporting Text Files” on page 413.

Working with Text Files

Panorama cannot directly access information in database or spreadsheet files created by other programs.
Exchanging data between Panorama and another program requires an intermediate text file. A text file is
very basic because it contains just the data—no forms, procedures, graphics, or anything else. Because text
files are so simple, they provide a common interchange format for different programs. Virtually all database,
spreadsheet, and word processing programs can read and write text files. This makes transferring data
between Panorama and another program a two step process. Let’s take Excel as an example. To transfer data
from Panorama to Excel you first must export the data from Panorama as a text file. Then you go into Excel
and import the text file. To transfer data from Excel to Panorama you start by exporting the data from Excel as
a text file. Once the text file has been created you can go into Panorama and import the data from the text file.

In addition to importing and exporting text files you can also edit them directly. On the Macintosh the Sim-
pleText application is provided free with every computer. Here’s what a typical text file looks like in this
application.
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On PC systems text files can be edited with the Notepad or WordPad applications.

On PC systems text files often have a three letter filename extension of .txt, for example My Data.txt. How-
ever, text files may use other extensions as well, such as the .csv (short for comma separated values) file
shown above. Panorama can work with text files with any extension.

On Macintosh systems no extension is required. However we recommend adding .txt to the end of the file-
name anyway. This makes it easier to remember what kind of data is in the file and also improves compatibil-
ity in case the file is ever transferred to a PC system.

Importing a Text File

The first step in importing a text file is to prepare the text file. You can create it manually using a text editor
like SimpleText or Notepad, but usually the text file is created by exporting from another database or spread-
sheet program.

Macintosh PC
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Once the text file is prepared go into Panorama and choose Open File from the File menu. This is the same
dialog that is used for opening Panorama databases. On the Macintosh, choose Text Files (Import) from the
Enable pop-up menu to see a list of text files that can be imported.

If you are using a Windows PC computer then use the combo box to choose Text files {*.txt}.

combo box
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When you choose this option the dialog will list all of the .txt files available to be imported.

If you want to import a text file that does not use the .txt extension then use the combo box to choose All files
{*.*}. This causes all files to be listed. In this illustration the All files option is being used to allow a .csv file to
be selected for import.
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Once the text file you want to import is visible simply click on it and press the Open button. Panorama will
create a new database and fill it with the data from the text file. Panorama automatically examines the text file
to decide whether the data is tab or comma separated and then creates the number of columns required to
hold the data.

The new database is initially assigned the name Untitled (or if that is taken, Untitled 2, Untitled 3, etc.). The
first time you Save the database Panorama will ask you to assign the actual name to the file.

The columns in the new database are initially assigned the names A, B, C, etc. To assign real names to these
columns you can use the Field Properties dialog (see “Field Properties” on page 215) or the Design Sheet (see
“The Design Sheet” on page 212)
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Importing into an Existing Database

When you import a text file Panorama normally creates a brand new database, as described in the previous
section. However, it is also possible to import data into an existing database. To do this you must check either
the Append to Current Database or the Replace Current Database option in the Open File dialog.

The data being imported should have the same fields in the same order as the current database. If the fields
are not in the same order you should use the Text Import Wizard (see “Using the Text Import Wizard” on
page 94) to import the text. Otherwise some data may be lost.

If the Append to Current Database option is checked, the imported data will be appended to the end of the
current database. Use this option to add new data to an existing database.

If the Replace Current Database option is checked, the imported data will completely replace the current
data. The old data will be erased, then replaced with the new imported data. Use this option to update a data-
base with the latest information, while leaving all the forms, reports, crosstabs, and procedures intact.
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Importing HTML Tables

Panorama can automatically import tables from a text file that contains HTML with the <table> tag. As an
example consider the HTML page shown below.

To import the data on this page you must first save the page as a text file. Consult the documentation for your
browser to learn how to do this. A sample HTML file named Aspen Hotels.html is supplied with your copy
of Panorama — locate this file now if you want to follow along.
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If you examine this file with a text editor you should see the <table> tag followed by the data and finished
up with the </table> tag.

You can import this file just like any other text file. Panorama will scan the file and notice the <table> tag.
When it finds this tag it switches gears and goes into HTML table import mode. It automatically analyzes the
tags and extracts the data in the table. Voila!
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If the .html file contains more than one <table> tag Panorama will only import the first one. You may need
to manually edit the file before you import to make sure that the data you want to import is the first table in
the file.

In some cases you may need to do further work to clean up the data after it is imported. Consider the table
shown here.

In this case the html is much more complex, and each data cell contains tags for setting the font.
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When the data is imported, these tags are also imported.

If you wish you can use the Change command to get rid of these extra tags (see “Change (Find and Replace)”
on page 472). Start by replacing <font face="geneva" size=-1> with nothing.
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The command removes this tag from the first column.

Repeat this process for each additional column. (This is an excellent potential application for automation
with a procedure — see “Procedures” on page 203 of Formulas & Programming.)

As you can see we’ve also adjusted the column widths. See “Changing the Width of a Field” on page 199 to
learn how to do this.



Page 92 Panorama Handbook
Now we need to go back to the first column and replace <font> with nothing.

The first column is now pretty much cleaned up.

Repeating the process for the other columns.

Cleaning up this data was a fair amount of work but was much easier than typing in the data all over again,
and less prone to errors.
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Importing OverVUE Files

OverVUE was ProVUE’s first database program and the predecessor to Panorama. However, since the last
version of OverVUE is almost twenty years old, Panorama 5 and later no longer supports import of Over-
VUE documents.

Re-Arranging Imported Data

Sometimes the data you want to import is not set up the way you want. Perhaps the fields are in the wrong
order, or the data is not split into fields correctly. The easiest way to handle this is to use the Text Import Wiz-
ard (see “Using the Text Import Wizard” on page 94). If you don’t want to use the wizard, Panorama has lots
of great tools for transforming the imported data after it is imported.

If the fields are simply in the wrong order, you can easily re-arrange them. See “Re-Arranging Fields” on
page 219 for details on re-arranging the field order.

If the data is not split into fields properly using tabs or commas, you can use the Manipulate Data in Field
command to massage the data into shape. See “The Manipulate Data Dialog” on page 434 to learn more
about this command.
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Using the Text Import Wizard

The Text Import Wizard makes it easy to import a text file into an existing database, even if the fields in the
text file are not in the same order as the database fields. Usually you’ll start the process by opening the data-
base you want to import the data into. To illustrate this wizard we’ll use a very simple mailing list file.

To start the import process choose Import Text from the File menu. As you can see the bottom section side of
the window shows that we are going to import into the Mailing List file, and lists the five fields in this data-
base.

The next step is to select the text you want to import into this database. There are four possible ways to do
this.

1) Drag a tab or comma delimited text file onto the top half of the wizard.
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2) Drag data directly from a spreadsheet, word processor or text editor onto the top half of the wizard (Mac
only), as shown below.

3) Click on the Choose Text File button, then select a text file containing tab or comma delimited text.

4) Copy tab or comma delimited text into the clipboard, then press the Import from Clipboard button.

The selected text will appear in the top section of the wizard.
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If the imported text is already in the correct arrangement you can simply click on the Favorites button (yel-
low star), choose ALL IMPORT COLUMNS from the pop-up menu, then press the Import button. Other-
wise, the next step is setting up the import configuration. There are several ways to do that, but usually the
easiest is to drag fields from the top to the bottom section of the wizard. 

When you release the mouse the wizard will update the import configuration.
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You’ll need to drag each field you want to import down from the top to the bottom.

Sometimes the data you want to import doesn’t match the fields in the database. In this case the database has
only a single Name field, but the import data contains separate first and last names. Somehow these separate
fields will need to be combined as the data is imported. The import wizard allows you to do this with a for-
mula (see “Formulas” on page 19 of Formulas & Programming). To edit the formula for a field double click
anywhere in the field’s column.

double click 
in column to 
edit formula
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Within this formula you can include any import field by typing the field number in between « and » charac-
ters (see “Special Characters” on page 57 of Formulas & Programming, or simply use the Fields menu to type in
the field number for you). To “glue” two text items together you can use the + symbol (see “Gluing Strings
Together” on page 67 of Formulas & Programming). To include constant text in the formula put the text inside
quotes (see “Constants” on page 49 of Formulas & Programming). The illustration below shows a formula that
combines the first and last name into a single field (with a space in between).

Press the OK button to preview the result of this formula.

You are almost ready to import the data. Before you do, make sure that the Append or Replace option you
want is selected. Append will append the new data to whatever data is already in the database, while
Replace will erase and replace the existing data.) You may also want to choose to skip the first line of the
imported data.

Now press the Import button. The wizard imports the data into the original database.

result

formula
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Common Import Formulas

Using a formula you can combine import fields, split import fields, convert to upper case or lower case, and
much much more. You’ve already learned how to combine two or more import fields together with the +
symbol like this (see “Gluing Strings Together” on page 67 of Formulas & Programming).

«1»+" "+«2»

«2»+", "+«1»

To pick out a single word (for example a first or last name) you can use the firstword( or lastword(
functions (see “Text Arrays” on page 93 of Formulas & Programming). Here is a formula for picking the first
name from a combined name field (assumed to be the first field, «1», and using the format First Last, for
example John Smith).

firstword(«1»)

To convert text to upper case use the upper( function (see “String Modification Functions” on page 80 of
Formulas & Programming). This formula extracts the last name and converts it to upper case.

upper(lastword(«1»))

To extract only a limited number of characters use a text funnel (see “Taking Strings Apart (Text Funnels)” on
page 69 of Formulas & Programming). This formula extracts the first five characters from a zip code.

«6»[1,5]

This table lists some common formulas that can be useful when importing.

Formula Description

firstword(«1») extract the first word of the first import column

lastword(«1») extract the last word of the first import column

«1»+" "+«2» combine the first and second import columns (with a space in between)

trimstart(«1»,2) include everything but the first two characters of the first import column

trim(«1»,3) include everything but the last two characters of the first import column

«1»[2,4] extract the 2nd thru 4th characters from the first import column

upper(«1») include first import column, converted to upper case (all caps)

lower(«1») include first import column, converted to lower case

upperword(«1») include first import column, first character of each word capitalized

striptoalpha(«1») include first import column, but only alphabetic characters

stripchar(«1»,"09..--") include first import column, but only numeric digits, periods, and minus signs 
(useful for importing numbers when there are extraneous characters like cur-
rency symbols)
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Here is an example that uses several of these techniques.

To learn more about Panorama formulas see “Formulas” on page 19 of Formulas & Programming.

More Import Configuration Techniques

This section describes some additional techniques for setting up the import configuration.

Tab Width. The top section of the Text Import wizard displays the data to be imported in fixed width col-
umns. Click on the Tab Width icon to change the width of these columns.

firstword(«1»)

upper(lastword(«1»))
«5»[1,5]
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Configuration Context Menus. As an alternate to dragging columns you can set up the configuration by
right clicking on either the top or bottom section of the wizard. Right clicking on an imported column allows
you to choose a database field to “slot” the imported column into.

Right clicking on a database field allows you to choose an import column to “slot” into that field. You can
also edit the formula associated with the field, or clear the field.
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Rearranging and Deleting Import Columns. If you make a mistake you can simply drag the column to the
correct position, or drag it completely out of the bottom section to remove it.

You can also remove a column by right-clicking on it and choosing Clear from the pop-up menu.

Starting Over. To start over, simply drag another text file onto the top section of the dialog. Or, you can click
on the trash can icon.

Clear Import Configuration clears out the bottom section of the wizard. Reset Wizard clears the entire wiz-
ard, after using this option you must re-select the text to be imported.

Choosing a Database to Import Into. The Text Import Wizard normally imports into database that was
active when the wizard was opened. However, you can use the Database menu to choose to import into any
open database. Simply choose the database you want to import into and then set up the configuration.

Importing into a New Database. The Text Import wizard is for importing into an existing database. If you
decide you would rather import into a new database, click the Import into new database icon. (This icon
does not appear until you have selected a text file.)

Converting an Import Configuration into a Procedure. To convert the current import configuration into a
procedure choose the Copy Procedure to Clipboard command from the Special menu. Now create a proce-
dure (see “Writing a Procedure from Scratch” on page 216 of Formulas & Programming) and Paste the auto-
matically generated procedure into it.

For more information on creating and using procedures see “Procedures” on page 203 of Formulas & Program-
ming.
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Saving the Import Configuration for Later

To save an import configuration for later, click on the Favorites icon and choose Add to favorites.

You’ll be asked to give the new favorite a name. (If you use the name of the text file being imported, Pan-
orama will automatically use this favorite configuration if you later re-import this text file.)

Later you can use the pop-up menu to bring back the saved configuration.

If you want to delete or rename a favorite, first select it, then click on the Favorites star again. Then choose
Remove or Rename.
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ALL IMPORT COLUMNS. In addition to the favorites you set up, Panorama automatically sets up a favor-
ite called ALL IMPORT COLUMNS. This favorite sets up a configuration where the first imported text field
goes into the first database field, the second database field into the second field, etc.

Importing Financial Data (QIF, OFX, QFX)

Panorama can import data directly from financial applications and from data downloaded from financial
institution web sites. To learn more about this feature see “Financial Data Wizard” on page 60 of the Wizards
& Demos PDF file.

Importing VCard Data

Panorama can import VCard data files from applications that support VCards. To learn more about this fea-
ture see “Using Generic Fields with the VCard Wizard” on page 237.
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Exporting a Text File

To export the selected records (see “Searching and Selecting” on page 331) in the current database into a text
file, use the Save As command in the File menu. The standard save dialog will appear on the screen. If you
are using a Macintosh computer select the folder and name of the text file and click the Text Only radio but-
ton. (The name must be different from the database name.)
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If you are using a Windows PC computer use the combo box to choose the Text file (Export) {*.txt} option.
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Once the name and text only option are set up, click the Save button. This opens a second dialog that allows
you to specify which fields to include in the exported data and what format to use.

Only the fields you select will be included in the text file. To select a field, click the mouse on the field name.
To select additional fields, click on them also. To un-select a field, click on the field again. If you want to
export all the fields in the database, you can quickly select them all with the Select All button.

The four radio buttons—Commas, Tabs, Tabs w/o quotes, and Word Perfect—let you pick how the text file is
formatted.

Option Description Example

Commas

Exported file will have commas between 
each field and a carriage return at the end of 
each line. If a data cell contains a comma, it 

will be surrounded by quotes (").

Tabs

Exported file will have an invisible tab char-
acter between each field and a carriage 

return (Mac) or carriage-return/line feed 
(Windows) at the end of each line. If a data 

cell contains a comma, it will be surrounded 
by quotes (").

Tabs w/o quotes

Exported file will have an invisible tab char-
acter between each field and a carriage 

return (Mac) or carriage-return/line feed 
(Windows) at the end of each line. No quotes 
are added even if the data contains commas.
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The Field Names checkbox lets you choose whether you want the first record of the text file to list the field
names. If this button is checked, an extra line will be added to the top of the text file. This extra line will con-
tain the names of each field.

The Output Patterns checkbox controls whether the data is exported using the output patterns set up for each
field (see “Numeric Output Patterns” on page 250 and “Date Output Patterns” on page 255), or in the stan-
dard numeric and date formats. Checking this box will cause numeric and date columns to be exported in
using the output patterns you have set up for each field.

Once you have selected the fields you want exported and checked the appropriate buttons and boxes, press-
ing the OK button will export the data to a text file on the disk.

The Save As command exports only the selected records in the database. If you don’t want to export the
entire database, use the Find/Select command to choose just the records you want (see “Searching and Select-
ing” on page 331) before using the Save As command. Only the selected records will be exported.

Word Perfect

Exported file will use Word Perfect’s unique 
mail merge format, which requires a Con-
trol-R/Carriage Return between each field 
and a Control-E/Carriage Return between 

each record.

Option Description Example
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Exporting with the Text Export Wizard

The Save As dialog gives you limited control over the format of the text you are exporting. For more control
you can use the Text Export Wizard. This wizard allows you to specify the order of the fields being exported,
and to manipulate the data as it is being exported (converting it to upper case, for example, or combining sev-
eral database fields into one export field). The wizard can even be used to convert the database into an HTML
table. To illustrate this wizard we will use this database of national parks.
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To begin the export process choose Export Text from the File menu. The top section of the dialog shows the
database being exported, the bottom section shows a preview of the exported text. When you first open the
wizard, it is automatically configured to export all fields in the database, in the order they appear in the data-
base.

Use the pop-up menu to choose the format of the exported text.

database

export
preview
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If you are using a Macintosh you can export the text simply by dragging from the Export Text icon to wher-
ever you need to go. For example, you can drag the icon onto any folder (any Finder window).

You can also drag onto any application that can receive dropped text. For example, you can drag onto a Num-
bers spreadsheet, as shown here:
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Many word processors can also handle tabular data. For example, you could drag exported Panorama data
directly into a table in Pages, like this:

If you are using a Windows system, or if you don’t want to drag, just click on the Export Text icon instead of
dragging. This opens a dialog that allows you to select a location for the exported text. You can also use the
Export menu to export to a file or to the clipboard (right clicking on the Export Text icon also displays this
menu.)
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Customizing the Export Field Arrangement

When you first open the Text Export wizard it defaults to exporting all of the fields in the database. You can
easily customize this if you need a different arrangement. If you want to start from scratch, click on the Clear
icon (you can always go back to all fields by clicking on the yellow star and choosing ALL FIELDS from the
Template pop-up menu). Then you can drag fields from the database (top section) to the export (bottom sec-
tion).

If you make a mistake don't worry, just re-drag the column into the correct spot. Or you can drag a column
out of the export area to remove it.
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Another method for setting up the configuration is to right click on an export column. This gives you options
for editing the column options (more on that in a moment), inserting a deleting columns, and setting the col-
umn to a database field.

There is a similar pop-up menu if you right click on a database field.

Preview Tab Width. The wizard defaults to displaying the previewed export columns on 1.5 inch spacings.
To change the spacing, click on the Preview Tab Width icon and choose the width from the pop-up menu.
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Customizing Export Column Properties

So far we've assumed that the columns in exported text will consist of unmodified database fields -- re-
arranged, perhaps, but otherwise unchanged. However, it's possible for Panorama to manipulate the data as
it is exported. You can combine two database fields into one exported column, split one database field into
two export columns, force to upper or lower case, etc. If the Include Title Line option has been enabled you
can also customize the title of each column. To make these changes simply double click on any column in the
lower section of the wizard, or right click and choose Edit Column Properties from the pop-up menu. This
dialog will appear:

To manipulate the data as it is being exported, edit the formula. You can use any function or operator as part
of the formula. For example, this formula converts the category field to upper case as it is being exported:

For assistance in constructing a formula, press the Build Formula icon. This opens the Manipulate Data dia-
log, which you can use to build a formula step-by-step (see “The Manipulate Data Dialog” on page 434).
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When you close the Column Properties dialog the wizard shows a preview of what the manipulated export
column will look like (in this case the field is being converted to all upper case as it is exported).

The Text Export Wizard allows you to use any valid Panorama formula (see “Formulas” on page 19 of Formu-
las & Programming) to create each item. See “Using Formulas to Display Text” on page 621 for examples of
formulas that are useful for exporting data.

Export Templates

If you think you’ll need to use an export configuration more than once you can save it as a template. The first
step is to set up the configuration (as described in the previous section). Once the configuration is set up you
can save it with the Save Template or Save Template As… commands in the Template menu. This menu is
available in the menu bar or by clicking the yellow star:
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The wizard will prompt you to type in a name for the new template (the default is the name of the text file
being imported).

Once a template has been saved you can open it again by selecting it from the Template menu. (Note: The
template is actually stored in the database being imported into (in this case National Parks). The template is
only available when that database is being exported from. Each database may contain its own separate set of
templates, which makes sense since the export configuration used with one database is not likely to work
with any other database.)

The wizard loads the entire export configuration, ready to go. You can use the configuration as is or modify it
before you actually import the data.

If you want to delete or rename a template choose the Rename/Delete Templates… command from the Tem-
plate menu. To rename a template first click on it and then press the Rename button. A dialog appears allow-
ing you to type in a new name. To delete a template press the Delete button.

When you are done press the OK button.

Choosing a Database to Export From

The Text Import Wizard normally exports from database that was active when the wizard was opened. How-
ever, you can use the Database menu to choose to export from any open database. Simply choose the data-
base you want to export from and then set up the configuration.
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Exporting HTML Tables

To export a database as an HTML table choose HTML from the pop-up menu. This adds several new options
to the wizard:

Press the Preview icon to see what the HTML output will look like in a web browser:
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Using the Generated HTML Page

Just like any other HTML file created with a web authoring tool the file you have created may be copied onto
a web server and used as part of a web site. The Text Export Wizard creates fixed “static” pages that repre-
sent a “snapshot” of the database at a certain point in time. If you want use a Panorama database to create
“dynamic” web pages (for example searching a database on the web or allowing a database to be updated via
the web) you must use our optional Panorama Enterprise server. You can find more information about this
server on the ProVUE web site (http://www.provue.com).

Customizing HTML Table Appearance

The HTML Table Appearance dialog gives you control over many aspects of the table format. You can access
this menu from the menu bar or by clicking on the HTML Options button.

This dialog allows you to control the title, margins, font and color of the table.
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Web Page Title. The Web Page Title is the title that appears in the title bar of the browser window when this
table is displayed. It defaults to the database name. For example, suppose you set the title to Phone List.

Here’s the table with title displayed in a browser.

Table Header Form. The Header Form option allows you to “stick” a form on top of the table. However this
option only works when used with the Panorama Enterprise server. For more information see the Panorama
Enterprise Handbook, a separate PDF file.

Table Margins. The Left Margin and Top Margin allow the table to be precisely positioned relative to the
upper left hand corner of the page.

The margins are specified in pixels (1 pixel = 1/72th of an inch). The margins shown above move the table
down and to the right.

You may need to “twiddle” with the numbers a bit to get the position you want. Just press the Preview in
Browser button to see what the current margins look like.
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Table Border. The Table Border is a numeric value that specifies the thickness (in pixels) of the border around
each cell in the table. If the value is set to 0 then there is no border at all. Here are some examples of different
border settings.

When combined with the cell spacing, cell padding, and cell color options there are literally dozens of
options for customizing the table appearance.

Cell Spacing. This option controls the space between each cell in the table (in pixels).

Border Example

0

1

2
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It’s easier to see the cell spacing if the table cells have a colored background. In this example there is 4 pixels
between each cell.

Cell Padding. This option controls the space between the contents of each cell (text or image) and the edge of
each cell (in pixels).

In this example there are 6 pixels of padding around each cell.

4 pixels

4 pixels

6 pixels

6pixels
6pixels

6 pixels



Chapter 1:Files and Memory Page 123
Table Font. This option specifies the font to use to display the table. (If left blank the browsers default font
will be used.) You can either type in the font name or choose from a pop-up menu listing the most common
web fonts. 

On your own computer you can use any font you want because you have complete control over what fonts
are installed and available for use. A web page, however, is the opposite situation since you have zero control
over what fonts may be available when the page is viewed. Because of this it is usually best to pick from a
restricted subset of fonts that are almost universally available. The fonts that are most commonly available
are: Arial, Comic Sans MS, Courier, Georgia, Helvetica, Times and Verdana. Here’s what the phone number table
looks like using Comic Sans.
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Text Size. This option specifies the size of the text to be used for the table. But take note — the size is not
specified in pixels. Instead it is specified using a special HTML text size specification. Absolute values (1-7)
specify a fixed font size from extremely small (1) to huge (7). Negative values specify sizes smaller than the
text size in the rest of the page, for example -2 is two sizes smaller than normal font. Positive values specify
sizes larger than the text size in the rest of the page, for example +2 is two sizes larger than normal font. You
can type in the size or select from a pop-up menu of common sizes.

Here’s the same table as the previous example but with the text displayed in a smaller (-2) size.
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Text and Background Colors. By default Panorama web tables use black text on a transparent background.
The bottom half of the dialog allows you to specify any custom color combination you want. There are 8 color
swatches on the left hand side, and a preview area that simulates the selected color combinations on the right
(only the color selections are previewed, this area does not show borders, cell spacing, padding, font or size).
 

Color Selection Techniques. There are three ways to change a color swatch in this dialog. The simplest
method is to simply click on a swatch. This opens the systems standard color picker dialog. When you select
the color the swatch and preview will update.

preview
area

color
swatches
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The second method is using the palette of 216 “web safe” colors. A few years ago, when most computers sup-
ported only 256 different colors, this list of 216 “web safe” colors was suggested as a standard. (The reason
there are only 216 safe colors, not 256, is because the Microsoft and Mac operating system used 40 different
"reserved" fixed system colors (about 20 each).) Since most computers can now display millions of colors it’s
no longer all that important to use colors from this palette, but the palette is still available for your use. To use
one of these colors simple drag it from the palette to one of the eight swatches.

When the color is dropped onto the swatch the swatch changes to the selected color.
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The third method for setting the color is to type in the color using the HTML color notation. HTML colors are
defined using a hexadecimal notation for the combination of Red, Green, and Blue color values (RGB). The
lowest value that can be given to one of the light sources is 0 (hex #00). The highest value is 255 (hex #FF). For
example #0000FF represents pure blue, #00FF00 represents pure green, and #FF0000 represents pure red.
Using this notation you can specify millions of different colors. A few of these are shown in the table below. 



Page 128 Panorama Handbook
The illustration shows how the table data can be displayed in dark green by typing #009900 into the Table
Data color.

The color will appear in the swatch and preview when you click on another area of the dialog.

You’ve probably noticed that some swatches and areas of the preview are shown with a light gray checker-
board pattern. This indicates that these colors have not been set and will be transparent.

Main Text Color. This is the default text color for the entire page, including any text outside the table. Usu-
ally there isn’t any text outside the table, but you can add extra text (headers, footers, etc.) using the HTML
Templates dialog (see “Customizing the table HTML (advanced)” on page 136). Here’s a simple example
with an extra header at the top of the page. 

Technical note: What this color actually does is change the text parameter in the <body> tag of the page. 
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Page Background Color. This is the default background color for the entire page (not just the table). Here is a
typical example.

Technical note: What this color actually does is change the bgcolor parameter in the <body> tag of the
page. 

Title Color. This is the color for the column titles.
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Title Background Color. This is the background color for the column titles. If you pick a dark background
color then it’s best to pick a light title color, or vice versa.

Table Data Color. This is the color for the text in the table.
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Row Background Color. This is the background color for the body of the table. If you pick a dark back-
ground color then it’s best to pick a light title color, or vice versa.

Multiple Background Colors. You can actually specify up to three row background colors. If you specify
more than one background color the server will automatically alternate them on successive rows.



Page 132 Panorama Handbook
The default pattern is for the colors to alternate every other row — 12121212. The row pattern allows you to
change the way the colors alternate. You can either type in a pattern, for example 11221122, or you can select
from common patterns from the pop-up menu.

With this pattern the table will have a grey background for three rows (color 1), then a blue background
(color 2), then three grey rows, one blue, etc.
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Don’t forget that you can adjust the font, borders and cell spacing with the other options described earlier in
this section.

When you are finished customizing the appearance press the Done button to close the dialog. The changes
are automatically saved to the template.

HTML Table Column Widths and Alignment

If you don’t assign any column widths the browser will try to assign appropriate widths for you. If you don’t
like the widths the browser has picked you can specify the widths to be used. The widths are specified in pix-
els or as percentages. Be forewarned, however, that sometimes a browser may sometimes ignore the widths
you specify and go ahead and use whatever widths it wants!

column width
column alignment
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To change the width or alignment, double click anywhere in the column, which opens this dialog:

You can either type in a a width, or choose a percentage from the pop-up menu. Click on whatever alignment
you want to use.

Inserting Links in an HTML Table

You can customize the formula for a column to generate HTML directly, for example to insert a link tag.

x
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The wizard will use the formula to generate links automatically.

Just click on a link to jump to the corresponding web page!
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Customizing the table HTML (advanced)

The Text Export wizard normally generates the HTML for a web table page automatically. You can, however,
use the HTML Templates dialog (in the Text Export Wizard’s HTML menu) to customize the HTML Pan-
orama generates.

The dialog controls how HTML is generated for each cell, row, and for the overall page.

Option Examples Description

Page HTML

<center><hr>Phone List<hr> 
<table><data></table></center>

This is the template for the overall HTML of the body of the 
page (the wizard will create the header and footer automati-
cally. At a minimum it should include the tags <table><data></
table>. The wizard will automatically replace the <data> tag 
with the body of table generated from the database.

Row HTML <tr valign=center><data></tr>

This is the template for each line in the table. At a minimum it 
should include the tags <tr><data></tr>. The wizard will auto-
matically replace the <data> tag with the body of the line 
(which has been built up from individual cells, see the next 
entry).

Cell HTML <td><i><data></i></td>

This is the template for each cell in the table. At a minimum it 
should include the tags <td><data></td>. The wizard will 
automatically replace the <data> tag with the data (an individ-
ual cell) from the database. As it does so the wizard will auto-
matically prepare the data for HTML display, for example, 
converting non 7-bit characters to the appropriate HTML entity 
wherever possible.

Title HTML <td><data></td>

This is the template for each title in the table. At a minimum it 
should include the tags <th><data></th> or <td><data></td>. 
The wizard will automatically replace the <data> tag with the 
column title as specified in the wizard.
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Exporting VCard Data

Panorama can export VCard data files to applications that support VCards. To learn more about this feature
see “Using Generic Fields with the VCard Wizard” on page 237.

Monitoring Memory Usage

Each database you open with Panorama is copied into the RAM memory of your computer. For most typical
databases you’ll have plenty of RAM available. You can use the Memory Usage command in the File Menu to
see how much memory is in use and how much is available for expansion or for opening additional data-
bases. This command opens a statistics window that displays the current memory usage of every open data-
base, along with overall memory usage statistics.

At the top of the memory statistics data sheet, each open file is listed with the amount of memory used by
that file (in bytes and as a percentage of the total memory). The Memory In Use line shows the total amount
of memory used by all of the open databases (in this case just under 2 megabytes for 7 databases). The Free
Memory line shows the amount of free memory available for database expansion or for loading more data-
bases (in this case over 32 megabytes). The Total Database Memory line shows the total amount of memory
available for Panorama databases, including the memory that is already in use.

The memory statistics window has four columns. The first column shows the name of each memory area. The
second column contains the actual number of bytes used by each area, while the third column displays each
area’s memory size as a percentage of the total database memory. The fourth column, Average Size, will be
explained later.

When you are done with the memory statistics window, you can put it away by pressing the close box.
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Memory Usage Details

The memory statistics window shown above doesn’t show much detail—only the overall memory usage for
each file. You can use Panorama’s outline tools (see “Expanding and Collapsing the Summary Outline” on
page 376) to expand to greater levels of detail. To see more detail about a particular file, click on that file and
choose the Expand tool.

The database statistics for this file are now divided into five subdivisions: Data Sheet, Forms, Procedures,
Cross Tabs, and Flash Art Scrapbook. (Note: The yellow highlight in the window above is for illustration pur-
poses only, it does not appear in the real window.)

The Data Sheet portion of the file contains the actual data itself. This line shows the number of records in the
database, the total amount of data occupied by the data itself, and the average character length of each record
in the database. In this case the database contains 25 records that are an average of 556 bytes long.

The Data Sheet line can be expanded further to show the amount of memory used by each field in the data-
base, as shown below.

Each line shows the total amount of memory used by one field of the database, and the average size of one
cell. For example, the Contact field (Name) is an average of 16 characters long, while the Company field is an
average of 21 characters long.

Click on the database you want to examine and press the            Expand tool
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The Forms, Procedures, and Cross Tabs lines can be expanded to show the actual amount of memory used by
each individual form, procedure, and crosstab within the database. The Flash Art Scrapbook line can be
expanded to show the size of each picture in the Flash Art Scrapbook. You usually won’t need this kind of
detail, but it can be useful if a file seems unusually large and you need to find out why.

Multiple Memory Statistic Windows

The memory statistics window displays a snapshot of Panorama’s memory usage at a single point in time.
The window will not be updated as memory usage changes. However, it is possible to take another snapshot
to see how usage has changed. In fact, you can open over a dozen memory usage snapshot windows on the
screen at one time, so that they can easily be compared with each other.

As an example, suppose you wanted to see how much memory is saved by converting the City field in a
mailing list database from text to choice data type. (Using the choice type will save memory by storing the
actual name only once, no matter how many times it is used in the database.) Start by taking a Memory
Usage snapshot to see the original size of the City field. Then use the design sheet to convert the field from
text to choice. Use the Automatic Choices command to create the list of cities (See “Generating a List of
Choices Automatically” on page 262). Finally, choose Memory Usage from the File Menu again to take
another memory snapshot. You can compare the two memory snapshots to see the actual effect of the change
(in this example, 3,474 bytes saved).

before conversion

after conversion
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Adjusting Panorama’s Memory Allocation

As shipped from the factory, Panorama normally allocates 200 megabytes of memory for databases. For most
applications this is more than enough. However, if you wish to use extremely large databases you may need
to increase this allocation. To do this, start by opening the Preferences dialog (from the Panorama menu) and
then choose Edit Panorama Initialization File from the Special menu.

This opens Panorama’s initialization file.

The databasememory line controls the amount of memory allocated by Panorama for databases. You may set
this to any value from 3M to 4000M. (Don’t forget the M!). Once you have set the new value press the OK
button, then relaunch Panorama. When launching, Panorama will attempt to allocate the amount of memory
you have requested. However, if the amount requested is not available, it will allocate the largest amount
possible on your system.

Note: If you set this value to larger than the physical amount of memory available on your computer, you
may reduce the amount of virtual memory available for other applications. We do not recommend opening
databases that are larger than the physical memory size of your computer. Panorama will open the file and
operate correctly, but its performance may be severely degraded.
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As you use Panorama most of the action takes place inside windows. Panorama uses standard windows with
a few unique touches, including a tool palette with pop-up help on the left side of each window. Panorama
also has an enhanced zoom box that lets you zoom a window to a specific position. This chapter covers both
the standard and enhanced window features.

Window Components

Each Panorama window has about a dozen components for configuring and controlling the window. Each of
these components is activated by clicking or dragging with the mouse. Here’s what a typical Panorama win-
dow looks like on a PC system.

On the Macintosh windows look very similar, except that the close box is on the left and the title is centered.

grow box

scroll bar

scroll bar
info palette

close box

zoom box (maximize)
minimize (inactive)

title

tool palette

drag bar
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Tool Palette

The left side of each window contains a tool palette. To help you learn and remember the function of each
tool, the tool palette displays a pop-up caption whenever you click on a tool. The caption will remain visible
as long as you hold the mouse down over the tool.

Unlike most tool palettes that perform a function when you click on a tool, Panorama’s tool palette doesn’t
perform the function until you release the mouse. This allows you to look at the caption before you activate
the tool. (Of course, you don’t have to hold down the mouse and look at the caption. Once you have memo-
rized the tool icons you can simply click on the tool you want—just like your favorite graphics or page layout
program.)

You can scan through the tool captions by dragging the mouse up or down the palette (just as you would
scan across the menu bar). The caption for each tool pops up as the mouse is dragged across it. You can stop
at any time and release the mouse to activate a tool.

Remember, to activate a tool you must release the mouse over the tool itself—not over the pop-up caption.
The pop-up caption is not a menu.

press on any tool to see caption
release to activate tool
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Scrolling the Tool Palette

What if all the tools don’t fit in the window? You can scroll the tools by pressing on any tool and then drag-
ging to the top or bottom of the palette. When you reach the edge of the palette the tools will scroll. You can
also scroll the tools by clicking on one of the small arrows at the bottom of the palette. Each click scrolls by
one tool.

If you have a scroll wheel mouse you can also scroll the tool palette by moving the mouse over the palette
and turning the scroll wheel (OS X only).

Close Box

Clicking on the close box makes the window go away. If you hold down the option key (Mac) or alt key (PC)
while you click the close box, Panorama will close the current file along with all of its windows.

Drag Bar

The drag bar allows you to move the window to a new position. When you press the drag bar a dotted out-
line of the window appears. Drag the outline to the new position, then release the mouse. Moving the win-
dow does not change the contents of the window. (You can also move the window by zooming into a spot—
see below.)

Title

The window title displays the name of the database and information about the view being displayed in the
window (form name, magnification, etc.). 

Zoom Box (Maximize)

Clicking on the zoom (maximize) box allows you to quickly zoom the window to cover the entire screen.
Clicking the zoom box again pops the window back into its original position. The zoom box is very handy
when you want to temporarily concentrate on a specific window.

The zoom box can also be used to move a window to a specific spot on the screen. See “Zooming Into a Box”
on page 148.

scroll downscroll up

press and drag to scroll
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Grow Box

The grow box adjusts the size of the window. When you press on the grow box a dotted outline of the win-
dow appears. Drag the bottom right hand corner of this outline and then release to set the new window size.
(You can also set the size of a window by zooming into a spot—see above.) On PC systems you can also
adjust the size of a window by dragging any side of the window.

Scroll Bars

The scroll bars are used to shift the information or graphics displayed in the window. The vertical scroll bar
(on the right edge of the window) shifts the display up and down, while the horizontal scroll bar (on the bot-
tom edge of the window) shifts the display left and right. The sliding box inside each scroll bar shows the
current position of the display.

If you are using OS X and a mouse with a scroll wheel, Panorama supports the scroll wheel. This wheel nor-
mally causes the window to scroll vertically when turned. If the Shift key is held down, the wheel will scroll
the window horizontally.

When using OS X or OS 9, the Option key changes the way the scroll bars work. If you hold down the Option
key and click on the up or down arrows, the window will scroll up or down an entire page. If you hold down
the Option key and click in the main body of the scroll bar, the window will scroll directly to that spot.

Instant Jump to any Scroll Bar Position

To jump instantly to any position within a scroll bar hold down the Option key and click on the location you
want to jump to.

Note: Most Mac OS X applications support this behaviour, including Safari, Preview, GarageBand, etc.

Horizontal Scrollwheel Scrolling with Shift Key

When using any scroll wheel holding down the Shift key while turning the wheel will cause the window to
scroll horizontally. Note: Most Mac OS X applications support this behaviour, including Safari, Preview,
GarageBand, etc.

Mighty Mouse and Trackpad Scrolling Support

Panorama supports vertical scrolling with the ball on Apple’s Mighty Mouse, as well as two finger scrolling
on laptop trackpads. Please note, however, that horizontal and diagonal scrolling are not supported (though
you can scroll diagonally using the Shift key as noted above.

 

option-click here

to jump directly to  here
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Splitting a Window

Some Panorama windows can be split into two side by side panes. Each pane displays a different area of the
database. The two panes are locked together vertically, but each pane has its own horizontal scroll bar.

To split a window, drag the splitter to the right. (The splitter is the small black rectangle to the left of the hor-
izontal scroll bar.)

To remove the split, drag the splitter back to the left edge. To adjust the split location, drag the splitter into
position.

press and drag to split window

each pane may be scrolled separately

drag to adjust split



Page 146 Panorama Handbook
Info Palette

Many Panorama windows display an Info Palette along the bottom left corner of the window. In windows
that are used for displaying and editing data (data sheet, forms, crosstabs), the info palette displays the cur-
rent number of database records in the bottom left corner of each window. Panorama displays both the total
number of records and the number of visible (selected) records.

If the window is less than 3 inches wide, the record count will not appear. You can also turn the record count
on or off with the Show Record Count command in the Setup menu.

Clicking anywhere in the record count opens the Find/Select dialog. This dialog allows you to locate infor-
mation within the database. See “The Find/Select Dialog” on page 336 for details on this dialog.

When a form window is switched into Graphic Display Mode the Info Palette displays a graphic control
strip. This strip displays the graphic attributes of the currently selected object (or objects), and allows you to
change the attributes with pop-up menus.
.

See “The Graphic Control Strip” on page 505, for more information on the graphic control strip.

Procedure windows also display status information along the bottom of the window. When writing a proce-
dure Panorama displays error messages here. When single stepping through a procedure Panorama displays
the results of any assignments into fields or variables in this area (see “The Panorama Interactive Debugger”
on page 315 of Formulas & Programming).

total number of records in database
number of records in currently visible subset

object type and IDobject dimensionsobject font and size

object color
line width

line pattern
fill pattern
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Bringing a Window to the Front

Each new window you open appears on top of the other windows. To bring another window to the front,
simply click anywhere on the window. If the window is hidden you can bring it to the front with the Window
menu.

Another way to bring a window to the front is to use the Arrange Windows wizard (see “Bringing Windows
to the Front” on page 162).

Hiding Windows

The Hide This Window command (in the Windows menu) temporarily hides the current window. The win-
dow becomes invisible, but can be made to re-appear by selecting it from the Arrange Windows submenu.

The Hide Other Windows command (in the Windows menu) temporarily hides all Panorama windows
except for the current window.

The Show All Windows command (in the Windows menu) makes all invisible windows visible again.

open windows
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Zooming Into a Box

The zoom box can also be used to zoom the window into a pre-defined box on the screen. This allows you to
move and resize the window in one step.

To zoom a window to a specific spot you must hold down a special key while you click on the zoom box. On
Windows (PC) systems this is the Control key, on Macintosh systems this is the Command key. When you
click on the zoom box while holding down this key the window options dialog will appear.

Drag the mouse across this dialog to define the new location for the window. When you press Ok, the win-
dow will “hop” into the new location.

Saving Window Positions

If you check the Save Window Positions option in the Save As dialog, Panorama will remember the position
of each open window in the file being saved. The next time the file is opened, Panorama will open the same
windows in the same positions.

drag mouse across
fake screen to define
new window position

original window position
other windows
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Note: The Save Window Positions option is only available when you save an individual file. You cannot save
window positions as part of a file set. If you want the files in a file set to open with predetermined window
positions, you must save each individual file with the Save Window Positions option enabled.

Saving with No Windows

If you check the No Windows option the database will open without any open windows at all. Why would
you want a database without any windows? It could be used as an invisible reference to store information
that is needed by other databases but never (or rarely) changes, for example a tax or shipping rate table (see
“Linking With Another Database” on page 131 of Formulas & Programming). A database with no windows can
also be referenced by a procedure using “secret windows” (see “Temporary “Invisible” Windows” on
page 454 of Formulas & Programming).

If you want to open a window in a database that has been saved with the No Windows option you can use
the View Wizard. See “The View Wizard” on page 173 to learn how to open windows in any database. You
can also open a window in an invisible database with a procedure. See “Databases Without Windows” on
page 455 of Formulas & Programming to learn how to bring back windows using this technique.

As an alternative to saving a database with the No Windows option you can instead open the database with a
procedure using the opensecret statement. This statement opens the database without any windows.
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Turning Window Components On and Off (Window Tweak Wizard)

Using the Window Tweak command in the Wizard menu you can enable and disable the tool palette and
scroll bars in a form. Start with a normal form window.

When you choose Window Tweak the wizard will remove the tool palette and scroll bars from the window.
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Choose Window Tweak again to bring the tool palette and scroll bars back again.

In addition to “tweaking” the current window the Window Tweak wizard also opens a small window.

When this window is open you can quickly tweak any form window. Simply bring the form window to the
front, then click on the big round Tweak button.

You can also use this window to control which window components get “tweaked.” Normally both scroll
bars and the tool palette get tweaked. However, you can disabled some of these options. A disabled option
doesn’t get tweaked. For example, if the Tool Palette option is disabled then the tool palette will not be
removed. Here is a window with both scroll bars “tweaked” but the tool palette has been left alone.

When you press the Tweak button again the scroll bars will re-appear.



Page 152 Panorama Handbook
Measuring a Window (Window Size Wizard)

Sometimes you may need to measure the height and width of a window (for example if you want to write a
procedure to re-open the window the same size, see “Specifying the New Window Location” on page 446 of
Formulas & Programming). It’s easy to measure a window with the Window Size wizard. First bring the win-
dow you want to measure to the front, then select Window Size from the Form Tools submenu of the Wizard
menu.

The wizard will cover the window and show the dimensions of the window.
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Don’t worry, your original window is still there. It’s just hidden behind the Window Size wizard, as you can
see by dragging the wizard to the side.

You can drag and resize the window anywhere you like. Or you can simply click on a window and select
Window Size from the Wizard menu and the size window will jump to cover the window you have selected.
When you’re done with the window you can simply close it.

Setting Exact Window Dimensions

In addition to displaying the current window dimensions the Window Size wizard can also be used to pre-
cisely set new dimensions. Start by opening the wizard, as described in the previous section. Then choose the
Set Size command from the WindowSize menu.

This command displays a dialog that shows the current window dimensions.
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Use this dialog to type in the new dimensions you want.

When you press the OK button Panorama will adjust the size of the wizard’s window to the new dimensions.
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When you close the wizard’s window (or move it to the side) you will see that the original window has also
been adjusted to the new dimensions.
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Arranging All Open Windows at Once (Tiling and Stacking)

Normally you manipulate one window at a time. The Arrange Windows wizard allows you to arrange all of
the open Panorama windows into a regular pattern, either side by side (tiled) or piled on top of each other
with a slight offset.

To illustrate the operation of this wizard, let’s suppose that there are currently six Panorama windows open
in more or less random locations, like this.

The first step is to choose Arrange Windows from the Wizard menu. This displays the Arrange Windows
options.
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To arrange the windows in a grid (like floor tiles) press the Tile button.

If you decide you don’t like this new arrangement you can revert to the original window positions by press-
ing the Restore button.

To make all the windows the same size, arranged in a staggered pattern, press the Stack button.
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When Panorama stacks or tiles the windows it checks the attributes of each window. It won’t make any win-
dow smaller than its minimum size or larger than its maximum size. Sometimes this can prevent the tile or
stack patterns from aligning perfectly. For example, suppose you start with the windows shown here.

Because of restrictions on the minimum and maximum window dimensions these windows cannot fit per-
fectly in the tile pattern. Panorama will leave some gaps and some overlaps.

limited to
max width

limited to
min heightlimited to

max width

limited to
max height & width
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Saving and Restoring Window Positions

The Arrange Windows wizard automatically saves window positions each time you Tile or Stack the win-
dows, allowing you to go back to the original window configuration. You can also ask the wizard to save the
current window positions at any time.

Later you can restore the original window positions by choosing Restore Window Positions. Please note,
however, that this only affects the windows that were open when the window positions were saved. If a win-
dow has since been closed, Restore Window Positions will not re-open it. Conversely, if additional windows
have been opened since the window positions were saved these new windows will not be affected by the
Restore Window Positions command.

Choosing Tile Configurations

The Arrange Windows wizard allows you to choose pattern used for tiling windows. For example, suppose
you have ten windows. Should the tiles be 4 by 3, or 5 by 2, or 2 by 5 or some other design? We’ve supplied a
default arrangement, but you can open the Tile Configurations window to change the design at any time.
When you open this window it shows you the current configuration for the current number of windows. In
this example there are currently 10 windows open, and they will be tiled into a 4 high by 3 wide grid. Any
empty slots are displayed in light green.
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To change the configuration simply press the mouse anywhere on the grid. A pop-up menu listing possible
arrangements will appear.
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Select the arrangement you want from the pop-up menu. After you make your selection the grid will be
updated to reflect your choice.
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You can use the list on the left side of the window to set up the configuration for any number of windows (up
to Panorama’s maximum of 64 windows).

When you are done simply close the Tile Configuration window and press the Tile button.

Bringing Windows to the Front

The Arrange Windows wizard also provides an alternative method for bringing a window to the front. To
bring any window to the front, click on the arrow button.

When you press on this button a menu listing all the open windows will appear. Simply select the window
you want to bring to the front.

Of course you can also bring a window to the front by clicking on it or using the Arrange submenu in the File
menu (see “Bringing a Window to the Front” on page 147).

click here for window menu
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A Panorama database can have up to six elements: data sheet, forms, design sheet, procedures, crosstabs, and
flash art. Each window shows a view of one of these elements.

The View menu is just to the right of the Edit menu.

Use this menu to pick which view you want to see in the window. Choosing different views from this menu is
like pointing a camera in different directions.

Types of Panorama Views

Panorama has six different kinds of views. Each type of view gives you access to a different element of the
database or gives you a different perspective on your data (for example, form vs. data sheet).

Forms

Crosstabs

Procedures
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A new database starts with a data sheet, design sheet, and an empty flash art scrapbook. Views for forms,
procedures, and crosstabs can be added if desired.

Data Sheet and Form Views

The most important views are the data sheet and forms. These views give you access to the actual data. Use
the data sheet view when you want to display the database as a sheet of rows and columns. The data sheet
view has a fixed format very much like a spreadsheet, as shown below. Although you can make minor alter-
ations like changing the font size or the width of a column, you cannot add graphics or change the overall
arrangement of the data sheet view.
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Use a form view when you want complete control over the arrangement and appearance of your data.
Instead of appearing in a fixed row and column grid, the data can be arranged any way you want. Graphics
can be added for clarity or to simulate an actual paper form. The form view is much more flexible than the
data sheet view, but it is also more work to set up. Here is a typical example of a form. Notice that the win-
dow name shows the database name, Checkbook, followed by the form name, Plain Checks.

Every Panorama database has a single data sheet view, but can have any number of form views. A simple
database might not have any form views, while a complex database may have dozens. You create as many
forms as you need. Each form is identified by a unique name.

Since the data sheet and form views are based on the same underlying data, any action or change made to the
data in one of these views will immediately appear in the other views. Of course you’ll only notice this when
several windows are open at once.

Other Views

In addition to the data sheet and form views Panorama has four other kinds of views. Instead of accessing the
actual data, these views let you access the other components of a Panorama file.

The design sheet view is the DNA or blueprint of the database. It contains the actual structure of the database
fields. You can add and remove fields and make other minor modifications to the database structure without
using the design sheet, but the design sheet provides the ultimate control over the structure of your database.
See “The Design Sheet” on page 212 to learn more.
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The flash art scrapbook view contains a catalog of pictures that can be displayed in a form or report. Using
the flash art scrapbook can sometimes save a significant amount of memory over pasting pictures directly
into the database, and it can be easier too. To learn more about the flash art scrapbook see “The Flash Art
Scrapbook (Gallery)” on page 764.

Crosstab views display a special 2-way summarization of the information in a database. Crosstabs display
the relationships between data in different fields, exposing trends that might be invisible in the normal data-
base views (data sheet and forms). Like form views, a database can contain any number of crosstab views—it
may have none or several, and each crosstab has a name. The window name shows the database name (for
example Checkbook), followed by XTABS, followed by the crosstab name (for example Spending by Month).
To learn more about crosstabs see “Crosstabs” on page 415.
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Procedure views contain sequences of instructions for Panorama to follow. You don’t have to remember each
step—Panorama will remember for you. Once a procedure is set up, it can be activated several different
ways. You can choose the procedure from a menu, press a button, or use a Command key combination (Mac-
intosh) or Control key shortcut (PC). Procedures can even be activated automatically when special events
occur. Like form and crosstab views, a database can contain any number of procedure views. Each procedure
has its own name, which is shown in the window title. To learn more about procedures see “Procedures” on
page 203 of Formulas & Programming.
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Switching Between Views

The View Menu lists all the views in a database. The pre-defined views appear at the top—data sheet, design
sheet, and flash art scrapbook. Next come the views you’ve created—forms, crosstabs, and procedures. The
View Menu also contains commands for creating your own new views—new form, new crosstab, and new
procedure.

To switch to a different view within the same window, simply choose the view from the menu and release the
mouse. You can flip back and forth between views at any time.

Forms

Crosstabs

Procedures
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Opening More Than One Window Per Database

You can also use the view menu to open a new window, allowing you to see two views of the database at
once. To open a second window the same size as the current window, hold down the Alt key while you select
from the View Menu. (If you are using a Macintosh, hold down the Control key or the Option key.) The new
window will appear slightly below and to the right of the original window.

1) Start with one window

2) While holding down the Alt key (PC) or the Control key (Mac), make a
selection from the View menu. On the Mac you can also use the Option key.

3) The new window appears sightly below and to the right...
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The new window will track the original window. In fact, all windows associated with a database will track
each other automatically. Any changes made in one window automatically appear in all other windows, and
when any navigation is done in one window (moving up or down within the database) all of the other win-
dows will follow along.

Another technique allows you to control the exact size and position of the new window in advance. (Of
course you can always drag and resize it after it has been opened.) To use this technique, hold down the
Control key while you select from the View Menu. (If you are using a Macintosh, hold down the Command
key.) After you choose the view you want to open, the Window Options dialog will appear shown below.
This dialog shows a miniature view of the entire computer screen, along with the positions of every window.
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To define the position and size of the new window, simply drag a rectangle across the miniature screen, as
shown in the illustration above. If you don’t get the position quite right, simply drag again. (Of course you
can also adjust the position and size later.) When you press the Ok button the new window will open in the
location you have specified.

Panorama allows you to open up to 64 windows at one time.

New window

Original window
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Window Options

The Options button in the Window Options dialog allows you to selectively eliminate up to four components
from a new window—the tool palette, scroll bars, and drag bar (you can also turn these components on and
off with the Window Tweak wizard, see “Turning Window Components On and Off (Window Tweak Wiz-
ard)” on page 150). This illustration shows a form with the scroll bars removed.
  

Some views will not work properly if components are eliminated—for example, you should not eliminate the
vertical scroll bar from a data sheet. Be very careful if you remove the drag bar. If the drag bar is removed, the
window cannot be manually moved, resized, or closed. (It can be closed by programming a procedure to
close the window.)
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The View Wizard

The View menu works well for most databases, but when a database grows to dozens of forms and hundreds
of procedures it can get a bit unwieldy. For these situations the View Wizard comes in handy. This is a data-
base that comes with Panorama that can help you locate and open any view. When you first open the View
Wizard database it displays a list of all the forms or procedures in the currently open Panorama database.
(Whether it initially displays forms or procedures depends on what type of window was open before the wiz-
ard was activated.) For example, suppose the Panorama 3 MegaDemo™ file is open.
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When the View Wizard opens it displays a list of the views in this database (Panorama 3 MegaDemo),

including  forms,  procedures,  crosstabs, the   data sheet and the  design sheet. In the
example below the procedures and forms appear to be grouped together, but that is just a coincidence — the
views are listed in alphabetical order.

procedures

forms
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Double click to open any view.
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If you know the name of the view you want to open you can find it quickly by typing in the first few letters.
As you type each letter, the wizard will show you the views that match that name.

Use the Database menu to view forms, procedures or crosstabs in a different open database.

empty search box,
all views displayed

type .Bi to select .BibleArea

cancel search

then double click to open the view in a new window
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View Wizard Window Size and Options

The Height, Width and Options menus allow you to control the size and options of the new window. The
Height and Width menus specify the dimensions of the new window in pixels (72 pixels per inch).

If you are opening a form view you can also use the Options menu to control whether or not the tool palette,
scroll bars and drag bar appear in the new window. (These options are ignored when opening other kinds of
windows.)

Remember that you can also adjust a form window’s size and options after you have opened it with the Win-
dow Tweak wizard, see “Turning Window Components On and Off (Window Tweak Wizard)” on page 150.)



Page 178 Panorama Handbook
Searching All Procedures

The View Wizard has the capability of searching the text of all procedures in a database. Simply check the
Full Procedure Search option and type in the word or phrase you want to search for. The list will update as
you type each key.

When you double click on one of these procedures the wizard will open the procedure window and automat-
ically locate the first occurrence of the word or phrase.

check this option to search the
actual code within each procedure
(not just the name)

These procedures contain the word
“shopping”.
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Choose Find Next from the Search menu to find the next occurrence of this word or phrase within the proce-
dure (if any).

You can repeat using the Find Next command until you have located every occurrence of the word or phrase
in this procedure. At that point you’ll need to go back to the View Wizard to continue with the next proce-
dure.

You can continue this process until you have located every occurrence of the word or phrase in the database.
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Form Modes: Data Access vs. Graphic Design

Unlike other views, the Form View operates in two distinct modes—data access and graphic design. Data
access mode (also called “data mode”) is the default mode. In this mode you can view and display data, and
navigate through the database.

Graphic design mode (also called “graphics mode”) functions like an electronic drafting table. In this mode
you design the form by drawing lines, boxes, and other graphic elements. This mode is very similar to many
drawing and page layout programs. Graphic design mode is easily recognized by the rulers that appear at
the top and left edges of the windows.

To switch between data access and graphic design modes, click on the  tool. Each click on this tool toggles
the window between the two modes.

Toggle graphic/data modes

Display/Edit

Navigation Controls

Toggle graphic/data modes

Graphic tools

Movable graphics and textRulers
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Form Operation: Individual Pages vs.View-As-List

Panorama allows you to set up blank forms as individual pages or as a continuous sheet (view-as-list). When
forms are set up as individual pages you see one record at a time. You can flip through the records just as you
would shuffle through a stack of paper forms. All of the examples of forms you’ve seen so far are individual
page forms.

A view-as-list form displays data as a continuous sheet, as shown below.Instead of flipping from record to
record, you scroll up and down through the data in a manner similar to the data sheet. However, unlike the
data sheet, a view-as-list form allows you to arrange the data any way you like, and even include graphics in
the display. On the other hand, view-as-list forms are slower than the data sheet (because of the overhead in
displaying the graphics) and they are much more work to set up.

Unless you tell it otherwise, Panorama sets up a new form as individual pages. To convert the form to a con-
tinuous sheet you must use the Form Preferences command (Setup menu) to set the View-as-List option. You
will also have to define the boundaries of the form by setting up a data tile (and optional header tile). For
more information about setting up view-as-list forms see “View-As-List Forms” on page 899.
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Creating a New Form, Crosstab or Procedure

To create a new view, choose New Form, New Crosstab, or New Procedure from the View Menu. A dialog
box will appear asking you to name the new view. A view name may be up to 25 characters long and can con-
tain any letter, number or punctuation.

When you create a new view, it is usually added to the end of the appropriate section in the View Menu. For
example, a new form usually becomes the last form in the View Menu. If you wish, you can insert the new
view into the middle of the View Menu. To do this, check the Insert before button and use the pop-up menu
directly below the Insert before button to specify the position of the new view. You can also re-arrange the
order of the views using the Re-Arrange command in the Setup menu.
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Renaming a Form, Crosstab or Procedure

To rename the currently visible form, crosstab or procedure choose Rename Form, Rename Crosstab, or
Rename Procedure from the Setup Menu. Type in the new name (limit 25 characters) and press Ok.

Deleting a Form, Crosstab or Procedure

To delete a form, crosstab, or procedure choose Delete Form, Delete Crosstab, or Delete Procedure from the
Setup Menu. Since you cannot undo after you delete a view, Panorama will ask you if you are sure before it
actually deletes the view. Note: If only one view is open and you remove it, Panorama will close the entire
file. To avoid this, open an extra window before you delete a view.

You can also delete views with the Re-Arrange command in the Setup menu (described in the next section).
The Re-Arrange command is the fastest way to remove several views at once (see below).

Changing the Order of Forms, Crosstabs or Procedures

The Re-Arrange Forms, Re-Arrange Crosstabs, and Re-Arrange Procedures commands in the Setup menu
change the order of the items listed in the View Menu. Each of these commands displays a dialog box listing
the current view order on the left and the new view order on the right.
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This dialog is like a puzzle—the object is to move the views from the left to the right in the order you want. To
move a view to the other side, either double-click on it or press the >>Move>> button. To insert a view into
the middle of the list on the right, first select the spot where you want to insert and then press the >>Insert>>
button. When all the views have been moved to the right hand side, press the Ok button to rearrange the
views.

You can also use this dialog to delete views. To delete one or more views, press the Delete button instead of
moving the view to the right. Warning: You cannot delete an open view using the Re-Arrange command.
First close the view (form, crosstab or procedure) and then delete the view.

The Privilege Dialog

The View menu normally gives you complete freedom to access any view in your database. If other people
are going to be using your database you may want to prevent them from switching to unauthorized views.

To restrict user access to the View menu, use the Privilege dialog (shown below). To open this dialog on a
Macintosh computer, hold down the Command or Option key and choose About Panorama from the Apple
menu. To open this dialog on a Windows system, hold down the Control or Alt key and choose About Pan-
orama from the Help menu. This dialog allows you to choose one of three possible user levels for the current
database: Author, User, and Custom.
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The Author level places no restrictions on the user—he or she can change the database design, draw graphics,
open and close windows, and generally perform any Panorama operation described in this manual.

The User level allows the user to perform data entry and analysis, but prevents the user from changing the
database design or changing the graphics in a form. User level disables the View menu, so the user cannot
choose which view he or she wants to use. They can only use views that are opened automatically when the
database is opened or views that are opened with procedures set up in advance.

The Custom level is even more restrictive. All of the tools in the tool palette disappear, along with all of the
menus except for the File, Edit and Action menus. When the database is locked to the custom level, the user
can perform data entry and predefined programs (procedures)—and that’s it. Everything else is forbidden.

To prevent unauthorized users from changing the user level, the Privilege dialog can be protected with a
password. Once the password is set, you cannot open the Privilege dialog unless you know the password.

User Levels vs. Save Window Positions

If the user level is set to User or Custom the Save command will not save the new window positions—even if
the Save Window Positions option is turned on. The window positions are only saved when the file is at the
Author level. This allows the database author to reliably set up the initial views and window positions.

Hiding Sensitive Data

Since the User and Custom levels prevent the user from using the View menu, it is possible to hide fields con-
taining sensitive information from most users of a database. To do this:

1) Create a form that shows only the non-sensitive data.
2) Close all of the other windows associated with this database.
3) Save the database with the Save Window Positions option checked.
4) Set the user level to User or Custom (you will probably want to set a password at this time also)
5) Save the file again.

The next time this database is opened, only the form displaying the non-sensitive data will appear. Since the
database is locked, the user cannot open any of the views that contain sensitive information. Users who know
the password can use the Privileges dialog to switch to Author level, or you can set up a procedure that
switches views if the user knows the correct password.
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Chapter 4: Records

The heart of a database is, naturally, the data stored in it. Since storing and organizing data is Panorama’s pri-
mary task, it has special rules and procedures for handling data.

Data Organization

Inside each Panorama database the information is organized into records and fields. A record consists of a
group of related information. In a personnel database, for example, each record would contain all the infor-
mation about a single employee. Most databases have anywhere from several dozen to several thousand
individual records. The example database shown below has 102 records, 17 of which are currently visible in
the window.

The database is also divided into fields. Each field contains a specific item of information—a street address, a
phone number, a birthdate, etc. Most databases have somewhere between five and one-hundred fields (Pan-
orama allows up to 65,000 fields per database).

records

fields
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Every record in a database contains exactly the same fields. If certain records don’t use a particular field it can
be left empty, but the field itself still exists for every record. For example, notice that in the illustration above
some of the Title and Company entries are empty. (However, you can create a form that does not display all
of the fields. See “Displaying and Editing Text” on page 587.)

As you work with a database, you will constantly be adding new records, revising and removing old records,
and rearranging (sorting, etc.) existing records. Fields can also be added, revised, and removed, but you will
do this much less often. Once the fields are set up, you will usually leave them alone.

Tables vs. Individual Pages

Panorama can display any database either as a table of records or as an individual page for each record. In the
table format each line corresponds to a record, and each column corresponds to a field. Common examples
include phone directories and price lists. In the individual page format each page corresponds to a single
record. Each item on the page corresponds to a field. Common examples include invoices, tax returns, and
report cards.

Panorama doesn‘t care whether the database is displayed as a table or as individual pages. As you can see,
the same information is displayed and edited either way. Use the method that seems natural for the database
you are working with.

Special Records

Most database programs treat every record the same way. Panorama, however, distinguishes between three
different types of records: data records, summary records, and invisible records. Most of the work you do
will be with ordinary data records. Summary and invisible records, however, are the keys to some of Pan-
orama’s unique capabilities.

Data Records

Ordinary records used for data storage are called data records. You can create new data records one at a time
by keying in information, or you can add many new data records at once by importing data.
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Summary Records

Summary records are temporary records used for calculating totals, subtotals, and other summary informa-
tion. Panorama’s Group commands automatically create summary records for you. When viewing the data-
base as a sheet you can identify summary records by the light blue background color, and by the fact that
they are usually displayed in bold.

Summary records may appear in one of seven levels, from 1 to 7. Each higher level is used for a higher level
of subtotal. Each summary level can be identified by the deeper shade of blue in the background, as shown
here. This database has been grouped into three summary levels.

summary records

level  1 (company)

level  2 (category)

level  3 (grand total)
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Panorama allows you to treat summary records as a collapsible outline. You can use the Outline Level com-
mand to collapse the outline to show only high level summaries, then use the Expand, Expand All, and Col-
lapse tools to expose the detail you need to see. For more about Panorama’s outline capability, see
“Summaries and Outlines” on page 365.

Summary records are designed to have a very short lifetime—usually only a few minutes. When you want to
calculate subtotals or other summaries you‘ll create new summary records. After you’ve examined (and pos-
sibly printed) the summaries, you’ll use the Remove Summaries command to remove them so you can get
back to regular work with your database. For more information about summary records, see “3-Step Summa-
rizing” on page 365.

Invisible Records

Invisible records are ordinary data or summary records that have been made temporarily invisible. For
instance right now you might be interested only in sales made in California, transactions over $250,000, or
invoices over 45 days old. Panorama’s Find/Select commands allow you to choose the data you want to see
and make the rest temporarily invisible. This allows you to see just the information you are interested in
without the other data getting in the way.

The following illustrations show a typical example. The original database started out with 102 records. We
can use the Find/Select command to make 92 of these records temporarily invisible.

Expand All
Collapse

Expand
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When the Select button is pressed, only records in Texas remain visible. All other records become tempo-
rarily invisible.

At any time you can make all records visible again with the Select All command. You can also make a new
selection at any time. For more information about invisible records, see “Finding vs. Selecting” on page 331.
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Chapter 5: Fields

The information stored in a database is organized into records and fields. Each field contains a specific cate-
gory of information—names, phone numbers, birthdates, etc. Your first task after creating a new database is
to decide how many and what fields are needed to get the job done. It’s somewhat like designing a house—
you have to decide what the best configuration is. How many bedrooms you need? How many baths? Will
you need an office? And just like architecture, there are sometimes trade-offs that have to be made in design-
ing a database.

For some database jobs it is extremely obvious how the fields should be set up. But usually you have more
flexibility than you might think. Take a simple name and address list, probably one of the most basic database
applications. How should the name be stored? All in one field? Or should there be separate fields for first and
last names? What about Mr./Ms./Mrs., should that be in a separate field? There are no hard and fast
answers—it depends on how you want to use the database. For this example (names), data entry will proba-
bly be easier if you use a single field. On the other hand, you’ll have more options for organizing and format-
ting if you split the name into several fields. The choice is up to you.

One thing to keep in mind is that if you make a mistake, it is much easier to combine two fields together than
it is to split a single field into two. For example, it is quite easy to take separate first and last name fields and
combine them, but if you type the names into a single field it could be quite difficult to later split them apart.
If you have any doubt, it is better to err on the side of separating the data into more fields.

You can add new fields, remove fields, or change the properties of fields at any time, even after you’ve filled
the database with data. Once you start entering data, however, it can be more work to re-arrange the fields.
Some extra planning before you start entering data can pay big dividends in the long run.
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The Fields Menu

The commands for adding, removing and modifying fields are found in the Fields menu.

You can also access these commands by right-clicking the name of a field at the top of the data sheet.
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Modifying the Properties of an Existing Field

To modify a field’s properties, choose Field Properties from the Fields menu, or simply double click on the
name of the field at the top of the data sheet.

There are nearly two dozen field properties that you can customize. Most of these can be set in the Field Prop-
erties dialog, though a few are only accessible using the Design Sheet (see “The Design Sheet” on page 212).

Field Name The field name identifies the field. It helps you remember what is in the field, and is also
used to identify the field in formulas.

Panorama does not place any restrictions on your choice of field names, but there are some
ramifications to using an unusual name (see “Rules for Field Names” on page 220).

Click on the star icon (to the left of the field name) to see a pop-up menu of common field
names. Choosing a name from this list sets not only the field name, but also the data type,
output pattern, default value and other options (of course you can customize these later if
you want). 
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Type This pop-up menu specifies the type of data stored in each field: text, numeric, date, or
choices,. See “Data Types” on page 245 for more information.

Digits This pop-up menu appears if you’ve specified Numeric for the data type (see above). The
menu specifies the number of digits to be used after the decimal point with numeric data: 0,
1, 2, 3, 4, Float or Money. See “Numeric Data” on page 249 for more information.

Align These buttons specify how the field should be aligned in the data sheet: left, center, or right
flush. Usually left flush is used for everything except numbers, which are displayed right
flush.

Output Pattern The output pattern allows you to specify the display format for numbers or dates. See
“Numeric Output Patterns” on page 250 and see “Date Output Patterns” on page 255 for
more information. You can either type in the pattern manually, or you can click on the icon to
the right for a pop-up menu of common patterns.

The dialog shows a preview of what the pattern will look like with actual data.

Auto Caps Use this pop-up menu to tell Panorama to automatically capitalize data entry in a field. Pan-
orama can automatically capitalize everything, or just the first letter of each word or sen-
tence. See “Automatic Capitalization” on page 281.

Dups This option specifies whether or not you want to allow duplicate entries in this field. You can
also specify that you want to require duplicate entries (no unique values). See “Checking for
Duplicate Data” on page 283.

Clairvoyance® This option controls Panorama’s Clairvoyance (auto-fill) feature. This feature tries to antici-
pate what you are about to type, then types it for you. See “Clairvoyance®” on page 284 for
the straight scoop.

Link This option (which is available only in the design sheet) allows you to link this field with a
field in another database. Only Clairvoyance® is affected by this link. You can set up this
field with the Clairvoyance Link command. For more information see “Clairvoyance®
Across Multiple Files” on page 286.

Default Value This option allows you to specify a default value for the field when a new record is created.
See “Default Values” on page 296. You can either type in the default value or choose from a
pop-up menu of common defaults for the type of data in the field.

Input Pattern The input pattern forces data into a specific pattern as it is entered, for example phone num-
bers or social security numbers. See “Input Patterns” on page 291 for more information. You
can either type in the default value or choose from a pop-up menu of common input pat-
terns for the type of data in the field.

Input Range This option allows you to restrict the characters that can be entered in a field. For example,
you can restrict a field to only allow alphabetic or numeric entry. See “Restricting Character
Types” on page 293 for more information.
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Choices This column allows you to specify a list of choices that are valid for this field; for instance
Yes/No, Gold/Silver/Bronze or Regular/Unleaded. The list of choices is used by the
Choices data type (see “Choices” on page 259) and is also used by the Choice Palette (see
“The Choice Palette” on page 317). You can also press the Auto button to let Panorama auto-
matically generate the list of choices for you (of course this only works if the database
already contains data).

Space Bar Tabs This option controls the Space Bar Tab feature. This feature makes the Space Bar work just
like the Tab key, saving wear and tear on your left pinky. See “Tabbing with the Space Bar”
on page 279 for details.

Formula This column allows you to specify one or more calculations to be performed whenever the
information in this field changes or is confirmed. For example, an invoice can be set up so
that all totals are calculated whenever a quantity or price is entered or changed. See “Auto-
matic Calculations” on page 303.

Read This attribute is used to control the security level for displaying (reading) the data in this
field. The value in this field may be from 0 (anyone can see this data) to 255 (only users with
the highest possible security level can see this data). For more information on security levels
see the Panorama Security Handbook, available separately. (This option is not accessible in
the Field Properties dialog, only in the Design Sheet.)

Write This attribute is used to control the security level for modifying (writing) the data in this
field. The value in this field may be from 0 (anyone can modify this data) to 255 (only users
with the highest possible security level can modify this data). For more information on secu-
rity levels see the Panorama Security Handbook, available separately. (This option is not
accessible in the Field Properties dialog, only in the Design Sheet.)

Width This contains the approximate width (in characters) of the field in the data sheet. For exam-
ple, a width of 20 means that the column is about 20 characters wide (the actual width
depends on the font and size). Although you can use the design sheet to set the column
width, it is easier and more exact to set the width by dragging on the column name (See
“Changing the Width of a Field” on page 199). (This option is not accessible in the Field
Properties dialog, only in the Design Sheet.)

Generic Field This option allows a field to be designated as a “generic” field (see ““Generic” Fields” on
page 230). Generic fields are fields that contain standard contact information — names,
addresses, phone numbers, etc. Designating a field as generic allows the data in that field
allows the data to be easily exchanged with other databases and compatible applications (for
example Apple’s Address Book application). This option may be set in the Field Properties
dialog or using the Generic Fields preference pane, it is not accessible in the Design Sheet.

Notes You can use this field to keep notes about the field. If a database contains dozens or hun-
dreds of fields, it may be difficult to remember what each field is for. You can use this field to
store reminders to yourself about the purpose and use of each field. Panorama ignores the
contents of this column. 
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Adding New Fields

To add a new field, use the Add Field or Insert Field command in the Fields Menu. The only difference is
that Add Field adds the new field at the end of the database, Insert Field insert the new field in front of the
current field. If your new field has a common name you can simply click on the star and choose the name
from the pop-up menu. As shown in the diagram below, Panorama will automatically fill in all of the options
that make sense for the field name you have chosen.

Press Ok to actually create the new field.

Deleting a Field

To delete a field from the database, select a cell in the field and choose Delete Field from the Fields Menu. (If
you are using the data sheet, you can also press Command-Delete (Mac) or Control-Delete (Windows) to
delete a field.) This not only deletes the field, it also deletes any data in the field. If the field contains data,
Panorama will warn you that it is about to delete the field. You must confirm that you really want to delete
the field before Panorama will proceed. You cannot Undo this operation, so be careful!
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Changing the Width of a Field

To change the width of a field, move the mouse over the right half of column name (or the left half if the col-
umn is right aligned, like a numeric column). The mouse cursor will turn into a double headed arrow.

When you see the double headed arrow, press the mouse. A gray box appears around the column. Drag the
mouse left or right, then release the mouse when the field is the correct width.

When the mouse is released the column width is adjusted (in this case, made wider).

If the column is right aligned (for example a numeric column) the process is flipped. Instead of dragging on
the right half of the column header, you click and drag on the left half.

It sounds more complicated than it is. Just move the mouse until you see the double headed arrow, then drag
left or right.

Automatically Setting the Field Width

If you’d like Panorama to set the field width for you, just choose the Autoset Field Width command from the
Fields menu. To set the field width, Panorama calculates the average width of entries in the field, and then
sets the width to 120% of that value. For most fields this should be close to the optimum width, but of course
you can always make your own manual adjustments as described in the previous section.
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The Autoset ALL Field Widths command sets the width of all fields. This can be handy after importing a lot
of new data into a database.

Note: Panorama automatically adjusts the field width after certain manipulations, for example splitting and
merging fields.

Re Arranging the Field Order

To move a field to a new position within the data sheet, move the mouse over the left half of column name (or
the right half if the column is right aligned, like a numeric column). You’ll see the mouse cursor turn into a
hand.

Now drag the column to the left or right to the new spot.

When the mouse is released the column moves to the new position.

If the data sheet is split horizontally you can drag a column from one side to the other. This makes it easy to
move a column a long horizontal distance within the sheet.

In the example above, the Email field will be moved between the Last and Organization fields.

Note: You can also swap two adjacent fields with the Swap Fields command.
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Duplicating a Field

To make a copy of a field, click anywhere in the field and chose the Duplicate Field command from the
Fields menu.

The duplicate will be named “Copy of “ original field, as shown above. To change the name just double click
on the name to open the Field Properties dialog.

Splitting a Field

Sometimes you’ll need to take an existing field that already has data in it and split it apart. This can be accom-
plished with the Split Field dialog. For example, this database contains a combined Name field that we’d like
to split into separate First and Last fields.

To split the field, click on it then choose Split Field from the Fields menu. The preview area shows how the
data will be split. Since splitting at the first space is the default for this dialog, the split looks perfect.

Before actually performing the split you have the change to assign the names for the new fields. Just type in
the names you want to use.

original duplicate
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Press the Split button to actually split the field into two fields.

Controlling the Split Location

Panorama can split a field at any of three dozen different characters or symbols, or at a specific character posi-
tion. For example, an e-mail address can be split into user name and ISP by splitting at the @ symbol.
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You don’t have to split at the first instance of a character - you can choose any of the first or last nine
instances. In this example the split occurs after the second / symbol.

If you choose to split at a character position instead of at a character or symbol, the pop-up menu expands to
allow you to select up to the first 99 positions. In this example a phone number is split into separate area
codes and local numbers by splitting after the sixth character (this is just one way to split a phone number,
another method will be described later).
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Stripping Extra Spaces and Punctuation

Sometimes after you split a field there will be extra spaces or punctuation that needs to be removed. For
example, suppose you want to split this name field into separate last and first names.

This can easily be done by splitting on the comma, like this.

But … there’s a problem — an extra space at the beginning of each first name. To remove this extra space
check the Strip surrounding Blanks checkbox.

Sometimes you’ll need to strip off punctuation in addition to or instead of blanks. In this example the dialog
is splitting a phone number into separate area codes and local numbers.
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To eliminate the ( and ) around the area code check the Strip Surrounding Punctuation option.

If necessary, you can always perform additional cleanup with the Manipulate Data dialog after the fields
have been split (see “The Manipulate Data Dialog” on page 434).

Partial Splits

Usually splitting involves turning one field into two, but sometimes you just want to keep one part of the
original field and discard the rest. To do that just uncheck the side of split that you don’t want. For example,
this dialog splits off the http portion of the URL.

We really don’t need a field that just contains http over and over. By unchecking the LEFT option, only the
right portion of the data is retained.

A useful option is to do a partial split combined with keeping the original field. For example, suppose I want
to start with this database and create a field that contains the email ISP name (aol.com, me.com, etc.)
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Here’s the setup for the Split Field dialog.

Here’s the final split.

Splitting Non-Text Fields

It's possible, though unusual, to split number or date fields. The number or date is converted to text before
being split, and the resulting fields are always text fields. Here's an example (please note that you may need
to set the output pattern for the date or number field before you split it to get the format you want).
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Merging Adjacent Fields

To merge two adjacent fields, click on the leftmost field you want to merge and choose Merge Fields from the
Fields menu. To illustrate this we’ll merge the Last and First name fields in this database.

When the Merge Fields dialog is first opened it defaults to merging the fields with a single space in between.

Use the pop-up menu to select the text to appear between the merged fields.

The preview shows what the merged field will look like. Edit the field name and you’re ready to merge.
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Here’s the finished result.

Merge Field Options

You can type any text you want to be inserted between the merged fields.

Normally the Merge Fields dialog intelligently omits the text in between the fields if one or both of the fields
are missing.

If necessary, however, you can tell Panorama to always include this text even if one or both fields are missing.

The final option is Keep Original Fields, which allows you to merge the fields while still keeping the original
split fields.
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Hiding and Showing Fields

If you don’t want to see one or more fields, you can temporarily hide them in the data sheet. This is great for
de-cluttering the data sheet and also eliminates the need to create a custom form for many simple reports.
The commands for hiding and showing fields are at the bottom of the Fields menu. (In addition to the menu
bar, these commands also appear when you right-click on a data sheet column title.)

To hide the current field, choose Hide Field (Note: You must have at least one visible field, and you cannot
hide or show fields if the design sheet is open).

To make all hidden fields visible again, choose Show All Fields. (Note: Using the New Generation tool in the
Design Sheet will also make all fields visible.)
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To hide and/or show a bunch of fields at once, open the Hide/Show Fields dialog.

This dialog displays a list of all the fields in the database. Check the fields you want to be visible, then press
the Apply button. All of the unchecked fields will be hidden.

If you have a configuration that you want to use regularly, click on the Favorites icon (yellow star). This
brings up a pop-up menu listing your favorite configurations.

The first two items in the menu are permanent, and quickly show or hide all fields. The other items in this
menu are custom and are set up by you on a database by database basis.
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To create a new favorite, start by choosing the fields you want to show.

Then click on the star and choose Add to favorites….

Panorama will ask you for a name for the new favorite and then save the configuration for later use.
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The Design Sheet

The Fields menu provides an easy way to add or remove a few fields at a time. The disadvantage of the
Fields menu is that it only allows you to see a little piece of the database structure at a time. To get a more
comprehensive view you’ll need to open the actual blueprints of the database—the design sheet. Like other
parts of the database, the design sheet is accessible from the View menu.

The design sheet shows all the fields and their properties. Like DNA, the design sheet contains all the infor-
mation about how the database is organized.

Database “Generations”

When DNA mutates, the change doesn’t take effect until the next generation. Panorama’s design sheet works
the same way. The changes you make to the design sheet don’t immediately change the database. Instead,
Panorama waits for you to tell it to create a “new generation” of the database. This allows you to make multi-
ple changes to the design sheet, check the changes for accuracy, and then apply all of the changes at once to
the actual database structure.

There are three ways to tell Panorama to create a new generation.

Notice that you don’t have to close the design sheet window to create a new generation. If you wish, you can
even leave the design sheet open as you work with the database. This allows you to make a change to the
design sheet, then quickly test the change and make further changes if necessary.

1. Click the New Generation tool.

2. Switch the window to a different view (using the 
View Menu).

3. Close the design sheet window.
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Once you have created a new generation, you cannot go back to the old generation with the Undo command.
However, you can go back to the last generation saved on the disk with the Revert to Saved command (See
“Total Recall (Auto-Save/Crash Recovery)” on page 66).

Typical Design Sheet Operation

Once you get the hang of it, the data sheet is very simple to use. As an example, we’ll show how to add two
new fields to a Contacts database using the design sheet. We’ll add fields for a prefix (Mr./Ms./Mrs.) and for
a middle name.

The first step is to open the design sheet using the View Menu.

If you hold down the Control key (Mac) or Alt key (Windows) the design sheet will open in a separate win-
dow, allowing you to see both the data sheet and the design sheet at the same time (see “Opening More Than
One Window Per Database” on page 169). In the illustration below we’ve dragged the design sheet window
down and to the right so that we can se both windows at once.
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Now we’ll add the two new fields to the design sheet. We use the Insert New Record tool to insert the new
lines, then type in the field names. The new fields are displayed with a pink background to show that they
have not been added to the database yet.

Once the fields are entered, click on the New Generation tool to update the database itself.

new fields

new fields

New Generation tool
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The new fields are ready to use—you can bring the data sheet forward and start entering data in them right
away. It’s not necessary to close the design sheet first—you can leave it open in case you need to make further
modifications to the fields. It’s usually a good idea, however, to close the design sheet when you are not
going to be using it again for a while.

Wait just one minute! There’s one final step you don’t want to forget. When you’re sure you’ve got the struc-
ture you want, make sure you Save the database to make your changes permanent (See “Saving a Database”
on page 63)!

Field Properties

Each row in the design sheet contains all the properties for a single field in the database. The design sheet
contains 19 columns—one column for each field property.

Field Name The field name identifies the field. It helps you remember what is in the field, and is also
used to identify the field in formulas. Panorama does not place any restrictions on your
choice of field names, but there are some ramifications to using an unusual name (see “Rules
for Field Names” on page 220).

Type This column specifies the type of data stored in each field: text, numeric, date, choices, or
picture. See “Data Types” on page 245 for more information.

Digits This column specifies the number of digits to be used after the decimal point with numeric
data: 0, 1, 2, 3, 4, Float or Money. See “Numeric Data” on page 249 for more information.

Align This column specifies how the field should be aligned in the data sheet: left, center, or right
flush. Usually left flush is used for everything except numbers, which are displayed right
flush.

Output Pattern The output pattern allows you to specify the display format for numbers or dates. See
“Numeric Output Patterns” on page 250 and see “Date Output Patterns” on page 255 for
more information.

Input Pattern The input pattern forces data into a specific pattern as it is entered, for example phone num-
bers or social security numbers. See “Input Patterns” on page 291 for more information.

Range This column allows you to restrict the characters that can be entered in a field. For example,
you can restrict a field to only allow alphabetic or numeric entry. See “Restricting Character
Types” on page 293 for more information.

Choices This column allows you to specify a list of choices that are valid for this field; for instance
Yes/No, Gold/Silver/Bronze or Regular/Unleaded. The list of choices is used by the
Choices data type (see “Choices” on page 259) and is also used by the Choice Palette (see
“The Choice Palette” on page 317).

Link This column allows you to link this field with a field in another database. Only Clairvoy-
ance® is affected by this link. You can set up this field with the Clairvoyance Link command.
For more information see “Clairvoyance® Across Multiple Files” on page 286.

Clairvoyance® This column controls Panorama’s Clairvoyance feature. This feature tries to anticipate what
you are about to type, then types it for you. See “Clairvoyance®” on page 284 for the straight
scoop.

Tabs This column controls the Space Bar Tab feature. This feature makes the Space Bar work just
like the Tab key, saving wear and tear on your left pinky. See “Tabbing with the Space Bar”
on page 279 for details.

Caps Use this column to tell Panorama to automatically capitalize data entry in a field. Panorama
can automatically capitalize everything, or just the first letter of each word or sentence. See
“Automatic Capitalization” on page 281.

Dups This column specifies whether or not you want to allow duplicate entries in this field. You
can also specify that you want to require duplicate entries (no unique values). See “Checking
for Duplicate Data” on page 283.

Default Value This column allows you to specify a default value for the field when a new record is created.
See “Default Values” on page 296.
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Adding New Fields Using the Design Sheet

In addition to changing the properties of existing fields, the design sheet can be used to add new fields or to
delete existing fields. The design sheet is especially handy when you need to add a lot of new fields at once.

Since each line in the design sheet corresponds to a field, you can add new fields simply by adding new lines
to the design sheet. The design sheet works the same way as the data sheet—you can add new lines using the
Add New Record tool, the Insert New Record tool, or by pressing the Return key. (Keep in mind that each
record in the design sheet corresponds to a field in the database, so adding or inserting a record here is equiv-
alent to adding or inserting a field in the database itself.)

Remember that adding a line to the design sheet does not immediately create the new field. When you are
ready to actually add the new field(s) to the database, tell Panorama to create a new generation (See “Data-
base “Generations”” on page 212).

Equation This column allows you to specify one or more calculations to be performed whenever the
information in this field changes or is confirmed. For example, an invoice can be set up so
that all totals are calculated whenever a quantity or price is entered or changed. See “Auto-
matic Calculations” on page 303.

Read This attribute is used to control the security level for displaying (reading) the data in this
field. The value in this field may be from 0 (anyone can see this data) to 255 (only users with
the highest possible security level can see this data). For more information on security levels
see the Panorama Security Handbook, available separately.

Write This attribute is used to control the security level for modifying (writing) the data in this
field. The value in this field may be from 0 (anyone can modify this data) to 255 (only users
with the highest possible security level can modify this data). For more information on secu-
rity levels see the Panorama Security Handbook, available separately.

Width This contains the approximate width (in characters) of the field in the data sheet. For exam-
ple, a width of 20 means that the column is about 20 characters wide (the actual width
depends on the font and size). Although you can use the design sheet to set the column
width, it is easier and more exact to set the width by dragging on the column name (See
“Changing the Width of a Field” on page 199).

Notes You can use this field to keep notes about the field. If a database contains dozens or hun-
dreds of fields, it may be difficult to remember what each field is for. You can use this field to
store reminders to yourself about the purpose and use of each field. Panorama ignores the
contents of this column. 
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When you add a new line to the design sheet, you may notice that your new line has a pink background. This
pink background serves as a reminder of the new fields you have created.

As soon as you create a new generation, the background of any new fields will change to gray. On the other
hand, if you close the design sheet without creating a new generation, the new fields will not be created.

Removing Fields Using the Design Sheet

To remove a field from the database simply remove the corresponding line from the design sheet and then tell
Panorama to create a new generation. You can delete a field using the Cut Field tool or by pressing the Delete
key (Mac) or the Backspace key (PC).

When you remove a field, all the data in that field is lost forever (unless of course, you have another copy on
the disk). Remember, you cannot go back to an old generation with the Undo command. Therefore, you’ll
want to be very sure that you really don’t need a field anymore before you remove it.

Making a Copy of a Field

You can create a copy of a field, including all the data in the field, by copying the corresponding line in the
design sheet. Use the Copy Field tool to copy the line into the clipboard, then use the Paste Field tool to make
a copy of the line in the design sheet. You’ll probably want to rename the new field. (You must use the clip-
board to create the copy—you cannot simply type in a copy of the line.) When you create a new generation
the database will contain a copy of the field, including the data in the field.

For example, let’s suppose we want to create a DateCleared field for a Checkbook database, starting with the
data already in the Date field. Start by selecting the Date field and copying it into the clipboard.

new field
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Now select the position for the new field and paste it in.

Rename the new field to DateCleared. Notice that the “new” field does not have a pink back ground, because
it is not really a new field, but a copy of an existing field.

Use the View Menu to switch to the data sheet. When Panorama asks you if you want a New Generation,
press the Yes button. As you can see, Panorama has created the new field with a copy of the data in the old
field.

Note: You can only use this technique to copy fields within a single database. You cannot copy a field from
one database and paste it into another database.

new field
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By the way, this technique is not the only way to copy a field. You can also use the Formula Fill command to
copy a field at any time, not just when it is created (See “Propagate” on page 466.)

Re-Arranging Fields

The design sheet can also be used to re-arrange the order of the fields. It’s a two step process—first re-arrange
the lines in the design sheet, then create a new generation.

To move a field up one line in the design sheet, press Command-Up Arrow (Mac) or Control-Up Arrow (PC).
To move a field down one line in the design sheet, press Command-Down Arrow (Mac) or Control-Down
Arrow (PC). Keep pressing until the field reaches the desired position.

Another way to move a field is with the Cut Field and Paste Field tools. This method may be faster if you
need to move a field a long distance.

When the fields are in the correct order, tell Panorama to create a new generation.
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Rules for Field Names

Each field in a Panorama database is identified by a field name. Field names serve several purposes: they
remind you what the field is for (i.e. the Dates field probably contains dates, the Name field probably con-
tains names, etc.), they appear at the top of each column in the data sheet, and they are used to identify fields
in formulas and procedures (for example Amount=Qty*Price).

Panorama doesn’t place any restrictions on the field names you choose. Field names may be as long as you
want, and they may contain any character that can be typed from the keyboard. Field names may be split
over two or more lines (see below). You can even have two or more fields with the same name (but we recom-
mend that you avoid this, see the next paragraph).

However, if you are planning to use a field in a formula or procedure, you may want to avoid some of these
unusual possibilities. If you have two or more fields with the same name, only the first field will be accessible
to a formula. Field names containing blanks or punctuation (for instance P/E Ratio) are more difficult to use
in a formula. To use such a field in a formula, you must surround the field name with «  and » (for example
«P/E Ratio». See “Fields” on page 50). (If you left out the «», Panorama would think you were trying to
divide P by E, with Ratio left over.) You may want to avoid field names like Date, Seconds, And, Or, and
Sum. These names can be confusing when used in a formula because Panorama has functions with the same
names.

Multiple Line Field Names

It is possible split a field name over two or more lines. The main reason for doing this is to create a multiple
line title for the data sheet. Simply type in a Return between each line.
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In the data sheet this field name will appear on two lines, like this.

If you use one of these fields in a formula, the Return’s should be represented as spaces, as shown here. The
formula on the left is correct, the formula on the right is wrong.

Correct Wrong

«Zip Code»=92365         «Zip
        Code»=92365
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Repeating Fields (Line Items)

Some databases contain several similar fields repeating within each record. For example, an invoice usually
contains several quantities, product descriptions, product prices, etc. These fields are often called Line Items
because they repeat for each line on the invoice. In Panorama these line item fields are created by adding a
numeric suffix to the root field name, for example Qty1, Qty2, … Qty15. This illustration shows part of a
form that contains line items arranged into 15 rows by 4 columns.

In the design sheet these line item fields are simply 60 individual fields.

Right about now you are probably groaning at the thought of typing in all those fields. Don’t panic yet —
we’ve got you covered (keep reading)!

Quantity1

Quantity2

Quantity3

Description4

Description5

Description6

Price7

Price8

Price9

Total13

Total14

Total15
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Creating Line Item Fields

You can create line item fields the same way you create ordinary fields, using the Add Field command (see
“Adding New Fields” on page 198) or the design sheet (see “Adding New Fields Using the Design Sheet” on
page 216). Just make sure to add the numeric suffix to the end of each name (with no space), and remember to
spell the base name the same way each time, including capitalization.

The design sheet has a shortcut for creating multiple line items in a hurry—the Create Line Items dialog in
the Special menu. To use this dialog start by positioning the cursor just above the spot where you want the
line items inserted. In the illustration below, the line items will be inserted between the Zip and Subtotal
fields.

Once the cursor is in the correct spot choose Create Line Items from the Special menu.

The dialog allows you to enter up to eight root line item names (for example Qty, Item, Price, etc.). You can
also specify the starting and ending numeric suffixes (for example 1 through 9).

OK Not OK

Qty1 Q1

Qty2 Qty2

Qty3 QTY3

Qty4 Qty4

new line items will be inserted here
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When you press OK Panorama will automatically insert the line items into the design sheet. The line items
are inserted below the currently selected field.

The new line item fields are actually added to the database when a new generation is created (see “Database
“Generations”” on page 212).
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Modifying Line Item Fields

When you modify the properties of a line item field, you usually want to make the same change to all the cor-
responding fields. For example, if you change Qty1 to numeric, you probably also want to change Qty2,
Qty3,Qty4…Qty15 to numeric also. The design sheet can do this for you. Whenever you change any of the
properties of a particular line item field, Panorama will ask you if you would like to make the same change to
all of the other corresponding line item fields. To illustrate this, let’s go ahead and change Qty1 to numeric.

When you press the Enter key you will be presented with a choice.
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If you press Yes (or the Enter key), Panorama will go ahead and change all of the Qty fields to numeric.
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This auto-repeat feature works for any column in the design sheet (except the Field Name). For example, we
could type a formula into the Total4 field.

When you press Enter Panorama can automatically repeat this formula to all the other Total fields.

To learn more about creating formulas for line items (and those funny Ω characters) see “Line Item Fields” on
page 52.

If you press Yes, and don’t ask me again or No, and don’t ask me again Panorama will remember your
choice for as long as the design sheet is open. If you close the design sheet and then re-open it later, however,
Panorama will start asking you again (until you tell it not to again!).
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Adding More Line Item Fields

If necessary you can use the Create Line Items dialog to add new line items at any time. For example, sup-
pose we wanted to add three more line items to the five we created earlier. Start by placing the cursor on the
last line item.

Now open the Create Line Items dialog and type in the field name roots again. Set the numbering to start just
past the previously created line items (in this case 6).
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Panorama adds the new line items.

These new items do not have any of the modifications you may have made to the existing line items (type,
equation, etc.) To update the new items simply edit open and close the appropriate data cells in one of the
line items that are already set up and let Panorama copy the changes into the new line items (see “Modifying
Line Item Fields” on page 225).

Learn More About Line Items

Line items get special treatment in the design sheet, in formulas, and in form layout. To learn about set up
formulas for calculating line items see “Line Item Fields” on page 52 and “Adding Line Item Fields” on
page 62. You’ll also find some examples of line item calculations in “Automatic Calculations” on page 303. To
learn how to automatically create rows and columns of line item cells in a form see “Line Items in a Form” on
page 669. To learn how to adjust the width of an entire column of line item cells in a form see “Cluster Resize”
on page 541. To learn how to change the font size of a table of line item cells see “Adjusting Spacing Between
Multiple Objects” on page 556.
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“Generic” Fields

Databases come in all sizes and shapes. Generic fields allow different databases to share information even if
they have different field names or slightly different configurations. For example, one database may store
company names in a field named Company, while another may have a similar field named Organization. By
setting up generic fields for each database, you build a bridge so that Panorama knows that these two fields,
though named differently, contain the same type of information. Once this bridge is built Panorama can
exchange data between these two databases (for example by drag and drop), and between Panorama and
other applications that can share information (for example Apple’s Address Book).

Unlike normal Panorama fields, generic fields don’t actually store any information themselves. Instead, a
generic field simply references one or more normal Panorama fields that contain the same information. When
Panorama needs to access the information in the generic field, it examines the generic field definition (see
below) to extract the data from the actual database fields.

Standard Generic Fields

While ordinary Panorama fields can store an unlimited variety of information, there are only about two
dozen generic fields to choose from (this list may grow in future releases). Not all databases will be able to
support all of these generic fields, but a database that contains contact information (mailing lists, phone
books, etc.) will be able to support many of them.

Category Generic Field Description Examples

Contact

Name A person’s first and last name. John Wilson, Mary Furnare

Nickname A person’s nickname. Sammy, Beth

Prefix A person’s honorific. Mr., Ms., Dr.

First A person’s first name. John, Mary

Middle A person’s middle name or initial. August, Walker

Last A person’s last name. Wilson, Furnare

Suffix A person’s suffix. Jr., D.D.S

Formal A person’s honorific and last name. Dr. Wilson, Ms. Furnare

FullName A person’s complete name. Dr. John August Wilson

Affiliation

Position A person’s title or position within an organi-
zation. President, Sales Manager

Organization The company, school, agency or other organi-
zation this person is affiliated with (if any). Acme Construction

Division The major division or group this person is 
affiliated with (if any). Communications Products

Department The department this person is affiliated with 
(if any). Human Resources

Address

Address Street address. 1892 North Glendale Blvd.

Suite Suite, apartment or room number (if any) Room 463

City City or town. Saskatoon

State State or province. SK

Zip Zip or postal code 4Y2 A8G

Country Country Canada

Internet
Email Email address. This field may contain multi-

ple e-mail addresses, one per line. maryf@acme.com

Web URL for web site http://www.acme.com/cp/hr/
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If you are familiar with the vCard specification (RFC 2426) for exchanging data between programs you’ll rec-
ognize that many of these generic fields correspond to vCard fields.

Adding Generic Fields to an Existing Database

Normal Panorama fields are set up with the New Database wizard, Design Sheet, or Field Properties dialog.
Generic fields can be set up with the FIeld Properties dialog or with Generic Fields preferences. Generic
fields can be added to an existing database at any time. The next few paragraphs will illustrate the process for
setting up generic fields. This example will use a basic address book database, shown here.

Telephone
(separate)

Voice Primary phone number. (303) 442-9011

Fax Fax phone number. (888) 763-1290

Cell Cell or mobile phone number. (909) 487-2063

Home Home phone number. (562) 491-3992

Work Word phone number (324) 987-3367 ext 2384

Pager Pager number. (817) 335-9832

Telephone
(line items/

array)

PhoneType

The PhoneType and Phone fields are compos-
ite fields designed for holding multiple phone 
numbers. Use these generic fields when the 
underlying database contains phone numbers 
in line items or an array instead of in separate 
fields. Each line in these fields corresponds to 
a single phone number. Each line in the Pho-
neType generic field contains the type of the 
corresponding phone number: Home, Office, 
Cell, Fax, etc. Each line in the Phone generic 
field contains the actual phone number.

Voice
Cell
Fax

Phone
(303) 442-9011
(909) 487-2063
(888) 763-1290

Other Notes Notes, memos, comments, etc.

Category Generic Field Description Examples
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Setting up Generic Fields with the Field Properties Dialog

To specify that a field is a generic field, open the Field Properties dialog and select from the Generic Field
pop-up menu.

That’s it!
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Using the Generic Fields Preferences

The Generic Fields preferences allows you to set up all of a databases generic fields at once. It also allows
you to set up generic fields that correspond to multiple actual fields. The first step is to open the Generic
Fields window — choose Preferences from the Panorama menu then Generic Fields. The Generic Fields
preferences are divided into three columns. The left column, Database Fields, lists the actual fields in the
database. The second column, Generic Fields, lists the generic fields for this database. The generic fields col-
umn is divided into major sections (like CONTACTS) and minor sections (Affiliation, Address, etc.) Since
we're just starting, none of the generic fields have been defined (everything to the right of the = sign is blank).
The rightmost column is for assigning formulas to define generic fields, we'll discuss that further in a
moment. 

If an actual field in the database contains the exact data required by a generic field, you can simply drag the
field from the Database Fields column to the appropriate generic field in the Generic Fields column.
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This drag and drop process must be repeated for each actual database field that corresponds to a generic
field. Notice that the name of the database field does not have to be the same as the name of the generic field,
as long as both contain the same data. (In this case, the actual database field that contains the organization
name is called Company.)

Assigning Multiple Database Fields to a Generic Field

In some cases there will be no single database field that corresponds to a generic field. In that case you may
be able to create a formula for the generic field. For our example, our sample database has no combined
Name field (first and last names). However, we can simulate that field with the formula First+" "+Last (see
“Text Formulas” on page 67 of Formulas & Programming for more information on how this formula was con-
structed). Instead of dragging to set up the generic field, it must be typed into the right hand column of the
wizard. For example, to set up a formula for the generic Name field, first click on that generic field. This
enables the rightmost pane of the window, which is used for editing formulas.

You can type in the formula, and you can also drag field names from the Database Fields column.

Note: A generic field that is defined with a formula can be used to export data, but not to import it.

Configuring Generic Phone Number Fields

The Generic Fields wizard supports three different ways to store phone numbers: separate fields, line items,
and arrays.
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Probably the most common method for storing phone numbers is to store each number in a separate field.
For example, the database might have a field for voice numbers, another field for fax numbers, another for
cell phones, etc. Here is a typical example of a database with separate fields for main phone number, cell
phone and fax.

To link these separate fields to generic fields, scroll down to the Phone (Separate) section of the Generic Fields
column and drag the database fields to the corresponding generic fields.

The second method for storing phone numbers is to use line item fields. Line item fields are repeating fields
with a numeric suffix, for example Phone1, Phone2, Phone3, etc. (see “Repeating Fields (Line Items)” on
page 222 for a general discussion of line item fields). The Generic Fields wizard assumes that phone numbers
are stored in two sets of line item fields, phone types (voice, fax, cell, etc.) and the actual phone numbers
themselves. Here's a typical example with four sets of line items:
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Line item fields like this are usually arranged in rows and columns on a form, like this:

To link these line item fields to generic fields, scroll down to the Phone (Line Items/Array) section of the
Generic Fields column. Drag the first phone type line item field (in this case PhType1) over the PhoneType
generic field. Then drag the first phone number field (in this case Phone1) over the Phone generic field. As
you release the mouse you'll notice that the field number changes from 1 to Ω, as shown below. This confirms
that all of the line item fields are linked to this generic field.

The final method for storing phone numbers is to use carriage return delimited arrays. In this case there are
two fields, with each line corresponding to a single phone number.
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This arrangement allows you to store an unlimited number of phone numbers in only two fields. To link
these two fields to generic fields, scroll down to the Phone (Line Items/Array) section of the Generic Fields
column. Drag the phone type field (in this case PhoneType) over the PhoneType generic field. Then drag the
phone number field (in this case Phone) over the Phone generic field.

Using Generic Fields with the VCard Wizard

Once generic fields have been set up they can be used to transfer data between the database and other data-
bases that also have generic fields, or between the database and applications that support vCards. For exam-
ple an address could be copied to Apple’s address book, or used to display a map. A phone number can be
used to actually dial the phone, or an e-mail address to send an e-mail.

The slickest way to use generic fields is to program them into your database itself (see “VCard Drag and
Drop” on page 656). However, it’s not necessary to do any programming to use generic fields. The VCard
Wizard allows you to use generic fields without any programming at all. You’ll find this wizard in the Utili-
ties submenu of the Wizard menu. When you first open this wizard it will display the generic data from the
current database, as shown below. (If the current database doesn’t have any generic fields, it will display an
error message.)

If you later move to a different record in the My Address Book database, or edit the data, the VCard Wizard
will automatically update when you bring it back to the front.

original database

VCard wizard displays the same information
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Dragging Data to Other Applications or Databases 

By dragging the phone book icon you can drag data to Apple's Address Book (or any other application that
supports VCards) or to any database that has generic fields.

Drag onto the Address Book (or any VCard compatible application).
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When you release the mouse, the data will be added to a new card in the Address Book.

You can also drag onto other databases that support generic fields. In this example the same person has been
dragged onto the Mini Correspondence wizard, creating a new letter to Ms. Hess.
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Dragging Data from other Applications or Databases 

To copy data from the Address Book (or any VCard compatible application) to your database, simply drag to
anywhere on the VCard Wizard.

Drag the address to anywhere on the VCard Wizard.
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When you release the mouse the contact will be added to the end of the database.

You can also drag from other databases that support generic fields. When you drag from the White Pages
wizard to the VCard Wizard, the address is added to the database that is currently linked to the VCard Wiz-
ard (in this case My Address Book).
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Displaying a Map

To display a map of the current address, click on the globe icon. The map will appear in whatever browser
you have set up as the default browser.

Sending an Email

To send an e-mail, click on the  postage stamp icon. The wizard will open the default e-mail program on
your computer and create a new e-mail message to this person.

Dialing the Phone

To dial the phone, click on the  telephone icon. Before you do, be sure you have set up the Channels wiz-
ard (see “Channels” on page 93 of Wizards & Demos) to specify the dialing method you want to use (touch
tones, modem, Vonage VOIP, etc.) and your local dialing information (area code, calling prefix and suffix,
etc.).
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Exporting a Batch of VCards

In addition to transferring records one at a time (by dragging them) you can also export a batch of vCards at
once in a file. Start by selecting the records you want to export, in this case all records in Palm Springs, CA.

Open the VCard Wizard and select Export VCards… from the VCard menu. The wizard will ask you to con-
firm that you want to export multiple vCards.

Next the wizard will ask you for the name of the file you want to export. We recommend that you use the .vcf
suffix for vCard files.

The resulting file can be imported into other applications that support vCard import (for example Apple’s
Address Book).
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Importing a Batch of VCards

To import a file containing a batch of VCards choose Import VCards from the VCards menu. The wizard will
ask you to select the file you want to import.

Press the Choose button and the vCards will be imported to the end of the current database.

Panorama is designed to import vCards that use the Western (Mac OS Roman) encoding. If you are exporting
vCards from Apple’s Address Book application you should make sure that this encoding is specified before
exporting the VCards from address book. To do that, open Address Book and choose Preferences from the
Address Book menu. Select the vCard tab, then use the pop-up menu to select Western (Mac OS Roman).

If some other encoding is selected Panorama may not be able to import the vCards properly, or perhaps even
at all. 
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In Panorama, all data is not the same. Just as Eskimos distinguish between 16 types of snow, Panorama dis-
tinguishes between five types of data—text, numeric, date, choices, and pictures. To get the most out of a
database, Panorama needs to know what type of data you intend to store in each field. This lets Panorama
store the data efficiently and check for data entry errors. It also tells Panorama how to compare different val-
ues (numbers, text, and dates are all compared differently) which is important for sorting and selecting data.
The data type also tells Panorama how to format some kinds of data (numbers and dates).

As mentioned above, Panorama databases can contain five different types of data. When you create the data-
base, you specify what type of data will be stored in each field.

The text data type is used for storing ordinary text—names, addresses, descriptions, etc. Panorama cannot
perform mathematical calculations (add, subtract, etc.) on data that is stored as text.

The numeric data type is used for storing numbers—prices, quantities, etc. Use the numeric data type for any
field you want to use in a calculation. The numeric data type has several variations that are discussed later in
this chapter.

It’s not always necessary to store numbers in numeric fields. For example, zip codes and phone numbers are
usually stored in text fields, not numeric fields. This allows the use of nine digit zip codes (for example 92867-
3482) and foreign postal codes and phone numbers. In general, use a numeric field if you want to perform
numeric calculations (addition, multiplication, etc.) and/or if you want to select or sort the information in
numeric order (1, 2, 3, … 10, 20, 30, … etc.)

The date data type is self explanatory—it is used for storing dates (for instance March 1, 1994). Panorama
understands the properties of dates—it knows that May 1st follows April 30th and that there are six days
between May 28th and June 3rd. Dates are discussed in more detail later in this chapter. Panorama can han-
dle dates from 100 A.D. to well past the year 20,000 A.D.

The choices data type is used for storing data that has only a few possible values—for instance yes/no, gold/
silver/bronze, or coach/first class. The choices data type saves space by storing a special code instead of the
entire text. The procedure for setting up a field using the choices data type is described at the end of this
chapter.

 Data Type Uses Examples

Text Names, Addresses, Descriptions, etc. John, 234 Peach Avenue

Numeric Prices, Quantities, etc. 4, 78.23, 4.9e-2

Date Dates. 9/18/2002

Choices Multiple Choice Options Yes/No, Gold/Silver/Bronze

Picture
(Obsolete)

Photographs, Drawings n/a
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The picture data type is used for storing-you guessed it-pictures! This data type allows you to paste graphics
from other Macintosh programs into your Panorama database. However, in general we do not recommend
storing pictures within the database using the picture data type. Instead, you should store images in separate
files and display them using Panorama’s Flash Art feature (See “Flash Art™” on page 750).

Data Types and Memory Usage

When we started writing Panorama in 1986, a typical personal computer had about 1 megabyte of memory.
Because Panorama loads the entire database into RAM, it was critical to store the data as efficiently as possi-
ble. To do this we created a variety of data types, allowing you to pick the data type that was most efficient
for each field (for example, there are 6 different numeric data types).

Nowadays a typical computer has 32 megabytes, 64 megabytes, or even more RAM. For most applications it
is no longer necessary to be hypervigilant about choosing the most efficient data type. For example, for num-
bers, it’s usually fine to simply use the most flexible floating point option, even though this consumes a little
bit more memory. It’s also rarely necessary to use the choice data type—you can simply use the text data type
instead. Throughout the rest of this chapter you’ll find a lot of discussion about picking the most efficient
data type for each field. If you are working with small to moderate size databases (from 10 to 20,000 records)
you probably don’t need to worry about picking the most efficient data types. You can simply stick with three
basic data types—text, floating point numbers, and dates. That being said, you can probably skip over most
of the material in the rest of this chapter!

Setting Up a Field’s Data Type

The data type of a field can be specified with either the Setup Menu or the Design Sheet. The simplest method
is using the Field Properties command in the Setup Menu. The Field Properties dialog box contains a pop-
up menu for selecting the data type. Tip: You can also open the Field Properties dialog box by double clicking
on the name of the field on the data sheet.
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An alternate way to specify the data type is using the Design Sheet. The second column of the design sheet
contains the data type of each field in the database. Using the design sheet allows you to quickly modify
many fields at a time. See “The Design Sheet” on page 212 for more information on opening and using the
design sheet.

Data Type Conversion Problems

When you change the data type of an existing field it is possible that you may lose some of the data in that
field. For example, if you convert a field from text to numeric, any letters or punctuation will be lost in the
conversion. Panorama will warn you if this situation occurs.

The alert gives you three options:

OK — Pressing this button tells Panorama to complete the conversion. Any data that cannot be converted
will be removed. For example, if you are converting a field from text to numeric any non-numeric data will
be lost in the conversion.

Cancel — Pressing this button cancels the conversion

Select Problem Data Pressing this button tells Panorama to cancel the conversion and show you the data that
is causing the problem. This option lets you look at the data that is causing the problem and decide what to
do next. If necessary, you can make manual adjustments to the data, or you may decide that you don’t want
to change the data type after all.

double click on any cell in this column to change the field type
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For example, suppose you wanted to change the Zip code field in the database below to numeric.

When you attempted to make the conversion, Panorama would display the conversion warning alert. Press
Select Problem Data to see what is causing the problem.

Aha! The problem is the Canadian postal codes, which have letters instead of numbers. At this point you
would probably want to rethink the idea of converting the Zip Code field to numeric.

If you did decide to go ahead with the conversion, Panorama would strip the letters from the Canadian
postal codes.

When you are done looking at the problem data, choose the Select All command (Search Menu) to make all
the data visible again. (See “Finding vs. Selecting” on page 331 for more information on selecting and the
Select All command.)
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Numeric Data

Numeric data can be stored in either fixed point or floating point format. If you choose fixed point you have
a choice of 0, 1, 2, 3, or 4 digits after the decimal point.

You may wonder why there are so many choices for storing numeric data. After all, a number is a number—
right? Not quite. By choosing different numeric storage formats you are making a trade-off between space,
speed, accuracy, and range.

Storing numbers using floating point gives you the most accuracy and numeric range. Floating point allows
you to store extremely large or small values with up to 16 digits of accuracy. If you are in doubt, go ahead and
pick floating point format.

Fixed point storage is more limited. The accuracy is only about 9 digits. The largest number that can be stored
is about 2 billion (2•109) while the smallest fixed point number is 0.0001 (10-4). Trying to store larger or
smaller values using fixed point storage will result in errors.

On the other hand the space required for fixed point storage is up to 8 times smaller than floating point for
the same number, and Panorama can perform fixed point arithmetic much faster than floating point. You
should use fixed point numeric storage whenever possible. Check the table above to see if the numbers you
will be using fit in one of the fixed point numeric ranges.

You can set the number of digits via a pop-up menu in the Field Properties dialog box.

Number of 
Digits After 

Decimal Point
Example Largest Value Smallest Value Typical Uses

0 93842 2,100,000,000 1 Quantities, Part Numbers

1 73.1 210,000,000 0.1 Rarely Used

2 253.22 21,000,000 0.01 Money (Dollars, Pounds, etc.)

3 0.447 2,100,000 0.001 Rarely Used

4 929.1123 210,000 0.0001 Rarely Used

Float 1.46e-12 1.7•10308 2.3•10-308 Scientific Data
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You can also set the number of digits using the Digits column in the design sheet.

Money

Usually the best way to store monetary values is using either 2-digit fixed point or Panorama’s special Money
format. The money format is the same as 2-digit fixed point but automatically enters the decimal point for
you during data entry. This table below shows how Panorama interprets data you enter into a money field.

Both the 2-digit and money formats allow you to store monetary values up to 21 million dollars, pounds,
francs, etc. (If your business deals with values greater than 21 million you should use floating point numeric
storage.)

Numeric Output Patterns

Output patterns allow you to control the way a number is displayed. In the design sheet, output patterns can
be used to control how numbers are displayed in the data sheet. Output patterns can also be used in a for-
mula (See “Converting Between Numbers and Strings” on page 84 of Formulas & Programming).

Below are some ways the same number may be displayed using different output patterns. Remember, the
way a number is displayed does not change its internal value. All the numbers listed below have the value
2654.

2654
2,654
$2,654.00
002654
2.654e+3
26-54
Two thousand six hundred fifty four

When you 
enter… it becomes

87204 872.04

3267 32.67

14 0.14

2 0.02

42. 42.00

15.4 15.40

156.78 156.78

double click on any cell in this column to change the number of digits
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Numeric output patterns consist of a string of characters containing one or more # symbols. The # symbol
tells Panorama how and where to print the number.

The overall output pattern for a field can be set using the Pattern button in the Field Properties dialog box or
the Output Pattern column in the design sheet.

If you choose Other from the pop-up menu a secondary dialog appears:

Simply choose the options you want using the checkboxes and pop-up menus. Close the window when you
are done.

type pattern here, or…

choose from pop-up
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If you are using the design sheet to set up the pattern, simply type the pattern into the Output Pattern col-
umn. See “The Design Sheet” on page 212 for more information on opening and using the design sheet.

Fixed Decimal Point Patterns

The table below shows how the output pattern can be used to display numbers with a specified number of
digits after the decimal point. These output patterns force a fixed point display even if you are displaying
floating point numbers. They also allow you to override the natural display of fixed point numbers. For
example, a money field can be set up to display only dollars, while still keeping track of cents for calculation
purposes.

Notice that if the number of # symbols after the decimal point is less than the number of digits in the number,
Panorama will round the number rather than truncating it.

Numbers with Commas, Punctuation, and Measurement Units

If a comma is added to the pattern, the number will be printed with a comma every third digit. Other charac-
ters can also be added to the beginning or end and will be displayed unchanged. For example, you can add a
currency symbol or measurement unit to the pattern, as shown below:

Number Pattern Display

1234.56 1234.56

1234.56 # 1235

1234.56 #.# 1234.6

1234.56 #.## 1234.56

1234.56 #.#### 1234.5600

Number Pattern Display

1234.56 #,.## 1,234.56

1234.56 $#,.## $1,234.56

1234.56 #,.## kg 1,234.56 kg

type the pattern into the Output Pattern column
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Scientific Notation

If an E or e is added at the end of the output pattern, the number will be displayed using scientific notation.
Any number may be displayed in scientific notation, including fixed point numbers.

Special Patterns for Negative Numbers

Negative numbers are usually displayed with a minus sign in the front of the number. This can be changed to
a trailing minus sign or to enclosing parentheses.

Leading Zeros

You can use an output pattern to force Panorama to display leading zeros. To do this, put several # symbols
in a row without a decimal point.

Tip: If you are storing US Zip codes in a numeric field, use ##### as the output pattern. This pattern makes
sure that all 5 zip code digits are displayed, even if the first digit is zero.

If your database also contains Canadian postal codes, the zip codes must be stored in a text field. In that case
no output pattern is necessary.

Number Pattern Display

1234.56 #e 1e+3

1234.56 #.#E 1.2e+3

1234.56 #.##e 1.23e+3

1234.56 #.###E 1.235e+3

1234.56 #.####E 1.2346e+3

1234.56 #.#####E 1.23456e+3

1234.56 #.######E 1.234560e+3

1234.56 #.#E kg 1.2e+3 kg

Number Pattern Display

-1234.56 #.## -1234.56

1234.56 #.## 1234.56

-1234.56 #.##- 1234.56-

1234.56 #.##- 1234.56

-1234.56 (#.##) (1234.56)

1234.56 (#.##) 1234.56

Number Pattern Display

123 ##### 00123

1234 ##### 01234

12345 ##### 12345



Page 254 Panorama Handbook
Numbers with Multiple Components

An output pattern can be used to split a number into multiple components. To split up a number, spread the
# characters through the output pattern, one # symbol for each digit you want to print. The examples below
show how this feature can be used for social security numbers, phone numbers, and combination locks.

Using output patterns this way can save a lot of memory. For instance, storing the combination L24 R10 L18
as text requires 11 bytes per combination. Storing the same combination as a number requires only 3 bytes per
combination. If your database contains 10,000 combinations this represents a savings of 80k of memory.
(Sure, in the new millennium 80k isn’t much! But if your database contains one million records using an out-
put pattern would save 8 megabytes.)

Phone Numbers

We recommend storing phone numbers in text fields. However, using multiple component output patterns it
is possible to store phone numbers as numbers. For local phone numbers you can use the output pattern
###-#### and store the numbers as fixed point with zero digits. This results in a savings of 5 bytes per
phone number (3 bytes vs. 8 bytes). On the other hand, who ever heard of a 7 digit phone number in this day
of area code splits every other week?

A long distance phone number requires more accuracy than is available in a fixed point number, so you‘ll
have to use the floating point data type. The output pattern is (###) ###-####. This results in a savings of
6 bytes per phone number (8 bytes vs. 14 bytes).

If your phone numbers are stored as numbers you should only enter the digits. For example to enter the
number (800) 432-4567 type 8004324567.

We recommend storing phone numbers in a text field. Although this takes more memory, it is more flexible,
allowing you to add extensions or other notes (for example 329-9583 ext 241). If you do use a text field, you
can use an input pattern to enter the (, ), and - characters for you. See “Input Patterns” on page 291 for more
information on this technique.

Plural Suffixes

If a pattern contains measurement units you may want to properly pluralize the units depending on the
value being displayed. Use the ~ symbol to do this.

Displaying Numbers as Words

If you wish, numbers can be displayed as words instead of digits. To do this, use the § symbol instead of the
# symbol. Only one § symbol should be used. To make the § symbol on a Macintosh, press Option-6. On the
PC, press Alt-0167. Only the integer part of the number will be displayed—any fractional part will be
ignored.

Number Pattern Display

219304349 ###-##-#### 219-20-4349

5293672 ###-#### 529-3672

241018 L## R## L## L24 R10 L18

Number Pattern Display

1 # mile~ 1 mile

5 # mile~ 5 miles
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If you are displaying money, you’ll probably want to display the fractional part (cents) as well as the integer
part. You can do this with the ¢ (cents) symbol. On the Macintosh, press Option-4 to create the ¢ symbol. On
the PC, press Alt-0162. Use one ¢ for each digit you want display (usually 2).

Dates

Panorama has a special data type for storing dates. When you use the date type to store your dates, Pan-
orama can sort your dates in the correct order, check your dates for validity as they are entered, and calculate
the number of days between two dates. Dates are quite compact; almost any date in the 20th or 21st century
will take only two bytes of storage.

Entering Dates

Panorama is very flexible about how you type dates. We call this feature “smart dates.” You can enter dates
numerically (for instance 04/09/02 or 4/9/2) or you can spell out the date (for instance April 9th, 1997 or Apr 9
97). You can use any character as a separator between numeric dates, for example 4-9-01 or even 4.9.01.

To enter today’s date, simply type today. You can also enter yesterday or tomorrow. Panorama will automat-
ically convert these entries to the correct month, day and year.

If the date is in the current week, you can simply type in the name of the day, for example saturday or tue. To
specify a day in the previous or upcoming weeks add the words last or next, for example next tuesday or last
saturday.

When a date is edited, Panorama normally displays the date in the format mm/dd/yy. However, if you have
set up an output pattern that Panorama understands for data entry, it will use that pattern instead. Patterns
that can be used for data entry include Month dd, yyyy, Mon dd yy, and mm/dd/yyyy.

If you are using an international system and you enter the date as numbers you must use the format dd/mm/
yy. Panorama does not understand the format 7-Aug-1998. (However you may use any delimiter character
you want, for example 7/8/98 or 7-8-98 or even 7.8.98.)

Default Year and Century

When you enter a date, you can leave the year off and let Panorama figure it out for you. Panorama will auto-
matically round the date to the nearest year. For instance, if today’s date is 3/9/02 and you enter the date 4/1
then Panorama will assume you mean 4/1/02. But if you enter 12/1 (or December 1) Panorama will assume
you mean 12/1/01, not 12/1/02, because 12/1/01 is closer to 3/9/02 than 12/1/02 is.

Panorama also rounds dates to the current century. If the current year is 2002 (or even 1992) and you enter the
date 7/2/23 Panorama will assume you mean 7/2/2023. If you want to enter a date more than 50 years from
the current date you must enter the full date, for example 7/2/1923

Date Output Patterns

Output patterns allow you to control the format Panorama uses to display dates. A date output pattern con-
sists of a number of individual components (month, day, year, etc.) that are strung together. For example, the
pattern mm/dd/yy contains three components and will display in the format 3/11/04.

Number Pattern Display

312 § Three hundred twelve

42.29 § dollar~ and ¢¢/100 Forty two dollars and 29/100
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The overall output pattern for a field can be set using the Pattern section of the Field Properties dialog box or
using the Output Pattern column in the design sheet.

If you are using the design sheet to set up the pattern, simply type the pattern into the Output Pattern col-
umn. See “The Design Sheet” on page 212 for more information on opening and using the design sheet.

type pattern here, or…

select from menu

type the pattern into the Output Pattern column
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Date Pattern Components

There are 15 different basic components that can be used as part of a date pattern. A date pattern is built up
by combining these components together with punctuation to build a complete pattern. (See “Common Date
Output Patterns” on page 258 for examples of complete, ready-to-use date patterns.)

Some of these components (qtr, quarter, mon, month, day, and dayofweek) can be either upper or lower
case. The table below shows how a component can be displayed in all lower case, initial caps, or all upper
case.

Component Example Description

yy 02 Year (within century)

yyyy 2002 Year (including century)

qq 2 Quarter (numeric)

qtr 2nd Quarter (abbreviated)

quarter second Quarter (spelled out)

mm 9 Month (numeric)

MM 09 Month (with leading zero)

mon sep Month (abbreviated)

month september Month (spelled out)

ww 46 Week (within year)

dd 5 Day (numeric)

DD 05 Day (with leading zero)

day tue Day Of Week (abbreviated)

dayofweek tuesday Day Of Week (spelled out)

dow 3 Day Of Week (0[sun]-6[sat])

Pattern Display

month september

Month September

MONTH SEPTEMBER

dayofweek friday

DayOfWeek Friday

DAYOFWEEK FRIDAY
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Common Date Output Patterns

A date output pattern is assembled from the basic components listed in the previous section along with any
punctuation or text that is needed between the components. The table below lists several common date pat-
terns.

If you need to include the words qtr, quarter, mon, month, or day in your date, you must quote them so that
they are not treated as components, as shown in several of the examples in the table above. The quote key is
just to the left of the Return key. Be sure to use regular quotes, not smart quotes (" not “ ”).

As shown in several of the examples, you can add the suffix nth to the mm, ww, or dd components, Panorama
automatically adds the correct suffix depending on the number displayed. 

Date Pattern Display

3/9/2002 mm/dd/yy 3/9/02

3/9/2002 MM/DD/YY 03/09/02

3/9/2002 mm-dd-yyyy 3-9-2002

3/9/2002 dd-MON-yy 9-MAR-02

3/9/2002 dd-Month-yy 9-March-02

3/9/2002 Month dd, yyyy March 9, 2002

3/9/2002 Month ddnth, yyyy March 9th, 2002

3/9/2002 DayOfWeek, Month ddnth, yyyy Saturday, March 9th, 2002

3/9/2002 qqqyy 1q02

3/9/2002 Week ww of yyyy Week 11 of 2002

5/23/2002 Quarter "Quarter" yyyy Second Quarter 2002

7/11/2004 Qtr "Qtr" yyyy 3rd Qtr 2004

3/9/2002 "Day" dd, "Month" mm Day 9, Month 3

3/1/2002 ddnth "day of" Month, yyyy 1st day of March, 2002

3/2/2002 ddnth "day of" Month, yyyy 2nd day of March, 2002

3/9/2002 ddnth "day of" Month, yyyy 9th day of March, 2002

3/1/1867 mmnth "month of" yyyy 3rd month of 1867

3/9/1978 wwnth week of yyyy 3rd week of 1978
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Choices

The choices data type is used for storing data that has only a few possible values. Some typical examples of
this type of data are listed below. (Notice that in the case of choices that contain spaces, like US Mail and East-
man Kodak, the space is represented by an underscore, for example US_Mail and Eastman_Kodak.) Of
course you can use the text data type to store this kind of information, but using the choices type can speed
up data entry, reduce keying errors, and reduce storage space.

The choices data type works by keeping a list of the possible choices for each field. In the database Panorama
stores a choice number instead of storing the actual data—for example 1 for yes and 2 for no. The list of
choices is used to decode the number whenever Panorama needs to display or use the data. The number itself
is never visible.

Choice Data Entry (Choice Palette)

The choices data type is treated differently than other data types for data entry. Instead of entering the data
from the keyboard, you pick a selection from a choice palette containing radio buttons for each choice.

If the choice list allows for exceptions, there will also be a box allowing you to type in the exceptions. See
“The Choice Palette” on page 317 for more information on using the choice palette.

In addition to picking from the list of radio buttons, you can also pick an item from the choice palette by typ-
ing in the first few letters of the item. For example, if the choice palette contains the buttons Gold, Silver and
Bronze you can pick Gold by pressing the G key. If two or more buttons start with the same letter, keep typ-
ing until you reach a letter that is different.

Type of Data Typical Choices

Questionnaire Yes No

Video Format VHS DVD

Gasoline Regular Supreme Diesel

Shipping Carrier UPS US_Mail FedEx Airborne DHL

Film ASA Speeds 25 64 100 200 400 800 1000

Film Manufacturers Agfa-Gevaert Eastman_Kodak Fuji_Photo 3M

Credit Terms Net_10 Net_30 COD Pre_Pay

Operating System Windows MacOS Linux

Medals Gold Silver Bronze
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If the choice list has many items, the choice palette may become too large. In that case you may want to turn
off the choice palette and use normal data entry via the keyboard. To suppress the choice palette but continue
using the choices data type, set the Number of Digits column in the design sheet to 1 instead of 0. The data
will still be compressed via the choice list, but you will be able to enter your choice via the keyboard instead
of from the choice palette.

Creating the List of Choices

The list of choices for a field can be set up with the Field Properties dialog or the Design Sheet. In the Field
Properties dialog, simply type in each choice, separated by a space. If a choice contains a space (US Mail),
type an underscore instead (US_Mail). You can type an underscore by pressing Shift-Underscore. (The
Underscore key is just to the right of the 0 key.)

In the design sheet, type the list into the Choices column. (See “The Design Sheet” on page 212 if you are not
familiar with the design sheet.) 

type the list of choices into the Choices column
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Exceptions

You can use the choices data type even if you cannot anticipate all of the possible choices in advance. For
example, you may usually ship via UPS and Federal Express, but occasionally you use a variety of other ship-
pers. In this situation you need to allow exceptions to the choice list. To allow exceptions, type in a line of
underscores at the end of the list.

In the data sheet, this line of underscores will appear as a text entry box where any value may be typed in.
The number of underscores determines the size of the exception box in the choice palette. For a larger box,
add more underscores.

When a value is entered into the database that is not one of the choices in the list, the value is stored as an
exception. Panorama must store the entire value instead of an internal number. As long as the number of
exceptions is small the choices data type is still useful. However, if there are too many exceptions, you should
stick to the normal text and numeric data types. In the worst case, if all the values are exceptions, the data-
base will actually take more memory than it would if you simply stored the data as text.

to allow exceptions, type in a line of underscores

type exceptions in this box
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Generating a List of Choices Automatically

If your database already contains data, Panorama can examine the database and automatically generate a list
of choices for you. Just press the Auto button in the Field Properties dialog.

In the Design Sheet you can use the Automatic Choices command (Special Menu) available in the design
sheet. Select the field (by clicking on the corresponding row in the design sheet), then choose Automatic
Choices from the Special Menu.

Before this command can generate the choice list you must specify an exception threshold.

This value tells Panorama how many times a choice must appear in the database to be included in the choice
list. Any value that appears fewer times than the threshold will become an exception. Any value that appears
that many times or more will be included in the choice list. When you press Ok, Panorama will scan the data-
base and create a choice list containing all the choices that occur the same number or more times than the
number specified by the exception threshold.

How do you decide what value to use for the exception threshold? There is no hard and fast answer. For
larger databases you will probably want to use a larger value. Experiment with different values to see the
effect on the choice list, then choose a value that includes the common choices on the list, while leaving out
the values that only occur occasionally

Updating the Choice List

As a database grows, the choices list may need to change over time. Choices that were once exceptions can
become common, while once popular choices become obsolete. If this occurs, you can update the choice list—
either manually or with the Automatic Choices command.

Using Math Operations with Choices

Sorry, no can do. If you need to perform any kind of math calculations (Total, Average, etc.) you must store
the information using the numeric data type. However, you can Count a choice type field.
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Sorting Choices

Data stored using the choices data type is sorted according to the order of the choice list. Therefore, if you
want the choices to be sorted alphabetically, you must make sure that the choice list is in alphabetical (A-Z)
order. The Automatic Choices command does this for you.

Sometimes you may wish to sort the choices in a different order. For example, Olympic medals should be
sorted in the order Gold, Silver, Bronze instead of alphabetically (Bronze, Gold, Silver). If you need the
choices to sort non-alphabetically simply set up the choice list in the order you want.

Warning: If your choice list is in non-alphabetic order the sort order of exceptions is ambiguous. For example
if the choice list is Gold, Silver, Bronze where does the exception Copper go? The final order is not predict-
able. You should only use a non-alphabetic choice list if there are no exceptions allowed.
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Chapter 7: Data Entry & Editing

Before you can organize, analyze, or report anything, you have to get your data into the computer. Usually
this means using the keyboard to type it in. Panorama has been designed to help make this task fast and
accurate.

Of course, if the information is already stored on a computer, you may be able to access it without re-typing.
Panorama can exchange data with most Macintosh software packages, and with many PC and mainframe
packages as well. See “Importing a Text File” on page 82.

Editing Records

A new database starts out with just one lonely record. Over its lifetime hundreds or even thousands of
records will be added to a typical database. In addition, many records will become obsolete and be deleted.
Both inserting and deleting records are easy tasks with Panorama.

Moving From Record to Record

Unless your database is very small, only a small part of it will be visible at a time. You can shift the data
within the window to work with different parts of the database. To shift the data you either scroll (data sheet)
or flip from page to page (form).

Use the vertical scroll bar to scroll a data sheet to any record in the database. Click on the scroll bar arrows to
move up or down one record at a time. Click in the scroll bar’s gray area to move up or down one window at
a time. Drag the scroll bar thumb to move directly to any position in the database.

down one line

up one line

up one page

down one page

drag up or down
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When you are using a form window, the vertical scroll bar works differently. Instead of scrolling to another
record, the scroll bar shifts the position of the form within the window. This allows you to get at every corner
of a large form even if you are using a small window. To move from record to record, use the First Record,
Previous Record, Next Record, and Last Record tools in the tool palette. The First Record tool brings you to
the very first visible record in the database—the top line of the data sheet. The Last Record tool takes you to
the end of the database—the bottom line of the data sheet. The Previous Record and Next Record tools move
one record at a time. You can also move up or down one record at a time by pressing the Up Arrow or Down
Arrow keys.

If the database has more than two open windows (for example a form and a data sheet), the position of both
windows will always remain synchronized. In other words, if you scroll the data sheet the form will follow
and vice versa.

In addition to manually moving from record to record, you can let Panorama search for the information you
want to look at or modify. The Find/Select command (Search Menu) can use a variety of criteria to locate the
information you need. See “The Find/Select Dialog” on page 336, for more information on this command.

use scroll bars to navigate within the form

previous record

first record

next record

last record
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Moving from Field to Field

Within a data sheet, you can move to another field by clicking anywhere the field’s column (if it is visible) or
by clicking on the horizontal scroll bar. (See “Splitting a Window” on page 145 for information on how to
split a window into two separately scrollable “panes.”)

You can also use the Goto Field dialog (in the Fields menu) to move to a specific field. This is especially use-
ful if the database dozens or hundreds of fields. Initially the dialog displays a list of all of the fields in the
database. To go to a specific field click on it and press the Goto button, or simply double click on the field
name.

You can also search for the field you want. Type in a few letters from the field name in the search area.

The first nine fields listed are numbered from (1) to (9). To go to one of these fields simply press the corre-
sponding numeric key. For example to go to the Country field in the example above you could simply press
co2.

click anywhere in a column to select a field
or use the scroll bar
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Adding a New Record

To add a new record to the end (bottom) of the database, either click on the Add New Record tool or choose
Add New Record from the Edit Menu.

You can also add a new record by tabbing from the end of the bottom line of the data sheet.

Inserting a New Record

When you are working in the data sheet, you can insert a new record either above or below the current
record. (In a form you can only add new records at the end of the database.) To insert a new record after the
current record press the Return key.

before Add New Record after Add New Record

before Return after Return

new blank record

new blank record
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To insert a new record before the current record, click on the Insert Record tool.

Usually new records are completely blank, ready for your input (as shown in the examples above). You can,
however, ask Panorama to automatically fill in one or more cells whenever a new record is created. A field
can default to a fixed value (like yes or no, or taxable, or today’s date), an automatically incrementing num-
ber (1, 2, 3, …), or a copy of the data in a previous record. See “Default Values” on page 296 for more informa-
tion.

Deleting a Record

To delete an entire record, click on the Cut Record tool.

before Insert Record after Insert Record

before Cut Record after Cut Record

new blank record
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If you are using the data sheet, you can also delete a record by pressing the Delete or Backspace key (upper
right hand corner of the keyboard, above Return). Panorama will display an alert asking you to confirm that
you really want to delete the record. (Mac only tip: If you want to skip the alert, hold down the Option key
while you delete the record.)

If you delete a line accidentally, you can use Undo to restore the line. You can also get the line back with the
Paste Record tool.

Tip: A Panorama database must have at least one visible record—it cannot have zero records. If your data-
base has only one record, Panorama will not allow you to delete it.

Deleting Multiple Records

Sometimes you may need to systematically delete large numbers of records. For example, you might need to
delete all invoices previous to 1987 or all students with below passing grades. Instead of deleting these
records one-by-one you can let Panorama do most of the work for you. First use the Find/Select command to
select either the records you want to keep or the records you want to remove. If you selected the records you
want to keep, use the Remove Unselected command to delete everything else. If you selected the records you
want to remove use Remove Selected.

Remember, however, that you cannot delete every record—you must leave at least one record in the database
at all times. See “The Find/Select Dialog” on page 336 and “Permanently Removing Unselected Data” on
page 360 for more information on these commands.

Delete All

To delete all the data in the database, use the Delete All command (see above). This command deletes all the
data, leaving just one blank record. Before it performs this dastardly deed, Panorama asks you to confirm that
you really know what you are doing. Keep in mind that there is no Undo after Delete All. (However, if you
saved a copy of your database, you can Revert to Saved, or you can use Panorama’s Time Lapse feature to
get back the previous data.)

You can use the Delete All command to set up a clone of an existing database. First open the original data-
base, then use Save As to save it under a new name (See “Saving a Database” on page 63). Finally use Delete
All to empty the new database. The new “cloned” database will contain all of the forms, crosstabs and proce-
dures of the original database, but no data.
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Duplicating a Record

In the data sheet you can easily make one or more copies of a record. Use the Copy Record tool to copy the
current line into the clipboard, then use the Paste Record tool to paste the line back into the database. The
Paste Record tool inserts a new line just above the current line and then pastes the contents of the clipboard
into the new line. You can paste the record back into the database as many times as you like. In this illustra-
tion the Paste Record tool has already made six copies of the line, and is about to create a seventh.

The Clipboard Window

If you would like to see the contents of the clipboard use the Show Clipboard command (Edit Menu) to open
the Clipboard window. You can watch the clipboard change each time you cut or copy something. Here’s
what the clipboard looks like as we are copying the records in the example above.

Close the clipboard window when you are finished using it.

Moving a Record

Sometimes you may wish to move a record from one spot to another. You can do this using the data sheet. To
move a record use the Delete or Backspace key or the Cut Record tool to remove the line, then use the Paste
Record tool to insert the line in its new position.
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Editing Data Within a Cell

Data cells are the smallest unit of information handled by Panorama. Each data cell contains a single piece of
information—a person’s name, a phone number, an account balance.

The currently selected cell is called the active cell. Only one cell can be active at a time. You can activate a cell
by clicking on it, or by scrolling to it with the scroll bars. You can also move the active cell with the arrow
keys.

The Input Box

Every data cell has a pop-up Input Box that is used to edit the text within the cell. The Input Box acts like a
temporary window that pops up on top of the data cell for data entry and editing.

typical data cells

active data cell

double click cell to open Input Box for editing contents of cell
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You can open the Input Box by double clicking on the cell, or by making the cell active and starting to type.
Once the Input Box is open, you can edit the text within the cell using the usual mouse editing (word process-
ing) techniques. Specifically, you can click the mouse to select an insertion point, drag the mouse to select a
range of characters, cut, copy or paste selected text using the clipboard, or use the keyboard to type charac-
ters at the insertion point. (If you are not familiar with these techniques you should review the operating sys-
tem documentation that came with your computer.)

When you have finished editing the text within the cell, press the Enter key. This closes the Input Box and
updates the data cell with your changes. The Input Box closes automatically (and updates the data) if you
click on any other data cell or window. Tip: Clicking anywhere outside of the Input Box is the same as press-
ing the Enter key.

If the Input Box is only one line high pressing the Return key will close the Input Box and update the data
cell. If the Input Box is more than one line high the Return key adds a new line to the data cell (see the next
section).

If you would like to close the Input Box without updating the data cell, press Command-Period (Mac) or
Control-Period (Windows). Pressing the Esc key also closes the Input Box without updating the data cell. Or
you can use the Undo command to restore the original text, then press the Enter key.

Expanding the Input Box

One of the most powerful features of the Input Box is that it can be expanded to accommodate large amounts
of data. To expand the Input Box, move the mouse to the lower right corner of the box. When you reach the
corner, the arrow will flip over. In the illustration below, you see the normal arrow cursor as you approach
the corner. The arrow flips over when it reaches the corner of the Input Box. (The arrow doesn’t actually
change color as shown here, the color is simply to make the illustration more clear.)

Once you see the upside down arrow, press the mouse and drag the corner of the box to its new location.

When you release the mouse Panorama will change the size of the box.
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Now you can type additional lines into the Input Box. Press Return to start a new line.

Once you change the size of the Input Box, Panorama remembers the size permanently. In the data sheet, the
Input Box size is remembered separately for each column, while in a form the size is remembered for each
individual data cell object. (Of course Panorama will forget the sizes if you Close or Quit without saving the
database.)

If you make the Input Box more than one inch high, a scroll bar is added on the right hand side of the box.
The scroll bar allows you to enter and edit up to 32,767 characters per data cell.

Tip: The scroll bar is actually outside the Input Box. To change the size of the Input Box you must click in the
bottom corner of the box itself, just to the left of the scroll bar (as shown above). Do not try to drag the corner
of the scroll bar.

Expanding a Right Justified Input Box

If you are editing a right flush data cell, move the mouse to the lower left corner of the box instead of the
lower right hand corner.

Once the mouse is over the lower left hand corner you can expand down and/or to the left.
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Now you can edit the text in the expanded input Box. Press Enter when you are finished.

Editing Cells Within a Form

All of the previous examples have shown editing cells within the data sheet. However, a form may contain
data cells also. Unlike the data sheet, the cells on a form may be arranged any way you like. They can also be
more than one line high.

Just as in the data sheet, you double click on a cell to edit it.
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You can also move the mouse over the corner of the cell and drag to expand the Input Box.

See “Working with Data Cell Objects” on page 635 to learn how to create a form with data cells.

As an alternative to data cells, a form may be designed with Text Editor SuperObjects. Text Editor SuperOb-
jects allow you to edit text right in the form window—no double click is required. You can simply click or
drag on the text to begin editing. Press Enter when you are finished. The illustration below shows the effect
of double clicking on the word Harmony. As you can see, instead of opening an Input Box this selects the
word for editing.

Since the Text Editor SuperObject doesn’t use an Input Box, you cannot expand the size of the editing area
“on-the-fly” the same way you can with data cells. The editing area must be defined in advance. On the other
hand, the Text Editor SuperObject doesn’t require the extra double click, and works more like other standard
applications you may be used to. See “Text Editor SuperObject” on page 639 to learn how to create a form
with Text Editor SuperObjects. 

Tabbing from Cell to Cell

To make it easier to enter several cells in a row, Panorama allows you to use the Tab key to move from cell to
cell as you enter data. In the data sheet you normally move from left to right, in a form from top to bottom. If
you want to move backwards press Shift-Tab.
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Tab Down

In the data sheet the Tab key normally moves from left to right. Sometimes it may be more convenient to key
a column from top to bottom instead of across a row from left to right. For instance, you may find it easier to
key in a dozen names, then a dozen addresses, then a dozen cities, instead of keying in each record sepa-
rately.

Click on the Tab Down tool to change the tab direction from across to down. Click the tool again to change
back to normal tab operation. Panorama indicates that tab down is active by changing the arrow direction in
the Tab Down tool.

Tab down can also be used in forms when the view-as-list option is enabled. See “View-As-List Forms” on
page 899 for more information on the view-as-list option.

Tab Order in Forms

Panorama has three tab order options for forms—data sheet order, back to front order, and natural order.
Use the Form Preferences command (Setup Menu) to specify the tab order option you want to use. (The form
must be in graphic design mode. See “Form Modes: Data Access vs. Graphic Design” on page 485 if you are
not already familiar with using graphic design mode.)

Data sheet order is exactly that—the Tab key moves from cell to cell in the same order as it would in the data
sheet. However, data sheet order will not work if your form contains one or more variables in addition to
fields to be edited (See “Text Editor Options” on page 643).

tab across

tab down
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Natural order causes the Tab key to move from left to right, then from top to bottom.

This usually works well (and is the default option), but in some cases isn’t really what you want. This is espe-
cially true in forms with side by side columns of data.

To fix this you can alter the natural order by grouping data cells together–the Tab key will move through all
the cells in the group of objects (in natural order) before it moves to the next cell. In this case the data cells
need to be brought together into two groups using the Group command (see “Grouping Objects Together”
on page 536 for more information on grouping graphic objects.)

group  1 group  2
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Now that the cells have been grouped together the tab order will tab through all of the cells in the left hand
column before moving to the right hand column.

Back to Front order gives you the most control, but also takes the most work to set up. When this option is
enabled the tab order depends on the back to front layering of the data cell objects in the graphic design
mode. Use Send to Back to bring a data cell to the start of the tab order, and Bring to Front to send it to the
end of the tab order. See “Changing the Stacking Order” on page 569 for more information on these com-
mands.

For example, suppose your form contained three fields A, B, and C and you wanted to tab from field to field
in the order B › A › C. To set up this order click on field B and use Bring to Front (the form must be in graphic
design mode). Then click on field A and use Bring to Front. Finally click on field C and use Bring to Front.

Tabbing with the Space Bar

Using the Tab key is a great timesaver when entering lots of data, but it sure is tough on your left pinky. You
can use Panorama’s Space Bar Tab option to give your pinky a rest. When you are using this option, pressing
the Space Bar bar once or twice tells Panorama to skip to the next cell, just like the Tab key.

The Space Bar Tab option can be configured separately for each field in the database. If a field never contains
a space (for example state, zip code, or price) you can use the 1 Space option. This option makes pressing the
Space Bar skip to the next cell.

If a field sometimes contains blanks (for example name, address, or description) you can use the 2 Space
option. When this option is active, you can press the Space Bar twice in a row to skip to the next cell. (This
option does not usually work well with Clairvoyance.)
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To set up the Space Bar Tab option, use the Field Properties Data Entry Options sub-dialog (open the Field
Properties dialog and press the Data Entry button).

You can also set up the Space Bar Tab option with the Tabs column in the design sheet. (See “The Design
Sheet” on page 212 if you are not familiar with the design sheet.)

The Space Bar Tab option may not sound very exciting on paper. You may wonder if it is worth the bother.
This option really does make it easier to enter lots of data without cramping your fingers, especially the left
pinky. Give it a shot!
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Data Entry Accelerators

Data entry is probably the most tedious task you’ll face while using your computer. Let’s face it, no one
enjoys keying in data. The best way is to get someone else to do it! But since that usually isn’t possible, Pan-
orama includes a number of features that help accelerate data entry. You don’t have to use any of these fea-
tures, but when you do, you’ll find that ugly data entry tasks are finished faster and more accurately.

Automatic Capitalization

Panorama has four options for automatic capitalization: off, all, word, and sentence. You can set up automatic
capitalization with the Field Properties dialog or with the Caps column in the design sheet.

The All option tells Panorama to capitalize every letter entered into the field. Use this option for fields con-
taining abbreviations—CA, NY, etc.

The Word option tells Panorama to capitalize the first letter of each word. Use this option for fields contain-
ing names, addresses, etc.

Sometimes you may need to override Panorama’s automatic word capitalization. If you need an extra capital
letter simply press the Shift key (for instance McDonald). If you want the first letter of a word to be lower
case type the letter twice (Bank Oof America), then delete the upper case letter (Bank of America).

The Sentence option tells Panorama to capitalize the first letter of each sentence. Use this option for fields
containing paragraphs of text—for instance catalog descriptions or correspondence.



Page 282 Panorama Handbook
Changing Capitalization of Existing Data

Automatic capitalization only applies to new data as it is typed into the database. It does not change data that
has already been entered. It also does not automatically capitalize imported data or data pasted into the data-
base. If you want to change the capitalization of existing data, you must use the Manipulate Data dialog.
This is best explained with an example. Suppose you wanted to convert the last names in the database below
to all upper case. Start by clicking anywhere in the Last column.

Now choose Manipulate Data in Field from the Fields Menu.

Click the + button (on the right) to add another row to the dialog, then choose Modify Capitalization from
the pop-up menu.

start by pressing +
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Now choose the type of capitalization you want.

When you press the Apply button, the field will be converted to all upper case.

See “The Manipulate Data Dialog” on page 434 for further details about the Manipulate Data in Field dialog.

Checking for Duplicate Data

Panorama usually does not care if you enter duplicate information into a database. However, if you wish you
can ask Panorama to check for duplicate data every time you enter or edit a data cell in a given field.

Panorama has three options for checking duplicate data—Yes, No Duplicates and No Unique. You can set up
duplicate checking with the Field Properties dialog or with the Dups column in the design sheet.

The Yes option simply tells Panorama to allow duplicates. This is the default.
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Use the No Duplicates option to make sure that a value is not entered more than once. For instance, a check-
book database should never have duplicate check numbers.

The No Unique option tells Panorama to warn you if you attempt to enter a value that is not already in the
database. For instance if a field contains only Yes/No values, this option would warn you if you attempted to
enter True or False.

When Panorama encounters a duplicate or unique value (depending on the option), it warns you. However,
it does not prevent you from entering the value. You are given the option of entering the data even though it
conflicts with the existing data—it’s up to you.

Checking for Duplicates in Existing Data

Checking for duplicates only happens when new data is typed into the database. Panorama does not check
data that has already been entered, and it does not check data that is imported or pasted into the database.

There are several techniques for checking for duplicates in existing data. See “Select Duplicates” on page 362
to learn how to use the Select Duplicates command. Another method is to sort the data and then use the
UnPropagate command to identify the duplicates (by searching for blank cells). See “Using UnPropagate to
Eliminate Duplicates” on page 470 for details on the UnPropagate command and this technique.

Clairvoyance®

Many databases contain fields where the same information is repeated over and over. For instance, a check-
book will contain the same bills month after month—rent, phone, utilities, charge cards. Another example is
an inventory database that contains many items from each vendor, with the vendor name repeated over and
over. Panorama’s Clairvoyance feature anticipates when you are about to enter data that has been entered
before, and completes the entry for you. This can save you a lot of typing, and helps improve consistency as
well.

How Clairvoyance® Works

How can Panorama anticipate what you are about to type? The secret lies in Panorama’s ability to scan the
database in a fraction of a second. When you are using Clairvoyance, Panorama scans the entire database
each time you enter a character. As it scans the database, it checks the characters you have typed against the
data already in the database. When there is only one possible match, Clairvoyance guesses that you are about
to repeat yourself and completes the word or phrase for you.

type   n

e
w
p
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Of course, Clairvoyance can only be helpful when you are repeating a word or phrase that is already in the
database. If you are entering a new word or phrase, Clairvoyance cannot help you—but it won’t get in your
way, either. As you type in a new word or phrase Clairvoyance may guess that you are entering an old word
or phrase. Just keep typing, and Clairvoyance will automatically erase its guess when it no longer matches
what you have typed.

Turning Clairvoyance® On or Off

Clairvoyance can be turned on or off with the Field Properties dialog box (Fields Menu) or with the
Clairvoyance column in the design sheet.

Clairvoyance® Helps Insure Data Consistency

One problem when building large databases is making sure that information always gets entered the same
way, especially when more than one person is keying in the data. For example, a single company could be
entered in your inventory database many ways—

Fuji
Fuji, Inc
Fuji USA
Fuji Photo, Inc
Fuji Photo Film USA
Fuji USA, Inc.

type   n

e

w

p

o

r

t

space

n

e

w

s



Page 286 Panorama Handbook
Clairvoyance helps solve this problem by accurately repeating the information time after time. You may find
that Clairvoyance’s ability to insure data consistency is more important than the keystroke savings.

Using Clairvoyance® With Dates

We do not recommend using Clairvoyance with date fields. Although Clairvoyance will work with dates, it is
not very useful since dates only contain up to six characters anyway. Using Clairvoyance with a date field can
be annoying, because scanning a date field takes much longer than for regular text fields. This can make the
data entry seem somewhat sluggish.

Clairvoyance® Across Multiple Files

Clairvoyance normally works only with the data you have already typed into the current database. But if you
have already typed this information into another database, you can specify that Clairvoyance should be
linked to that database instead of the current one. For example, you could link an invoice with your price list,
allowing you to type in only a few letters to bring up a product description. This is called linking clairvoy-
ance to another field.

There are two reasons for linking clairvoyance to another field. Clairvoyance cannot anticipate values until
they have been typed in at least once. If all the possible values have already been entered into another data-
base, Clairvoyance can start working immediately by looking into the other database.

Another advantage is speed. If your price list contains 200 records and your invoice database contains 2000
records, Clairvoyance can scan the price list 10 times faster. As your database gets larger, this speed difference
may become noticeable.

To illustrate setting up a clairvoyance link to another field we’ll use the invoice and catalog databases shown
below. We’ll link the Item field in the Catalog database to the Description field in the Invoices database.
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To set up the link open the Invoices design sheet. Click on the name of the field you want to set up, in this
case Description1.

Once the field is selected choose Set Up Link from the Special menu, which opens the dialog shown below.
On the left hand side of the dialog is a list of open databases. Select the database containing the field you
want to link to, in this case Catalog. Once the database is selected a list of fields in that database appears on
the right. Select the field you want to link to, in this case Item.
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Once the database and field are selected press OK to enter the link into the design sheet. You can see the new
link definition in the Link column.

As you can see the link definition is simply the name of the database followed by a colon (:) followed by the
field name. You can type in a link definition manually if you want instead of using the Set Up Link dialog.

In this example Description1 is a line item field (see “Repeating Fields (Line Items)” on page 222) you will
probably want to set up the same link for all of the other line items (Description2, Description3, etc.). The
easy way to do this is to simply double click on the Link cell, like this.

When you press Enter Panorama will ask you if you want to copy this data to all of the other line items (see
“Modifying Line Item Fields” on page 225).
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Press Yes and Panorama will make the changes.

Like all other design sheet options, the link does not actually take effect until you tell Panorama to create a
new generation (see “Database “Generations”” on page 212).

When you are editing data within a field that has a clairvoyance link set up, Clairvoyance checks the charac-
ters you type against the data in the second database. When it finds a possible match, it enters the rest of the
value for you.

In this example Clairvoyance has been linked to a field in another database. However you can also link Clair-
voyance to a field in the same database.
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Clairrows

When you hold down the Command key (Mac) or Control key (Windows), the up and down arrows on the
keyboard become clairvoyant arrows, or “clairrows.” With the key held down you can use the arrows to scan
through the values that are already in the database. Each time you press Command/Control-Down Arrow
the next value appears, while each time you press Command/Control-Up Arrow the previous value appears.
You can scan through the values until you find the information you are looking for, then press the Enter key
to enter the value.

To give the clairrows a head start you can type in the first few letters of the information you are looking for.
For example, suppose that you are looking through a travel database for a particular Best Western Hotel.
Start by typing Best, then press Command/Control-Down Arrow. The first hotel with a name beginning with
Best will appear. Each time you press Command/Control-Down Arrow the name of next hotel (alphabeti-
cally) will appear—for example Best Western Aspenalt Lodge, Best Western Bar X Motel, Best Western Boul-
der Inn, etc. Press Command/Control-Up Arrow to move backwards through the hotel names. Continue
until the hotel you are looking for appears, then press Enter.

This technique also works when Clairvoyance has been linked to a field in another database (see “Clairvoy-
ance® Across Multiple Files” on page 286).
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Input Patterns

Sometimes you may wish to force the data being entered into a specific pattern. For instance in the United
States and Canada long distance phone numbers almost always use the pattern (999) 999-9999. Panorama’s
Input Pattern can take care of entering the pattern for you. Once the pattern is set up, you only type the
actual data (in this case the digits of the phone number). Panorama combines the data you enter with the pat-
tern to produce the actual data. For example, combining the input pattern (_ _ _)   _ _ _-_ _ _ _
with 3124562468 produces the data (312) 456-2468. 

An input pattern consists of a string of characters with an underscore in each spot where actual data will be
entered. The input pattern is just like fill in the blanks, but instead of filling in the blanks you fill in the under-
scores. (Press Shift-Dash to enter the underscore character. The dash key is in the top row of the keyboard,
just to the right of the 0 key.) The table below lists some common input patterns.

You can set up the input pattern with the Field Properties dialog.

Type of Data Input Pattern Example

Phone Number (_ _ _)  _ _ _-_ _ _ (312) 456-2469

Social Security Number _ _ _ - _ _ - _ _ _ _ 234-54-5476

License Plate _ _ _   _ _ _ AGB 287

Date _ _ / _ _ / _ _ 03/24/05

Time _ _ : _ _ : _ _  _ _ 11:24:36 PM

Choose from a pop-up menu of common input patterns, or…

type the input pattern into the box
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You can also set up the pattern with the Input Pattern column of the design sheet. (See “The Design Sheet” on
page 212 if you are not already familiar with using the design sheet.)

Tip: Input patterns should not be used with numeric fields. If you want to add a pattern to a numeric value,
you should use an output pattern (See “Numeric Output Patterns” on page 250).

Entering Data with an Input Pattern

This illustration shows an example of entering a phone number with an input pattern.

The input pattern is only active when you are adding new characters at the end of the text. It does not adjust
the data when you are inserting text in the middle of the cell. For example, it does not prevent you from cre-
ating a four digit area code, like this:

Using Input Patterns with Dates

The purpose of input patterns is to save keystrokes in data entry by inserting constantly occurring dashes,
colons, parentheses, or other punctuation. When it comes to date fields, you must decide how you like to
enter dates. Using the input pattern _ _ /_ _ /_ _ removes the need to type /’s (or some other separator)
between the month, day and year. However, using the pattern requires that you type leading zeros in front of
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single digit months and days. For instance, to enter January 1st you must type 0101. Without the pattern you
can enter a single digit, for example 1/1. (Keep in mind that Panorama allows any non-numeric character as
the separator, so you could also type 1.1 on a numeric keypad—very fast.) It’s up to you which method you
prefer.

One other point to keep in mind—the input pattern can interfere with Panorama’s Smart Date feature
(“Entering Dates” on page 255). For example, with a pattern if you attempt to enter yesterday you will get
ye/st/erday, and if you enter tuesday you will get tu/es/day. You can go back and edit out the /’s, but if you
are going to use Smart Dates frequently you might want to forego the input pattern.

An input pattern can be used to override Panorama’s century rounding feature. If you want to enter all dates
in the 20th century you can use the pattern _ _ /_ _ /19_ _ . If you are using this pattern then Panorama will
treat 030423 as 3/4/1923, not 3/4/2023. (Remember, Panorama normally rounds the year to the nearest cen-
tury (within 50 years) if you do not specify all four digits of the year.)

Restricting Character Types

Panorama normally allows you to enter any character that can be typed from the keyboard. If necessary you
can restrict the kinds of characters that can be entered into each field. Panorama has five different character
restriction levels—Any, Alphabetic, Numeric, AlphaNumeric, and Custom.

You can choose basic character entry restrictions with the pop-up menu in Field Properties dialog.
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If you choose the Other… option an advanced dialog opens. Simply check the all of the character sets you
want to allow, then close the window.

You can also set up the character range with the Range column of the design sheet. (See “The Design Sheet”
on page 212 if you are not already familiar with using the design sheet.)

The Any “restriction” really isn’t a restriction at all—it allows any kind of text—letters, numbers, spaces, or
punctuation. Panorama lets you type in anything you want with no restrictions. This is the default option.

The Alphabetic restriction allows only letters (A-Z and a-z) and spaces. The letters may be either upper or
lower case. If you attempt to type in a non-alphabetic character (a number, for example) Panorama will beep
and ignore the character.

The Numeric restriction allows only digits (0…9), periods, minus sign, and the letter E (for scientific nota-
tion).

The AlphaNumeric restriction allows both letters and numbers, as well as spaces.
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Custom Character Restrictions

The Custom option allows you to exactly specify the characters you want to allow and disallow in this field.
The actual characters allowed are defined by one or more pairs of characters. Each pair specifies a range of
characters that are allowed. For example the pair 09 would allow all characters in the range 0…9, while the
pair az would allow all lower case letters. You can combine several pairs to create a more complex range, for
example az09 for all lower case letters or numbers. A pair may specify a single character as both the begin-
ning and end of the range, for instance %% (only the percent symbol allowed), or 09%% (numerals and the
percent symbol, but not the decimal point). If you wish to allow spaces, one of the pairs should be a pair of
spaces, for instance AZ  az09. To preview the effect of a character range you can use the ASCII Chart wizard
— see “Showing Character Ranges with the ASCII Wizard” on page 91 of Formulas & Programming.

The table below shows some common examples of custom character restrictions. For each range a sample of
Ok data and bad data is shown, with the disallowed characters shown in red.

If you are using the Field Properties dialog, you can set up a custom restriction by typing the custom range
directly into the dialog.

When you press the OK button Panorama will convert the list into a series of character ranges as described in
the previous section. If you want to see what the custom range you have created looks like, open the design
sheet.

Custom Range Ok Data Bad Data Comments

09 936 923.77 Only digits, no decimal point, spaces or 
other punctuation allowed.

09.. 156.23 1,294.48 Basic fixed point numbers

09..%% 67.82% 67.82  % Percentages (no spaces)

09// 5/23/02 March 1st Numeric format dates

09:: 1:24:83 1:24 PM Time

09  ::AAaaMMmmPPpp 5:32 PM 5:32 DL Time (am/pm)

AZ SEATTLE Seattle Upper case letters only—no punctuation or 
lower case letters

Azaz John John Smith Letters but no spaces

AZaz@@.. sue@my.net sue$my.net Handy for email addresses

09  (())-- (213) 444-1234 342-3982 ext 12 Basic US phone numbers

!~ Check# El Niño Everything ok except spaces, international 
characters and special symbols

!Ù Niño El Niño Everything ok except spaces
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Default Values

When a new record is added to a database, it is usually completely empty. You can, however, set up a default
value for each field. One way to set up default values is with the Field Properties dialog. The dialog below is
for a State field which defaults to CA (California).

You can also set up the default with the Value column of the design sheet. (See “The Design Sheet” on
page 212 if you are not already familiar with using the design sheet.)
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The simplest default is a fixed value, as shown in the example above. For example you might want the Coun-
try field to default to your home country, a shipping field to default to your preferred shipper. Once defaults
are set up, they are automatically entered whenever a new record is created.

Default to Today’s Date

To default to today’s date use the default value today.

If you are using the Field Properties dialog, you can choose Today from the pop-up menu (or you can just
type in today).

new record with default values
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Note: The today default only works for fields that use the date data type. If you use the default value today
with a text field you will simply get the word today. See “Dates” on page 255 for more information on the
date data type.

“Ditto” Defaults Based on the Previous Record

Instead of being fixed, a default value can be based on the data in the previous record. You can produce this
type of “ditto” default by using the default value ". This is the quote character, which is produced by holding
down the Shift key and pressing the " key (just to the right of the semicolon key). (Some people mistakenly
call this the double-quote character.)

When you create a new record, the fields using the ditto default will contain the same values as the previous
record. In this illustration a new record has been added with four default values, two fixed and two “ditto.”

“ditto” defaults for City and Zip

fixed defaults for State and Country
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Automatically Incrementing Defaults (1, 2, 3, …) Based on the Previous Record

For a numeric field you can specify a default that is created by adding to the previous value in the field. To do
this, use a default of +nn, where nn is the amount to add to the previous value. For example +1 causes the
value to increment by one for each new record.

You can use any number, even a negative number like +-5. This default would cause Panorama to add nega-
tive 5 (same as subtracting 5) to the value each time a new record is created. If the numeric type allows it, you
can even use non-integer values like 2.5 or 0.1.

As new records are added to the database, they are numbered automatically, like this.

automatically incrementing check numbers

this field set up to default to today’s date
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Be sure to keep in mind that an incrementing default like +1 is based on the previous record, not on the larg-
est value in the entire database. So if you insert a record in the middle of the database, the incremented value
will be based on the value just above it, not on the value at the end of the database.

If you want to generate a unique incrementing number for use as a record ID (for instance an invoice number
or check number), use the technique described in the next section.

Creating a Unique Record Number

Many databases applications require that each record contain a unique number that can be used to identify
the record. Common examples include invoice numbers, batch ID's, employee numbers, etc. Panorama can
automatically assign a unique number to each new record as it is created, even if several people are using the
database simultaneously over a network.

The field containing the record number must be a numeric field. To specify that this field should contain a
unique record number, the default should be + . Do not specify any increment value, just use a single + char-
acter.

Each database contains a counter for keeping track of the next record number. Every time a new record is cre-
ated the counter is incremented by one. Even if the record is later deleted, the number will never be re-used
(unless you Quit Panorama or close the database without saving your changes, or unless you reset the
counter manually as described below).

records inserted in the middle have incorrect numbers
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Manually Changing the Record Number Counter

You can manually change the record number counter using the Privileges dialog. (See “The Privilege Dialog”
on page 184 if you don’t know how to open this dialog.) Simply type in any integer value for the Next Record
ID# option.

It is also possible to access and modify this ID number in a procedure. (See “GETAUTONUMBER” on
page 5290 and “SETAUTONUMBER” on page 5738 of the Panorama Reference.) To access the next record ID #
use the GetAutoNumber statement. Here is a simple procedure that displays the next record ID number.

local id
GetAutoNumber id
message "The next record number will be "+str(id)+"."

This one line procedure uses the SetAutoNumber statement to reset the record ID number to 1000.

SetAutoNumber 1000

Automatic Time/Date Stamping

Using the design sheet you can designate a field as a time stamp field. Once a field has been designated as a
time stamp field, Panorama will automatically copy the current date and time into this field every time any
other field in the record is modified. Setting up a time stamp field allows you to reliably track when each
record in the database was last modified.
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To set up a time stamp field you must have the design sheet open. Choose the Time Stamp Field command
from the Special menu, then use the pop-up menu to select the field that will become the time stamp field.
This field must be an integer (numeric 0 digits) field and it must already exist in the data sheet. (Just adding a
new field to the design sheet isn’t enough to make it appear in the Time Stamp dialog’s pop-up menu. You
must also make a new generation.)

Once the time stamp field is set up, Panorama will automatically update the time and date every time any
cell in that database is modified. The value stored in the cell is actually the number of seconds since midnight,
January 1, 1904. This combination of date and time into a single number is called a SuperDate. See “Super-
Dates (combined date and time)” on page 118 of Formulas & Programming for more information about Super-
Dates.

As you can see, it’s pretty difficult to look at a SuperDate and make much sense of it. Fortunately, you can
convert a SuperDate into a regular Panorama date with the regulardate( function, and into a regular time
(seconds since midnight) with the regulartime( function. Here is a formula that converts a SuperDate in
the field LastModified into a readable date and time.

datepattern(regulardate(LastModified),"mm/dd/yy")+" @ "+
timepattern(regulartime(LastModified),"hh:mm:ss am/pm")

time stamp field must be Numeric 0 Digits
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This formula may be used in an auto-wrap text object (see “Displaying Formulas in Auto-Wrap Text” on
page 602) or Text Display SuperObject (see “Text Display SuperObjects™” on page 608) to display the modi-
fication date in a format like this: 11/27/03 @ 4:37:22 PM.

Automatic Calculations

The Equation column in the design sheet allows you to set up a formula for calculating the value of a field
based on the values in other fields (see “The Design Sheet” on page 212 if you are not already familiar with
using the design sheet).

In the following sections you’ll learn how to perform calculations within the current record as data is entered.
To learn how to calculate an entire column of data at once see “The Manipulate Data Dialog” on page 434 and
“Storing Formula Results in the Database” on page 22 of Formulas & Programming. To learn how to display
the result of a calculation without storing it in the database see “Displaying Formulas in Auto-Wrap Text” on
page 602, “Text Display SuperObjects™” on page 608 and “Displaying/Printing A Formula” on page 20 of
Formulas & Programming.

Spreadsheet Mode Calculations

If you’ve ever used a spreadsheet you’ll be very comfortable with Panorama’s default Spreadsheet Mode for
automatic calculations (see “Procedure Mode Calculations” on page 311 for an alternative calculation mode).
In this mode you simply place the formula for calculating a field into the Equation column of the design sheet
for that field. To illustrate this we’ll use this simple database with four numeric fields for data entry (A, B, C
and D) and two fields that we will be calculated (Total and Avg).

To automatically calculate the total and average simply enter the formulas in the appropriate rows of the
Equation column in the design sheet.

formula to calculate total
formula to calculate average
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To activate these formulas you need to create a new generation for this database (see “Database “Genera-
tions”” on page 212). Once you’ve done this you can start entering or updating information. In this illustra-
tion a new record has been added (Diamond Bar) and the first number typed in (but not entered into the
database yet).

As soon as the data is entered by pressing the Tab (or Enter) keys the formulas update the Total and Avg
fields.

As more data is entered the Total and Avg fields are updated instantaneously.

The Total and Avg fields will be updated any time the A, B, C or D fields are modified.

formulas in design sheet update fields as data is entered
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You can also edit the formula with the Field Properties dialog. The dialog shows a preview of the formula
result.

Click on the yellow eye to open a dialog that can assist with assembling a formula.

This dialog works just like the Manipulate Data in Field dialog, see “The Manipulate Data Dialog” on
page 434.
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Next we’ll look at a simple invoice that shows some more realistic examples of automatic calculations in
action. Here are the calculations needed as data is entered.

This table explains each of these formulas. Several of these formulas reference line item fields using the Ω
character, see “Line Item Fields” on page 52 to learn how these fields can be used in a formula.

Formula Explanation

city(Zip)

Using Panorama’s optional zip code lookup database (see “Zip 
Code Lookup” on page 145 of Formulas & Programming) this for-
mula looks up the name of the city when the zip code is entered. 
For example, if 92548 is entered this formula will calculate that 
the city name is Huntington Beach.

state(Zip)

Using Panorama’s optional zip code lookup database (see “Zip 
Code Lookup” on page 145 of Formulas & Programming) this for-
mula looks up the name of the state when the zip code is 
entered. For example, if 92548 is entered this formula will calcu-
late that the state is CA.

city(Zip) state(Zip)

zeroblank(lookup("Catalog",Item,DescriptionΩ,PriceΩ,0))

zeroblank(QuantityΩ*PriceΩ)

Total1+Total2+Total3+  ... +Total13+Total14+Total15

Subtotal*0.05

Subtotal+Tax
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zeroblank(lookup("Catalog",Item,
Description

 

Ω

 

,Price,0)

 

When an item is entered this formula looks up the price from a 
catalog database (see “Linking With Another Database” on 
page 131 of 

 

Formulas & Programming

 

). Here’s what the catalog 
database, which must be open, looks like.

Panorama’s Clairvoyance Link option has been used to help 
make sure that the Description always matches an item in the 
catalog database. See “Clairvoyance® Across Multiple Files” on 
page 286 to learn how to set up this option.

 

zeroblank(Quantity

 

Ω

 

*Price

 

Ω

 

)

 This formula calculates the total for a each line item row (see 
“Line Item Fields” on page 52). The zeroblank( function (also 
used in the previous formula) suppresses zero values to make 
sure that the empty items really look empty (see “ZERO-
BLANK(” on page 5915) of the 

 

Panorama Reference

 

.

 

Total1+Total2+Total3+ ...
Total13+Total14+Total15

 

This formula calculates the sum of all the line item totals. The 
sum( function (see “Adding Line Item Fields” on page 62) can-
not be used because it is not compatible with Spreadsheet 
Mode. If this calculation is being performed in Procedure Mode 
(see “Procedure Mode Calculations” on page 311) this formula 
can be replaced with the much simpler formula sum("Total

 

Ω

 

").

 

Suttotal*0.05

 

This formula calculates the sales tax at 5%. To calculate the sales 
tax for a non-integer rate (for example 7.75%) using 2 digit 
numeric fields the formula must be rewritten as (Subto-
tal*7.75)/100 to avoid numeric overflow problems (see “Over-
flow/Underflow Problems” on page 61 of 

 

Formulas & 
Programming

 

). If you are using floating point fields the formula 
can simply be Subtotal*0.0775.

 

Subtotal+Tax

 

This formula calculates the grand total.

Formula Explanation
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Each of these formulas must be set up in the Equation column of the design sheet. The Price and Total line
item formulas only need to be entered once. Panorama will automatically copy them to the other line item
fields (see “Modifying Line Item Fields” on page 225).

Once the formulas have been typed in you need to create a new generation for this database (see “Database
“Generations”” on page 212). Once you’ve done this you can start entering or updating information. For
example you can enter the zip code 95689.
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If the optional Zip Code dictionary is installed the formula will “calculate” the city and state. Yes, there really
is a place named Volcano, California.

When you enter a quantity Panorama calculates the line item total. Since the price hasn’t been entered yet, the
total is zero, which is suppressed by the 

 

zeroblank(

 

 function (see “ZEROBLANK(” on page 5915 of the

 

Panorama Reference

 

).

When a description is entered Panorama kicks into high gear. The automatic calculations look up the price
from the catalog database, multiply the price by the quantity for the line item total, calculate the subtotal, the
tax, and the grand total.
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One potential problem appears if a calculation is “circular,” in other words, if the result of the calculation is
part of the calculation itself. In this database the formula for calculating the Price field actually contains the
Price field.

 

zeroblank(lookup("Catalog",Item,Description

 

Ω

 

,Price,Price

 

Ω

 

,0)

 

If you attempt to edit a price, this will trigger the calculation, which modifies the price. Let’s suppose you
decide to give the customer a 50 cent discount on their flat car.

When you press the 

 

Enter

 

 key Panorama performs the calculations. But in this case part of the calculation is
to look up the price from the catalog database. This resets the price back to $4.25.

The solution is to edit the description so that it no longer matches any entry in the catalog database. In this
case we’ve added the word (Discount) after the item name. Once the description has been modified you can
go ahead and mark down the price.

For another solution to this “circular” calculation problem see the next section.
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Procedure Mode Calculations

 

An alternate mode for performing calculations is called Procedure Mode. In this mode little “mini-proce-
dures” are triggered when data is entered into a cell. Each mini-procedure can contain one or more assign-
ment statements (see “Assignment Statements” on page 243 of Formulas & Programming). A mini-procedure
can also trigger a real procedure (see “Automatically Triggering a Procedure” on page 314). (Note: Procedure
mode calculations can only be set up with the design sheet, not with the Field Properties dialog).

To use procedure mode you must turn it on. This is done with the Special menu in the design sheet.

Note: New databases default to Spreadsheet Mode. However, if a database was created with Panorama 2.1
or earlier it will default to Procedure Mode for compatibility with these earlier versions of Panorama. Either
way you can easily switch back and forth between the modes using the Special menu. However, you will
have to re-create any formulas in the Equation column when you make the switch.

When procedure mode is used the assignment statements go along with the field(s) where the data entry is
done, not where the answer is placed. This usually means that you’ll have to repeat the assignment state-
ments to place them in each column where the data is entered. Use the Copy and Paste commands to dupli-
cate the assignment statements into each field.

when data is entered in this field these assignment statements are triggered

no formulas in the fields where the results are stored
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Once these assignment statements are entered and the new generation has been created (see “Database “Gen-
erations”” on page 212) the automatic calculations will be performed when data entry is performed, just as it
was when Spreadsheet Mode was used.

data entered here

assignment statements calculate these values
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Here is the design sheet for a revised version of our simple invoice example. This version is designed to use
Procedure Mode calculations. We’ve opened the Equation cell for Description3 so that you can see all five
assignment statements that are performed when data is triggered in this field. As you can see these are basi-
cally the same formulas that we used in Spreadsheet Mode, but re-arranged into a single cell. In addition, we
also used the sum( function (see “SUM(” on page 5816 of the Panorama Reference), which works just fine in
Procedure Mode.
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Using Procedure Mode gives you precise control over what calculations are performed. In this example that
means that an item’s price can be modified without Panorama trying to re-lookup the price from the catalog
database (as it did in the previous section in Spreadsheet Mode).

As you can see we have been able to discount the price without having to modify the description. This pre-
cise control over exactly what calculations are performed is one of the advantages of Procedure Mode, and
sometimes makes it worth the extra effort.

Automatically Triggering a Procedure

When Procedure Mode is used data entry can trigger a real procedure in addition to performing calculations.
To trigger a procedure simply enter the name of the procedure in the Equation column of the design sheet
(the procedure name may not contain any spaces). If the procedure name is combined with any assignment
statements the procedure name must come last. Here is an example that triggers the .PaymentDialog proce-
dure whenever the Payment Method field is edited.
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This procedure makes a dialog appear whenever the Payment Method field is modified (in this case by click-
ing on radio buttons). The exact dialog that appears depends on which radio button was clicked.

If you are using Spreadsheet Mode there is no way to trigger a procedure from the design sheet. However,
you can still create a .ModifyRecord procedure that will be triggered whenever any field is modified. See
“.ModifyRecord” on page 383 of Formulas & Programming to learn more about this special procedure.

Pros and Cons of Spreadsheet vs. Procedure Mode

How do you decide which mode to use? The table below summarizes the advantages of each mode.

For most applications Spreadsheet Mode works fine and is easier to use.

Spreadsheet
Mode

Procedure
Mode

• Easier to use (less typing)

• Easier to modify

• Less chance of errors

• More familiar to spreadsheet users

• Can be set up with Field Properties dialog

• More precise control

• Can trigger a procedure

• Works with sum( function

• Slightly faster execution
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The Run Automatic Calculations Wizard

When you set up an automatic calculation that calculation is automatically applied when new data is entered
or existing data is modified. The calculation is not applied to any existing data. One way to apply a calcula-
tion to existing data is to use the Formula Fill command in the Math menu (see “Propagate” on page 466).
Another method is to use the Run Automatic Calculations wizard. This wizard will perform calculations
based on the formulas you have entered into the design sheet (see “Automatic Calculations” on page 303).
For example, consider this sample database.

Looking at the design sheet we can see that calculations have been set up for the Total and Avg fields.

When new data is entered into this database the Total and Avg fields are calculated automatically. However,
they are not calculated for the existing data. To perform this calculation, open the Run Automatic Calcula-
tions wizard.

To calculate the values for all fields that have calculations set up (in this case Total and Avg) press the All
Fields button. The wizard will perform the calculations and fill in the fields. (Note: This wizard only works
with Spreadsheet mode formulas, it does not work if the database uses Procedure mode.)

If you only want to perform the calculation for the current field press the Current Field button. (If the current
field doesn’t have a calculation set up an alert message will appear.)
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The Choice Palette

The choice palette provides a completely different way to use the Input Box. Instead of entering the data with
the keyboard, you pick the value from a list of buttons.

The choice palette can be used with any data type except pictures. All you have to do is create a list of choices
(see below).

Changing the Shape of the Choice Palette

Panorama automatically arranges the buttons in the choice palette for the best fit in the Input Box. By chang-
ing the size and shape of the Input Box you can arrange the buttons vertically, horizontally, or in a grid of
rows and columns.

Creating the List of Choices

The list of choices (if any) for each field is kept in the Choices column of the design sheet. (See “The Design
Sheet” on page 212 if you are not familiar with the design sheet.)   You can key in the list manually or you can
use the Automatic Choices command to create the list for you (See “Creating the List of Choices” on
page 260).

If you key in the list of choices manually, you must separate each choice with a space. If a choice contains a
space (US Mail) you must represent the space with an underscore character (US_Mail).
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You can also set up the list of choices with the Field Properties dialog.

To automatically create the list press the Auto button. Panorama scans the database and creates a list of all the
choices already in the data.

Exceptions

An option for any choice palette is an exception box. The exception box lets you type any value into the data
cell, even if the choice palette doesn’t contain a button for it. Use the exception box when you have a few
common choices, but cannot anticipate every value in advance. To create an exception box, simply type in a
line of underscores at the end of the choice list.
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The exception box is always one line high. The width of the exception box is controlled by the number of
underscores.

To make the exception box wider, add more underscores.

The Choice Palette vs. the Choices Data Type

If you’ve already read about the choices data type (See “Choices” on page 259), you may be wondering how
the choice palette relates to the choices data type.

The choice palette is a way to enter data. It provides a way to enter or edit data by picking from a list of
choices instead of typing from the keyboard. Using the choice palette does not affect how that data is stored,
however. The data can be stored as text, as a number, a date, or using the choices data type.

The choices data type is a way to store data. This data type is efficient (saves memory) for storing data that
has only a few possible values.

The choices data type can be used with a choice palette (and it usually is), but you can also use regular key-
board editing to enter choice values. A choice data type field will use regular keyboard editing (instead of the
choice palette) if you set the number of digits to 1.

Editing Tools within a Data Cell

Most data cells contain no more than a few words or phrases. Some applications, however, require that each
data cell contain several paragraphs or even an entire page of information. Panorama’s search, replace, and
spelling checker tools can help you accurately create catalogs, letters, glossaries, bibliographies, etc.

Searching for Text Within the Input Box

To locate a word or phrase within the Input Box use the Find in Cell command in the Edit Menu. Make sure
you use the Find in Cell command in the Edit Menu, not the Find/Select command in the Search Menu.
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Enter the word or phrase you want to search for into the dialog box, then press the Find button or the Return
key.

Panorama will move the insertion point to the first occurrence of the word or phrase within the text in the
cell.

If you want to look for more occurrences of the word or phrase, use the Find Next in Cell command in the
Edit menu (not the Find Next command in the Search Menu).

The Find in Cell dialog has two options, Case Sensitive and Words Only. Use the Case Sensitive option if you
want the Find in Cell command to only locate words or phrases that exactly match the capitalization of the
text you are searching for. For example, when searching for the word Panorama, the Find in Cell command
would normally also locate panorama and PANORAMA. However, if the Case Sensitive option is checked
only Panorama will be located—the other two versions would be skipped.
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Use the Words Only option when you only want to locate occurrences of the text that are complete words, not
part of a larger word. For example, if you search for the word head, the Find in Cell command will also
locate the words header, headline, subhead, etc. However, if the Words Only option is checked, these addi-
tional variations will be skipped.

To find additional occurrences of the word or phrase within the Input Box, use the Find Next in Cell com-
mand in the Edit menu (not the Search menu).

The Find in Cell command in the Edit menu searches only through the text in the Input Box. If you wish to
search the entire database you must use the Find/Select command in the Search menu (see “The Find/Select
Dialog” on page 336).

Replacing Words or Phrases Within a Cell

To replace a word or phrase within the Input Box use the Change in Cell command in the Edit Menu.

Make sure you use the Change in Cell command in the Edit Menu, not the Change command in the Search
Menu. Enter the word or phrase you want to replace and the new word or phrase into the dialog box. Press
the Change button or the Enter key to change all occurrences of the word or phrase within the Input Box.

The Change in Cell dialog has the same Case Sensitive and Words Only options that appear in the Find in
Cell dialog. These options work exactly the same way as described in the previous section.
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Using the Spelling Checker within a Cell

If you have purchased Panorama’s optional spelling dictionary, you can use the Check Spelling command
(Edit Menu) to check the spelling of the text in the Input Box.

Starting from the currently selected spot in the text, the Check Spelling will scan the Input Box looking for
spelling errors. If it finds a spelling error, Panorama will stop and highlight the misspelled word.

If the word is actually misspelled, you can correct the error. In the example above, geeky is probably correct,
but is not in Panorama’s dictionary. To resume scanning for more spelling errors, choose Check Spelling
again from the Edit Menu.



Chapter 8: Sorting

Most data is more useful when it is in some kind of order. Panorama’s Sort Menu has several commands that
can quickly sort your data into order.

Basic Sorting

Before sorting, you must choose the field to be sorted. For example, you might want to sort a mailing list
database by name, city, state, or zip code. To choose the field you want to sort, just click on it. In a data sheet
or view-as-list window, you can click on any cell in the column. If you are using a regular form (individual
pages), click on the field you want to sort. (You must click on a data cell, not on an auto-wrap text object con-
taining the field.)
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To sort in ascending order (A to Z) use the Sort Up command. To sort in descending order (Z to A) use the
Sort Down command. The Sort Down command is especially useful with numeric data if you want to rank
the numbers from largest to smallest.

When the database is sorted, all the records are re-arranged. However the current record remains in the same
spot in the window. For example, if you click on the name Zabriskie and then sort, the record containing
Zabriskie will remain on the screen. The record will not be in the same spot in the file, however, because it is
now near the end of the file with the other Z’s. In this case the current record was Keith Baker, which is still
the current record. However the database is now sorted from A to Z within the Last name field.

Sorting By More Than One Field

It is often necessary to sort by more than one field at a time. For example, you may need to sort both first and
last names, or cities and states. After you have sorted the database once, you can use the Sort Up Within (or
Sort Down Within) commands to sort by additional fields.
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For example to sort by city and state, first sort by the state.

As you can see, the records are now sorted by state. However, the cities are not sorted within each state. For
example, Davis, CA should appear before San Francisco, CA, but it doesn’t. In fact, within each state the
records aren’t sorted at all, they are still in the order they were in before they were sorted.
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To complete our two column sort, click on the City field and use Sort Up Within to sort the cities. The Sort
Up Within command leaves the states in order but sorts the cities within each state.

As you can see, the cities are now sorted within California and Connecticut (and within all of the other states
with more than one record as well).

The Sort Within commands can be used over and over again to sort 3, 4, or more fields within each other.
Always start with the regular Sort Up or Sort Down commands, then use Sort Up Within or Sort Down
Within to sort each of the additional fields. For example, if you look closely you will notice that the three San
Francisco records in the window above are not sorted by zip code. If you wanted them to be, you could sim-
ply click on the Zip field and then choose Sort Up Within again. The records will still be sorted by state and
by city within state, but now they will also be sorted by zip code within city as well.
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Note: There is an alternate way to sort multiple fields. This alternate method does not use the Sort Within
command. Instead of sorting within, sort the fields in reverse order using the regular Sort Up or Sort Down
commands. For example to sort by city within state, first click on the City field, then Sort Up, then click on
the State field, and finally Sort Up again.

Sorting By Color

Usually the database is sorted according to the data in a field, but you can use the Sort by Color command to
sort by the color of each cell in the field. Sorting by color can be useful if you have set up your database so
that each color has a meaning. The sort order for colors is black, red, green, blue, cyan, magenta, yellow. See
“Data Style and Color” on page 474 for details on how to assign a color to a cell.

Here is a database where each name has been assigned a color.
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After Sort By Color the records are grouped together by color.

Undo Sorting

The Undo command will undo the effect of the last Sort or Sort Within command, putting the database back
into the original order. Remember that only the last sort can be undone. Once you sort again the original
order cannot be restored (unless you have saved the file on the disk in the original order, then you can use
Revert to Saved to restore the order.)

Sorting Numbers and Dates

It is important to store numbers using the numeric data type, and dates using the date type. If you store num-
bers and dates using the text data type they will not sort correctly, as shown in this table.

If your numbers or dates are not sorting correctly, make sure they are stored using the correct data type. See
“Numeric Data” on page 249 for more information on the numeric data type. See “Dates” on page 255 for
more information on the date data type.

Stored

as Numeric

(correct)

Stored

as Text

(incorrect)

9 6000

80 700

700 80

6000 9
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Sorting Right Justified Text

If your text is right justified, it will sort like a numeric field. In other words, 2 will sort before 10, and B will
sort before AA. The actual sorting rules for right justified text are—1) short data sorts before longer data (B
before AA) and 2) if two data items are the same length, they will be sorted in alphabetical order (AA before
BA).

Sorting Selected Data

Sorting is not affected by the Find/Select command. The sort commands always sort the entire database—not
just the selected records. When the invisible data is selected again you will see that it is sorted properly
within the rest of the data.

Sorting Within Groups

Later you’ll learn how Panorama can organize a database into groups, with summaries for each group. (See
“3-Step Summarizing” on page 365.) If you attempt to sort your database after it has been grouped, Pan-
orama will automatically sort the data within the groups instead of sorting the entire database. If you want to
sort the entire database you must remove the groups with the Remove Summaries command (Sort Menu).

Sorting Choices

Data stored using the choices data type is sorted according to the order of the choice list in the design sheet. If
you want the choices to be sorted alphabetically, you must make sure that the choice list is in alphabetical (A-
Z) order. The Automatic Choices command does this for you.

Sometimes you may wish to sort the choices in a different order. For example, Olympic medals should be
sorted in the order Gold, Silver, Bronze instead of alphabetically (Bronze, Gold, Silver). If you need the
choices to sort non-alphabetically, simply set up the choice list in the order you want.

Warning: If you use a non-alphabetic choice order, Panorama cannot correctly sort exceptions. Panorama will
attempt to place the exceptions in alphabetical order, but if the choice list is not in alphabetical order that may
be impossible. The final order is not predictable. If the choice list allows exceptions it should be in alphabeti-
cal order.

See “Choices” on page 259 for more information on the choice list and the choice data type.
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Chapter 9: Searching and Selecting

A Panorama database may contain dozens, hundreds, or even thousands of records. Finding a particular
piece of information could be like locating a needle in a haystack. Fortunately Panorama can easily locate
information for you.

Finding vs. Selecting

Panorama has two ways of locating information, finding and selecting. Finding is much like looking up a
name in a phone book—Panorama points out the location of the information you are looking for. For exam-
ple, you might ask Panorama to find a phone number or a price in a catalog. Panorama will locate the infor-
mation, and position the database to that spot. In this example we’ve asked Panorama to find Blue Cross.

find Blue Cross
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Selecting is like creating a whole new phone book containing only the information you are looking for. All the
selected data remains visible, while everything else temporarily vanishes. For example, you might ask Pan-
orama to select all customers that have purchased from you in the last six months, or all transactions over
$250,000.

Deciding whether to find or select is your choice. Usually find is used when you want to locate a specific item
like an address or price, while select is used when you want to locate a set of information. You can also com-
bine the two techniques—for example, first select a subset of the database, then find a specific item within
that subset.

Note: Some other database programs have a “Find” command that actually does the same thing as Pan-
orama’s Select command (for example FileMaker). These programs do not have a true find capability like
Panorama.

select Blue Cross
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Selecting with the Context Menu

If you want to select more data that is related to data you can see on the screen, the easy way to do it is to use
the context menu. To see this menu simply right click on any data cell (if you don’t have a two button mouse,
hold down the control key and click on the cell).

The selection options in the menu vary depending on the type of data you click on.

Select Same

The Select Same option selects cells that contain the same value as the cell that was clicked on. For text cells,
this will include cells that are the same except for capitalization (so pat, Pat and PAT would all be treated the
same). If you want only cells that match in all aspects including capitalization, choose Select Same (Exact).
The Select Sounds Like option uses a phonetic option, selecting all cells that sound similar, for example Guti-
eriez, Guteres, Gutierrez, etc.

Text Numeric Date
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For date fields there are additional options for different periods — same week, month, quarter or year. For exam-
ple to find all records in January, just right click on any date in January and choose Select Same Month.

For numeric fields you can use Select Within 10% to find all records that are near the clicked value. For
example if you clicked on a cell that contained 2,000 this would select all records between 1,800 and 2,200.

Select Larger/Smaller

These options apply to numeric cells. For example, right click on a cell that contain $100 and choose Select
Larger to select all records with values greater than 100.

Select Before/After

These options apply to date cells. For example, to find all records before a certain date simply right click on
the date and choose Select Before. If you clicked on a cell that contained January 1, 2007 then Panorama
would select all records from 2006 or earlier.

Select Next/Previous/First/Last

These commands allow you to “walk” through the data, one item at a time. Select Next is like Select Same,
except that instead of selecting data that is the same as the current cell, it selects the next data item. For exam-
ple, suppose you have a database field named Category that contains these seven categories.

If you right click on a cell that contains Printing and choose Select Next, Panorama will show you all of the
records that contain Rent. Choosing Select Next again will show you Shipping, then Utilities, then finally
Travel.

Select Previous goes in the opposite direction. If you right click on a cell that contains Printing and choose
Select Previous, Panorama will show you all of the records that contain Payroll. Choosing Select Next again
will show you Advertising.

Select First will show you the first value in the field. In this example you could right click on any cell in the
Category field and choose Select First to see all of the Advertising records. You could then “walk” thru each of
the different categories by choosing Select Next.

When working with date fields you can “walk” thru the data by day, week, month, quarter or year. For exam-
ple, you could start by right clicking on a cell in January and choosing Select Same Month to see all of the
records in January. Then choose Select Next Month to see all of the records in February, then again for March,
April, May, etc.

Advertising

Payroll

Printing

Rent

Shipping

Utilities

Travel
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Quick Subtotals

Once you’ve made a selection you can click on a numeric field and choose Column Stats from the context
menu to get some quick statistics about the selected records. For example, you could start by selecting all
records in April, then right click and choose Column Stats.

A small window appears displaying information about the debits in the currently selected records, including
the total, count, average and standard deviation.

Close the window when you are ready to do further processing.
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The Find/Select Dialog

Panorama locates information by scanning through the entire database looking for data that matches your
criteria. The Find/Select dialog (Records->Search) allows you to specify the criteria for locating informa-
tion— including the field (or fields) containing the data, the kind of match you want (contains, exact match,
greater than, etc.) and the match value (the data you are looking for).

Tip: You can also open the Find/Select dialog by clicking on the record count displayed in the lower left hand
corner of the window.

click in this box to open Find/Select dialog
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Here is what the Find/Select dialog looks like when you first open it.

By default the Find/Select dialog searches all fields in the database. Simply type in the word, phrase or name
you want to search for. If the Live Preview option is checked, a preview of the search results will appear
immediately as you type. Here’s an example of a search for engineer. In this example engineer has been
found in both the Organization and Title fields.
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Selecting a Subset

To actually select a subset of the database, press the Select button. Panorama will scan through the entire
database and select the records that match the criteria you have specified. The selected records remain visible,
while the records that do not match temporarily vanish. Panorama displays the number of selected records in
the lower left hand corner of the window.

To restore the invisible records, choose the Select All command from the Search Menu.

To make a different selection, simply use Find/Select again. The original selection will vanish and the new
selection will become visible. (You do not need to choose Select All before selecting another subset.)

Note: If your database is large and you have selected only a few records, you may find that Panorama seems
sluggish. Remember, Panorama may be skipping over hundreds of invisible records that are between the vis-
ible records on the screen. When you use Select All, Panorama’s normal blazing speed will return.

Note: After you have selected a subset of the data, you may find that you cannot move the data sheet scroll
bar to the very top or very bottom. This will happen if the first or last record is not one of the selected (visible)
records.

Find and Find Next

Another way to locate data is to “find” it (see “Finding vs. Selecting” on page 331). There are two ways to
find a record — either double click on it in the preview or press the Find button. Double clicking on a record
in the preview closes the dialog and causes Panorama to jump to the actual record in the database. When you
press the Find button, Panorama will go to the top of the database and start scanning. When Panorama finds
a data cell that matches what you are looking for, it stops scanning and displays the information it has found.

To resume scanning for additional matches, use the Find Next command (if there aren’t any more matches,
Panorama will beep). To scan backwards, use the Find Previous command. (You can also use Find Next and
Find Previous after double clicking on a record in the preview.)

select any field contains engineer

current selection (505 records contain engineer)
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Creating Specific Search Criteria

Panorama allows you to set up detailed criteria to narrow a search down to the exact information you are
looking for. You’ve already seen the most general search, for text contained in any field, now we’ll look at
how to narrow a search to more specific criteria.

Searching a Specific Field

To search in a specific field instead of all fields, choose the field you want to search from the pop-up menu.

Once you’ve selected a field you also have the option of selecting a comparison method for matching the data
with the field. The matching options available will change depending on the type of field you have selected
(text, number or date). Matching options are covered in more detail later in this chapter.
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Once you’ve selected the field and matching option you can type in the data you are looking for. If the Live
Preview option is checked the preview will update as you press each key. In this example the search done
earlier in this chapter has been narrowed to show only records where the job title contains engineer, instead
of engineer being in any field.

Compound Searches

To search for multiple terms at once, press the + button at the far right end. This adds another row to the
search criteria.

add row

delete row
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In this example I’ve revised the search to show engineers in Colorado.

You can continue adding multiple search rows as necessary, for example here I’ve narrowed the search down
to engineers in Colorado born before 1965.

Once you’ve narrowed the search down to the subset you want you can press the Select or Find buttons to
apply the search to the actual database. (You can also save this search for later, see “Managing Queries” on
page 355).
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Compound Search with AND/OR

Normally when you specify multiple criteria they must all be true, in other words, each criteria is ANDed
together. In the previous example, a record matches if the Title contains engineer and the state is CO and the
birthdate is before 1965. Using the pop-up menu at the top left of the dialog you can change how multiple cri-
teria are combined.

By changing this pop-up menu I can search for anyone who is either an engineer or a supervisor.

Or, I can find anyone who is neither an engineer nor a supervisor.

click to choose
how rows are combined
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Search Options (Text)

When searching in a text field there are almost two dozen options for determining whether data is a match.

Contains — Any data cell that contains the match value will be identified as a match. For example, if you ask
Panorama to locate cities containing an, it will locate cities like Anaheim, Lansing, Los Angeles, and San Jose
since they all contain an. Notice that capitalization is ignored, so an, An, AN, and aN are all acceptable
matches.

Does Not Contain — Any data cell that does not contain the match value will be identified as a match. For
example, if you ask Panorama to locate phone numbers not containingcontaining (714) it will locate phone
numbers in other area codes. Capitalization is ignored, so an, An, AN, and aN are all equivalent as far as this
option is concerned.

Begins With — Any data cell that begins with the match value will be identified as a match. For example, if
you ask Panorama to locate states beginning with co, it will locate states like Colorado and Connecticut. Cap-
italization is ignored, so co, Co, CO, and cO are all acceptable matches.

Ends With — Any data cell that ends with the match value will be identified as a match. For example, if you
ask Panorama to locate baseball teams ending with sox it will locate both Red Sox and White Sox. Capitaliza-
tion is ignored, so sox, Sox, SOX, and sOx are all acceptable matches.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match. An exact
match means just that. The spelling, punctuation, and capitalization must be exactly the same—for example
red will not match RED or Red.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Less Than (<) — Any data cell that is less than the value in the box on the right will be identified as a
match.

Is Greater Than (>) — Any data cell that is greater than the match value will be identified as a match.

Is Less Than or Equal to (≤) — Any data cell that is less than or equal to the match value will be identified as
a match.

Is Greater Than or Equal to (≥) — Any data cell that is greater than or equal to the match value will be iden-
tified as a match.
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Contains the Word — Any data cell that contains the specified word will be identified as a match. The word
must not be part of a larger word. For example, if you specify contains the word engineer it will not match
engineers or engineering.

Sounds Like — Any data cell that “sounds like” the match value will be identified as a match. Panorama
uses a special algorithm to determine which values sound like the match value. This algorithm is not perfect,
but it does work pretty well. For example, if you are looking for someone named Luboviski but you are not
sure if it is spelled with an i, ie, or y, the sounds like match will save the day.

The sounds like match can be used with more than one word at a time. For example, if you are searching
through a video rental database for the movie Escape from New York, the sounds like algorithm will find it
even if it is misspelled Escapade from New York. If any word in the match value sounds like any word in the
data cell, the data will be identified as a match.

Note: If two words do not start with the same letter, the sounds like algorithm will not think they sound alike.
For example, sounds like does not think that Chris and Kris sound alike.

Matches (Wildcard) — This option allows you to create a “pattern” for comparing data. The pattern allows
you to set up very flexible “wildcard” matches where some characters must match but others don’t have to.
The pattern must contain one or more “normal” characters (letters, numbers, punctuation, etc.) and also may
contain one or more of the wildcard characters ? (question mark) and * (asterisk). The ? wildcard character
will match any character in this position. The * wildcard character will match any number of characters in
this position.

A few examples should help to make the operation of the wildcard characters within the pattern clear. Sup-
pose you want to find all records where the first three digits of the zip code are 926, and you don’t care what
the last three digits are. The pattern will be 926??. This pattern will match any five digit zip code that begins
with 926. It will not match if there are less than or more than 5 characters in the zip code.

If the pattern is changed to 926*, Panorama will match with any zip code that begins with 926, no matter
what the length is. It could be three digits long or thirty — Panorama doesn’t care and will say that it matches
as long as it starts with 926.

By changing the pattern to 926??* we tell Panorama to match any zip code that starts with 926 and is at least
five characters long. The zip code could be 5, 6, 7, or 70 characters long, but will not match if it is only 3 or 4
characters long.

If you wanted to select only 9 digit zip codes we could use the pattern ?????-????. This will match any 10
character long string with a - (dash) in the sixth position.

Suppose that you wanted to find everyone in your database with the last name Johnson and the first initial J.
Assuming that the first and last names are stored in a single field, you could use the pattern j*johnson to
locate the person (or persons) you are looking for. The match option doesn’t care about upper or lower case,
so this pattern would match Jerry Johnson, jim johnson, or JOHN JOHNSON. (It will also match weird data
like j346ujohnson or j@#opcjohnson, so take care to watch for unexpected matches.) If you want upper and
lower case treated as different characters use the matches exact case option (see below).

Matches Exact Case — This option is the same as the matches (wildcard) option (see above), except that any
letters in the data must exactly match the pattern, including upper vs. lower case. For example, if the pattern
is J*Johnson, names like Jerry Johnson will match, but JERRY JOHNSON will not match.
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Length is Between  — When this option is selected there are two match values, the minimum and maximum
length (in characters). In this example this option is being used to search for organizations with unusually
long names (more than 35 characters).

Number of Words is Between  — When this option is selected there are two match values, the minimum and
maximum number of words. In this example this option is being used to search for job titles with only one
word in them (excluding compound titles like vice president or security analyst).

Number of Lines is Between  — When this option is selected there are two match values, the minimum and
maximum number of lines. For example, you could use this to find all records where a cell contained more
than one line by using 2 for the minimum number of lines and 9999 for the maximum.

Is All Upper Case — Any data cell that contains all upper case characters (for example AZ) will be identified
as a match.

Is All Lower Case — Any data cell that contains all lower case characters (for example west) will be identi-
fied as a match.

Is All Word Caps — Any data cell that contains words with the first character captialized (for example San
Diego) will be identified as a match.

Is Not All Upper Case — Any data cell that contains any lower case characters (for example az) will be iden-
tified as a match. This is useful for double checking that a column is all upper case (for example a column of
state abbreviations).

Is Not All Lower Case — Any data cell that contains any upper case characters (for example West) will be
identified as a match.

Is Not All Word Caps — Any data cell that contains words with the first character lower case, or any other
character upper case (for example hOusTon, CHICAGO or philadelphia) will be identified as a match. This is
useful for double checking the capitalization of fields containing proper names.
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Search Options (Numbers)

When searching in a numeric field there are over a dozen options for determining whether data is a match.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Between  — Any data cell that contains a value between the two specified match values will be identified
as a match.

Is Not Between  — Any data cell that contains a value outside the two specified match values will be identi-
fied as a match.

Is Less Than (<) — Any data cell that is less than the value in the box on the right will be identified as a
match.

Is Greater Than (>) — Any data cell that is greater than the match value will be identified as a match.

Is Less Than or Equal to (≤) — Any data cell that is less than or equal to the match value will be identified as
a match.

Is Greater Than or Equal to (≥) — Any data cell that is greater than or equal to the match value will be iden-
tified as a match.
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Is Near (10%) to  — Any data cell that is within plus or minus 10% of the specified will be identified as a
match.

Is Not Empty  — Any data cell that contains a value (even zero) will be identified as a match.

Is Empty  — Any data cell that does not contain a value will be identified as a match. In other words, this
option locates completely blank fields.

Is an Integer  — Any data cell that contains an integer value will be identified as a match. For example, 1, 2,
45 and 5,687 would match but 1.27, 9.87 and 764.12 would not.

Is a Multiple of  — Any data cell that is a multiple of the specified value will be identified as a match. For
example if you specify 2 then 2, 4, 6, 8, etc. would match, while any other numbers would not.

Search Options (Dates)

When searching in a date field there are over a dozen options for determining whether data is a match. When
specifying a date you can use Smart Dates (see “Entering Dates” on page 255), so you can use dates like
March 12, yesterday, or last tuesday.

Is Equal to (=) — Any data cell that exactly matches the match value will be identified as a match.

Is Not Equal to (≠) — Any data cell that does not exactly match the match value will be identified as a match.

Is Before — Any data cell that contains a date before the date you type into the box on the right will be iden-
tified as a match.

Is on or Before — Any data cell that contains a date before or on the date you type into the box on the right
will be identified as a match.

Is After — Any data cell that contains a date after the date you type into the box on the right will be identified
as a match.

Is on or After — Any data cell that contains a date after or on the date you type into the box on the right will
be identified as a match.
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Is Between  — Any data cell that contains a date between the two specified dates will be identified as a
match. In this example all checks between last friday and today are selected (the example was taken on
March 30, 2010).

Is Not Between  — Any data cell that contains a value outside the two specified dates will be identified as a
match.

Is Not Empty  — Any data cell that contains a any date will be identified as a match. Blank cells will not be
selected.

Is Empty  — Any data cell that does not contain a value will be identified as a match. In other words, this
option locates completely blank fields.

Is Today  — Any data cell with today’s date is identified as a match.

Is This Week  — Any data cell in the current week is identified as a match.

Is This Month  — Any data cell in the current month is identified as a match.

Is This Quarter  — Any data cell in the current quarter (3 months) is identified as a match.

Is This Year  — Any data cell in the current year is identified as a match.

Is WIthin 3 Days of  — Any data cell that contains a date within 3 days of the specified date will be identified
as a match.

Is WIthin 7 Days of  — Any data cell that contains a date within a week of the specified date will be identi-
fied as a match.

Is WIthin 1 Month of  — Any data cell that contains a date within a month of the specified date will be iden-
tified as a match.
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Query Errors

It's possible to create a query that doesn't make sense -- for example asking Panorama to match all records
with dates between a and b. When this happens Panorama will display a pink background behind the query
line that doesn't make sense, along with a red alert triangle.

Click the red alert triangle to see the exact problem (in this case Illegal Date).

Search Options (Entire Records)

Most searches are based on specific fields, but there are also about a dozen criteria that apply to entire
records. (Keep in mind that these criteria can be used in any combination with other search criteria.)

Is Already Selected — This option allows new selections to be partially based on the results of previous
selections. If this option is chosen, only records that were already matched in a previous selection will be
identified as a match. In the example below, a previous selection located all organizations with Photo in the
name. Now that selection is being revised to include only photo related organizations in Texas. (To learn
about another way to revise an existing selection see “Revising a Previous Selection” on page 357.)
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Is Not Already Selected — This option allows new selections to be partially based on the results of previous
selections. If this option is chosen, only records that were not matched in the previous selection will be identi-
fied as a match in this selection.

Is a Data Record — Any raw data record (not a summary record) will be identified as a match.

Is a Summary Record — Any summary record will be identified as a match. (This option duplicates the
Select Summaries command that was available in previous versions of Panorama.)

First NN records — This option allows you to select the first few records in the database. In this example the
first 25 records in the database will be selected.

Last NN records — This option allows you to select the last few records in the database.

Every other record (1, 3, 5…) — This option allows you to select half of the records in the database. Every
other record is selected, starting with the first record.

Every other record (2, 4, 6…) — This option allows you to select half of the records in the database. Every
other record is selected, starting with the second record.

Every 3rd record (1, 4, 7…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the first record.

Every 3rd record (2, 5, 8…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the second record.

Every 3rd record (3, 6, 9…) — This option allows you to select one third of the records in the database. Every
third record is selected, starting with the third record.
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Search Options (Formula)

The standard matching options can be combined in many ways to easily perform most searches, but Pan-
orama has an even more powerful option — searching with a boolean formula. This option is a bit “geeky”,
but allows you to locate virtually anything that can be described by Panorama’s powerful formulas. 

The formula is true option relies on the ability of a formula to make comparisons and true-false decisions.
See “True/False Formulas” on page 124 of Formulas & Programming for a detailed explanation of true-false
logic. Here is an example that shows how a formula can be used to combine both and and or operators into a
single query.

The formula is true option allows you to select data based on calculations or comparisons between two
fields. For example, the formula

Price/Cost > 2
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allows you to quickly locate items with high profit margins, like this.

Panorama has hundreds of different functions that can be used in a formula to perform very specific selec-
tions. In the example below the upperword( function has been used to locate cities where a character other
than the first character in a word has been capitalized (in most cases a space is missing). The formula has
instantly located the 12 records (out of ten thousand) in this database where the city name has been incor-
rectly capitalized. With any other database program the only way to find these mistakes would be to search
the entire database by hand.
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Combining Formulas with Other Search Options

A formula search can be combined with standard search options, like this:

You can even combine multiple formulas in different rows. You can intermix formulas and standard search
options in any combination.

Help with Creating Formulas

In the process of creating a formula you’ll often need to type in field names and functions. You don’t have to
have these memorized, Panorama can help you type these in quickly and accurately. To type in a field name,
choose from the Fields menu. (This menu lists all of the fields in all open databases. The currently active
database is listed first.)

When you make your selection the field name will be typed into the formula for you. (If the field name has
any punctuation in it the necessary « and » chevrons will be added automatically.)
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To enter a function name, use the Formula menu.

Instead of choosing a function directly from a menu, you can also open the Programming Assistant. This dia-
log allows you to type in the first few letters to quickly find the function you want. 

Once the function you want is visible you can 1) click on it and press the Insert button, 2) double click on the
function name, or 3) type 1-9 to insert the any of the first nine functions listed. For more information on the
Programming Assistant see “The Programming Assistant Dialog” on page 225 of Formulas & Programming.
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Managing Queries

The tools in the upper left corner of the Find/Select dialog allow you to manage and easily re-use previous
queries.

Clear Query — This button clears the current query. It resets the dialog to a simple query of searching all
fields for a word or phrase. (If you press Clear Query by mistake you you can press Previous Query to go
back.)

Previous Query, Next Query — This pair of buttons allows you to go back to previously used queries. (Note:
Only queries that you actually "finalized" by pressing the Find or Select buttons are included in the list of
previously used queries.)

Favorites — This button displays a pop-up menu of favorite queries, along with options for adding and
removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the favorite
from the menu.

The query is restored just as it was saved. You can use it as is by pressing Select or Find, or you can modify it
first.
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To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.

Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.

Note: In addition to saving favorites, you can also include a query in a procedure by using Panorama's
recorder (see “Creating a Procedure with the Recorder” on page 212 of Formulas & Programming).

Show Formula — This button opens a small window that shows the internal formula associated with the
current query. Normally you would never need to use this, but it can be handy if you want to copy the for-
mula for use in a procedure.
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Live Preview

The Live Preview area of the dialog displays a preview of the search you are about to perform. For small to
medium sized databases the live preview area will update instantaneously as you change the search. If your
database contains tens of thousands of records, or if you are using an older computer, updating the preview
may take a second or two. While the preview is updating the number of records will display in gray in the
lower left hand corner of the dialog. When the preview is complete the number will turn green.

Note: The Live Preview area will only show up to about 1,000 records. If there are more than 1,000 matches
the number of records displayed will not be accurate (a + is added to the number to indicate that there are
additional matches not counted). To see the exact number of matches use the Select button.

If your database is large or your computer is slow, you may want to temporarily turn off Live Preview updat-
ing while you set up the query. Simply uncheck the Live Preview checkbox in the upper right corner. To
resume the live preview simply re-check the checkbox.

If you want to leave the Live Preview option off by default, open Preferences from the Panorama menu, then
open the General Preferences panel, then uncheck Enable Live Preview in the Search Options area.

Revising a Previous Selection

As you have seen, the Find/Select dialog makes it easy to make selections based on multiple criteria at once.
Sometimes, however, you don’t know in advance exactly what you are working for. Panorama has two
options that let you build a selection incrementally — Select Within and Select Additional. The Select
Within option allows you to whittle your data down gradually until you’ve extracted just the nugget of
information you really need. The Select Additional button lets you assemble the pieces of information you
need piece by piece.

To use these options, first make a regular selection, then open the Find/Select dialog again. When there is
already a previous selection you’ll see an additional +/- button at the top of the dialog.

turns green when live preview update is complete
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Set up the revised selection criteria and then click on the +/- button to choose either Select Within or Select
Additional from the pop-up menu.

To demonstrate this, I’ll start by selecting Office Supplies in this checkbook database.

Now I want to revise this selection to show only office supply purchases greater than $500. To do that, I open
the Find/Select dialog and set up the selection for checks (Debit) greater than 500. Notice that the preview
shows all checks greater than 500, not just office supplies. When you revise selections this way, the preview
does not show you what the revised selection will look like.
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To actually revise the selection, click on the +/- button and choose Select Within Current Subset from the
pop-up menu.

Now the revised selection appears -- there are only two checks for office supplies greater than $500.

Of course, you could obtain the same effect by combining multiple criteria in the first place. But you don’t
always know in advance exactly what you are looking for. The Select Within option allows you to whittle
your data down gradually until you’ve extracted just the nugget of information you really need.

The Select Additional option is similar, but allows you to select a superset of the currently selected records.
For example, if you have already selected names in Ohio, you could use Select Additional to also select
names in Illinois. The result would be the subset containing all names in either Ohio or Illinois. The Select
Additional option lets you assemble the pieces of information you need piece by piece.

Select Reverse

The Select Reverse command (in the Records->Search menu) reverses selected and deselected records. For
instance, if you have selected all transactions greater than $600, the Select Reverse command will select all
transactions less than or equal to $600.

Undo Select

The Undo command can reverse the effects of the last 16 select operations, including Select, Select Within,
Select Additional, and Select Reverse. As long as you do not use any other commands or tools, you can use
the Undo command up to 16 times in a row.

The quickest way to select the entire database is the Select All command (Command-A).
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Customizing the Find/Select Dialog

The Find/Select dialog has several options that can be customized. To access these options, open the Prefer-
ences dialog, then click on the General Preferences button. This opens a window with many types of prefer-
ences, but at the moment we’re only interested in the Search options.

The first option is Default Search. If the All Fields option is checked, the dialog will initially default to search-
ing all fields when it is first opened. If the Current Field option is checked, the dialog will default to searching
just the currently selected field (this is similar to previous versions of Panorama).

The Reset search criteria option controls whether the Find/Select dialog starts fresh each time it opens. If this
option is checked, the dialog will always start empty when it opens, ready for a new search (you can recall
the previous search by pressing the Previous Query icon, see “Managing Queries” on page 355). If this
option is not checked, the dialog will start out with the previous search. You can then modify the search, or
you can start over by pressing the Clear Query icon (see “Managing Queries” on page 355).

The Enable Live Preview option controls whether Live Preview is enabled when you first open the dialog.
This is normally on, but if you have a slower computer or use extremely large databases you may want to
turn Live Preview off to make the dialog more responsive. See “Live Preview” on page 357.

Using the “Classic” Find/Select Dialog

If for some reason you want to use the older (pre-Panorama 6) search dialogs, open the Preferences dialog,
then click on the General Preferences button. Then check the Use “Classic” menus (Search, Sort, Math)
option. This also enables the older search wizards: Live Clairvoyance, Search All Fields, and Quick Search. For
more information on these “classic” dialogs and wizards see the Panorama 5.5 documentation (available
from the ProVUE web site).

Permanently Removing Unselected Data

Unselected data is hidden, but it is still part of the database. You can restore the invisible data with the Select
All command. Sometimes, however, you may wish to free the memory occupied by the hidden records. The
Remove Selected and Remove Unselected command in the Records->Search Menu allow you to perma-
nently remove records from the database based on a selection.

Before Panorama actually erases the unselected data, it asks you to confirm that you really want to proceed.
Panorama doesn’t want you to accidentally delete hundreds or thousands of records. Be careful, because
these command cannot be reversed with the Undo command.
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If you have saved a copy of the data on disk prior to using Remove Selected or Remove Unselected, you can
still recover the data with the Revert to Saved command (until you save again). Even after you have saved
the database, you can still recover the previous data with Panorama’s Time Lapse feature (see “Time Lapse” on
page 67).

Panorama’s Total Recall feature (introduced in Panorama 6) eliminated the need for the Auto-Save option,
and we recommend that you disable this option if it is in use (using the Save As dialog). However, if you are
still using this option, be aware that it can interfere with your ability to restore data after using the Remove
Selected or Remove Unselected commands. If Auto-Save is on and you use Remove Unselected, Panorama
will ask if you would like to temporarily disable Auto-Save. If you do disable Auto-Save, it will remain dis-
abled until you manually save the file with the Save command. (See “Auto-Save” on page 109.)

The Select Summaries Command

The Select Summaries command (Records->Search menu) selects all of the summary records in the database,
and makes all the data records invisible. At the same time, it converts the summary records into data records.

You can use the Select Summaries command to select random records within your database. First pick the
records you want to select by turning them into summary records. (To turn a record into a summary record,
click on the left edge of the record in the data sheet. See “Manually Creating and Removing Summary
Records” on page 402.) To actually select the summaries, choose Select Summaries from the Search menu.
Remember, this will convert all your summary records into data records.

Warning: If you use the Select Summaries command to select random records, you can’t use summary
records for their regular job—calculating subtotals. If you need to use summary records for calculating subto-
tals, don’t use the Select Summaries command! Instead, create an extra field for specifying the records you
want to select. See “3-Step Summarizing” on page 393 for more information on the regular uses of summary
records.
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Select Duplicates

The Select Duplicates command (in the Search Menu) provides a fast and easy way to locate duplicate infor-
mation in a database. The Select Duplicates command does not remove the duplicates, it simply selects them
so you can examine them. You can then decide what to do about each duplicate on a case-by-case basis. You
may select duplicates based on a single field (for example, all duplicate company names), on multiple fields
(for example, all records with duplicate address, city, and state), or on a formula that may combine fields or
use partial fields (for example, all records containing duplicate area codes).

To select duplicates based on a single field, start by using the Sort Up command to sort the database by that
field. If the database is not sorted, the Select Duplicates command will warn you. For example, here is a con-
ference registration database that may contain duplicate company information. It has been sorted into alpha-
betically order by company.

After the database is sorted, choose the Select Duplicates command from the Search Menu (Make sure you
have clicked on the field you want to check for duplicates before selecting the command.) This command
opens a dialog box. Leave the dialog box empty and press the OK button. Panorama will select the records
that contain duplicate information (if any), making everything else invisible. 
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As you can see, there are two possible duplicates in this database.

The Select Duplicates command allows you to examine duplicate records. See “Using UnPropagate to Elim-
inate Duplicates” on page 470 if you simply want to delete all but the first duplicate entry automatically.

Select Duplicates Using a Formula

To select duplicates based on multiple and/or partial fields, you’ll need to use a formula. The formula tells
Panorama exactly what data should be checked for duplicates. For example, suppose a database contains
separate fields for first and last names. This formula could be used to check for duplicate names:

FirstName+LastName

If you wanted to check for duplicates using the first initial and the last name, you would use this formula:

FirstName[1,1]+LastName

This formula would tell Panorama to treat John Doe, Joan Doe, and Jeff Doe as duplicates because they all
have the same first initial and last name. Let’s search for duplicates in our conference registration file. Start by
sorting up by Last Name.

Now sort up within by first name.

Now choose the Select Duplicates command, and type in the formula:
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Here is the final result. There are two R Jacobsen’s, two J Jones, two R Knights, and two J South’s.

Note: The formula must produce a text result. If you want to include numeric fields, they must be converted
to text with the str( or pattern( functions (see “Converting Between Numbers and Strings” on page 84 of
Formulas & Programming). Date fields must be converted to text with the datepattern( function (see “Con-
verting Between Dates and Text” on page 107 of Formulas & Programming).

Warning: When you are using a formula to check for duplicates, only the first 300 characters from the for-
mula result are actually used for duplicate checking. If the first 300 characters are the same, Panorama will
treat these records as duplicates. Normally, this isn’t a problem when you are check for duplicate names,
addresses, etc., which are much shorter than 300 characters.
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It is very difficult to look at a database containing thousands of records and make much sense of it. There’s
simply too much information to cope with. To make the information more understandable, it needs to be
summarized. Panorama can rapidly summarize a database according to the criteria you specify.

Panorama has two methods for summarizing a database. The first method, which is discussed in this chapter,
is to create an outline using summary records. See “Crosstabs” on page 415 to learn about the second
method, crosstabs.

3-Step Summarizing

Summarizing a database is a three step process—group, calculate, and outline. Before diving into all the
details and options, let’s take a look at a basic overview of these three steps.
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The first step is always the raw data. For this example we’ll use a checkbook database, which we will summa-
rize by category. Notice that the categories start out in more or less random order.
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Step 1 is group, so we’ll start with the Group Up command (Records->Analyze menu) to divide the database
into groups by spending category (advertising, purchases, rent, etc.). As you can see, the database is now
sorted in order by category. In addition, Panorama has added several new records to the database. These are
called summary records and can be identified by their blue background color and by the fact that they are
displayed in bold.

summary records
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Step 2 is calculate, which we’ll do with the Total command (Records->Analyze menu). This command scans
the database and calculates the subtotal for each category, as well as an overall total at the bottom of the data-
base (not visible in this illustration).

subtotals



Chapter 10:Summaries and Outlines Page 369
Step 3 is outline, which allows us to hide unnecessary detail so that we can focus on just the numbers that are
important to us. For our example we’ll use the Summary Outline Level dialog (Records->Analyze menu) to
collapse the database so that only the summary information is visible. In addition to the subtotals you can
also now see the grand total at the bottom. Notice that the background blue color for the grand total is
slightly darker than the other summary records.

grand total



Page 370 Panorama Handbook
Using the Expand and Collapse tools (in the tool palette) the summaries can be expanded or collapsed to
show more or less detail. Here we’ve used the Expand tool to examine the maintenance detail.

When you are finished with the summary, use the Remove All Summaries command (Records->Analyze
menu) to remove the subtotals and totals, leaving only the original data. You can then continue with normal
operations on your database (data entry, sorting, searching, etc.).

expand

collapse
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The Summarize & Analyze Dialog

In the preceding examples the Group/Calculate/Outline analysis was done manually, one step at a time, to
make the steps easier to understand. Starting with Panorama 6, however, there is a new feature that combines
all three of these steps into a single, all-in-one dialog. (You can still perform these steps separately, see “Gen-
erating Summaries Manually” on page 394.) This dialog allows you to use pop-up menus to set up the entire
Group/Calculate/Outline process, and allows you to preview the analysis before you actually apply it to the
database.

The top section of the dialog, Summary & Analysis Options, is where the Group/Calculate/Outline analysis is
set up. When you first open the dialog this section contains three rows that are preset for summary (group),
total (calculate) and outline level:
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Start by choosing the field you want to summarize by. For date columns you will also have a choice of peri-
ods (day, month, year, etc.)

Once you've selected the summarization field the dialog will show you how many different groups of data
are associated with that field, and also list all of the groups in the Group Preview area below.

Next, use the pop-up menu in the second row to choose a column you want to perform calculations on. (In
addition to totals, you can also calculate counts, averages, minimums and maximums.) Once you've chosen a
column the dialog will show you the grand total for this column.

The final row allows you to control what level of the outline is initially displayed. It defaults to the primary
summary field, so you can usually just leave it as-is. However you have a choice of any field you have sum-
marized by or you can elect to include the raw data in the display.
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To actually create the outline press the Apply button. Panorama will organize the database into an outline
with summary records for the groups you have specified.

Multi-Level Summaries

The previous example create one summary level. Panorama can create up to seven nested summary levels,
for example Categories within Months, or Cities within States within Months within Years. To add an addi-
tional summary level, re-open the Summarize & Analyze dialog, then press the + button on the first row to
add a second summary level.

click + to add another summary level
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Now use the pop-up menu to select the field to be summarized. The summary preview will show the groups
that will appear at this summary level.

The outline level pop-up menu now gives you the choice of either summary level or raw data. All levels at
and above the selected level will be display.



Chapter 10:Summaries and Outlines Page 375
Pressing the Apply button organizes the database into a multi-level outline.

Scrolling down to the bottom of the database shows the grand total for the entire database.

Using the same technique you can add up to seven nested summary levels.

summaries by month

sub summaries by category (within month)

grand total
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Expanding and Collapsing the Summary Outline

A unique feature of Panorama is that summaries aren’t just static on a report, they can be dynamically
expanded or collapse to show more or less detail. You can “zoom out” to look for major trends, then “zoom
in” to examine specific details. We call this collapsing (zoom out) and expanding (zoom in). To expand a par-
ticular summary, click on the summary, then click on the Expand tool or right click on the summary and
choose Expand One Level of Detail from the pop-up menu (you can right click on any cell in the line).

Panorama makes the next level of detail visible.

click on Expand tool
or right click and choose Expand One Level of Detail
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If the database has more than one summary level you can repeat the process all the way down to the raw
data.

In this example we are now down to the raw data for purchases in October 2009.
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To collapse a summary, click on it and then click on the Collapse tool. Or, right click and choose Collapse
Underlying Detail.

Another way to collapse is to right-click on a detail record, then choose Collapse this to. This is especially
handy if the summary record you want to collapse isn’t currently visible in the window.

click on

or right click and choose Collapse Underlying Detail

Collapse
tool
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The example above shows doing this with a data record, but this trick works on any record except for the
final grand total. The menu adjusts to show exactly what is about to be collapsed, as shown below.

At the start of this section we showed how to expand one level at a time. You can also click on a summary and
ask Panorama to expand it all the way to the raw data, all in one step. To do this either click on the Expand
All tool, or right click on the summary and choose Expand ALL Underlying Detail.

click on Expand All tool
or right click and choose Expand ALL Underlying Detail
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This makes all subsummaries and raw detail associated with this summary record visible. In the example
below, we now can see all of the data and sub-summaries for February 2010.

Expanding and Collapsing the Overall Summary Outline

In the previous section you learned how to collapse and expand individual summary records. Sometimes,
however, you’ll want to expand or collapse the entire database as a whole. The fastest way to do this is with
the Data Sheet Context menu. Simply right click anywhere in the data sheet and choose the outline level you
want to see.

right click anywhere in data sheet

then choose the level you want to see
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If you choose RAW DATA then everything will be visible — the original data, and all summary records.

If you choose GRAND TOTAL then only one record will be visible — the grand total summary record. The
choices in between will display varying levels of summary detail.

A second way to expand or collapse the entire database is to use the Summary Outline Level dialog (in the
Records->Analyze submenu). This dialog shows the current outline structure of the database.

To switch to a different level, click on the level and then press the green “eye” button. Or just double click on
the level you want to see.
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Getting Rid of Summary Records

When you’re finished with summary records, you can simply choose Records->Analyze->Remove All Sum-
maries to get rid of them. All of the summary records will disappear, and you can get back to working with
your original data. This command is also available in the right-click context menu.

It’s also possible to use the Summary Outline Level dialog to get rid of some summary record levels while
retaining higher levels. To do this, click on the summary level you want to remove, then click on the trash
can.

Getting Rid of Detail Records

Occasionally you may want to completely remove the raw data, leaving only the summary information. The
Summary Outline Level dialog can do this also. To do this click on RAW DATA, then click on the trash can.

This will remove all of the data records. The level 1 summaries (in this case Category) will be turned into data
records. Level 2 summaries will be turned into Level 1, etc. Panorama will ask you to confirm before you
delete the raw data, and you also have the option to later Revert to Saved or use Time Lapse if it turns out
you made a mistake. Nevertheless, this feature is extremely dangerous, since it effectively deletes most of
your database. Handle with care!

click on the summary level you want to remove

then click on the trash can

click on the RAW DATA level

then click on the trash can
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Ranking Summaries

Panorama normally generates summaries in alphabetical order. By adding an extra rule to the Summarize &
Analyze dialog you can tell Panorama to rank the summaries by value. For example, if you are summarizing
by month they could be ranked to show the month with the highest sales (or spending, etc.) first, then the sec-
ond highest etc. Start by clicking on the + button in the outline level row of the dialog.

Panorama assumes that you want to rank by the field that is being totalled in this analysis (in this case Debit),
but you can choose another field if you wish. Then press the Apply button to see the ranked summaries.

For multi-level nested summaries you can use the outline level pop-up menu to pick which level is ranked.
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Whatever level you specified will be ranked. In this example, the category summaries are ranked within each
month.
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Ranking the summaries doesn’t affect the ability to expand detail. For example, now that the summaries are
ranked we can easily see that the purchasing category in May was a bit higher than usual. To find out why,
right click on the record and choose Expand One Level of Detail (or just click and choose the Expand tool).

Now we can see that there was a large purchase made to Stamford Manufacturing, raising the purchasing in
that month.

The ability to “zoom” in and out like this is a great tool for actually understanding your data.
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Additional Calculation Options 

The summaries shown so far have totalled a single field. However you can also perform counts, averages, etc.
and you can also perform calculations on multiple fields. To change the type of calculation, choose from the
pop-up menu.

To perform additional calculations, click the + button on the right.
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Then use the pop-up menus to choose the type of calculation (Total, Average, etc.) and the field to perform
the calculations on.

It’s possible to perform multiple calculations on the same field, for example both the total and the average, as
shown below.

Both calculations will be displayed in the preview (as shown above). However, when you press Apply only
the last calculation will appear in the database itself (in other words in the actual database only one calcula-
tion can be performed per field).

Hiding Non-Analyzed Fields

Sometimes a database will contain many fields but only a few are of interest for summaries or analysis. For
example this database has over a dozen fields but a typical analysis might include only two fields, Date and
Total.
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In this situation, simply check the Hide non-analyzed fields option.

When you press the Apply button, Panorama will automatically hide all of the fields that aren’t involved in
the summary or calculation. This makes it much easier to examine the summary information.

Sometimes you might want to leave one or more fields visible even if they aren’t part of the summary or cal-
culations. To do this, add extra rows to the analysis and specify Show for these fields, as shown below.
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The primary reason why you might want to show these additional fields is so that the raw data in the fields is
visible when you expand details of the summary, like this:

Of course you can customize which fields are visible at any time, see “Hiding and Showing Fields” on
page 209.
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Previewing Subtotals

The Summarize & Analyze dialog allows you to preview summary results right in the dialog. When you click
on a summary, the subtotal and preview areas update to reflect the item you clicked on. In the database
shown below, there were 120 orders placed in February 2010, for a total of $32,927.96.
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If you’ve grouped by multiple columns, you can click on multiple summary items to preview them. The illus-
tration below shows that there were 3 orders placed from Arizona in February 2010, and you can see exactly
who these orders were from. You can click around to preview any summary you like. If you click a selected
summary, it will become unselected (for example if you want to see the grand total again.)

Using this technique you’ll sometimes be able to get the answers you need right from the dialog, without
even pressing the Apply button.
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Managing Analyses

The tools in the upper left corner of the Summarize & Analyze dialog allow you to manage and easily re-use
previous analyses.

Clear Analysis — This button clears the current analysis, reseting the dialog. (If you press Clear Analysis by
mistake you you can press Previous Analysis to go back.)

Previous Analysis, Next Analysis — This pair of buttons allows you to go back to previously used analyses.
(Note: Only analyses that you actually "finalized" by pressing the Apply button are included in the list of pre-
viously used analyses.)

Favorites — This button displays a pop-up menu of favorite analyses, along with options for adding and
removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the favorite
from the menu.

The analysis is restored just as it was saved. You can use it as is by pressing Apply, or you can modify it first.
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To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.

Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.

Note: In addition to saving favorites, you can also include an analysis in a procedure by using Panorama's
recorder (see “Creating a Procedure with the Recorder” on page 212 of Formulas & Programming).
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Generating Summaries Manually

In addition to the Summarize & Analyze dialog you can also generate summaries “manually” step by step
with commands in the Analyze submenu. (This technique will be familiar to users of previous versions of
Panorama. The Summarize & Analyze dialog was introduced in Panorama 6.)

STEP 1 - GROUP

The first step in manually summarizing a database is to divide the database into groups or categories. For
example, a checkbook database could be arranged into groups by month (Jan, Feb, Mar, etc.), by budget cate-
gory (rent, food, transportation, etc.), or by payee (Evian Apartments, Lakeman’s Market, Unocal, etc.).

To divide a database into groups, first click anywhere in the field you want to group. Then use either the
Group Up or Group Down command (Records->Analyze menu) to divide the database. The Group Up
command arranges the data into ascending order—A’s first, Z’s last. The Group Down command arranges
the data in descending order, Z to A.

The Group Up and Group Down commands add a special summary record at the end of each group. Sum-
mary records are temporary records used for calculating and displaying summary information. On the data
sheet you can easily identify summary records by their blue background color, and by the fact that they are
usually displayed in bold.

Subgroups

Groups can be sub-divided into even smaller subgroups. For example if you had arranged a mailing list into
groups by state, you could further divide each state into subgroups by city. You can continue subdividing the
groups up to six times (up to seven levels of groups within groups).

To subdivide groups into smaller groups, first click on the field you want to sub-group, then use the Group
Up or Group Down command again.

When you are looking at the data sheet, you can identify the subgroup level by the size of the plus sign to the
left of the summary record. The lowest level subgroups have the smallest plus signs; the higher level groups
have larger plus signs. The grand-total record has the largest plus sign (see illustration above).

Grand Total

When you arrange a database into groups, Panorama automatically creates an additional summary record at
the bottom of the database. This summary record is for the largest group of all, the entire database. When
totals or other summary calculations are performed (see “STEP 2 - CALCULATE” on page 398), this sum-
mary record holds the overall grand total (or average, count, etc.) for all of the selected records in the entire
database.

darkness of blue background indicates summary level
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If all you need is a grand total (or average, count, etc.), you can skip Step 1 and go directly to Step 2, Calcu-
late. When a summary calculation is performed on a database that doesn’t have any summary records, Pan-
orama automatically appends a single summary record to the end of the database. It then calculates the
grand total (or average, count, whatever) in this summary record. The illustration below shows the result
after the Total command has been used without first grouping the database.

The Group Command

Unlike Group Up and Group Down, the Group command does not sort the database. The Group command
is useful when you want to add summary records to a database that is already arranged in the proper order.

Grouping by Week, Month, Quarter, or Year

When a group command is used on a field containing dates, Panorama will ask you how long each group
should be—a week, month, quarter, or year.

Select the period and press Group to arrange the data into groups. Note: The dates must be stored using the
date data type, not text. See “Dates” on page 255, for more information about the date data type.

You can group dates more than once—for instance first by year, then by month. This produces subgroups (in
this case by month) within the larger groups (by year).

Grouping a database by month, quarter, or year does not change the way the dates are displayed. You may
want to change the output pattern for the date field so that only the month, quarter, or year is displayed,
instead of the entire date. The output pattern is specified as part of the design sheet. To display only the
month and year, use an output pattern like Mon-yy or mm-yy. To display only the quarter and year, the pat-
tern could be qqqyy or Qtr “Qtr” yy. To display the year only, the pattern could simply be yy or yyyy. See
“Date Output Patterns” on page 255 for more information about date output patterns and how to set them
up.

If you print a database that is grouped by month, quarter, or year, you can use different summary tiles to for-
mat the dates properly. See “Printing Data Grouped by Month, Quarter or Year” on page 1148.
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Group by Color

The Group by Color command groups the database by the color of the data cells in the field. The database
can be divided into as many as seven groups—black, red, green, blue, cyan, magenta, and yellow. See “Data
Style and Color” on page 474 for details on how to assign colors to data cells.

Propagating Data into Summary Records

The Group commands create summary records but leaves most fields blank. The Propagate command can be
used to copy additional information into the newly created summary records. In the illustration below the
database has been Grouped by City.

Next we’ll fill in the State field for each summary record by choosing Propagate from the Math menu.

See “Propagate” on page 466 for more information on the Propagate command.

Manually Creating and Removing Summary Records

Summary records are normally created automatically with one of the three Group commands, and removed
with the Remove All Summaries command. You can also manually turn any normal data record into a sum-
mary record and vice versa, although this should rarely be necessary. In fact, we actively discourage the use
of this feature.

summaries filled in with Propagate
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To turn a normal data record into a summary record, click anywhere in the record in the data sheet, then
choose the Toggle Summary Level command in the Records->Analyze menu. Each time you choose this
command will toggle between normal and summary.

The Toggle Summary Level command allows you to create the lowest level of summary records, correspond-
ing to the smallest subgroup. If you want to create higher level summary records (for instance for grand
totals) hold down the Option key (Mac) or Alt key (PC) while you choose this command. As long as you hold
down the Option/Alt key, each click will increase the summary level of the record. You can continue increas-
ing the level until you get to the maximum level (seven). You can see the blue background get darker as the
level increases.

There is no way to go down one level at a time, but by releasing the Option/Alt key and choosing the Toggle
Summary Level command the line will turn back into an ordinary data record and you can start over.

If you want to select the summary records you have manually created, use the Select Summaries command.
See “The Select Summaries Command” on page 361 for details on this command.

Choose Toggle Summary Level  to convert it to a summary record

start with an ordinary record…

Choose Toggle Summary Level  again to convert it back to a regular record
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STEP 2 - CALCULATE

Once the database has been arranged into groups, the next step is to calculate the summary information. The
Records->Analyze menu has 5 different kinds of summary calculations).

To perform a calculation, first pick the field you want to calculate by clicking on it. Then choose the command
(Total, Average, etc.) from the Analyze menu. Panorama will calculate the summaries for each sub-group,
group, and for the entire database.

Total

The Total command adds up the data in the current field. It calculates subtotals for each group and the grand
total for the entire database. The Total command can only be used with numeric fields. If you attempt to total
a text, date, or choice field, Panorama will display a warning message.

Count

The Count command counts the number of non-empty data cells in the current field. If the database is
arranged into groups, it will also count the number of non-empty data cells in each group. Empty data cells
will not be counted. You can count any field containing either text or numbers, but dates cannot be counted.
(Date fields cannot be counted because Panorama would be unable to correctly display the result.)

Average

The Average command averages the data in the current field, calculating sub averages for each group and the
overall average for the entire database. Averages can only be computed for numeric and date fields. If you
attempt to average a non-numeric field Panorama will display a warning message.

Minimum

The Minimum command finds the smallest value in the current field. If the database is arranged into groups,
it will find the smallest value in each group and sub-group. The Minimum command can be used with text,
numeric or date fields.
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Maximum

The Maximum command finds the largest value in the current field. If the database is arranged into groups,
it will find the largest value in each group and sub-group. The Maximum command can be used with text,
numeric or date fields.

Recalculating Summaries

Summaries are not re-calculated automatically when the database changes. If the information in the database
changes, you must go back and use the Math menu to re-calculate. If the summary records have been deleted,
or if the categories have changed, you must remove the summary records and re-group the database before
you can re-calculate the new summary values.

Running Total

Running Total, which is part of the Vertical Data Tabulation dialog, is a special computation. Unlike the
other summary calculations, Running Total modifies every data cell in the active field, not just the summary
records. Like the Total computation, Running Total starts at the top of the database and adds up each data
cell as it moves down the column. Running Total, however, replaces each data cell with the current total. The
result is a field which contains the cumulative total at each point in the database. This is very useful for com-
puting checking account balances, sales year to date, and other cumulative statistics.

If you use the Running Total command on your raw data, the raw data will be destroyed in the process of
calculating the running total. We recommend that you avoid this problem by creating an extra field to hold
the running total. You can use the Manipulate Data dialog to copy the data into the field, and then use the
Running Total command without disturbing the original raw data.

Using Running Total to Balance a Checkbook

Let’s take a look at how to balance a checkbook using the Running Total command. Start with an empty Bal-
ance field.
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Use the Manipulate Data dialog (see “The Manipulate Data Dialog” on page 434) to calculate the how much
the balance changes for each line by subtracting Debit from Credit.

Press the Apply button to calculate.
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Now choose the Vertical Data Tabulation command from the Fields menu, and click the Running Total
option.



Page 402 Panorama Handbook
Press Apply to calculate the balance after each transaction.

You’ll need to repeat these steps when new transactions are added, or existing transactions changed. This
process can be automated with a procedure.

field Balance
formulafill Credit-Debit
runningtotal

See “Procedures” on page 203 of Formulas & Programming for more information on creating procedures.

Running Difference

Running Difference is the opposite of Running Total. Running Difference fills each data cell with the dif-
ference between the cell and the cell above it. Use Running Difference when you want to compute the
spread or interval between consecutive values, for example odometer readings or dates.

If you use the Running Difference command on your raw data, the raw data will be destroyed in the process
of calculating the running difference. We recommend that you avoid this problem by creating an extra field to
hold the running difference. You can use the Manipulate Data dialog to copy the data into the field, and then
use the Running Difference command without disturbing the original raw data. 
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Using Running Difference to Calculate Gas Mileage

Let’s take a look at how to balance a checkbook using the Running Difference command. Start with empty
Range and MPG fields.

Use the Manipulate Data command to copy the Odometer field into the Range field.
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Press Apply to copy the field.

Now choose the Vertical Data Tabulation command from the Fields menu, and click the Running Difference
option.
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Press Apply to convert the odometer readings into the distance between fillups.

Now we’ll calculate the actual miles per gallon. Move to the MPG field and use the Manipulate Data com-
mand to calculate the formula Range/Gallons.
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Press Apply and presto, the miles per gallon between each fill-up is calculated.

You’ll need to repeat these steps periodically as you continue to drive. This process can be automated with a
procedure.

field Range
formulafill Odometer
runningdifference
field MPG
formulafill Range/Gallons

See “Procedures” on page 203 of Formulas & Programming for more information on creating procedures.

STEP 3 - OUTLINE

Outlines are a way of organizing information into groups within groups. Panorama’s group commands re-
arrange your database into an outline structure. Tip: Unlike most outlines which start from the top, Pan-
orama’s outline is upside-down…it starts from the bottom.

Unlike a paper outline, a Panorama outline can be expanded or collapsed to show more or less detail. This
makes it easy to spot overall trends in your data, and then zero in on the details behind those trends.

Sorting by Summary Value

Once summary information has been calculated, you can sort the database so that the data is ranked in order
by the summary values. For example, the information in an invoice database can be summarized by customer
and then rearranged to rank each customer by sales volume. Once the data is ranked you can see who your
top customers are at a glance. The ability to rank summary information is a unique feature of Panorama.

The first step in sorting summary information is to calculate the summary information. To do this use the
group (see “STEP 1 - GROUP” on page 394) and summary calculation (see “STEP 2 - CALCULATE” on
page 398) commands already covered in this chapter.

The second step is to collapse the outline. Use the Summary Outline Level command to collapse the data-
base to the level you want to sort (see “Expanding and Collapsing the Summary Outline” on page 376).

Once the database is collapsed, the final step is to sort the database by summary value. Click on the field con-
taining the summary values and then choose Sort Up or Sort Down. Sort Down is the usual choice because it
ranks the summaries from highest to lowest.
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To illustrate this technique, we started by grouping and totalling the checkbook database by category.

As you can see, the subtotals are listed in alphabetical order. Use the Sort Down command to sort the subto-
tals so that they are listed in order from highest to lowest amount.
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After the database has been sorted, you can re-expand some or all of the outline if you wish. The detail infor-
mation for each summary follows the summary as it is sorted. (In other words, when the database is grouped
the sort commands sort the groups, not the individual records.)
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The real power of this technique appears when the database is grouped by multiple levels. For example, sup-
pose the checkbook database is grouped by month and by category, then collapsed to show the monthly
totals for each category. This is shown in the window on the left. On the right is the same database, but now
the Sort Down command has been used to sort the subtotals. The subtotals have been sorted within each
month. Now we can easily see that Purchases was the top spending category in January, March, and April,
but Advertising was tops in February (with Purchases dropping to number 3).

This technique is very powerful any time you need to rank summary information. You can quickly answer
questions like “Who are our top customers?” “What products had the most service problems last year?” or
“Which SKU’s are the best sellers in different seasons of the year?”

before Sort Down… after Sort Down
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Sorting Within Groups

If you sort your database without collapsing it, Panorama will sort the data within each group instead of sort-
ing the entire database. If you want to sort the summary values themselves, you must use the Summary Out-
line Level dialog to collapse the outline, as described in the previous section.

Printing Reports with Summary Information

You’ll often want to print reports with the summary information you have generated. In Panorama reports
are printed using forms and report tiles (see “Custom Reports” on page 1061). In addition to the standard
report tools Panorama also has special features for printing summary information. You can print special
headers and footers for each group, and can control how groups break across columns and pages. See “Print-
ing Summary Information” on page 1141 to learn more about how to use these features.

The Mini Statistics Wizard

In addition to the summary & outline tools described previously in this chapter Panorama also has a special
wizard to help with statistical analysis. This wizard can calculate the mean (average), median, and standard
deviation of a data set. In addition the wizard can plot a normalized chart showing how the data is distrib-
uted around the mean. You can easily see how this distribution compares with the standard gaussian distri-
bution (the famous bell shaped curve).

To use this wizard you’ll need a database that contains one or more numeric fields. To illustrate we’ll use a
database that contains medical data.



Chapter 10:Summaries and Outlines Page 411
To analyze the data, open the Mini Statistics wizard.

To set up the statistical analysis, start by selecting the database you want to use, in this case Diabetes Log.
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Now choose the field that contains the data you want to analyze, in this case BBLevel. (Note: The Field menu
only lists numeric fields — text, date and picture fields are not listed.)

After a couple of seconds the analysis will appear.

For these data points the mean (average) value is 121.6154. The standard deviation (∂) is 9.0405. The data set
contains 91 values, the median is 122, and the variance is 81.7312. The blue bars show how the data is clus-
tered around the mean, while the red line shows the normal gaussian “bell shaped curve” distribution.

If the original data changes you may want to update the analysis. You can either select the field again from
the Fields menu, or simply click on the chart.
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Saving a Statistical Snapshot

Once you’ve performed a statistical analysis on a set of data you can save a snapshot of that analysis for later
review. To save a snapshot of the current analysis choose New Snapshot from the Snapshot menu.

Enter a name for the new snapshot. (If you enter the name of an existing snapshot it will overwrite the old
snapshot.

When you press the OK button the new snapshot is listed in the Snapshot menu.

To see a snapshot you have recorded before simply select it from the menu.

Note: Snapshots are actually stored in a permanent variable in the database that contains the original data (in
this case Diabetes Log). This means that you will only see the snapshots for the currently selected database. It
also means that the snapshots are not permanently saved to disk until you save the original database to disk.
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Renaming and Deleting Snapshots

The Rename/Delete Snapshots command opens a dialog.

To rename a snapshot, click on it, press the Rename button, then type in the new name. To delete a snapshot,
click on it and then press the Delete button.

Printing a Statistical Analysis

To print a statistical analysis use the Print menu inside the window.



Chapter 11: Crosstabs

This chapter describes Panorama’s most powerful tool for analyzing and summarizing data—crosstabs. A
crosstab is simply a table with categories across the top and down the left, with numbers in the middle and
totals across the bottom and down the right.

The word crosstab is short for cross tabulation, referring to the criss-cross way that totals are tabulated both
across and down. Probably the most common example of a crosstab is a budget, with months or years across
the top, and spending categories down the left.

Before Panorama became available, crosstabs were usually created using a spreadsheet. Spreadsheets are per-
fect for totalling the rows and columns in the crosstab table. Unfortunately, spreadsheets cannot help with the
really tedious part of creating a crosstab table—taking the raw data, categorizing it, and converting it into the
crosstab table format. With a spreadsheet, this tedious number crunching must be done by hand.

Panorama automates the entire crosstab process from start to finish. Starting with raw data (a checkbook
database, for example), Panorama divides the data into categories and automatically creates and calculates
the entire crosstab table. When the raw data changes, the entire process can be repeated with a single mouse
click. A simple dialog sets up the whole process.

Panorama can also work a crosstab backwards, allowing you to locate the raw data associated with any
crosstab value. For example, if the crosstab table shows that July’s advertising expenditures seem a bit high,
simply click on that value and press the Select Original Data tool. The individual data records for July adver-
tising will appear.
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Panorama does not limit you to one crosstab table per database. Each crosstab table appears in its own win-
dow, and you can have as many different crosstabs as you need. Crosstab tables are created and opened with
the View menu.

Although each crosstab table gets its raw data from the main database, it is otherwise independent. Setting
up and calculating a crosstab table does not change the main database in any way.

list of crosstabs

create new crosstab
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Category and Tabulation Fields

A crosstab is based on three fields in the main database. Two of these fields are called category fields, and the
third is called the tabulation field. The two category fields are the fields that criss-cross across the top and left
sides of the crosstab table. The tabulation field holds the raw data that is counted or totalled in the center of
the crosstab table. In the example crosstab shown below, Date and Category are the category fields while
Debit is the tabulation field.



Page 418 Panorama Handbook
Creating and Setting Up a New Crosstab View

New crosstab views are created using the View menu. Choose New Crosstab from the menu. Then you must
give the new crosstab view a name (up to 25 characters) and press Ok to create the new view.

When a new crosstab view is created, the Crosstab Design dialog box automatically appears. This dialog
allows you to specify the category and tabulation fields (see previous section) and to specify what type of cal-
culation (total or count) to use.

To use the Crosstab Design dialog you copy fields from the list on the left over to the list on the right. The left
side lists all the fields in the database. The right side lists the fields in the crosstab. The first two fields copied
to the right become the two category fields. The third field becomes the tabulation field. As you build the
crosstab, a miniature schematic diagram of the crosstab appears in the lower right hand corner of the dialog.
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Let’s walk through the creation of a crosstab like the one shown at the beginning of this chapter. First, click on
the Date field and copy it to the right. (Hint: To copy the field either press the »Copy» button or double click
on the field name.

As you can see, the Date field now appears in the list of Crosstab fields. It also appears in the preview of the
final crosstab, showing that the Date will appear across the top of the crosstab.

Since we want the date to be grouped by month, select Month from the Date Period pop-up menu. (If you for-
get to do this now you can always go back and change it later.)

preview
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Next, copy the Category field into the crosstab. It will appear in the list and on the left side of the mini-dia-
gram, showing that the category will appear on the left side of the crosstab.

Now copy the Debit field into the crosstab. You’ll also need to click on the Total radio button, since we want
to calculate sums of the checks, not counts of the checks.
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Once you’ve specified the category and tabulation fields, press Ok to actually calculate the crosstab. Depend-
ing on the complexity of the database, there may be a delay of seconds or even minutes as the crosstab is cal-
culated. When the calculations are finished, the new crosstab table will appear. It will look something like
this.

You can use now adjust the window size, font, and column widths as you like.
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Crosstabs by Day, Month, Quarter or Year

If one of the category fields contains dates, you must tell Panorama what period to group by. The Date Period
pop-up menu has five choices: day, week, month, quarter, and year. You can also specify a pattern for dis-
playing the date in the crosstab. For example, months can be displayed as 1-04, Jan-04, or January 2004.

Panorama supplies a default pattern when you choose from the Date Period pop-up menu. You can use this
predefined pattern, or you can type in any pattern you want. See “Date Output Patterns” on page 255 for
more information about date patterns.

Changing the Crosstab Design

The crosstab design can be changed at any time by pressing the Crosstab Design tool. This brings up the
same dialog box you used to originally set up the crosstab.

To erase the entire crosstab design and start over, select all the fields in the CrossTab Fields list and press the
Remove button. (You can select all the fields by dragging the mouse over the list.)

If you want to change just one field, select both the old field from the CrossTab Fields list and the new field
from the Database Fields list. Then press the »Copy» button to change the field.

date pattern

crosstab design tool
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Re-Calculating a Crosstab

Crosstabs do not automatically update when the main database changes. This is because of the time it takes
to recalculate the crosstab. If you change the main database and want to re-calculate a crosstab, press the Cal-
culate Crosstab tool.

Adjusting Crosstab Column Widths

When a new crosstab is created, Panorama tries to assign an appropriate width for each column. You can
adjust these column widths the same way you would adjust the column widths in the data sheet. Move the
cursor over the column titles and drag left or right to adjust the width.

Whenever the crosstab is recalculated, Panorama automatically resets the width of every column except for
the first two. The third, fourth, fifth and all additional columns are all set to the same width as the second col-
umn.

Crosstab Font and Size

You can change the font and size of the crosstab with the Text Menu.

Selecting Original Data

Using the Select Original Data tool, Panorama can locate the raw data behind any value in the crosstab table.
To do this you must have a regular database window open in addition to the crosstab window, usually the
data sheet window.

calculate crosstab tool

select original data tool
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To select the original data, first click on the crosstab value you are interested in. Then click on the Select Orig-
inal Data tool, The original data is selected and will appear in the data sheet or other database window. For
example, you could click on the Mar 99 Office Supplies cell, then choose Select Original Data.

In the data sheet the raw data backing up this crosstab cell will be selected - in this case the seven checks writ-
ten for Office Supplies in March of 1999.
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You can select the original data for any value in the crosstab. If you click on a cell in the first or last column of
the crosstab, the Select Original Data tool will select all the data associated with the entire row. For example,
you could click on the Fixed Assets cell.

When you choose the Select Original Data tool, the data sheet will show all of the checks written for Fixed
Assets in every month.
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If you click on a cell in the bottom row of the crosstab, the Select Original Data tool will select all of the data
for the entire column. For example, you could click on the total for April 99.

When you choose the Select Original Data tool, the data sheet will show all of the checks written for April 99
in every category.

If you click on the grand total value in the lower right hand corner of the crosstab, the Select Original Data
tool will select the entire database.

To re-select the entire original database, activate a data sheet or form window, then choose the Select All
command from the Search Menu. Be sure to re-select the entire database before you re-calculate the crosstab.

Warning: If the database has been edited since the crosstab was calculated, the Select Original Data tool may
not be able to locate the original data. If the database contained invisible (unselected) data when the crosstab
was calculated, the Select Original Data tool may select this unselected data. If this is a problem, use the
Remove Unselected command before calculating the crosstab (see “Permanently Removing Unselected
Data” on page 360). Make sure you have a backup copy of your data on disk before you use this command.
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Crosstabs Based On Selected Data

To build a crosstab summary based on a subset of the database, use the Find/Select dialog before calculating
the crosstab. For example, you can include this year’s checks in a crosstab summary while excluding previ-
ous years. Be sure you select the data before you calculate the crosstab. (If you forget, just go back and select
the data, then recalculate the crosstab).

Crosstabs Containing Outlines

Most crosstabs have just two category fields—one across the top and one down the left side. It is possible,
however, to create a crosstab with two (or more) category fields down the left side of the crosstab. In that case
the category fields will be combined in an outline structure down the left side of the crosstab. You can use
Panorama’s outline tools to expand and collapse the crosstab to show more or less detail. See “STEP 3 - OUT-
LINE” on page 406 for more information on these outline tools.

To set up a crosstab with more than one category field down the left, you must copy additional fields into the
Crosstab Fields list. The first field is always the top category field, while the last field is always the tabulation
field. The fields in the middle are the left category fields. Here is on example of what the dialog should look
like when set up for a two level outline crosstab.
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This crosstab breaks down spending per month not just for each category, but also for each vendor within
each category.

Using the Outline Level command in the Sort Menu you can collapse the outline to show just the category
summaries (see “Sorting by Summary Value” on page 406).
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The collapsed outline looks kind of like our original, one-level crosstab.

There’s a big difference, however. We can use the Outline tools to selectively expand and/or collapse sections
of the crosstab (see “Expanding and Collapsing the Summary Outline” on page 376).

Don’t forget, you can click on any cell in any cell, including a summary cell, and use Select Original Data to
see the raw data that went into the cell.

Sorting a Crosstab

Crosstabs are automatically sorted by category. Use the Sort Up and Sort Down commands to sort the
crosstab by other columns.
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Removing and Renaming Crosstab Tables

To remove a crosstab table, choose Delete Crosstab from the Setup Menu (“Deleting a Form, Crosstab or Pro-
cedure” on page 183). To rename a crosstab, choose Rename Crosstab from the Setup Menu (see “Renaming
a Form, Crosstab or Procedure” on page 183). A crosstab name may be up to 25 characters long. You can also
change the order of the crosstabs within the view menu using the Re-Arrange Crosstabs dialog (see “Chang-
ing the Order of Forms, Crosstabs or Procedures” on page 183).

Exporting a Crosstab Table

Use the Save As command to export the data in a crosstab table. Type in a file name and choose the Text Only
option.

This brings up a second dialog allowing you to choose the columns you want to export and the export format
(tab delimited, comma delimited, etc.).

Press the Select All button to select all the columns, then press Ok to export the data. See “Exporting a Text
File” on page 105 for more information on the export dialog.
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Once the crosstab data is exported, you can import it into another program or back into another Panorama
database for further manipulation.
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Chapter 12: Data Processing

This chapter describes some of the most powerful commands in Panorama. These commands allow you to
automatically transform and modify large amounts of existing data. Many different kinds of transformations
are possible, including mathematical calculations, re-arranging characters or words, transforming individual
characters (for example converting from lower to upper case), and transformations based on patterns in the
data. Transformations can be performed on all kinds of data, including text, numeric, dates, and choices.

The commands described in this chapter are very powerful. In a few seconds you may be able to make
changes to your data that would otherwise require tedious hours of manual data entry. Like any power tool,
these commands should be treated with respect. For insurance, you should Save your database before you
begin trying to transform it (see “Saving a Database” on page 63). If you mangle your data, you can always
get it back with the Revert to Saved command (see “Total Recall (Auto-Save/Crash Recovery)” on page 66)
or using Panorama’s Time Lapse feature (see “Time Lapse” on page 67).

Transforming Selected Data

The transformation commands described in this chapter may be used on an entire database, or on a selected
subset. The Find/Select command (or the right-click context menu) is used to select the data you want to
transform, then the commands described in this chapter are used to transform the data. Only the selected
data will be transformed—the invisible data will be left untouched. See “The Find/Select Dialog” on
page 336 for more information on selecting a subset of the database.

The same rules apply to data that has been collapsed with the outline tools. If data is invisible because it has
been collapsed, it will not be transformed. Only data that is both selected and expanded will be transformed.
See “Summaries and Outlines” on page 365 for more information on outlines.
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The Manipulate Data Dialog

This dialog, in the Fields menu, is the workhorse of data manipulation. (If you’ve used previous versions of
Panorama, the Manipulate Data dialog replaces Fill, Formula Fill, Empty Fill and Sequence commands you
are used to.) When you first open this dialog you’ll see that it is split into three sections:

There are three components to a manipulation — the data source, the manipulations, and the destination. The
destination is the current field when the dialog is opened (to remind you, this field is shown in the title bar of
the dialog). Any data already in the destination field will be overwritten when you press the Apply button.

Specifying the Data Source

The first step in performing a manipulation is specifying a data source. There are four data source options:
Field, Text/Number/Date, Sequence and Formula. Use the pop-up menu to choose the source you want to use:
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Start with Field

You’ll usually want to manipulate data that is in an existing field in the database. Simply choose the field you
want to manipulate from the pop-up menu. The simplest manipulation you can perform is to copy the data
from one existing field to another. To illustrate this I’ll copy the data in this database from the Color field to
the X field. I start by clicking on the destination field, X.

Now I open the Manipulate Data dialog (either from the Field menu, or by right clicking the field name, or
by pressing Command-=). Then I choose the field I want to copy (Color) from the pop-up menu.

Once I’ve chosen the data source field the preview area shows what the result will look like. The BEFORE
area shows the current contents of the X field (which is empty), the AFTER area shows what it will look like
after the manipulation (in this case a copy of the Color field). The preview area always lets you know what is
going to happen before you actually commit to modifying the original data.

To actually copy the data I press the Apply button. Now I have two copies of this field.

Of course most manipulations are more complicated than this, but the basic steps remain the same: Click on
the destination field, open the dialog, choose the data source, choose the manipulations, then apply.
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Start with a Fixed Value (Text/Number/Date)

Choose this option if you want to fill all of the selected cells in the current field with the same value. For
example, suppose you wanted to mark all of the checks in this database as Posted.

The first step is to select only the records that should be modified -- in this case, with a check number larger
than 0. I can easily do that by right clicking on a deposit and choosing Select Larger.

As you can see, the 462 checks in this database are now selected, while deposits and other transactions are not
selected. Now I click anywhere in the field I want to modify, in this case Posted.

The database is ready to be manipulated. Open the Manipulate Data dialog and set up the options to fill
every record with the same, fixed value.

1) choose from pop-up menu 2) type in text, number or date (depending on type of destination field)
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Press the Apply button to modify the actual data.

Choosing Select All shows all of the records again. As you can see, the unselected records were not modified.

The new data must be compatible with the field that is being filled. For example, you cannot fill a date field
with n/a because n/a is not a date value. Panorama will warn you if you attempt to fill a field with an incom-
patible value.

Click on the red triangle to find out more information about the problem (in this case, Illegal Date).
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Starting with a Sequence

Choose this option if you want to fill the field with a incrementing or decrementing sequence, for example 1,
2, 3, 4, … 100, 110, 120, … 99, 98, 97, etc. When using this option you specify the starting value and the
amount to increase or decrease for each record.

The preview shows what the sequence will look like, so just play with the values until you get the sequence
you want.

Sequencing a Date Field

If the destination is a date field the start value must be a valid date (Panorama’s “smart dates” are allowed, so
you can specify today, yesterday, tomorrow, monday, tue, next tue, etc. This example will generate a sequence
every day starting with May 1st.

The example below generates a record for each week, starting with next Monday. If I wanted an event every
two weeks, I would change the 7 to 14.

1) start value 2) increment or decrement
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When manipulating a date field, an extra option appears in the Data Source pop-up menu — Start with
Sequence by Month. This option allows date sequences to be generated by months, quarters or years.

To generate the sequence by quarter, change the 1 to 3, for by year, change to 12.

Starting with a Formula

If none of the other options fit the bill you can use a formula as the starting point for your manipulation. Once
you learn how to use them, formulas give you incredible power for any kind of manipulation you want to do.
Formulas are covered in detail elsewhere (see “Formulas” on page 19 of Formulas & Programming), but let’s
look at a simple example to see how a formula can be used in this dialog. In this example the database has
three fields, First, Last and Name. The formula below combines the first and last names into a combined
Name field.

If you’ve used formulas in a programming language or spreadsheet before, this may look natural to you.
Otherwise, it probably just looks like a geeky mystery. Fortunately many common manipulations can be per-
formed simply by selecting from pop-up menus. Here’s an alternate method for combining the first and last
names:

The following sections will explain how to set up these kinds of simple non-formula manipulations.
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Manipulating the Data

Unless you’re doing something really simple like copying a field or filling with a fixed value, the second step
is to add one or more manipulations to your data source. To add a manipulation, press the + button on the far
right hand side of the dialog.

There are many standard manipulations you can choose from. Use the pop-up menu to pick the manipula-
tion you want to use.

add manipulation
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In most cases there will be one or two options you can specify to control the manipulation, either with a pop-
up menu or by typing in an option.

You can add up to seven manipulations, just keep pressing the + button.

When there are multiple manipulations they are performed in order from top to bottom. In some cases the
order of the manipulations may be important. You can insert a new manipulation in any spot by pressing the
appropriate + button, the new manipulation will be inserted just below the button you pressed. You can also
re-arrange the order of the manipulations by dragging on the arrows on the left hand side. Keep your eye on
the preview area to make sure that the manipulations are doing what you want them to.
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Manipulating Text

The types of manipulation you can perform varies depending on the type of data you are manipulating —
text, numbers or dates. There are about two dozen different manipulations available for text.

The following sections discuss each of these manipulation options.

Add Prefix/Suffix

This option allows you to add a prefix to the beginning of the text, or a suffix on the end, or both (as shown
below).
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Sandwich Prefix/Suffix

This option also adds a prefix and/or a suffix. However, unlike the Add Prefix/Suffix option, when the
“sandwich” option is used the prefix and/or suffix are only added if the source text is non-blank. In other
words, if there is no “meat” then this sandwich doesn’t include any “bread” either.

Add FIeld to End

This option appends a database field to the end of the manipulated text. It also allows you to specify “connec-
tor” text between the existing text and the field being added (in the example below the connector text is a
comma and a space).
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Panorama is smart about adding the connector text -- the connector is only added if necessary. In the example
below either the city or state is missing for some records. The connector is omitted in that case.

If necessary, you can append multiple fields, one after the next.
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Add Field to Start

This option is just like Add Field to End, but the field is added at the beginning of the manipulated text. In
the example below a space has been typed into the connector option.

Modify Capitalization

This option changes the capitalization of the text. Use the pop-up menu to select all upper case, all lower case,
or capitalization of the first letter of each word.

Strip Surrounding Blanks

This option strips off any extra blanks at the beginning or end of the text.

space
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Strip Surrounding Punctuation

This option strips off any punctuation at the beginning or end of the data. (Punctuation in the middle of the
data is left intact.) Punctuation is defined as any non-alphanumeric character, so this can be used to strip off
extra parentheses, braces, periods, question marks, spaces etc.

Eliminate Repeating Blanks

This option converts strings of two or more spaces in a row into single spaces.

punctuation in the middle is left intact
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Keep Alphabetic Characters

This option strips out all non-alphabetic characters. In other words, anything other than A to Z and a to z will
be stripped from the text.

Keep Numeric Characters

This option strips out all non-numeric characters. In other words, anything other than 0 to 9 will be stripped
from the text.

Keep Custom Characters

This option is more flexible than the previous two, but also a bit more complicated. It allows you to specify
exactly what characters to keep and what to strip out. The character to keep are specified as a series of charac-
ter pairs. The example below includes three pairs: AZ (A to Z), space-space (space) and az (a to z). The result
is that all characters except for letters and spaces are stripped.
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Here are some common pairs:

If you want to include a single character rather than a range, simply include that character twice to make a
pair. For example to allow semicolons use ;;, to allow exclamation points use !!. You can use as many pairs as
you need, but make sure there is no punctuation or spaces between the pairs (of course punctuation and
spaces can be used as part of a pair). Here are some typical custom character specifications you might want to
use.

Keep First

This option keeps the first few letters, words or lines of the data, removing the rest. For example, you could
use this to convert a name into an initial.

Pair Description

AZ Upper case characters

az Lower case characters

09 Numeric digits

Åü International characters

() Parentheses

!~ All non-blank characters

Spec Description

AZaz Alphabetic

AZ  az Letters & spaces

AZaz09 Alphanumeric

09()-- Phone numbers

09..++-- Positive or negative numbers

09// Dates (mm/dd/yy)

09::AAaaMMmmPPpp Times

$$09..-- Money (US)
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This might not seem that useful, but remember that you can combine multiple manipulations. Here I’ve
added a second step that gives us the first initial and last name.

I can edit the number of characters, in this example keeping the first 15 characters of the organization name.

The pop-up menu allows you to pick whether you want to keep text by character, by word or by line.
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Keep Last

This option is similar to Keep First, but keeps characters, words or lines at the end of the data. In this exam-
ple this option has been used to extract the last word from the organization name.

Remove First

This option removes characters, words or lines from the beginning of the text. In this example the first two
words (number and direction) have been removed from the address, leaving only the street name.

Remove Last

This option removes characters, words or lines from the end of the text. In this example the last word (Ave,
Place, Blvd, St. etc.) has been removed from the address.
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Keep Text Before

This option keeps the text before the specified matching text, discarding whatever is after. In this example
only text before the comma is kept. 

The matching text can be more than one character long, as shown here.
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Keep Text After

This option keeps the text after the specified matching text, discarding whatever is after. In this example
we’re keeping the ISP name, while discarding the user name.

The matching text can be more than one character long, as shown here.
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Replace

This option replaces a sequence of characters with another sequence of characters.

The original sequence of characters must match exactly, including upper and lower case. In the example
above it means that only Atty. will be replaced, not atty. or ATTY. For more flexibility in replacing text see
“Change (Find and Replace)” on page 472.

Insert Text at Spot

This option inserts one or more characters at a specified spot within the text. In this example we’re inserting a
dash before the 4th character of the phone number.

If the insertion spot is a negative number it is relative to the end of the text instead of the beginning.

text to insert (one or more characters) insertion spot
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Extract Between

This option is like a combination of Keep After and Keep Before. It returns text that is after the first matching
string and before the second matching string. In this example it is extracting the area code phone numbers.

The matching strings can be more than one character. This example extracts the name of the first image refer-
enced in the text (in this case the text contains HTML markup).

With one additional step I can extract just the name of the image, without the folder.
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Strip Tags

This option strips out all text that appears between beginning and end tags. If the tags are < and >, this option
will strip out all HTML markup from the specified text, leaving just the text itself.

The tags don’t have to be single characters. In this example only image tags are stripped out — all other
HTML tags will be left in the text.

Count

This option counts the number of characters, words or lines in the text. (If you use the lines option, Panorama
is actually counting the number of carriage returns in the text.)
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Add Sequence to End

This option adds a numeric sequence to the end of the text. You can specify the starting number and the
amount to increase or decrease for each record.

Formula

If none of the option so far will do the job then it’s time to pull out the big gun — a formula. You can use a for-
mula all on its own (see “Starting with a Formula” on page 439) but you can also use a formula in combina-
tion with other manipulations. When used this way, the «◊» symbol will expand into the text produced by
the previous manipulations. Then the result of the formula will be fed into any additional manipulations
below it. This example expands the abbreviations for North, South, East and West in an address.
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The «◊» symbol can be used more than once in the formula. This formula checks to see if the text contains a
comma, and if so, swaps it.

As you can see, formulas are very powerful, but there’s also a lot to learn. To find out more about the details,
see “Formulas” on page 19 of Formulas & Programming.

Manipulating Numbers

There are about a half dozen different manipulations available for numbers.

The following sections discuss each of these manipulation options.
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Add Number

This option adds a fixed value to each cell.

If you want to subtract, use a negative number.

Multiply by Number

This option multiplies each number by a fixed amount.

Multiply by Percentage

This option multiplies each number by a percentage.
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Add Field

This option adds another numeric field to the data source.

Subtract Field

This option subtracts another numeric field from the data source.

Multiply by Field

This option multiplies the data source by a numeric field.

Divide by Field

This option divides the data source by a numeric field.

Formula

For more complex calculations you can use a formula. You can use a formula all on its own (see “Starting
with a Formula” on page 439) but you can also use a formula in combination with other manipulations.
When used this way, the «◊» symbol will expand into the number produced by the previous manipulations.
Then the result of the formula will be fed into any additional manipulations below it. The example below cal-
culates the square root of X*Y.

To learn more about numeric formulas see “Arithmetic Formulas” on page 60 of Formulas & Programming.
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Manipulating Dates

There are about a just a handful of manipulations available for dates.

The following sections discuss each of these manipulation options.

Add/Subtract Days

This option adds or subtracts a fixed number of days to the data source.

Add/Subtract Months

This option adds or subtracts a fixed number of months to the data source.

Add/Subtract Years

This option adds or subtracts a fixed number of years to the data source. For example, I can easily bring this
sample data forward ten years.
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Formula

For more complex calculations you can use a formula. You can use a formula all on its own (see “Starting
with a Formula” on page 439) but you can also use a formula in combination with other manipulations.
When used this way, the «◊» symbol will expand into the number produced by the previous manipulations.
Then the result of the formula will be fed into any additional manipulations below it. For example, this for-
mula turns all dates into Mondays.

To learn more about date calculations see “Date Arithmetic” on page 106 of Formulas & Programming.

Managing Manipulations

The tools in the upper left corner of the Manipulate Data dialog allow you to manage and easily re-use pre-
vious manipulations.

Clear Manipulation — This button clears the current manipulation, reseting the dialog. (If you press Clear
Manipulation by mistake you you can press Previous Manipulation to go back.)

Previous Manipulation, Next Manipulation — This pair of buttons allows you to go back to previously used
manipulations. (Note: Only manipulations that you actually "finalized" by pressing the Apply button are
included in the list of previously used manipulations.)



Page 462 Panorama Handbook
Favorites — This button displays a pop-up menu of favorite manipulations, along with options for adding
and removing favorites. To select a favorite you’ve saved previously, just click on the star and choose the
favorite from the menu.

The manipulation is restored just as it was saved. You can use it as is by pressing Apply, or you can modify it
first.

To save a new favorite, first set up the query specification, then click on the star and choose Add to favor-
ites…

Enter a name for the new favorite.
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Your new favorite now appears in the pop-up menu.

To delete or rename a favorite, first select the favorite from the pop-up menu. Then choose Remove or
Rename, as shown above.

Note: In addition to saving favorites, you can also include a manipulation in a procedure by using Pan-
orama's recorder (see “Creating a Procedure with the Recorder” on page 212 of Formulas & Programming).

Show Formula — This button opens a small window that shows the internal formula associated with the
current query. Normally you would never need to use this, but it can be handy if you want to copy the for-
mula for use in a procedure.

The Modify Empty Cells Only Option

The Manipulate Data dialog normally modifies all selected cells when you press the Apply button. However,
if the Modify Empty Cells Only box is checked, only empty cells will be modified. Any cells that already con-
tain a value will not be changed. In the example below all empty cells are changed to n/a, while cells that
contain memos are left untouched.

Live Preview

The bottom section of the Manipulate Data dialog shows a live preview of the manipulations you have spec-
ified. (For speed, only the first 100 records are shown.) The preview is divided into two sections. On the left is
the original data in the field you are manipulating. On the right is the manipulated version of data. The pre-
view updates instantly as you modify the manipulation options, making it easy to see the effects of the
options you choose.

Note: If your data contains carriage returns, they will be displayed using the ¶ symbol.
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Customizing the Manipulate Data Dialog

The Manipulate dialog has several options that can be customized. To access these options, open the Prefer-
ences dialog, then click on the General Preferences button. This opens a window with many types of prefer-
ences, but at the moment we’re only interested in the Data Manipulation options.

The first option is Default to formula. If this option is checked, the dialog will initially default to Start with
Formula (instead of Start with Field) when it is first opened. If you are a formula wizard you may find this
option more convenient. This essentially makes this dialog default to behaving like the Formula Fill com-
mand in earlier (5.5 and before) versions of Panorama.

The Reset manipulation criteria option controls whether the Manipulate Data dialog starts fresh each time it
opens. If this option is checked, the dialog will always start empty when it opens, ready for a new manipula-
tion (you can recall the previous search by pressing the Previous Manipulation icon, see “Managing Manip-
ulations” on page 461). If this option is not checked, the dialog will start out with the previous manipulation.
You can then modify the manipulation, or you can start over by pressing the Clear Manipulation icon (see
“Managing Manipulations” on page 461).

Using the “Classic” Manipulation Dialogs

If for some reason you want to use the older (pre-Panorama 6) manipulation dialogs (Fill, Formula Fill, etc.),
open the Preferences dialog, then click on the General Preferences button. Then check the Use “Classic”
menus (Search, Sort, Math) option. This also enables the older search wizards: Live Clairvoyance, Search All
Fields, and Quick Search. For more information on these “classic” dialogs and wizards see the Panorama 5.5
documentation (available from the ProVUE web site).
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Vertical Data Tabulation

The Manipulate Data dialog manipulates each record independently. The Vertical Data Tabulation dialog,
on the other hand, manipulates data vertically across multiple records.

The dialog contains six vertical data manipulations options. Choose the option you want, then press the
Apply button.
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Propagate

he Propagate option fills all the empty cells in the current field, leaving the previously filled cells untouched.
The Propagate option propagates filled data cells into the empty data cells (if any) below them.

To illustrate, here is a database where the date was only entered for the first check written each day. For
example, checks 1907, 1908 and 1909 were all written on January 8th, but the date has only been filled in for
check 1907.

The Propagate command will fill in the empty cells, as shown by the arrows in this illustration.
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Here is the actual result after the Propagate has completed.

The Propagate Up command performs the same operation upside down, propagating filled data cells into the
empty data cells above them.

The Propagate command can be used to copy information into newly created summary records. The Group
Up command creates summary records but leaves all but one field blank. (see “STEP 1 - GROUP” on
page 394 for more information on the Group Up command.) Use the Propagate command to copy other
fields from the data records into the summary records. In this example the database has been grouped by city,
but not by state. This means that the State field in each summary record is blank.
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To fill in the state, click on the state field and choose the Propagate command.

You could repeat this process to fill in the zip code. (However, this may not generate the results you want
since some cities have multiple zip codes, as shown by Cambridge and Chicago in this example.)
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UnPropagate

This command performs the exact inverse of the Propagate command. If the same value appears in two or
more consecutive data cells, the Unpropagate command empties the second and subsequent data cells. Here
is a database that has been sorted by city.

The Unpropagate command eliminates all but the first entry for each city.
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The Unpropagate Up command performs the same operation upside down, leaving the last of several dupli-
cate values while clearing the others.

Using UnPropagate to Eliminate Duplicates

The UnPropagate command can be used to eliminate duplicate values in a database. The first step is to click
on the field that contains the potentially duplicate values, for example Name or Company. If you want to
eliminate duplicates over multiple fields (for example an entire address) you must create a new field and use
the Manipulate Data dialog to combine the data into a single field.

The next step is SortUp the database. This brings all the duplicate values together. For example, there are two
Bayshore Typesetting entries in this database.



Chapter 12:Data Processing Page 471
The next step is to UnPropagate with the Vertical Data Tabulation dialog. Wherever a duplicate value
appears in the data cell, the UnPropagate option clears the cell.

Now use the Find/Select dialog to select the non-empty data cells.

All of the duplicate records will disappear when you press the Select button. In this database there were two
duplicate companies, so there are now 120 selected (non-duplicate) records.

The final step is to permanently remove the duplicate records with the Remove Unselected command.
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It’s possible to create a procedure that will automatically perform all of these steps for you. This procedure
will remove all of the duplicate entries in the current field.

sortup
unpropagate
select «» <> ""
removeunselected

Tip: One possible problem with this technique is that all cells that start out empty will be removed. For exam-
ple if you are removing duplicate company names but some records don’t contain company names, the
records without company names will be removed. To fix this problem, use the Empty Fill command to fill the
empty names with a unique value like n/a before you start, then use Find/Select to select all values not equal
(≠ or <>) to n/a. Then perform the rest of the steps listed above. Here is a revised version of the procedure
that takes care of this problem.

emptyfill "!empty!"
select «» <> "!empty!"
sortup
unpropagate
select «» <> ""
removeunselected
formulafill ?(«» = "!empty!" , "" , «»

Warning: Keep in mind that all of these techniques will blindly remove all but the first duplicate entry. In this
example, there were two entries for Bayshore Typesetting. However, they were probably not really dupli-
cates, since one was in Washington, DC and the other in San Rafael, CA. There is no way for an automatic
technique like this to know which of these is really correct, or even if they are really duplicates at all. If you
want to manually examine duplicate records instead of blindly deleting them, use the Select Duplicates com-
mand in the Search Menu. See “Select Duplicates” on page 362 for more information on this command.

Change (Find and Replace)

The Change command (in the Search menu) finds and replaces a word or phrase in the current field. For
example, you can use the Change command to replace every occurrence of Inc. to Incorporated, or every
occurrence of Purchase Order to P.O.

The Change dialog allows you to specify the original (From) and the new (To) word or phrase.

The Adjust Capitalization option allows you to specify whether you want capitalization to be adjusted as the
word or phrase is replaced. If you check this option, Panorama will automatically adjust the capitalization of
the new word or phrase as it is inserted into the database. If you leave this option off, capitalization is not
adjusted. In fact, if the Adjust Capitalization option is off, only words or phrases that exactly match the capi-
talization typed into the dialog will be replaced. The table below shows the result of replacing Inc. with Incor-
porated with Adjust Capitalization both off and on.
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The Replace Entire Words Only option tells Panorama to replace only entire words, not sections of words. For
example, if you ask Panorama to change is to was, it will also change this to thwas. This is, of course, wrong.
To prevent this, just check the Replace Entire Words Only option.

Changing with the Replace( Function

The Change command is not the only way to replace words or phrases. You can also use the Manipulate
Data in Field command and the replace( or replacemultiple( functions (see “String Modification
Functions” on page 80 of Formulas & Programming). This technique is especially handy if you need to replace
several words or phrases at once. For example, consider the addresses in the database below.

Suppose you wanted to expand the abbreviations in these addresses: St. to Street, Dr. to Drive, etc. You could
do this by using the Change command over and over again. Or you can simply use the replacemultiple(
function to replace all of the abbreviations in one fell swoop.

Original Adjust Capitalization OFF Adjust Capitalization ON

 Inc. Incorporated Incorporated

INC. INC. INCORPORATED

inc. inc. incorporated
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Press Apply to replace all of the abbreviations at once:

See “Starting with a Formula” on page 439 for more information on using formulas to modify data.

Data Style and Color

In addition to the data stored in each cell, Panorama also keeps track of the style (plain, bold, italic, etc.) and
(to a limited extent) color (red, green, etc.) of each cell. Use the Style & Color command (Math menu) to
change the style or color of one or more data cells.

The Style & Color dialog allows you to specify what cells to change and what style or color to use.

Choose Cell to change the style or color of the current cell, Record to change the style or color of all the cells
in the current record, Field to change the style or color of all the selected cells in the current field, or All to
change the style or color of every selected data cell in every field.
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Let’s see how to underline an individual cell. Start by clicking on the cell you want to underline.

Now choose the Style & Color command, and click on Cell and Underline.

When you press OK, the cell will be underlined.

It’s easier to see the underline if you click on another cell.
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Using an almost identical process we can make an entire line bold. In the Style & Color dialog, choose
Record and Bold.

Press OK to make the record bold.

By choosing Field, Blue and Italic we can make all Phone Numbers appear in italic blue, as shown here.

Notice that the italic blue has overridden the bold applied in the previous example.
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For our final example we will go to a checkbook database and mark all insurance payments in green. Start by
selecting Insurance from the Category field. (See “The Find/Select Dialog” on page 336 for more information
on the Find/Select command.)

Now click on the Debit field, and choose the Style & Color command. Click on All and Green.



Page 478 Panorama Handbook
When you press OK everything visible will turn green.

Use the Select All command to see all of the records. The green insurance records are mixed in with the oth-
ers.
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A cell retains its style and color until the data is modified. Any data modification (editing, formula fill, etc.)
will cause the cell to revert to plain black.

Every data cell that is not plain black takes up an extra byte of storage. For example a database with 10 fields
and 500 records will expand by 5K bytes if you change every data cell to blue or italic (or both).

Displaying Data Style and Color in Forms

Panorama always keeps track of the style and color of every data cell. However, Panorama does not always
display a cell using its style and color! Why not? In a form, you can specify the permanent style and color of
any object using the Text and Graphics Menus. This permanent style and color usually overrides the style
and color of individual data cells.

If you want the style and color of data cells to override the permanent style and color, open the Form Prefer-
ences dialog (Setup Menu) and check the Use Data Style/Color. When this option is checked, the style and
color of the each data cell overrides the permanent style and color specified in graphic design mode. Note:
This option works only with data cells, it does not work with Text Editor SuperObjects. (See “Text Editor
SuperObject” on page 639 for more information on Text Editor SuperObjects.)

When you are using the data sheet, Panorama always displays the style and color of each individual data cell.

Accessing Style and Color in a Formula

Panorama formulas can use the fieldstyle( function to access both the style and color of individual data
cells. When combined with the Formula Find/Select command, these functions allows you to select data
based on its style or color. (See “The Select Summaries Command” on page 361 for more information on this
command.)

The basic syntax for the fieldstyle( function is:

fieldstyle(fieldname)

This function returns the style and color of a data cell— bold, italic, etc. The fieldname parameter is a string,
so it should usually be in quotes—for example fieldstyle("Price")="bold". If the data cell has more
than one style or color, this function will return all of them, for example red bold italic. Use the contains
operator (see “String Testing Functions” on page 78 of Formulas & Programming) to check for a specific style or
color, for example

select fieldstyle("Name") contains "italic"

To check if a cell is plain, use a formula like this

fieldstyle("Address")=""

For more information on this function see “FIELDSTYLE(” on page 5221 of the Panorama Reference.



Page 480 Panorama Handbook



Chapter 13: Introduction to Forms

Panorama has two interfaces for displaying and editing data — the data sheet and forms. So far most of this
manual has concentrated on using the data sheet. Starting with this chapter we’ll introduce a much more
flexible way to display and edit data: the form.

A single database only has one data sheet but it may contain many forms. You can design each form for a spe-
cific purpose, for example entering data, printing a mailing label, or printing a report.

The data sheet displays a fixed format of rows and columns. You can change the text font and the width of the
columns, but beyond that you don’t have any control over the data sheet’s appearance. Each form, on the
other hand, is completely customizable. You can (and in fact must) set up the placement of each item on the
form, including data, text and artwork. The form view is much more flexible than the data sheet view, but it is
also more work to set up. Here is a typical example of a form. Notice that the window name shows the data-
base name, Checkbook, followed by the form name, Plain Checks.
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Opening a Form

The View Menu lists all the views in a database, including forms. The pre-defined views appear at the top—
data sheet, design sheet, and flash art scrapbook. Next come the views you’ve created—forms, crosstabs, and
procedures. The View Menu also contains commands for creating your own new views—new form, new
crosstab, and new procedures.

To open a form within the current window, simply choose the form from the menu. You can flip back and
forth between different forms (or other views, like the data sheet) at any time.

Forms

Crosstabs

Procedures
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Opening A Form in a New Window

If you wish, you can open a form in a new window, allowing you to see two different views of the database at
once. To open a form in a second window the same size as the current window, hold down the Alt key while
you select from the View Menu. (If you are using a Macintosh, hold down the Control key.) The new window
will appear slightly below and to the right of the original window.

The new window will track the original window. Any changes made in this new window automatically
appear in all other windows, and when any navigation is done in one window (moving up or down within
the database) all of the other windows will follow along.

1) Start with one window

2) While holding down the Alt key (PC) or the Control key (Mac), make a
selection from the View menu.

3) The new window appears sightly below and to the right...
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Another technique allows you to control the exact size and position of the new window in advance. To use
this technique, hold down the Control key while you select from the View Menu. (If you are using a Macin-
tosh, hold down the Command key.) After you choose the view you want to open, the Window Options dia-
log will appear shown below. This dialog shows a miniature view of the entire computer screen, along with
the positions of every window.

The Options button in the Window Options dialog allows you to selectively eliminate up to four components
from a new window—the tool palette, scroll bars, and drag bar. See “Window Options” on page 172 for more
information about eliminating these components.

To define the position and size of the new window, simply drag a rectangle across the miniature screen, as
shown above. If you don’t get the position quite right, simply drag again. When you press the Ok button the
new window will open in the location you have specified.

New window

Original window
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Form Modes: Data Access vs. Graphic Design

Unlike other views, the Form View operates in two distinct modes—data access and graphic design. Data
access mode (also called “data mode”) is the default mode. In this mode you can view and display data, and
navigate through the database.

Graphic design mode (also called “graphics mode”) functions like an electronic drafting table. In this mode
you design the form by drawing lines, boxes, and other graphic elements. This mode is very similar to many
drawing and page layout programs. Graphic design mode is easily recognized by the rulers that appear at
the top and left edges of the windows.

To switch between data access and graphic design modes, click on the  tool. Each click on this tool toggles
the window between the two modes.

Toggle graphic/data modes

Display/Edit

Navigation Controls

Toggle graphic/data modes

Graphic tools

Movable graphics and textRulers

Graphic control strip
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Form Operation: Individual Pages vs.View-As-List

Panorama allows you to set up blank forms as individual pages or as a continuous sheet (view-as-list). When
forms are set up as individual pages you see one record at a time. You can flip through the records just as you
would shuffle through a stack of paper forms. All of the examples of forms you’ve seen so far are individual
page forms.

A view-as-list form displays data as a continuous sheet, as shown below. Instead of flipping from record to
record, you scroll up and down through the data in a manner similar to the data sheet. However, unlike the
data sheet, a view-as-list form allows you to arrange the data any way you like, and even include graphics in
the display. On the other hand, view-as-list forms are slower than the data sheet (because of the overhead in
displaying the graphics) and they are much more work to set up.

Unless you tell it otherwise, Panorama sets up a new form as individual pages. To convert the form to a con-
tinuous sheet you must use the Form Preferences command (Setup menu) to set the View-as-List option. You
will also have to define the boundaries of the form by setting up a data tile (and optional header tile, see
“Adding a View-As-List Header” on page 909). For more information about setting up view-as-list forms see
“Creating a View-As-List Form” on page 902.
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Creating a New Form

To create a new view, choose New Form from the View Menu. A dialog box will appear asking you to name
the new form. A form name may be up to 25 characters long and can contain any letter, number or punctua-
tion.

When you create a new form, it usually becomes the last form in the View Menu. If you wish, you can insert
the new view into the middle of the View Menu. To do this, check the Insert before button and use the pop-
up menu directly below the Insert before button to specify the position of the new view. You can also re-
arrange the order of the forms using the Re-Arrange Forms command in the Setup menu. See “Changing the
Order of Forms, Crosstabs or Procedures” on page 183 for more information on this process.
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Renaming a Form

To rename the currently visible form choose Rename Form from the Setup Menu. Type in the new name
(limit 25 characters) and press Ok.

Deleting a Form

To delete a form choose Delete Form from the Setup Menu. Since you cannot undo after you delete a view,
Panorama will ask you if you are sure before it actually deletes the form. Note: If the form is the only window
open for this database, Panorama will close the entire file when it deletes the form. To avoid this, open an
additional window (the data sheet or another form) before you delete the form.

You can also delete forms with the Re-Arrange Forms command in the Setup menu. This is the fastest way to
remove several forms at once. See “Changing the Order of Forms, Crosstabs or Procedures” on page 183 for
more information on this process.

Browsing the Database With a Form

When working with a normal form (as opposed to a view-as-list form) Panorama displays one record at a
time. You can navigate from record to record using the VCR style buttons in the tool palette.

If the form is taller and/or wider than the current window, you can use the scroll bars on the bottom and
right to slide the form around within the window. The form can also slide automatically as you tab from cell
to cell within the form.

First Record
Previous Record

Next Record
Last Record
Add Record

Delete Record

Scroll within form
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Browsing the Database With a View-As-List Form

When working with a view-as-list form, Panorama display several records at a time — one row per record.
You can click on any visible record to make it active, or use the vertical scroll bar to move to any record
within the database (just like the vertical scroll bar in the design sheet). You can also use the up and down
arrow keys to move up or down one record at a time.

If the form is wider than the window, you can use the horizontal scroll bar at the bottom of the window to
slide the form left or right within the window. See “View-As-List Forms” on page 899 to learn how to create
view-as-list forms.

Current cell or 

Scroll left or right within form

Scroll from
record to record

record is reversed.



Page 490 Panorama Handbook



Chapter 14: Graphic Design

Panorama has a built in graphic editor for creating and modifying the layout of forms and reports. If you’ve
used an object oriented graphic editor before you will find many familiar features.

Graphic Objects

Panorama forms are built with graphic objects (also called simply objects). Each object is treated as a unit
(rather than as a collection of dots), and each object has a specific shape, position, size, and color. You can eas-
ily modify an object without disturbing the other objects—for instance sliding a rectangle to a new position
or changing the diameter of a circle. Most of the next few chapters deals with techniques and shortcuts for
arranging graphic objects on the surface of the form.

Types of Graphic Objects

Panorama has over two dozen different types of graphic objects. Objects fall into five classes: Shapes, Text,
Multi-Media, Buttons, and Layout. Each type of object has its own characteristics and appearance, as shown
in the following table.

Class Samples Object Tool Description

Shapes

Line Simple line at any angle.

Rectangle Simple rectangle, may be filled or 
transparent.

Round Rectangle Rectangle with curved corners.

Oval Oval (or circle), may be filled or 
transparent.
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Text

Click Text Displays simple text captions.

Auto Wrap Text
Displays one or more paragraphs 
of text. May contain fields or vari-

ables merged within the text.

Text Display

Displays text based on a formula. 
The text can scroll within the 

object, may be aligned in 9 different 
positions within the object, and can 
scale based on the size of the form.

Data Cell

Used for editing fields. When dou-
ble clicked, an expandable pop-up 

editing box appears (similar to 
editing in the data sheet).

Text Editor

Used for editing fields or variables. 
Unlike the Data Cell, there is no 
pop-up editing box (more like 
other software applications).

Word Processor

Used for editing a field or variable 
containing stylized text. The text 
may contain different fonts, sizes, 

styles, margins and tab stops.

Multi-
Media

Picture none Displays a fixed image. May be 
used for backgrounds, logos, etc.

Flash Art

Displays changing images (PICT 
format) based on a formula. Images 

may be part of the database or 
stored as separate files on the disk.

Super Flash Art

Displays images or QuickTime 
movies with advanced features like 

scroll bars, advanced alignment 
and scaling, and hypertext.

Chart Displays column, bar, line, area, 
scatter and pie charts.

Flash Sound Automatically plays sound
(Macintosh only).

Class Samples Object Tool Description
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Buttons

Button

Generic button tool for creating 
push buttons, radio buttons and 

checkboxes (fields only). (For new 
applications we recommend the 
new button tools listed below.) 

Push Button 2 and 3 dimensional push buttons 
in a variety of styles.

Data Button

2 and 3 dimensional checkboxes 
and radio buttons in a variety of 

styles. These buttons may be tied to 
a field or a variable.

Sticky Push Button
2 and 3 dimensional buttons that 
look like push buttons but act like 

checkboxes or radio buttons.

Pop-Up Menu
Pop-up menu tied to a field or vari-

able. May use any font, text size, 
color, or number of columns.

List Scrollable list.

Flash Art Push Button Push button with custom artwork.

Flash Art Data Button Checkbox or radio button with cus-
tom artwork.

Scroll Bar Standalone scroll bar.

Layout

Tile Used for report and view-as-list 
layout.

Super Matrix

Display a repeating matrix that 
may contain graphics and data. 

Options include grid lines and the 
number of rows and columns.

Auto Grow
Adjusts other objects as window 
size changes, making the form 

“elastic.”

Class Samples Object Tool Description



Page 494 Panorama Handbook
Creating a Graphic Object

To create a new graphic object, first click on the appropriate tool in the tool palette. For example, to draw an
oval you would click on the Oval tool.

Then move the cursor onto the form and drag the mouse across the surface of the form to define the location
and size of the new object (the dragging motion is shown by the dashed arrow in the illustration below). A
gray outline of the new object will follow the mouse.
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When you release the mouse, the new object will appear.

Each time you drag across the form you will create a new shape. When you are finished creating shapes, click
on the Pointer tool.

Don’t forget to click on the Pointer tool when you are done! If you don’t, the next time you click you will
create another graphic object.
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The procedure for creating more complex objects is the same as for simple objects: 1) select the tool, 2) drag
the mouse across the form. However, when you release the mouse after creating a more complex object a dia-
log will appear allowing you to configure the new object. Each type of complex object has its own dialog. For
example, here is the dialog for creating a push button.

Rather than describing the dialog for each type of item here, each will be described in detail later along with
the corresponding objects.

Creating Perfect Squares, Circles and Lines

If you press the Shift key while you create a rectangle or oval, Panorama will automatically force the new
shape to be a perfect square or circle. The Shift key was used to create the illustration below.
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If you press the Shift key while creating a line Panorama will force the alignment of the new line to a multi-
ple of 45 degrees (0°, 45°, 90°, 135°, etc.).

Customizing the Tool Palette

There are a total of 29 graphic tools available for use in Panorama. Many computer screens are not large
enough to handle this complete palette of tools (and we expect the number of tools to increase in future ver-
sions). To get around this problem, Panorama allows you to customize the graphic tool palette on the fly. You
can configure the palette to contain only the tools that you need right now in any order you want. If your
needs change later, you can simply reconfigure the palette at any time.

To customize the graphics tool palette, choose Tool Palette from the Setup menu.

Tip: You can also open his dialog by holding down the Command key (Macintosh) or Control key (Win-
dows) and clicking anywhere in the graphic tool palette.

Click anywhere in the tool palette
while holding down the
Command key (Macintosh)
or Control key (Windows)
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The Configure Tool Palette dialog contains two lists of tools. On the left is a list of all tools available.

On the right is a list of the tools you currently have installed. If this list is empty, Panorama will use the
default tool palette (which is the original tool palette from Panorama II). Tools can be moved into the palette
on the right either individually (one at a time) or in groups. To move an individual tool from the left to the
right, double click on the tool in the left. Or you can select the tool (or tools) and press the Move or Insert but-
ton.
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To move an entire group of tools at once press the Basic, Advanced, Programmer, Reports or “Classic” but-
tons. The table below shows the tools included by each of these options.

To delete one or more tools from the right hand list, select the tool(s) and press the Delete button. You can
also delete a tool from the right hand list by double clicking on it. The Delete All button clears the list on the
right so you can start over or go back to using the default tool palette.

Here is an example of a custom palette configuration:

Basic Advanced Programmer Reports “Classic”
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When you press the OK button the new palette configuration will become active, like this.

If you need to change the tool palette again later, just open the dialog again and make the necessary adjust-
ments.

Using the Keyboard to Select Common Tools

Usually you will use the mouse to select the tool you want to use. The most common tools, however, can also
be activated with the keyboard. This saves you a trip to the tool palette each time you want to select one of
these tools. The table below lists the tools that can be selected with the keyboard. Note that these keys are
pressed by themselves — not in combination with any other key.

Tool Key Notes

Press the Escape key to toggle between Graphics Mode
and Data Access Mode (disabled if tool palette has been disabled)

P Press the P key to select the Pointer tool
(except when typing or editing text with the T tool).

œ Press the Enter key to select the Pointer tool
(at any time, even when typing or editing text with the T tool).

= Press the= key to toggle the crosshair cursor on/off
(See “Nudging to the Crosshair Cursor” on page 515)

T Press the T key to select the Text tool

L Press the L key to select the Line tool

R Press the R key to select the Rectangle tool

O Press the O key to select the Oval tool

custom tool palette
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SuperObjects

The astute observer will notice that the list of tools in the configuration dialog is divided into two groups -
gray tools and purple tools. The purple tools are actually not built in to Panorama, but are special plug-ins
called SuperObjects. Because they are written as plug-in tools, ProVUE can develop new SuperObjects faster
and with more capabilities than for standard objects. You can expect to see many more SuperObjects added to
Panorama in the future. You may also notice that some SuperObjects perform functions similar to regular
objects, but with more features. However, as far as you, the user, are concerned, you don’t really have to
worry about whether an object is a SuperObject or not. The techniques for creating and modifying SuperOb-
jects and regular objects are the same.

Modifying Objects

Once an object is created it is far from being cast in stone. At any time you can go back and move, resize,
change the color, change the alignment, or make virtually any other change. You can change objects one at a
time or in groups. About the only change you cannot make is changing an object into another type of object
(for example, you cannot change a square into a circle or change a rectangle into a pop-up menu).

Selecting a Single Object

Before you can modify an object (change its size, color, pattern, etc.) you must select the object. Selecting an
object (or objects) tells Panorama that you want to work with that object. The Pointer tool is used for selecting
objects. If the Pointer tool is not highlighted, click on it before you try to select an object. One of the most
common mistakes made by new users is to try to select an object when a tool other than the Pointer tool is
highlighted.

There are two ways to select an object. The simplest is to click on the object. When an object is selected, han-
dles appear at the corners of the object. The handles let you know the object is selected and waiting for you
to do something with it.

Make sure Pointer
is highlighted

Click in object
to select it Handles at corners

indicate that this object
is selected

These objects are
not selected,
so they do not
have handles
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If an object is hollow (transparent, or filled with NONE) you must click on the border of the object to select it.
Objects with thin borders may be difficult to click on. If you find it too difficult, remember that you can also
select an object by dragging a selection marquee around it (see the next section).

It’s possible for one object to be hidden behind another object, making it impossible to click on. See “Selecting
a Completely Hidden Object” on page 570 to learn how to select hidden objects.

Selecting Multiple Objects at Once

Sometimes you may want to modify several objects at a time. You can select multiple objects by clicking on
each object while holding down the Shift key, or by dragging a selection marquee around the objects. (You
can also unselect an object that is already selected by holding down the Shift key and clicking on it.)

The selection marquee is simply a dotted line that appears when you drag the pointer across the surface of a
form. The marquee is like a lasso—it selects any object that is completely enclosed within it. In this example
the marquee is used to select two objects while leaving a third unselected.

Click on the edge...

Not in the hollow center

Start on empty spot
and drag marquee around objects
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When you release the mouse the two rectangles will be selected.

To drag a marquee you normally need to start on an empty spot on the form. If an empty spot isn’t conve-
nient, just hold down the Space Bar and drag the marquee. Holding down the Space Bar removes the stem
from the cursor arrow and disables clicking on objects, allowing you to drag a marquee anywhere.Either way,
drag the marquee all the way around the objects you want to select. Only objects that are completely inside
the marquee will be selected. In this example we’ll select the three smaller objects but not the large orange
rectangle.

Hold down Space Bar
and click anywhere to
start dragging,
even on top of an object

When the Space Bar is pressed,
the cursor arrow loses its tail
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When you release the mouse, the three objects inside are selected. The large orange rectangle is not selected
and has not moved.

Of course this is not the only way to select these three objects. You could hold down the Shift key while you
clicked on each object, or in this case you could start dragging from the empty area at the bottom or right, like
this.
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Double-clicking is another shortcut for selecting multiple objects. Double-clicking on an object selects all the
objects inside the object as well as the object itself.

There’s one more way to select multiple objects. The Select All Objects command in the Edit menu will select
every object in the form. (To unselect all objects, click on an empty spot within the form.)

The Graphic Control Strip

When a Panorama form window is in graphic design mode, a graphic control strip usually appears along the
bottom of the window. The graphic control strip occupies some of the space that is normally used by the hor-
izontal scroll bar. (If the window is too narrow for both the horizontal scroll bar and the graphic control strip,
the control strip will disappear.)

Double click anywhere within an object to select the object
and any objects within the object

These objects
are not within
the double
clicked object,
so they are
not selected

Graphic Control Strip
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The graphic control strip displays information about the currently selected object or objects (if any), and also
allows you to easily change some of the properties of the currently selected objects with pop-up menus and
dialogs. The complete graphic control strip has eleven elements.

If the window is not wide enough for all seven of these elements, the control strip will automatically adjust to
show fewer elements. When this happens, an extra triangle icon appears at the end of the control strip. Click-
ing on this icon cycles through the Font/Text Size, Dimension, and Object Type/Object Name control strip
elements (the first four elements are always visible unless the window is extremely narrow).

Rulers

The graphic editor always displays rulers along the top and left sides of the graphic window. The rulers
always start from zero in the upper left hand corner of the entire form (not the window). An indicator in each
ruler follows the mouse as you move it across the form. These indicators help you measure objects. Note: The
rulers do not represent where an object will be printed on a piece of paper. They are only a convenience for
sizing and positioning objects on the screen.

The rulers usually show measurements in inches. Click on the box in the upper left corner to toggle between
different measurement units—inches, centimeters, pixels, pica and elite.

Color

Line Width

Line Pattern

Fill Pattern

Text Size

Font

Location

Height
Width

Object Name

Object Type

Click here to change ruler measurement units
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Clicking once changes the ruler to centimeters.

A second click changes the ruler to pixels. A pixel is one screen dot, or 1⁄72 inch.

Pica (1⁄6 inch) and elite (1⁄12 inch) rulers can be handy for designing graphics that need to be overlaid on pre-
printed forms.
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You can also change the measurement units with the Form Preferences dialog in the Setup menu.

Use the Form Preferences dialog if you want to permanently change the default measurement units for this
form.

Moving a Single Object

There are several ways to move a single object, including dragging, nudging, and using the dimensions dia-
log. To drag an object, the Pointer tool must be highlighted. Press on the object, then drag the object to its new
position. If you drag the object near the edge of the window, the form will automatically scroll.
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When you release the mouse, the object will move to the new position.

If an object is hollow (transparent, or filled with NONE), you must click on the border of the object to drag it. 

If you want to move the object horizontally or vertically (but not diagonally), hold down the Shift key as you
drag the object. When the Shift key is held down you won’t be able to drag an object diagonally, as shown
below.

If you don’t have far to go you might consider nudging the object instead of using the mouse (see below).
This allows you to exactly position the object or handle in one pixel (or less) increments.

Nudging an Object (or Objects)

You can use the arrow keys (¯, ˘, ¿, ˜) to nudge selected objects into position. Each time you press an
arrow key, the object (or objects) moves one pixel in the direction of the arrow.
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For even finer adjustments you can reduce the nudge distance using the Forms Preferences dialog. (Setup
menu). Using this dialog you can set the nudge distance to 1⁄8, 1⁄4, 1⁄2, or 1 pixel.

Nudge “Auto Guides”

As you nudge an object (or objects) Panorama checks to see if the object is aligned with any other objects on
the form. When an alignment occurs a blue guide line briefly appears. In this illustration the guide line
appeared as the purple oval was nudged to the left, the guide automatically appeared when the left edge of
the purple oval was aligned with the left edge of the pink oval.
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The automatic guide will disappear when you click the mouse or press any key, or it will simply disappear by
itself after a few seconds. If more than one edge is aligned the multiple guide lines will appear, like this.

The alignment doesn’t have to be top to top or left-to-left, if any edge of the nudged object(s) aligns with any
edge of any other object the guides will appear.

The guides can also appear when nudging an object’s size, see “Nudge Size “Auto Guides”” on page 514.
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Viewing and Setting Exact Object Dimensions

If the window is wide enough, the Graphic Control Strip will show the exact location and size of the cur-
rently selected object. (This is only valid if a single object is selected — it does not reliably display the location
or size of multiple objects.) To see the exact location and size of any object, simply click on the object.

The Dimensions dialog allows you to display and change the exact dimensions of any object. To use this dia-
log, simply select an object and click on the dimensions in the Graphic Control Strip (you can also choose
Dimensions from the Edit menu).

The Dimensions dialog gives you the choice of absolute or relative dimensions. Absolute dimensions dis-
play the position of all four corners of the object, that is each corner’s position from the top left corner of the
form. Relative dimensions display position of the top left corner of the object along with the size of the
object; that is, the relative distance from the top left corner to the bottom right corner. Use relative dimensions
when you want to move an object without changing its size, or change the size of an object without moving
it. (Note: When using Relative dimensions, the object’s height and width must have a + symbol in front of the
number, as shown above.)

The Dimensions dialog can work with dimensions in inches, centimeters, or pixels. The dialog will default to
the current ruler measurement units. (See “Rulers” on page 506 to learn how to set the ruler units.) Dimen-
sions in inches or centimeters will be rounded to the nearest 1⁄

576 inch (0.017 inch).
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Changing the Size of a Single Object

To change the size of an object, first select the object with the Pointer tool. Then use the mouse to drag one of
the corner handles. As you drag the handle, an outline of the object will follow the mouse. Release the mouse
when the corner is in the correct spot.

If you want to change the width or height of an object (but not both at once), hold down the Shift key while
you change the size. Holding down the Shift key prevents the corner from moving diagonally.

Nudging the Size of an Object

The arrow keys (¯, ˘, ¿, ˜) usually nudge the entire object. However, after you click or drag a handle,
the arrow keys will nudge just that handle. Each time you press an arrow key the handle will move one pixel
in the direction of the arrow. In other words, each time you press an arrow key the object will grow (or
shrink) one pixel in the direction of the arrow (or less than a pixel if you have changed the nudge distance
using the Form Preferences dialog).

Let’s look at the procedure step by step. Start by clicking on the object whose size you want to adjust.
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Now click on the corner you want to adjust.

Use the arrow keys to adjust the size of the object in small increments. In this case we pressed the ¿ and˘
keys about half a dozen times each.

As soon as you click on another object, the arrow keys go back to nudging the entire object instead of just the
corner.

Nudge Size “Auto Guides”

As you nudge the size of an object, Panorama checks to see if any of the edges of the resized objects are
aligned with the edges of any other objects. If any edge is aligned a temporary blue guide appears. In this
illustration the lower right hand corner of the pink square has been nudged, and is now aligned in two direc-
tions with the yellow rectangle.

For more information on auto-guides, see “Nudge “Auto Guides”” on page 510.
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Nudging to the Crosshair Cursor

You can use the Crosshair cursor to help you nudge objects into alignment. (However, this technique is usu-
ally not necessary now that Panorama has automatic guides that appear when nudging (see “Nudge “Auto
Guides”” on page 510) so you may want to simply skip this section.) Start by clicking on the Crosshair tool to
turn on the crosshairs.

Select the object you want to nudge,

then move the crosshair to the desired spot.
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Use the arrow keys to nudge the object until it is aligned with the crosshair. In this case we nudged the entire
object, but we could also adjust the size by clicking on the corner as described in the previous section.

Finally, turn off the crosshair by clicking on the Crosshair tool again.

Percentage Scaling

Use the Scale command (Arrange menu) to expand or shrink an object by an exact percentage.

You can choose one of the pre-defined scales or type in any percentage between 1% and 999%.

Resizing Without Handles

Dragging on the inside of an object normally moves the object. But if you hold down the S key (the letter S)
while you drag, dragging on the inside of an object resizes the object—just like dragging on a handle. This
feature can be very handy when you are working on a cluttered form—the handle you want may be hard to
find. To remind you that the S key is pressed, the cursor turns into a hollow arrow. When you release the S
key Panorama will go back to normal operation.
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This operation is easier to see than to explain with words. Here’s what happens when you drag on the object
normally — it simply moves:

But if you hold down the S key (the letter S) while you drag, the object will change size instead of moving.
(Notice the hollow mouse arrow.)

When you release the mouse the object will expand or shrink.
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Here’s another way to view the operation of the S key. When you press this key, Panorama behaves as if the
handles at the corners of the object had expanded to fill the entire object. No matter where you click, you are
clicking on a handle. Therefore, you cannot drag the object, but only resize it. The four colored rectangles in
the illustration below symbolize the expanded handles (actually, they would be slightly bigger than this, so
that they would cover the entire object).

If you want to change only the width or height of the object, but not both, hold down the Shift key at the
same time as you hold down the S key. This will prevent the object from changing size diagonally.

Changing the Radius of Round Corners

Rounded rectangles have an extra handle in the upper left hand corner.

extra handle
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This handle is used to adjust the radius of the corner. Drag the handle towards the center of the rectangle to
increase the radius, drag it towards the corner to reduce the radius.

The new radius will appear when you release the mouse.

You can drag the corner diagonally if you want an elliptical corner. Hold down the Shift key if you want a
circular corner.

Removing Objects

To completely remove one or more objects from the surface of the form first select the objects (See “Selecting
a Single Object” on page 501 and “Selecting Multiple Objects at Once” on page 502). Then choose Cut or
Clear from the Edit menu. Cut places the object on the clipboard so that it can be pasted back into the form in
a new location. You can also remove the object by pressing the Delete or Backspace key (this is the same as
choosing Clear). 

Modifying Object Attributes

New objects are usually white with a thin black border. To customize an object you can change the fill pattern,
border (pen) pattern, line thickness, and color. You can customize these with the Graphic Control Strip or the
Graphics menu.
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Solid, Outline and Hollow Objects

The first three choices in the Graphics menu, Solid, Outline and Hollow, set the fill and line patterns of the
selected objects to their most common choices, as shown in the diagram below.

Solid objects are colored all the way through. Outline objects are filled with white with a colored border. Hol-
low objects have a colored border but a transparent center.
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Fill Pattern

The Fill Pattern menu in contains 40 different fill patterns.

To fill the inside of an object with one of these patterns, first select the object (or objects), then choose the pat-
tern from the Fill Pattern menu. When you release the mouse the object(s) pattern will change.

Click here to set the fill pattern

…or select from the Graphics Menu
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To make a hollow (transparent) object, choose the empty pattern in the top left corner of the Fill Pattern sub-
menu.

Here’s the transparent object.
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Line Pattern

The Line Pattern menu contains 40 different patterns that can be used to draw lines and borders. Only a few
of these patterns are really useful for drawing lines.

To create a dotted horizontal or vertical line choose one of the diagonal patterns.

Click here to set the line pattern (or use the Graphics Menu)
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The most common line pattern is basic black. If you want an object with no border at all, choose the empty
pattern in the top left corner.

The result is an object without a border.
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Line Width

The Line Width menu contains seven different line/border thicknesses from 1⁄4 to 6 points.

When you release the mouse the line width of the object will be updated. Notice that the object’s line width
also appears in the Graphic Control Strip.

click here for line width menu (or use the Graphics Menu)
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The top spot in the menu, which appears to be empty, actually represents a 1⁄4 point line (1⁄300 inch) hairline. 

Hairlines can be printed on Postscript laser printers and imagesetters— on the screen and on other types of
printers hairlines will appear as ordinary 1 point lines.

Color

The Color menu contains 256 colors. To color an object, first select the object with the Pointer tool, then pick
the color from the menu.

hairline

click here to set the color (or use the Graphics Menu)
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When you release the menu the object(s) will change color.

To choose a color that is not one of the 256 colors in the palette, use the Choose Colors command in the
Graphics menu. The system’s standard Color selection dialog will appear, allowing you to choose any of mil-
lions of colors.

You can also open this dialog by holding down the Control key (Mac) while clicking the color swatch in the
Control strip. On PC systems you can right click the swatch.
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Copying and Pasting Colors

Sometimes you’ll want one object to exactly match the color of another object. You can use the Copy Color
and Paste Color commands to transfer a color from one object to one or more other objects.

Start by selecting the object that has the color you want, then choose the Copy Color command. This copies
the color into a special clipboard. Now select the other objects that you want to set to this color and choose
the Paste Color command. The selected objects will change to the same color as the original object. (Note: The
color clipboard is completely separate from the normal clipboard that is used for other copy and paste opera-
tions.)
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Font

The Font menu lists all the fonts installed on your system. To change the font of an object that contains text,
first select the object with the Pointer tool, then pick the font from the menu.

When you release the mouse the object will change to the new font.

You can use the Font Usage Wizard to display a list of all the fonts used in every form in your database. See
“Font Usage” on page 50.

Maintaining Fonts across Multiple Computers and Platforms

If a font has the same name on two different computers then it can be used in a database on either computer
— even if they are different types of computers (Macintosh vs. Window PC). For example, suppose your
database is created on a Macintosh and uses the Adobe fonts Palatino and Optima. If the database is trans-
ferred to a Windows PC system these fonts will continue to display properly if the Palatino and Optima are
installed on the Windows PC.

click here to choose font, or use Font menu
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No matter what type of computer you are using Panorama will check for the necessary fonts each time it
opens a database. If a database uses one or more fonts that are not installed on this system an alert will
appear listing the fonts that are not available on your system.

To allow you to continue to use the database the objects that use these fonts are switched either to Geneva
(Macintosh) or Alpine (Windows). If you want to keep the original fonts you must close the database without
saving it, install the necessary fonts, then re-open the database. Once the database has been saved you cannot
go back to the original fonts except by manually setting up the fonts again, object by object. 

Universal Fonts

Panorama has special handling for four special fonts.

On the Macintosh these four fonts are always present as universal fonts, so you can rely on them always
being available. We have created the four equivalent fonts for Windows computers to guarantee that these
fonts are always available on any computer. For example, if you create an object using the Geneva font on a
Macintosh computer it will automatically be translated to the Alpine font when displayed on a Windows PC
computer. If you want to make sure that your database will display properly on any computer you should
restrict yourself to using only these four fonts.

Macintosh Windows

Geneva Alpine

New York Yankee

Chicago City

Monaco Block
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Text Size

The Size menu allows you to adjust the text size of an object. To change the text size, first select the object
with the Pointer tool, then pick the size from the menu.

When you release the mouse, the size of the text will change.

If the size you want is not listed in the menu, choose Other. A dialog will appear asking for the new font size.

click here to choose size, or use Size menu
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You can type in any integer font size you like — big or small.

You can also make small adjustments to the text size by selecting Up or Down. These commands increase or
decrease the text size by one point.

Text Style

The Text menu allows you to change the style of an object containing text.



Chapter 14:Graphic Design Page 533
You must change the style of the entire object — all the characters in the object must have the same style.

The only exception to this rule is the Word Processor SuperObject, which allows different styles, fonts, sizes
and colors to be mixed. See “Word Processor SuperObject” on page 673 for more information.

Object Type/Object Name

Panorama allows a name to be assigned to any graphic object. The name can be used to identify the object
when programming. If an object has a name, a program can get information about the object, or even modify
the object on the fly. If you are not planning to do any programming with an object, there is no need to assign
a name to it.

The Graphic Control Strip can display the type of the currently selected object, along with its name (if it has
a name). Object types describe what the object is: Rectangle, Oval, Line, Button, Data Cell, etc.

type of object name of object

click here to toggle between
dimensions, font/size
and type/name of object
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You cannot change the type of an object, but you can change its name. To do so, either click on the object type
or name in the Graphic Control Strip, or choose Object Name from the Edit menu.

You can use any name you want for the object. You can even have two objects with the same name, which can
be handy if you always want to program them the same way. For more information on programming objects
via their name see “Programming Graphic Objects on the Fly” on page 633 and “Program Control of Super-
Objects™” on page 666 of Formulas & Programing.

The Object Properties Dialog

Many graphic objects have dialogs that control various options for the object. To open the dialog for a partic-
ular object, first select the object and then choose the Object Properties command in the Edit menu. This
command will work for data cells, tiles, buttons, flash art, flash sound and all SuperObjects. There is no dia-
log for basic shapes like rectangles, ovals, etc. The Object Properties dialog is the same dialog that appears
when you create the object. Here is a typical Object Properties dialog.
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Another way to open the Object Properties dialog is to simply double click on the object in question. In fact,
this is the most common way to open this dialog. With most types of objects you can double click anywhere
in the object. For a report tile, however, you must double click on the name of the tile. If you double click on
the drag bar of the tile (outside the name), Panorama will not open the Object Properties dialog, but instead
will select all the objects inside the tile. (See “Working with Tiles” on page 1062 to learn more about report
tiles.) The illustration below shows a report tile with two other objects, a list and a rounded rectangle.

If an object doesn’t have an Object Properties dialog (for example basic shapes like rectangles and ovals)
then double clicking on the object will select all of the object inside the object. “Selecting Multiple Objects at
Once” on page 502 for more information about this technique.

Note: In older versions of Panorama (Panorama 2.x) you needed to click on the object with the corresponding
tool to open the Object Properties dialog. For example to open the Object Properties dialog for a button you
needed to select the Button tool, then click on the button. This will still work, but is no longer necessary with
the Object Properties command in the Edit menu and the double clicking (with the pointer) shortcut.

double c lick to open dialog

double c lick title to open dialog

double c lick to select enclosed objects

double c lick to select enclosed objects
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Working With Multiple Objects

Most forms contain dozens or even hundreds of objects. Often you’ll need to move, resize, or align several
objects at once. Panorama has a number of tools to make these kinds of tasks easier.

Grouping Objects Together

The Group command (in the Arrange menu) gathers several objects together and combines them into a single
object. Once the objects are grouped together, they act as a single unit. The group can be selected, moved,
copied, or resized just as if it was a single object. To group several objects together, first select the objects. 

Once the objects are selected, choose the Group command in the Arrange menu. The handles at the corners of
each individual object will disappear, while new handles appear at the corners of the new composite object.
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The group now acts as if it was a single object. You can move it, resize it, copy it or delete it, all as a single
entity. For example if you expand the group object, all of the component objects within the group will expand
proportionally.

If you want to manipulate one of the individual objects within a group you must reverse the process with the
Ungroup command. This command splits a group back into the original separate objects.

Tip: Don’t confuse the Group command in the Arrange menu with the Group command in the Sort menu.
The Group command in the Sort menu is used to collect data into groups, while the Group command in the
Arrange menu is used to collect graphic objects into groups. See “STEP 1 - GROUP” on page 394 for more
information about the other Group command.
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Moving Multiple Objects

You can move several objects at once by selecting the objects and then dragging one of them. The other
selected objects will follow as you drag. You can also nudge the selected objects with the arrow keys (see
“Nudging an Object (or Objects)” on page 509).

Fast Drag 

As you drag multiple objects, a gray outline of the objects follows the movements of the mouse (as shown in
the previous illustration). If you have a very slow computer and are dragging a large number of objects, there
may be a delay while Panorama creates this gray outline. You can eliminate this delay by checking the Fast
Drag option in the Edit menu.
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When this option is checked the delay is reduced, but the gray outline may be less detailed.

The Fast Drag option remains on until you turn it off or quit Panorama.
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Resizing Multiple Objects

You have several choices available for resizing multiple objects. You can combine objects into a group and
then change the size of the group. You can use the Dimensions dialog to make each selected object a fixed
height or width, or to increase or decrease the size of each selected object. Finally, you can use cluster resize
to change the width of a column within a table, or the height of a row.

When you change the size of a group object, all of the dimensions inside the group change as well. For
instance, if you double the width of a group, all of the individual objects within the group will also double in
width. The horizontal spacing between the groups will also double. Here is a group of objects before the
width is adjusted…

and after.
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Cluster Resize

Panorama’s Cluster Resize is automatically active whenever you select several objects and then change the
size of one of them. Cluster resize adjusts the sizes and locations of the other selected objects to match the
change. For instance, suppose you have a matrix of boxes, and you want to increase the width of one column.

Start by selecting all of the objects (see “Selecting Multiple Objects at Once” on page 502). Then grab one of
the handles in the column you want to make wider and drag it to expand the box.

When you release the mouse, cluster resize will kick in. In this case, it will automatically increase the width of
all the other boxes in the same column. It will also shift the boxes on the right to make room for the expan-
sion.

drag to change the size of one object
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At first glance cluster resize may look a little bit like magic, but actually it is quite simple. After you change
the size of any object, Panorama checks to see which edge (or edges, for diagonal moves) of the object you
moved—top, bottom, left, or right. It then adjusts the corners of any other selected objects that are in that
direction. For example, if you move the right edge of an object, any objects that are even with or to the right
of that edge will be adjusted.

Here’s another example. We’ll start with six objects.

We’ll slide the right edge of the second object to expand the object about an inch.
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Here’s how Panorama will adjust the other five objects. 

The first object is completely unaffected. This is because we expanded to the right and this object is com-
pletely to the left of the expansion axis. The third and fourth objects straddle the expansion axis. Therefore,
they grow to match the growth of object number 2. The final two objects are completely to the right of the
expansion axis. Therefore, they stay the same size and slide to the right. Here’s the final result when you
release the mouse.

object corners in this area are pushed to the right

object corners in this area do not move

expansion axis
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Cluster resize isn’t limited to horizontal expansion. In this example we’ll stretch the second object both hori-
zontally and vertically.

Now there are two expansion axis, one horizontal and one vertical. Depending on what quadrant they are in,
a point will stay in place, move horizontally, move vertically, or move diagonally.

expansion axis

expansion axis
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Here’s the final result.

Cluster resize affects all selected objects, even when objects are nested inside each other. If you select nested
objects and then change the size of the innermost object, cluster resize will adjust the size of the larger object.
This makes sense because the right edge of the outer object is to the right of the right edge of the inner object
(say that three times fast!). A real world example of nested objects is a border around a table (or borders
around individual columns in a table). Cluster resize makes sure that if you resize one of the columns in the
table the borders will adjust as well. Just make sure that you always change the innermost object, and cluster
resize will take care of the rest.To illustrate cluster resize with nested objects we’ve added a border around
our six objects.
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Once again we expand the second object.

The border also expands. Since it straddles the expansion axis, the left side of the border stays put while the
right side expands to fit the expanded objects inside it.

Only selected objects are affected. If the border is not selected, it won’t expand.
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Cluster resize makes it easy to adjust the size of rows or columns in a table. Just select all of the objects in the
table, then adjust the size of any object within the table.

Cluster resize adjusts the other objects to maintain the table structure.



Page 548 Panorama Handbook
So far all of our examples have shown expanding to the right and/or down. However, you can also expand to
the left, or shrink. In this case we’ll expand the last column to the left. (When you have this many handles
packed into a small area, it can be difficult to hit the one you want. To make it easier we held down the S
key, which expands the handles. See “Resizing Without Handles” on page 516 for more information on this
technique. We also held down the Shift key to make sure that the expansion was entirely horizontal and not
diagonal.)

When the mouse is released the entire table is adjusted.



Chapter 14:Graphic Design Page 549
Cluster resize is also great for working with reports. If you keep your report tiles lined up, then changing the
width of an item in the body of the report automatically adjusts the width of the same item in the report
header. (Remember that all the objects must be selected. Only selected objects will be adjusted.) In this exam-
ple all the objects are selected and we expand the width of the City field.

Cluster resize automatically adjusts all of the other objects, including the report tiles.

By the way, cluster resize also works when you nudge the size of an object using the arrow keys (see “Nudg-
ing the Size of an Object” on page 513). Select the objects, then click on the handle you want to nudge. As you
use the arrow keys to resize the object, cluster resize will automatically adjust the other objects. You can com-
bine this with the crosshair cursor (see “Nudging to the Crosshair Cursor” on page 515) to quickly and accu-
rately nudge a collection of objects exactly into place.

Don’t forget that when you are resizing an object you can use the Shift key to make sure that only the height
or width changes, but not both. For example, if you are adjusting the width of a column using cluster resize,
hold down the Shift key so that the height of the row doesn’t change also. You can also hold down the S
key to make sure that you are resizing, and not dragging. See “Resizing Without Handles” on page 516 for
more details on this technique.
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Cluster Resize Troubleshooting

Sometimes you may run across a situation where cluster resize doesn’t seem to work. You change the width
of a column, but some of the objects don’t get adjusted. What’s the problem?

This problem occurs when not all the objects in the column are lined up on the right. Usually this is because
the objects are not quite the same width. If one of the objects in a column is 1 or 2 pixels shorter than the other
objects the short object won’t get adjusted.

The solution is to make sure your objects are all lined up before you start. If necessary, you can use the Align
command to force all the objects into alignment See “Aligning Objects” on page 553 to learn about this com-
mand.

Setting Exact Dimensions of Multiple Objects

When the Dimensions dialog (in the Edit menu and the Graphic Control Strip) is used with a single object,
you can specify both the position and size of the object. But if several objects are selected, the Dimensions
dialog cannot specify the position—only the size of the object. You can use this dialog to set the width and/or
height of all the selected objects—for example, you can make all the selected objects 2 inches wide. Or you
can use the dialog to increase or decrease the size of each selected object—for example, you can make every
selected object 1⁄2 inch wider.

To set the height or width of several objects at once, first select the objects. Then open the Dimensions dialog.
Type in the new height and/or width, then press Ok. All of the selected objects will be set to the specified
height and/or width. For example, suppose you have a collection of miscellaneous objects like this:

To make all these objects 2 inches wide, open the Dimensions dialog (either by clicking in the dimensions
area of the Graphic Control Strip or by choosing Dimensions from the Edit menu).
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Set the width to 2 and erase the height.

When the Ok button is pressed all of the selected objects will be changed to 2 inches wide while retaining
their original locations and heights.
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To increase or decrease the size of several objects at once, first select the objects.

Then open the Dimensions dialog. Type in the increase or decrease amount, with a + (increase) or -
(decrease) sign in front of the number. For example, to make all selected objects 1⁄2 inch wider enter +0.5.

When the Ok button is pressed all of the objects will get 1/2 inch wider.

If you are not careful, the Dimension dialog can turn a form into a big mess in a hurry. If this happens, don’t
panic—just Undo!
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Aligning Objects

If you need to line up several objects, you can either do it by eye or you can let the Align command (in the
Arrange menu) do it for you. The Align dialog gives you eight options for aligning objects in different direc-
tions.

Most of the alignment options simply shift the objects to align them, but the Left & Right and Top & Bottom
options actually change the sizes of the selected items. Instead of shifting the objects, these options actually
expand the selected objects to make them all the same width or all the same height. If you ask for Left &
Right, all the selected objects will be expanded to the width of the widest object. If you ask for Top & Bottom,
all the selected objects will be expanded to the height of the tallest object.

This table shows how a collection of three objects is affected by the different alignment options.

Top
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Bottom

T/B Centers

Top & Bottom

Left

Right
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L/R Centers

Left & Right
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Adjusting Spacing Between Multiple Objects

The Spacing command (in the Arrange menu) allows you to adjust the vertical or horizontal spacing between
multiple objects. The dialog will shift the selected objects so that they are evenly spaced. For example, you
could start with a somewhat random collection of objects like this.

Open the Spacing dialog and set the spacing to 4 pixels between the objects.



Chapter 14:Graphic Design Page 557
When the Ok button is pressed the objects will slide vertically into place.

To finish our cleanup we’ll use the Align command to make all of the objects the same width (by selecting
Align Left & Right).
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If the selected objects are arranged in a table, the Spacing dialog will preserve the table structure. For exam-
ple, if the font size of a table is increased the individual rows in the table will overlap. This can be fixed with
the Spacing dialog. To illustrate this, we’ll start with a table that contains 9 point text.

We’ll start by converting the text from 9 points to 12 points. Our table doesn’t look so neat anymore!
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The next step is to use the Dimensions dialog to increase the height of each object by four pixels (see “Setting
Exact Dimensions of Multiple Objects” on page 550).

The table still doesn’t look so hot.
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The final step is to use the Spacing dialog to restore the vertical spacing between the rows.

When the Ok button is pressed, the table spread out and now looks great. This may have seemed like a fairly
complex process, but it is much easier than manipulating all 60 of these objects individually!

The Spacing dialog does not align the objects into neat rows or columns. If the objects need to be aligned use
the Align dialog (see “Aligning Objects” on page 553).

Duplicating Objects

Why do the same work twice? Panorama has several methods for creating a duplicate of one or more objects.
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Duplicate

The easiest way to copy objects is with the Duplicate command. Just select the objects and choose Duplicate
from the Edit menu. The new object(s) are placed just below and to the right of the originals.

If you duplicate an object (or objects) and then immediately drag (and/or nudge) the copy to a new position,
Panorama will memorize this position relative to the original object. Now if you duplicate the copy, Pan-
orama will automatically place the copy of the copy in the same relative position.

Drag Duplicating

You can also duplicate an object by dragging the object with the a special key held down. On the Macintosh
the special key is the Option key. On PC systems the special key is the Alt key. When the special key is held
down you drag a copy of the object(s), instead of the original. Just hold down the key and drag the same way
you would to move the object(s).

original objects
duplicate objects
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When the mouse is released a second copy of the object(s) appears at the new location.

If you want the copy to line up with the original hold down Shift key and the Option/Alt key as you drag
the object. The Option/Alt key tells Panorama to makes copies, while the Shift key prevents you from drag-
ging the copy diagonally.

Once you have created a copy by Option/Alt dragging, you can make another copy with the Duplicate com-
mand. The Duplicate command will exactly mimic your Option/Alt drag, allowing you to quickly create an
accurately spaced row or column of objects (see the next section for an example). Warning: If you want the
Duplicate command to mimic your Option/Alt drag, you must not do anything in between dragging and
pulling down the menu. If you click anywhere else in the form, the Duplicate command will not mimic the
Option/Alt drag.

Step and Repeat

You can combine Option/Alt dragging (see previous section) with the Duplicate command to quickly step-
and-repeat evenly spaced rows, columns, and complete tables of objects. To create a row of objects, start with
just one object.
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Hold down the Shift and Option/Alt keys and drag the object to the right.

Release the mouse to create a copy.

Then use the Duplicate command to create another copy of the object. The copy will automatically be placed
at the same spacing as the first duplicate.
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Repeat the Duplicate command until the row is complete.

To create a complete table, select all of the objects in the row by dragging a marquee around them.

Hold down the Shift and Option/Alt keys and drag the row down, creating a copy of the row.
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Release the mouse to create the new row.

If you don’t get the spacing just right, you can nudge the row with the arrow keys (see “Nudging an Object
(or Objects)” on page 509). Once the second row is in position, use the Duplicate command to step and repeat
an additional copy of the row
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Repeat the Duplicate command until the table is complete.

Once the table is complete, you can modify the width of columns within the table using cluster resize (see
“Cluster Resize” on page 541). Or you can change the spacing between the rows and columns using the Spac-
ing command (see “Adjusting Spacing Between Multiple Objects” on page 556).

Cut, Copy, and Paste

You can use the clipboard to copy objects and to transfer objects from one form to another form. The Cut and
Copy commands copy the selected objects into the clipboard. Cut also removes the objects from the form.

The Paste command places a copy of the objects in the clipboard on to the form. The object (or objects) is
placed into the middle of the current window.

You can also use the Paste command to paste in graphics created in another program. For more information
see “Fixed Images” on page 741.

Copying Objects Between Forms

The Copy and Paste commands can be used to copy objects from one form to another. Just copy the objects
from the original form, then switch to the second form and paste. Tip: Both forms must be in graphics mode
to copy graphics between the forms.

Copying Objects Between Files

Using the Copy and Paste commands, you can easily copy graphic objects from one file to another. If you
copy a data cell object to another file, the data cell field name may not match up with any of the fields in the
second database. If this happens Panorama will automatically substitute the first field name in the second
database. You can use the Data Cell tool to assign a different field to the cell.

Copying an Entire Form

The Copy Form and Paste Form commands (in the Graphics Mode's Edit menu) allow an entire form to be
copied at once -- including the form’s Page Setup, custom menu setup, form comments -- everything!

To duplicate a form, start with the original form in Graphics Mode. Then choose the Copy Form command
from the Edit menu. Then choose the Paste Form command. (If you want to duplicate the form in another
database you must go that database, open a form and switch that form to Graphics Mode before using the
Paste Form command.) The Paste Form command will ask you for the name of the new form. When you
press the Paste Form button, Panorama will create the new form as an exact duplicate of the old form. (Notice
that you do not create the new form in advance — the Paste Form command creates the new form for you.)
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You can also use the Copy Form command with the regular Paste command to copy all the objects in a form
into another form. When used this way, the Copy Form command is the same as choosing Select All Objects
followed by Copy command. When used this way, only the objects are copied and not the Page Setup, cus-
tom menus, etc.
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Overlapping Objects

The computer screen is two dimensional, in other words, flat. So what happens if two objects overlap each
other? To resolve this question, Panorama treats the objects as if they were placed on a stack of clear sheets.
For example, consider the three overlapping objects in this form — 

If you could look at this form on edge, it would look like this —

An object that is on top of another object is said to be in front. An object that is below another object is said to
be in back. When you create a new object, the new object is placed in front of all other objects.

Objects that were created earlier will be partially or completely hidden if the new object overlaps them.

front

back
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Changing the Stacking Order

The Bring to Front and Send to Back commands (in the Arrange menu) change the stacking order of overlap-
ping objects. To put an object behind everything else, select the object and then choose Send to Back. For
example, suppose you wanted to move the red box behind the other three objects on this form. Here’s the ini-
tial form, including the edge view.

The Send to Back command will move the red box behind the other objects.
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To bring an object to the front, select the object and then choose Bring to Front. For example, you could bring
the purple box to the front (again showing the edge view).

Selecting a Completely Hidden Object

If an object is completely hidden you can’t click on it. However, there are several ways to select hidden
objects.

To find a hidden object, use the Select All Objects command (in the Edit menu). This command makes han-
dles appear for every object, including hidden objects. For example, at first glance the form shown below
would appear to have only one object — a yellow box. The Select All Objects command reveals that there are
two hidden objects behind the yellow box.

handles of
hidden objects
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Of course, you can also find a hidden object by moving the objects in front of it out of the way —

or by sending the object in front to the back.

Sometimes you may be able to select a hidden object by dragging a marquee around the object.
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Once the object is selected you can bring it to the front, change the object properties, or nudge the object with
the arrow keys.

Another technique for selecting a hidden object is to hold down a special key while you click. On the Macin-
tosh this special key is the Command key, on PC systems it is the Control key. The first time you click, the
topmost object will be selected.

The next click will select the next object behind the top object (remember, you must hold down the
Command/Control key).
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Each time you Command/Control click again the next object behind the current object will be selected

When you reach the bottom of the file Panorama will cycle back to the top and select the topmost object
again. You can keep clicking around and around forever.

Making a Drop Shadow

Use Duplicate and Send to Back to create a drop shadow for a box. Start with a basic box.
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Use the Duplicate command to make a copy of the box (see “Duplicate” on page 561). (An alternate tech-
nique is to hold down the Option/Alt key and drag to create a copy of the box, see “Drag Duplicating” on
page 561.)

Next, use the Fill menu to make the new box black (see “Fill Pattern” on page 521).

click here to change fill pattern
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Finally, use the Send to Back command to move the shadow behind the original object (see “Changing the
Stacking Order” on page 569).

If the shadow is too large or too small, use the arrow keys to nudge it until it looks right (see “Nudging an
Object (or Objects)” on page 509).

Locked Objects

Use the Lock command to lock objects. Locked objects can’t be moved or resized. Locking is convenient
when you want to make sure the work you have already finished isn’t disturbed as you continue working.

To lock one or more selected objects, choose Lock from the Arrange menu. The object handles will turn gray.
This shows that the objects are locked. The illustration below shows three selected objects, one of which is
locked.

gray handles on locked object
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If you attempt to drag these three objects, only the unlocked objects will actually move.

A locked object cannot be moved, resized, or have any of its attributes (color, fill pattern, etc.) changed. How-
ever, you can duplicate the object (the copy is not locked).

Use the Unlock command to release a locked object(s). Once they are unlocked the objects can be moved and
resized normally.
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Ignoring Locked Objects

Although locked objects cannot be moved, they can still be selected by clicking on them. (Otherwise they
could never be unlocked again!) However, if you check the Ignore Locked Objects option in the Arrange
menu, you will not be able to select locked objects.

Tip: The Ignore Locked Objects option is useful for working on top of a large background covering the entire
form. For example, you might paste a scanned image into the form, and then create data cells and other
objects on top of the scanned background. By locking the scanned image and turning on the Ignore Locked
Objects option, you won’t have to worry about accidentally selecting and possibly moving the scanned back-
ground image.

Alignment Grid

Panorama normally allows you to position objects freely anywhere on a form. The Grid dialog (in the
Arrange menu) allows you to set up a grid that can help you arrange objects in neat rows and columns.

The grid spacing can be specified in inches, centimeters, or pixels. If you use inches or centimeters, the spac-
ing will be rounded to the nearest 1⁄576 inch (For example a grid spacing of 0.1 inch will be rounded to 0.098
inches, or 7.25 pixels.)
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If you want to make the grid visible, check the Show Grid option. When this option is checked a dot appears
at each grid point.

When the Snap to Grid option is checked, Panorama will automatically align objects to the grid. Objects are
aligned to the grid whenever they are created, moved, or resized. This option does not affect objects already
in the form (unless you modify them).
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Panorama snaps the object into place as it is created.

Tip: When Snap to Grid is on, every object you create is automatically aligned to the grid. But what if you
need one or two objects that are not aligned to the grid? Instead of turning Snap to Grid off, you can nudge
the object into place using the arrow keys. Both the position and size of the object can be adjusted with the
arrow keys. See “Nudging an Object (or Objects)” on page 509.

Magnification and Reduction

Panorama allows you to magnify the form for closer inspection, or for more accurate alignment of graphic
objects. Use the Magnify tool to zoom in to 2x, 4x, or 8x magnification. When you select the Magnify tool, the
cursor turns from an arrow into a magnifying glass.
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Move this magnifying glass to the spot you want to work on, then click the mouse to zoom in.

You can continue to zoom in up to 8X magnification.
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Press the Shift key to turn the magnifying glass into a microscope. (If you are using a Macintosh pressing the
Option key or Space Bar also converts the magnifying glass into a microscope. If you are using a Windows
PC you can also press the Alt key or Space Bar.) When the Shift key is held down, each click reduces the
magnification (zoom out). You can continue clicking until you get back to 1x magnification, or you can zoom
out even farther and reduce to 50% or 25% magnification.

All of Panorama’s graphic editing tools and menu commands work at any magnification level—all the way
from 25% to 8x.

By holding down the Command key (Macintosh) or Control key (Windows) and clicking you can force Pan-
orama to immediately return to the normal 100% view.

A Note About Measurement Accuracy

Panorama keeps track of the position and size of each object to an accuracy of 1⁄576 inch (1⁄8 pixel). However,
this accuracy is only visible when you zoom in to 8x magnification (see previous section).

If you are going to print your form, keep in mind that printers are not 100% accurate. We have found that
many printers can be up to 1⁄8 inch off over the length of a page. (For example, a 10 inch high line may actu-
ally print anywhere from about 9.9 to 10.1 inches.) This variation can cause problems if you are attempting to
print unusually small labels or if you want to exactly match a pre-printed form. Most printers are more accu-
rate horizontally rather than vertically—this is probably due to slight variations in drum speed as the paper
feeds through the printer.
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Form Background Colors

The default background for a form is white, but you may choose from 256 background colors for any form. To
change the background color, open the Form Preferences dialog (in the Setup menu) and choose the back-
ground color from the pop-up menu.

Here is a typical form with a gray background color. (Note: If the form is displayed on a black and white
monitor, Panorama will automatically use a white background even if you have specified another color.)
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To set background colors for a view-as-list form, apply colors to the data tile and header tile. If these two tiles
have different colors, the header and data sections of the form will also have different background colors. See
“View-As-List Background Colors” on page 919 for more information on background colors in a view-as-list
form.

It is possible to check and change the form background color from inside a procedure. See “FORMCOLOR”
on page 5262 of the Panorama Reference.

Using the Form Explorer Wizard

Panorama comes with a Form Explorer wizard that you can use as an alternative tool for examining and
modifying (to some extent) forms. To use this wizard you must start with a form in Data Access Mode, not
Graphics Mode. Choose Form Explorer from the Form Tools submenu of the Wizard menu.

The Form Explorer window opens. The left hand side of this window contains a list of all of the objects in this
form. The objects are listed from back (top of the list) to front (bottom of the list). The number for each object
is relative to the front to back stacking order of the object - lower numbers are further towards the back.
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When you click on an object the object will flash on the original form (unless it is invisible). This will also
cause a listing of all the object attributes to appear.

Each attribute is displayed as a name value pair, for example name->BOX or width=74. If a name/value pair
is connected with an = sign then you can click on the text and modify the value. For example you can change
the object width to 200 pixels and the color to solid blue.

When you press the Enter key the object will be modified with the new attributes.

modified object
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Some objects have more attributes than others. This Text Editor SuperObject has over three dozen attributes.
In general the attributes correspond to the options in the object’s configuration dialog. You can edit most of
these attributes with the Form Explorer if you wish.

You can use the Form menu to explore any open form. You should also use the menu to update the object list
after you edit the form in Graphics Mode (or you can simply close and re-open the Form Explorer).

The Form Explorer wizard can be a great tool for deciphering a form created by another person. You can
quickly zero in on which fields and procedures are used where.
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Chapter 15: Displaying and Editing Text

Graphics and icons are powerful tools, but written text is still the primary medium for communication and
record keeping. Panorama forms can display both permanent text (for captions, titles, instructions, etc.) and
textual information from the database.

Displaying Text

This chapter is divided into two sections, displaying text and editing text. In this first section we’ll consider
displaying text, both fixed text and text that changes depending on the information in the database or in a
variable.

Fixed Text Objects

Panorama has two different kinds of fixed text, click text and auto-wrap text. Both types of fixed text are cre-
ated with the Text tool.
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Once the Text tool is selected you can create click text simply by clicking on an empty spot on the form.

Now you can simply start typing.

As you type each character, the click text object automatically expands.
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You can add additional lines to the click text by pressing the Return key.

Auto-wrap text does not expand automatically as you type. Instead, the text automatically wraps inside a
box.

To create auto-wrap text, start by selecting the Text tool, just like for click text. But instead of clicking on the
form, drag the mouse to define the size and location of the box (don’t worry about exact positioning, you can
adjust it later).
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Once the box is defined you can start typing in text. The text will automatically wrap to the next line when it
reaches the right edge of the box.

To help you keep track of the type of text you have created, the graphic editor displays a dotted border
around all auto-wrap text objects. (This border disappears when the form is switched to data access mode.)

Editing Fixed Text

To edit text within an object, you must use the Text tool. Once this tool is selected, move the mouse over the
text you want to edit. When the mouse moves over the text it changes from an arrow to an I-beam. Use the I-
beam to edit the text—click to select an insertion point, drag to select a range of characters, or double-click to
select a word.
 

When you have finished editing the text, either click on the next text object you want to edit or click on the
Pointer tool.

Note: If a text object doesn’t contain any text at all, the entire object will be deleted from the form. The first
thing you should do after creating a text object is to type at least one character into it.

Moving and Resizing Fixed Text Objects

Text objects can be moved just like any other shape. Use the Pointer tool to drag the text to the new location.
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The size and shape of a text object can be changed by dragging one of the handles to a new position.

If this is done to auto-wrap text, the text will re-flow into the new size.

If you change the size of click-text, it will be converted into auto-wrap text.
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Once the click-text is converted to auto-wrap text it will re-flow into the new size.

To convert auto-wrap text into click text, resize the object so that it is less than one line high or less than one
character wide.

Panorama converts the auto-wrap text into click text.

Later the text can be converted back into auto-wrap text simply by expanding the height again.
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Text Font, Size and Style

Text in a form may be displayed using any font installed in your system. However, you cannot mix different
text styles, sizes, or fonts within a piece of text. To change the font, size, or style of an entire text object, use
either the Pointer or the Text tools to select the object (or objects), then change the text appearance by choos-
ing from the Font, Size, and Style Menus. You can also change the color of the entire text object with the
Color menu (in the Graphics menu or the Graphic Control Strip).

If you need a size that is not listed in the Size menu pick Other. You can also change the text size in 1 point
increments by choosing Up or Down from the Size menu.

Creating Reverse Type (White on Black)

To print reverse type, start with regular text.

Next, put a black object (or any dark color) behind the type. Use Send To Back to send the dark object to the
back (see “Changing the Stacking Order” on page 569).

Select the text object, then use the Line Pattern menu (see “Line Pattern” on page 523) to set the text to white.
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An alternative technique is to leave the Line Pattern alone and use the Color menu (see “Color” on page 526)
to set the text to white or some other light color.

Text Alignment

Text is usually aligned flush left within the text object. Use the Left Justify, Center, and Right commands (Text
menu) to change the alignment of the text.
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Displaying Data in Auto-Wrap Text

Auto-wrap text objects are not limited to fixed text. They can also be used to display data, either alone or in
combination with fixed text.

To display a field into the middle of an auto-wrap text object, type the name of the field into the text. Sur-
round the name with the « and » chevron characters (for example «First Name» or «Zip Code»). On a Macin-
tosh the « chevron is Option-\ and the » chevron is Shift-Option-\. On Windows systems the « chevron is
Alt-0171 and the » chevron is Alt-0187. To illustrate this technique, suppose you had a database of national
parks like this.

Now you can create an auto-wrap text object that contains fields, like this.

When the form is switched to Data Mode (see “Form Modes: Data Access vs. Graphic Design” on page 485)
Panorama will substitute the actual data in this fields, like this.

fields
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As you move from record to record, the substituted text will change appropriately.

Since this technique “merges” the database information with the fixed text, it is sometimes called data merg-
ing.

Data Merge Pop-Up Menu

Typing in exact field names with chevrons can be a pain, so Panorama has a pop-up menu that can type in the
field names for you, including the « and » chevrons. To use this menu, first select the Text tool. Then click on
the text to create an insertion point. Once the insertion point is set, press either the Command key (Macin-
tosh) or Control key (Windows) to change the cursor from an I-beam to a tiny menu icon.

With the Command/Control key still held down, press the mouse to activate the pop-up menu
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then pick the field name you want to insert.

Switch back to Data Access Mode to see the final result.

Using Data Merge to Create Address Labels

Data merge is an excellent way to create address labels. To create an address label using data merge, start by
creating an auto-wrap text object the size of the label.
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Hold down the Command key (Mac) or Control Key (Windows) and select the first field name from the pop-
up menu.

When you release the mouse button Panorama will insert the field name. The insertion point is at the end of
the line.

The first line is complete, so press Return to advance to the second line.
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Repeat the same steps for the second line: hold down the Command/Control key, select Address from the
pop-up menu, and press Return.

The third line contains three fields: City, State and Zip. Start by using the pop-up menu to enter the City field.
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Now press the Comma and Space Bar keys.

Finish the label by inserting the State field using a pop-up menu, typing a Space and then inserting the Zip 
field.

When you switch back to Data Access Mode Panorama will substitute the actual data. Voila! A label!

Panorama will automatically wrap the text within the rectangle you provided. It will start a new line wher-
ever you have typed a Return (or when a line becomes too long to fit).
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If a field is empty and that causes the entire line to be empty, Panorama will completely remove the line. For
example, Great Basin National Park doesn’t have a street or P.O. Box, as you can see in the data sheet.

In the label, Panorama will remove the completely blank line.

If you don’t want the blank line removed, put a space at the end of the line.

space at end of line
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Now the line can never be completely empty, so Panorama will not remove it.

An address label can be used as part of a larger form (like an invoice), or it can be used by itself as a mailing
label. If you wish to print a mailing label you must define the overall size of the label by creating one or more
report tiles. Report tiles tell Panorama how to print a form. For more information on creating and printing
mailing labels see “Label Fundamentals” on page 1169.

Displaying Formulas in Auto-Wrap Text

In addition to fixed text and fields, auto-wrap text can also contain complete formulas with text and numeric
calculations. Simply type the formula into the text, surrounded by { and } curly brace characters. Here’s what
a formula looks like in Graphics Mode.

When the form is displayed in Data Mode Panorama substitutes the result of the formula instead of the for-
mula itself.

formula inside { and }

formula result
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Of course 2+2 is a pretty silly formula. More useful formulas can be formed by combining fields, variables,
and functions, like this.

In Data Mode this auto-wrap text object looks like this:

An auto-wrap text object is not limited to a single formula. You can include as many formulas as you need.

Here is the same auto-wrap text object in Data Mode. The formulas have been replaced with their results.

formula #1

formula #2
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Using a formula gives you almost unlimited possibilities for combining and manipulating data on the fly as it
is displayed or printed. By using formulas containing the lookup function you can display or print data from
more than one database at once. You can use a formula to display or print computed information that is not
stored in the database. You can use true-false formulas to display or print data only if a certain condition is
met. The possibilities are almost endless. See “Formulas” on page 19 of Formulas & Programing.

The Build Formula Dialog

You can use the Build Formula dialog box to help you create formulas to merge into auto-wrap text. To create
a new formula with this dialog, click on the Text tool, then click in the text to create an insertion point.

Now choose Build Formula from the Text menu. This causes a dialog to appear.



Chapter 15:Displaying and Editing Text Page 605
Once the Build Formula dialog is open, you can type in a formula using the keyboard. Or you can use the
Field and Function menus to help enter the formula for you. The Field menu contains a list of all fields in the
database; pick from this menu to type a field name into the formula. The Function menu contains a list of all
the functions and operators available; pick from this menu to type a function or operator into the formula.
For example, if you wanted to convert text to upper case, you would select the upper( function from the
Function menu.

If you need to include a field name in your formula, select it from the Field menu.
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As you select items from these menus, Panorama will insert them into the formula. (Of course you can also
type text into the formula.)

When the formula is finished, press the OK button. Panorama will check the formula for errors. If the for-
mula is correct, it will be inserted into the auto-wrap text (with the required { and } curly braces automatically
added).

If the formula contains an error, Panorama will display an alert and highlight the location of the error. You
won’t be able to close the dialog until you correct the error (unless you press Cancel).

By the way, here’s what our finished formula looks like in Data Mode. Notice that the Park name has been
converted to all upper case (YOSEMITE NATIONAL PARK instead of Yosemite National Park).
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You can also use the Build Formula dialog to edit a formula you have created earlier. To do this, start by
dragging over the text of the formula to select it.

Once the text is selected, choose Build Formula.

Now you can edit the formula by typing or choosing from the Field and Function menus, just like when you
created a new formula.
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Text Display SuperObjects™

The Text Display SuperObject displays text based on a formula. In some ways, this is similar to an auto-
wrap text, but there are many more options for calculating the formula and formatting the displayed text.
You can store the formula itself in a variable (so it can be changed on the fly), align the text in any corner of
the object, automatically scale the text for different size windows, and even change the color of the text on the
fly.

Creating and Modifying Text Display SuperObjects

The Text Display SuperObject tool is not in the default tool palette, so you’ll need to use the Tool Palette dia-
log to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the Text
Display SuperObject.

When you release the mouse, the Text Display SuperObject configuration dialog will appear.
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At a minimum you must enter a valid formula into the dialog. For this example we’ve also turned on the
Border and Drop Shadow options and set the alignment to centered (these options are discussed in detail
below). When the OK button is pressed the new object appears. (Notice that unlike the auto-wrap text object,
the Text Display SuperObject shows the result of the formula in both Graphics Mode and Data Mode, not just
Data Mode.)

After it has been created you can modify the location, size, font, style and color of a Text Display SuperObject
just like any other object. To change any of the object attributes (formula, border, alignment etc.) select the
Pointer tool and double click on the object. The configuration dialog will appear again. Make your changes
and press the OK button.
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Text Display Options

The Text Display SuperObject configuration dialog is divided into several sections.

Formula: This section of the dialog specifies the formula for displaying text in this object. If you want to dis-
play fixed text, remember that you need to surround the text with quotes.

This object will always display the word Geography.
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To display a field or variable, type in the name of the field or variable. You can use the Field menu to type in
the name of a field for you (that way you don’t have to worry about misspellings. Here’s the formula to dis-
play the Company field.

And here is the finished object.

Panorama has hundreds of different functions that you can use to assemble your formula. See “Using Formu-
las to Display Text” on page 621 for some useful tips on building formulas for displaying text on a form.
You’ll find a complete description of formulas in “Formulas” on page 19 of Formulas & Programing.

Evaluate Formula Twice: If this advanced option is enabled, Panorama will calculate the formula, then treat
that result as a new formula and calculate it again to get the final result. The purpose of this feature is to allow
you to store the “real” formula separately in a global or permanent variable (see “Variables” on page 53 and
“Variables” on page 247 of Formulas & Programing for more information about setting up and using vari-
ables).

Don't Wrap Text: If text is too long to fit on a single line, it will usually "wrap" around to the next line. How-
ever, if the Don't Wrap Text checkbox is turned on, the text will not wrap. Instead, the text will be cut off.

For example, suppose you are constructing a mailing label. With the Don't Wrap Text option turned off, a
long company name will wrap to a second line, messing up the label.

long company name wraps to second line
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To fix this problem, go into Graphics Mode (see “Form Modes: Data Access vs. Graphic Design” on page 485),
double click on the Text Display object, and turn on the Don’t Wrap Text option.

Now the long line will be cut off, and the remaining lines will stay in the correct position.

3D Text: If this option is turned on, a white shadow appears behind the text. This gives the text a "3D" effect if
it appears over a colored background, like this.

Border: If this option is turned on, a one pixel border appears around the object, like this.

extra text is truncated
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"Aqua" Text: If this option is turned on the text will be smoothed (anti-aliased) if the operating system sup-
ports that feature.

Drop Shadow: If this option is turned on, a black drop shadow appears "below" the object. This option is
usually used in combination with the Border option, like this.

Scroll Bars: This section controls what scroll bars (if any) will be available when displaying this text, and
whether space will be left for a grow box if only one scroll bar is used. Here is a Text Display SuperObject
with the Vertical Scroll Bar enabled.

Here is the same object with both Vertical and Horizontal scroll bars.

Text Display scroll bar

Text Display scroll bars



Chapter 15:Displaying and Editing Text Page 615
With the Vertical and Grow Box options turned on, Panorama leaves an empty spot for a grow box in the
lower right hand corner.

Elsewhere in this manual you can learn how to turn off the form’s scroll bars (see “Window Options” on
page 172) and how to add your own custom grow box (see “Elastic Forms” on page 922), to make a final win-
dow that looks like this.

Thin Scroll Bar: Scroll bars are normally 16 pixels wide. When this option is checked the scroll bar will be
only 11 pixels wide. 

empty spot for grow box

thin scroll bar (11 pixels)
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Align: This area contains nine radio buttons, allowing you to control the position of the text within the object. 

You have the choice of left, center, or right and top, middle, or bottom. (You can also choose left, center, or
right from the Text menu.) This table illustrates the nine different alignment options.

Note: If you have enabled the vertical scroll bar, you must choose one of the top three alignment buttons. If
you have enabled the horizontal scroll bar, you must choose the top left alignment button. 
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Scale Text Size: Usually the Text Display SuperObject displays text in a fixed size, controlled by the Text
menu or the Graphic Control Strip (see “Text Size” on page 531). However, if the Scale Text Size option is
turned on, the text size will be proportional to the height of the Text Display SuperObject. The taller the
object, the bigger the text This option can be very useful when used with a form that adjusts as the window
size changes.

To illustrate this option, let’s first look at an ordinary object with this option turned off.

No matter how much we expand or shrink this object, the text size will always be 18 points.

Now let’s turn on the Scale Text Size option. At a small size, the object looks pretty similar to the way it did
before.

Check out what happens now when the object is expanded! The text size expands also, automatically and in
exact proportion to the new height of the object.

When the Scale Text Size option is enabled, Panorama ignores the font size setting. Instead the value in the
Lines box tells Panorama what ratio to use for scaling the text. If the value is 2, the text height will be one half
of the object height. If the value is 3.5, the text height will be 1/3.5 of the object height.

You may need to play with the value to get the effect you want, and the value may need to change depending
on the font you select. (Remember that when you use the Scale Text Size option, the text may be displayed in
any size, so you should select a font that will look good in any size—either a True Type font or a PostScript
font with ATM (Adobe Type Manager).)
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As an example of a practical use for the Scale Text Size option, here is a calendar that uses this option so that
the text gets bigger as the window get bigger. Here’s the calendar viewed at minimum size.

When the window expands, all of the text in the calendar expands also.

In addition to Text Display SuperObjects this form also uses a SuperMatrix object (see “Super Matrix
Objects” on page 939) and Auto Grow SuperObject (see “Elastic Forms” on page 922).
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Controlling Text Display Color and Style on the Fly

Display text normally appears in the color and style you have selected for the object (see “Color” on page 526
and “Text Style” on page 532). If you are using a Text Display SuperObject, however, it is possible for the for-
mula to change the color and style of the displayed text on the fly. For example you could set up the object so
that positive numbers are black and negative numbers are in red. Or, you could make high priority items dis-
play in bold italic.

To control the color and style, you must use the textdisplay( function (see “TEXTDISPLAY(” on
page 5852 of the Panorama Reference for detailed information on this function). Warning: The textdisplay(
function must be the very first item in the formula! If the textdisplay( function is not the first item in the
formula, the display will be incorrect. (Advanced Note: The textdisplay( function actually generates a
special header that is intercepted and removed by the Text Display SuperObject. This header contains special
control characters that the object uses to determine what style and color to use.)

The textdisplay( function has two parameters: color and style The color must be the result of the
rgb( function (see “Colors” on page 154 of Formulas & Programing for detailed information on the use of
color within Panorama formulas). Some useful colors are listed in the table below.

Here is an example of the textdisplay( function in a formula.

This formula causes Panorama to display any price over $150,000 in red. Lower prices are in black.

The style parameter is a number that controls the style of the displayed text. For simple styles, simply use the
name of the style: "Plain" "Bold" "Italic" "Underline" "Outline" or "Shadow". If you want to
combine multiple styles together, you must specify the style numerically. Add up the number for the styles
you want from the table listed below. For example, for bold italic text the style should be 3.

Formula Color

rgb(0,0,0) Black

rgb(65535,65535,65535) White

rgb(65535,0,0) Red

rgb(0,65535,0) Green

rgb(0,0,65535) Blue

red black
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This example uses the textdisplay( function to display numbers greater than 130 in bold.

The formula is being used as part of a blood sugar log for a diabetes patient. Values over 130 are abnormally
high and possibly indicate the need for a change in treatment.

With a slight change this formula will display the abnormal values in bold italic.

Style Number

Plain 0

Bold 1

Italic 2

Underline 4

Outline 8

Shadow 16

1 (bold) + 2 (italic) = 3 (bold italic)
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Here’s the final result.

Using Formulas to Display Text

Panorama uses formulas to manipulate numbers and text. Using an auto-wrap text object (see “Displaying
Formulas in Auto-Wrap Text” on page 602), a Text Display SuperObject (see “Text Display SuperObjects™”
on page 608) or a Text Editor SuperObject (see “Text Editor SuperObject” on page 639) you can display the
result of a formula on a form (and, since forms are used to produce reports, on a printed report).

There are an infinite number of ways to combine fields, variables and functions into useful formulas. In the
following sections we will explore some of the more common types of formulas used to display information
in forms.

Combining Multiple Text Items Into One

Many times you’ll need to combine several different fields or variables together, usually with captions and
punctuation (carriage returns, commas, spaces etc.) In a formula two text items can be combined with the +
operator.



Page 622 Panorama Handbook
This formula probably isn’t what you had in mind, because the result (seen below in Data Mode) doesn’t
have a space between the first and last name.

Fixed text items (like captions, spaces and other punctuation) must be enclosed in quotes. Panorama allows
several different kinds of quotes, as shown in this table.

Curly braces cannot be used to quote text in an auto-wrap text object, because they are used to surround the
entire formula. Other than that you can use any one of these pairs of quote characters whenever you want.
See “Constants” on page 49 of Formulas & Programing for more information about quoting text.

Now that we know how to quote a fixed text item we can add a space between the first and last names.

Switch to Data Mode (see “Form Modes: Data Access vs. Graphic Design” on page 485) and voila! The cor-
rectly formatted name appears.

Type Open Close Example

Double Quote " " "January"

Single Quote ' ' 'Tuesday'

Curly Braces { } {San Francisco}

Smart Double Quote “ ” “Gothic”

Smart Single Quote ‘ ’ ‘Bohemian’
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In a formula a carriage return is represented by the ¶ symbol. On the Macintosh you can enter this by typing
Option-7. On Windows systems press Alt-0182. We can use this symbol to help build a complete address
label.

The formula appears all on a single line, but switching to Data Mode shows the finished label on three lines.

Our example used an auto-wrap text object, but the exact same formula could be used with a Text Display
SuperObject. In Data Mode this object will look exactly like the previous example. (Of course, using a Text
Display SuperObject would give you more options for aligning and scaling the text, see “Text Display
Options” on page 611).

Note: The alert reader will have noticed that it is possible to create a label like this using data merge in an
auto-wrap text object, without using all of these quotes and ¶ and + symbols (see “Displaying Data in Auto-
Wrap Text” on page 595). The data merge is simpler, so why bother with a formula? In this case there is no
reason except to illustrate the ability to combine text items together. In the following sections, however, we
will expand on this example to show applications that can only be done with a formula.
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Creating a Smart Formula

In the real world, data often doesn’t fit into neat little boxes. Some people will enter their middle initial, some
won’t. Some motels have off peak rates, some don’t. Some countries measure temperature in Fahrenheit,
some in Celsius. It takes a bit of work, but using the ?( and sandwich( functions you can set up formulas
that display data correctly under changing, sometimes opposite circumstances.

The ?( function allows a formula to make a yes/no, either/or decision. For example, consider the address
label created in the previous section. Suppose the first name is missing? Using the ?( function a formula can
be constructed that substitutes Mr. for the missing first name.

In data mode, anyone with a first name will simply display a standard label including the first and last
names.

But if the first name is missing, Mr. will be substituted.

the function will make a decision based on whether First is empty (equal to "") or not empty

if First is empty, then "Mr." will be substituted where the first name normally goes

if First is not empty, then it will be included here
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There are many ways you can use the ?( function. Here is a slight re-arrangement of the previous example.

Here’s what this formula produces if the first name is missing.

The ?( function is a simple but very powerful tool. See “The ? Function” on page 130 of Formulas & Program-
ing for more detailed information about this function.

Eliminating Unnecessary Punctuation and Blank Areas With the Sandwich Function

Yes, Panorama actually has a function named sandwich! If an item of data is missing, you’ll usually want to
eliminate any punctuation that is associated with that item. For example, if the middle name is missing, you
won’t want to include the extra space. If the city is missing from an address, you’ll want to leave off the
comma afterwards, instead of leaving a comma hanging in the air like this.

If the company name is missing from an address, you’ll want to leave off the following carriage return so
there won’t be a blank line. All of these tasks can be performed with the ?( function, but there’s also an easier
way: the sandwich( function.
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The sandwich( function has three parameters: prefix, root and suffix. The root is the main item of text you
want to display. The sandwich( function will add the prefix and suffix to the beginning and end of the root,
kind of like slapping bread around a slice of salami. However, if the root is empty, the sandwich( function
won’t “slap on the bread.”

The results of this function depend on whether or not the City field contains any text. If it does, Panorama
adds the prefix (which in this case is empty) and the suffix.

If the City field is empty, Panorama leaves out the prefix and the suffix also. Here’s our empty record again,
but this time, no comma hanging in the middle of the air!

You’ll find that the sandwich( function is very delicious any time you need to conditionally include spacing
or punctuation around a field that might be blank. (Sorry, couldn’t resist.)

root (the “meat”)

suffixprefix

root (the “meat”)
suffixprefix (none)
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Combining Numbers with Text

If a formula contains nothing but a single numeric value, Panorama will automatically convert the value to
text for you, like this.

Panorama will decide for itself what format to use for the number.

If you don’t like the format that Panorama chooses you can use the pattern( function to specify the exact
format you want to use.

The pattern( function gives you total control over the format of the final number. See “Converting Between
Numbers and Strings” on page 84 of Formulas & Programing for a complete description of this function.
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If your formula results in more than a single number (for example two numbers or text and a number) you
must convert the numbers to text before they can be used in the formula. This must be done with the str( or
pattern( functions as shown in this example.

Here’s the finished result in Data Mode.

The pattern( function gives you total control over the format of the number. Use the str( function if you
are content to let Panorama decide what format to use.

In this case Panorama chose a simple integer format.

By the way, in case you haven’t guessed, the info("records") function calculates the total number of
records in the database. See “INFO("RECORDS")” on page 5410 of the Panorama Reference for the complete
details on this function. See “Converting Between Numbers and Strings” on page 84 of Formulas & Program-
ing to learn more about the str( function.
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Displaying Dates

To display a date in a field or variable you must convert that date to text with the datepattern( function
(see “Converting Between Dates and Text” on page 107 of Formulas & Programing for all the gory details).
Here’s a simple example that prints the current date and time on the top of each page of a report.

When this report is printed the date and time will appear at the top of the page, like this.

use datepattern( function to convert date to text
use today() function to calculate current day

this pattern specifies the date format

use timepattern( function to convert time to text

use now() function to calculate current time

this pattern specifies the time format
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This example was created with an auto-wrap text object and two embedded formulas. You can create the
same effect with a Text Display SuperObject, but in that case you must use a single formula like this.

"Printed on "+datepattern(today(),"Month ddnth, yyyy")+
" at "+timepattern(now(),"hh:mm am/pm")

The end result is the same either way. (However, with the Text Display SuperObject you would have the
option to center the text vertically or to scale the text automatically. See “Text Display Options” on page 611.)

Merging Images Into Text

Panorama allows an image from the Flash Art Gallery (either stored in the database file itself or on disk) to
be merged into the middle of an auto-wrap text object or Text Display SuperObject (see “Flash Art™” on
page 750 for more information about this gallery). The image cannot be merged into the middle of a line, but
simply replaces one line of text. The line will expand to the full height of the image. For example, this feature
could be used to insert a logo or a signature in a letter. To illustrate this feature we’ll assume you have an
image in your Flash Art Gallery named My Signature.

To insert an image into an auto-wrap text object you must use a special formula. The formula looks like this
(Of course, you should insert the actual name of your image instead of My Signature).

{chr(1)+"My Signature"+¶}
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Here is a complete letter with the special formula for inserting the image at the bottom. The formula must be
on a separate line all by itself, with nothing else on the line.

Switch to Data Access Mode to see the finished product.

formula to insert image
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Panorama can be a little bit picky about displaying an image in an auto-wrap text object. Remember, the
image cannot be mixed in the middle of a line of text, but must be on a line all by itself. In addition, this fea-
ture only works if the auto-wrap text object is filled with NONE (see “Fill Pattern” on page 521). If the text
object is filled with white or any other color, the image will not appear. Since NONE is the default for new
text objects you probably won’t have a problem, but if you do have difficulties getting the image to appear
this is the first thing to check.

One final tip — this feature works with either an auto-wrap text objects or a Text Display SuperObject. (How-
ever, it does not work with Text Editor or Word Processor SuperObjects.)

Editing Text

Most data entry and editing is done with the keyboard. The rest of this chapter shows how to set up a form
objects for editing text.

Types of Data Editing Objects

In a form data entry is done through objects (just like everything else in a form!). Each object allows a specific
item of data to be edited (for example a person’s first name or a phone number). A collection of data editing
objects is assembled to create a complete data entry form.

fill pattern must be NONE (N)

each object edits a single data item
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Panorama has two primary types of objects for editing text: data cell objects (shown above) and Text Editor
SuperObjects. You can mix these two types on a single form, but usually you’ll want to choose one type per
form and stick with it.

Data cell objects are the “classic” way to edit data in a Panorama form. In early versions of Panorama (before
version 3) this was the only kind of text editing object available. Data cell objects are designed to mimic the
way Panorama works in the data sheet. In Data Mode, clicking once on a data cell object selects the field, but
does not open the field for editing.

Clicking twice on the object opens the pop-up data editing Input Box you are familiar with from the data
sheet (see “The Input Box” on page 272).

Just as in the data sheet, the data cell object’s Input Box can be expanded by dragging on the lower right hand
corner (see “Expanding the Input Box” on page 273).

To learn how to add data cell objects to your form see “Working with Data Cell Objects” on page 635.

click once to select field

double click to edit field

drag corner to resize Input Box
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As an alternative to data cells, a form may be designed with Text Editor SuperObjects. Text Editor SuperOb-
jects allow you to edit text right in the form window—no double click is required. You can simply click or
drag on the text to begin editing. Press Enter when you are finished. The illustration below shows the effect
of double clicking on the word Harmony. As you can see, instead of opening an Input Box this selects the
word for editing.

Since the Text Editor SuperObject doesn’t use an Input Box, you cannot expand the size of the editing area
“on-the-fly” the same way you can with data cells. The editing area must be defined in advance. On the other
hand, the Text Editor SuperObject doesn’t require the extra double click, and works more like other standard
applications you may be used to. See “Creating and Modifying Text Editor SuperObjects” on page 639 to
learn how to create a form with Text Editor SuperObjects. 

The table below summarizes the differences between data cell objects and Text Editor SuperObjects. For
many applications, either type will work all depending on your personal preferences. Some advanced fea-
tures (for example editing variables, see next section) do require the use of Text Editor SuperObjects.

Feature Data Cell Text Editor SuperObject

Operation Edit in pop-up Input Box
(similar to data sheet) Edit directly in form window

Expandable Editing Area? Yes No

Double Click before Editing? Yes No

Edit Fields? Yes Yes

Edit Variables? No Yes

Optional Borders? No Yes

Custom Object Pattern? Yes No
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Working with Data Cell Objects

Data cells are created with the Data Cell tool. To create a data cell, start by selecting this tool.

Next drag the mouse across the surface of the form. It’s just like creating a rectangle.

When you release the mouse, Panorama automatically assigns the first field from the database to the new
data cell.
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As you create additional cells, each cell is automatically assigned to the next field (using the same order that
the fields appear in the data sheet). In this case the second field in the database is named Last.

You can continue to add cells to the form. The next field in this database is Credit Card. 

To change the field assigned to a data cell, move the mouse over the cell. The mouse arrow will change to a
mini-menu icon.
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When you see the mini-menu icon, press the mouse to activate a pop-up menu showing all the fields in the
database.

Select the field you want assigned to this data cell and release the mouse.

You can use this technique to change the field assigned to any data cell at any time. Remember, however, that
you must have the Data Cell tool selected. You cannot change the field assignment when any other tool
(including the Pointer) is selected.

At this point we can continue making additional data cells. The next data cell will be assigned the next field
after Title (in this case Company).
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When you create data cells by hand like this, the result is likely to be a bit messy. After creating some more
cells, we cleaned up this form using a combination of the Dimension dialog (see “Setting Exact Dimensions of
Multiple Objects” on page 550) the Align dialog (see “Aligning Objects” on page 553), the Spacing dialog
(see “Adjusting Spacing Between Multiple Objects” on page 556) and nudging with the arrow keys (see
“Nudging an Object (or Objects)” on page 509).

These data cells are ready to use. Simply click on the Switch To Data Access Mode tool and you are ready to
start typing.

If you need to revise the data cells (or any other form object) later, click on the Switch to Graphic Design
Mode tool.

Data Cell Custom Output Patterns

Numeric and date data cells are normally formatted using the master output pattern specified in the design
sheet (see “Field Properties” on page 215). If you wish, you can override the design sheet output pattern for
an individual data cell in the form. To do this, use the pointer tool to select the cell and choose Output Pattern
from the Text menu. (Alternately, you can simply double click on the data cell.) Type the new output pattern
into the dialog.
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The data cell will now display the date using the output pattern you typed in.

To review output patterns, see “Numeric Output Patterns” on page 250 and see “Date Output Patterns” on
page 255.

Text Editor SuperObject

The Text Editor SuperObject is used to edit text in a field or variable. Unlike a data cell, the Text Editor Super-
Object does not use a temporary pop-up window for editing. Instead, the user simply clicks and edits the text
right in the form window, just as they do with most other applications (see “Types of Data Editing Objects”
on page 632). (Of course the down side of this is that the area available for editing is fixed and can't be
expanded except by changing the form layout in graphic mode, or with an Auto Grow SuperObject). Another
difference from data cells is that Text Editor SuperObjects can edit variables as well as fields. They can auto-
matically draw borders and include one or two scroll bars (or none). (If you wish, you can mix Text Editor
SuperObjects with standard data cells objects on the same form).

Creating and Modifying Text Editor SuperObjects

The Text Editor SuperObject tool is not in the default tool palette, so you’ll need to use the Tool Palette dialog
to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).
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Now that the tool is added to the palette you can select it.

Once the tool is selected, drag the mouse across the form in the location where you want to create the Text
Editor SuperObject.



Chapter 15:Displaying and Editing Text Page 641
When you release the mouse, the Text Editor SuperObject configuration dialog will appear.

At a minimum you must enter a field name, variable or formula into the dialog. You can use the pop-up
menu to select a field.
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For this example we’ve also turned on the Borders options (all of the available options are discussed in detail
in the next section).

When the OK button is pressed the new object appears. (Notice that unlike the data cell object, the Text Editor
SuperObject shows the actual data in both Graphics Mode and Data Access Mode, not just Data Access
Mode.)

After it has been created you can modify the location, size, font, style and color of a Text Editor SuperObject
just like any other object. To change any of the object attributes (scroll bars, border, formatting etc.) select the
Pointer tool and double click on the object. The configuration dialog will appear again. Make your changes
and press the OK button.
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Text Editor Options

The SuperObject Text Editor Properties dialog is divided into several sections.

Data: Each Text Editor SuperObject edits a single data item, which may be a database field, a variable, or a
formula. To edit a field, type in the name of the field or select the field name from the pop-up menu.



Page 644 Panorama Handbook
A variable is a place to store information independently of any database. The primary use for variables is as
temporary storage for procedures (see “Variables” on page 53 and “Variables” on page 247 of Formulas & Pro-
graming). A variable can also be created and edited by a Text Editor SuperObject. Simply click on the Variable
option and type in the name of the variable.

If you specify a variable that has not already been created with a procedure, Panorama will automatically cre-
ate a global or fileglobal variable with this name the first time the form is displayed. (The default is a global
variable unless the FileGlobal Variables option is set in the Form Preferences dialog, see “Creating Variables
with a SuperObject” on page 251 of Formulas & Programing.) Once it has been created this variable can be
used in formulas and procedures, just like any other variable. For example, suppose that your database has
fields named AreaCode and PhoneNumber. The short procedure listed below will check the area code against
the local area code entered by the user in the Text Editor SuperObject. If it is a local call, only the local number
is dialed. If the number is out of the local area, Panorama will dial 1 plus the area code plus the phone num-
ber. (See “Writing a Procedure from Scratch” on page 216 of Formulas & Programing to learn how to create a
procedure. See “The ? Function” on page 130 of Formulas & Programing and “DIAL” on page 5167 of the Pro-
gramming Reference for more information about the specific statements and functions used in this procedure.)

dialdigits ?(AreaCode=LocalAreaCode,PhoneNumber,"1"+AreaCode+PhoneNumber)

For an application like this you would probably want to make LocalAreaCode a permanent variable so that
you don’t have to re-enter it every time you open the database. See “Creating a Variable” on page 247 of For-
mulas & Programing to learn how to create a permanent variable.
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The final data option is Formula. If you select this item the Text Editor SuperObject is not editing a real data
item, but a temporary data item created “on-the-fly” using a formula. To illustrate this capability we’ll create
an object that edits two database fields (first and last names) in a single Text Editor SuperObject. Select the
Formula option and type in the formula — in this case a formula that combines the first and last names.

formula

procedure for splitting the result into two fields (see text)

this option must be set
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This illustration shows the finished object (in the front window). As you can see, the object combines the two
separate fields into just one object.

There’s only one problem — if you edit the name, how does Panorama know where to put the edited text?
You can’t store text in a formula! Since it doesn’t know where else to put it, Panorama places the edited text in
a variable called TextEditingResult. If you want to store this text somewhere else you’ll need to create a pro-
cedure that takes this variable and stores the data somewhere (see “Writing a Procedure from Scratch” on
page 216 of Formulas & Programing to learn how to create a procedure). The procedure can have any name
you like. For this example we have created a procedure called .SplitTheName.

This procedure uses the array( function (see “Text Arrays” on page 93 of Formulas & Programing) to take the
edited text and split it back into separate first and last names. Panorama has several statements and functions
that are very handy for splitting data into multiple components, see “Natural Data Display” on page 528,
“Taking Strings Apart (Text Funnels)” on page 69 and “Text Arrays” on page 93 of Formulas & Programing.

Once the procedure has been created you must select it in the Text Editor SuperObject configuration dialog
(see below). You also need to make sure that the Finished option is turned on. The Finished option tells Pan-
orama to trigger the procedure when editing is finished (when the Enter key is pressed or when you click on
another object).

First and Last name combined in one object

data sheet shows that First and Last are separate fields

select procedure using pop-up menu

this option triggers the procedure when editing is finished
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Once the procedure is set up and configured in the dialog you can use the Text Editor SuperObject to edit the
name. In this case the last name is being changed from Kovacs to Dempsey.

When the Enter key is pressed the First and Last name fields in the database are updated (in this case only the
last name actually changed).

As you can see, it takes a bit of work to set up the Formula option, but it does give you the power to set up a
user interface that is independent from the data sheet structure.

Scroll Bars: This section controls what scroll bars (if any) will be available when editing this text.

updated last name
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Here is a Text Display SuperObject with the Vertical Scroll Bar enabled.

The Thin Scroll Bar option makes the scroll bar (or bars) 11 pixels wide instead of 16.
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Here is the same object with both Vertical and Horizontal scroll bars.

With the Vertical and Grow Box options turned on, Panorama leaves an empty spot for a grow box in the
lower right hand corner.

empty spot for grow box
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Elsewhere in this manual you can learn how to turn off the form’s scroll bars (see “Window Options” on
page 172) and how to add your own custom grow box (see “Elastic Forms” on page 922), to make a final win-
dow that looks like this.

Padding: When this option is checked extra padding appears around the top, left and right sides of the text.
Here is an example of an object without padding.

Here is the same object with padding.
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Wrap at End of Line:  If text being edited is too long to fit on a single line, it will usually "wrap" around to the
next line.

However, if the Wrap at End of Line checkbox is turned off, the text will not wrap. Instead, the text will con-
tinue off the right edge. 
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If the horizontal scroll bar is enabled, you can scroll over to see the rest of the text.

Non-White Background: We recommend that you use this option if the Text Editor SuperObject is placed
over a color (non-white) background. If this option is turned on, Panorama will temporarily display a white
background behind the text while it is being edited.

background of object turns white during editing
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If you don't use this option, you'll find that portions of the background will turn white as you edit anyway.
the result is ugly and possibly confusing.

I think you can see why we recommend using the Non-White Background option!

Terminate When: You can always press the Enter key when you have finished editing a data item. Depend-
ing on the options set in this dialog other keys may also cause editing of this cell to finish, including the
Return, Tab, Up Arrow, or Down Arrow keys. (Note: If you want to be able to tab from this item to the next,
be sure to select the Tab key as one of the keys that causes termination. On the other hand, if you want to be
able to use the Tab key inside this field or variable, Tab should not be checked.)

Borders: The options in this section control the borders that are displayed around the text (if any). You may
separately control the top, bottom, left, and right borders or click on the word Borders to turn all four on or
off at once. 

The Shadow option makes a drop shadow appear.

click on the word Borders to turn all 4 borders on or off
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The 3D border effect works best with a light gray background.

The Aqua border effect displays the same soft 3D borders that are used by most OS X applications. This
option can work with a light gray or white background.

When the Focus Ring option is checked, Panorama will display a blue ring around the object when it is being
actively edited.

When you shift to editing a different object, the blue ring will move to this new object.

(Note: You can control the background color for the entire form with the Form Preferences command in the
Setup menu. See “Form Background Colors” on page 582.)
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Tab = 4 Spaces:  If this option is enabled, pressing the Tab key will be the same as pressing the Space Bar four
times.

If this option is selected, the Tab checkbox (part of the Terminate line) should be turned off.

Insertion Point:  This option gives you the choice of what text should be selected when you tab into this Text
Editor SuperObject. (Of course when you click into a Text Editor SuperObject, the insertion point goes where
you click.) The three options are: At End, At Start, and ALL (which selects all the text). In the example above,
the Address object has the Insertion Point option set to ALL.

When you Tab from the Company into the Address field, all of the text is selected.

press TAB to indent
4 spaces
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If the At End option had been selected, the insertion point would be at the end of the address.

If the At Start option had been selected, the insertion point would be at the start of the address.

Update Variable Every Key:  This option only works when editing variables, not fields. If this option is
enabled, the Text Editor SuperObject will update the value of the variable immediately after every key is
pressed. Otherwise the variable will not be updated until editing is finished. This mode is especially useful
when the Text Editor SuperObject is set up to trigger a procedure after every key or most keys (see next sec-
tion).
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Procedure: This section specifies what procedure is associated with this Text Editor SuperObject (if any) and
when that procedure will be triggered. To select or change the procedure associated with this object, use the
pop-up menu.



Page 658 Panorama Handbook
If you later decided to disable the procedure, click on the checkbox (or simply select another procedure).

There are four choices for triggering a procedure: Every Key, Most Keys, Finished and Focus.  Finished sim-
ply means that the procedure will be triggered when the user signals that he or she has finished editing the
text by pressing Enter, Return, Tab, etc. (Note: If the Text Editor SuperObject is associated with a field, a pro-
cedure may also be triggered even if no procedure is assigned in the configuration dialog. If the field has a
procedure assigned to it in the design sheet, it will be triggered (see “Data Entry Triggers” on page 387 of For-
mulas & Programing). If there is no Finish procedure selected and no design sheet procedure, the .Modi-
fyRecord procedure (if any) will be triggered (see “.ModifyRecord” on page 383 of Formulas & Programing).)

If the Every Key option is checked, the procedure will be triggered every time the user presses a key. For
example, you might use this option if you wanted to count the user's key strokes.

If the Most Keys option is checked, the procedure will be triggered after every key when the user types
slowly, but will not be triggered for each key when the user types several characters quickly in a row. The
procedure will not be triggered until the user pauses in his or her typing. This option often works as well as
the Every Key option but usually appears much smoother and faster to the user because the procedure is not
being triggered as frequently while the user types. Possible applications for the Most Keys options include
counting the characters or words being edited, performing a calculation (metric conversion, for example),
checking spelling, etc.

In this illustration the Text Editor SuperObject containing the formula has been set up with the Most Keys
option. 

click here to disable procedure
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When a key is pressed (most times) a procedure is triggered. This procedure calculates and displays the result
of the formula. The new result appears immediately, as soon as the key is pressed. (If the Finished option was
used instead of Most Keys, the result would not appear until you pressed the Enter key.)

If you want to duplicate this example yourself, here is the .Calculate procedure (see “Procedures” on
page 203 of Formulas & Programing). This procedure relies on the execute statement to perform the calcula-
tion. See “Building Subroutines On The Fly (The Execute Statement)” on page 280 of Formulas & Programing
to learn about this statement.

The last line of this procedure refers to the Text Editor SuperObject by the name Formula.

superobject "Formula","Open"

For this to work the SuperObject must be given this name with the Object Name dialog. See “Object Type/
Object Name” on page 533 to learn how to give an object a name.

If the Focus option is checked, the procedure will be triggered every time editing starts to happen in this
object. In other words, when you click on the field or tab into the field, the procedure will be triggered. It’s
called Focus because this option is triggered whenever this object becomes the focus of attention. 

One use for a focus procedure is to implement Undo for editing. Here is a procedure that saves the data in the
field as the editing begins.

if info("trigger") beginswith "Focus."
undoCell=«»   /* «» is the current field */
undoField=info("fieldname")

endif

The Undo procedure would look like this.

if undoField<>""
set undoField,undoCell

endif

As soon as a key is pressed…

the new result appears
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For completeness you may wish to add the following line to your .CurrentRecord procedure (see “.Curren-
tRecord” on page 381 of Formulas & Programing). This line ensures that you cannot undo after moving to a
different record.

    undoField=""

Another use for the Focus procedure is to memorize the selection point when editing was terminated and re-
set the selection when editing resumes again. This example assumes that the database has two numeric fields
named textStart and textEnd.

if info("trigger") contains "focus"
activesuperobject "setselection",textStart,textEnd

else
activesuperobject "getselection",textStart,textEnd

endif

The Focus option must be used with the ..Handler option turned on. When the ..Handler option is turned on,
all procedures triggered by the Text Editor SuperObject are treated as event handler procedures (see “Event
Handler Procedures” on page 394 of Formulas & Programing). The benefit of using event handler procedures
is that these procedures are guaranteed to trigger and work properly under all conditions, no matter how the
user started or stopped editing and whether or not another procedure is currently running. The only down-
side is that event handler procedures cannot open or close windows. To retain compatibility with databases
created with earlier versions of Panorama you are allowed to turn the ..Handler option off. To learn more
about this type of procedure see “Event Handler Procedures” on page 394 of Formulas & Programing.

AutoCaps: This option only appears if the Text Editor is associated with a variable or formula.

Use the pop-up menu to control automatic capitalization of the text as it is entered. You can force the text to
all upper case (ABC), word caps (Abc), or capitalization of the first letter of each sentence. If the Text Editor
SuperObject is associated with a field, the Text Editor SuperObject will automatically use the Auto Caps set-
ting for that field (set in the design sheet or the Field Preferences dialog, see “Field Properties” on page 215.)
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Use Field Attributes: This section only appears if the Text Editor SuperObject  is associated with a variable or
formula. You can use this if you would like the Text Editor SuperObject to use the attributes assigned to one
of the fields in your database.

When you select a field with the pop-up menu, the Text Editor SuperObject will use that field's settings for
Input Pattern, Range, Clairvoyance, Space Bar Tab, and Duplicates. (Of course, if the Text Editor is associated
with a field, the text editor will always use the attributes of that field (set in the design sheet or the Field Pref-
erences dialog.)

Converting Data Cells into a Text Editor SuperObjects

To convert one or more data cells into Text Editor SuperObjects, start by selecting the cells. Then double click
on one of the selected cells.
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When you double click the dialog shown below will appear.

Check the Convert to SuperObject box and press OK to convert the selected data cells into Text Editor Super-
Objects.

If you want to change the attributes of any of these new SuperObjects you must double click each object and
set the attributes individually.

Automatically Creating Rows or Columns of Data Cells or Text Editor SuperObjects

Earlier in this chapter you learned how to create data cell objects and Text Editor SuperObjects one at a time.
The Auto Cell Layout command (in the Arrange menu) can automatically generate an entire row or column
of these objects. To use this command, first pick the font and size you want to use from the Graphic Control
Strip or the Text sub-menus (see “Font” on page 529 and “Text Size” on page 531). Once the font is set, make
sure the Pointer tool is selected and click on the spot where you want to place the new objects.

click once at the location
where you want to place
the new objects
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Then open the Auto Cell Layout dialog using the Arrange menu. This dialog allows you to choose the fields
and arrangement you want.

The box on the left of the dialog lists all the fields in the database. Select each field you want to place in the
form. There are several ways to select fields. You can select individual fields by clicking on them. You can
select several fields at once by dragging the mouse across them. You can select all the fields by pressing the
Select All Fields button. If you change your mind, you can de-select a field by clicking on it again.

Once you have selected the fields you want to create, press the OK button to place the fields into the form.

The new objects appear just below and to the right of the spot you originally clicked on.

Automatic Layout Options

The right hand side of the Auto Cell Layout dialog contains options for varying the arrangement of objects
that are created.
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The Across option controls the direction of the generated objects. The normal direction is down.

If the Across option is enabled the objects are generated horizontally, in a row.

The Same Width option controls the width of the generated objects. If this option is off, the width of each
object will be the same as the width of the corresponding column in the data sheet (see “Changing the Width
of a Field” on page 199). If the Same Width option is enabled, all of the objects will have the same width. (Of
course you can always change the width of any object after it has been generated — see “Changing the Size of
a Single Object” on page 513.) This illustration shows what the end result of this option looks like both in nor-
mal mode and with the Across option enabled.
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The Lines High option specifies the height of each object. Normally each object is one line high in the current
font, but you can generate objects that are two lines high, three lines high, or more. Of course you can also
change the height of any object after it has been generated (see “Changing the Size of a Single Object” on
page 513).

The Pixels Between option specifies the spacing between adjacent data cells. (A pixel is one dot on the screen
at 100% magnification, or 1⁄72 inch.) When you create a column of data cells, this option specifies the vertical
spacing between the cells.

each object is three lines high

each object is two lines high
each object is one line high

5 pixels between2 pixels between1 pixel betweenZero pixels between
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When you create a row of data cells (Across), this option specifies the horizontal spacing between the cells.

The Field Names option tells Panorama to create a field name next to each generated object. If you create a
column of objects, the field names will be placed to the left.

If you create a row of data cells (Across), the field names will be placed above the objects, like this.

Zero pixels between
1 pixel between
2 pixels between

5 pixels between
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Use the Boxes option if you want Panorama to draw a box around each generated object. This usually makes
sense only for data cells, since for Text Editor SuperObjects you can generate borders as part of the object
itself. This illustration shows what the boxes look like when used with data cells.

It’s a bit easier to see what the boxes look like in Data Access Mode (see “Form Modes: Data Access vs.
Graphic Design” on page 485).

If Field Names option is checked Panorama will draw a box around the field names as well.
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To create Text Editor SuperObjects instead of data cell, check the Create SuperObjects option. Once this
option is turned on, you can select the options for the Text Editor SuperObjects you want to create — borders,
formatting, etc. These options are the same as the options in the Text Editor SuperObject configuration dialog
(see “Text Editor Options” on page 643).

Pressing OK generates a column of Text Editor SuperObjects (instead of data cells).

Clicking on the word Borders will turn all four borders on or off. If you use the Text Editor SuperObject bor-
ders your probably will not want to turn on the Boxes option, which adds an additional box around each
object (see above).
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Line Items in a Form

Line items are used for repeating items within a record (see “Repeating Fields (Line Items)” on page 222). The
Auto Cell Layout command makes it easy to create a table of line items within a form. With the Pointer tool
selected, click on the upper left hand corner of the spot where you want the line items to appear. Next choose
the font and style you want to use. Now open the Auto Cell Layout dialog and press the Line Items button.

Pressing the Line Items button selects all the line item fields, and also checks the Across and Field Names
options. You may also want to check the Boxes option and/or the Create Superobjects option (see “Automatic
Layout Options” on page 663). When you press the OK button, Panorama will automatically create a table of
line items formatted into rows and columns.

To learn how to adjust the width of an entire column in this table see “Cluster Resize” on page 541. To learn
how to change the font size of this table (or the spacing) see “Adjusting Spacing Between Multiple Objects”
on page 556.



Page 670 Panorama Handbook
Tab Order in Forms

Panorama has three tab order options for forms—data sheet order, back to front order, and natural order.
Use the Form Preferences command (Setup menu) to specify the tab order option you want to use. (The form
must be in graphic design mode.)

Data sheet order is exactly that—the Tab key moves from cell to cell in the same order as it would in the data
sheet. However, data sheet order will not work if your form contains one or more variables in addition to
fields to be edited (See “Text Editor Options” on page 643).

Natural order causes the Tab key to move from left to right, then from top to bottom.

This usually works well (and is the default option), but in some cases isn’t really what you want. This is espe-
cially true in forms with side by side columns of data.
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To fix this you can alter the natural order by grouping data cells together–the Tab key will move through all
the cells in the group of objects (in natural order) before it moves to the next cell. In this case the data cells
need to be brought together into two groups using the Group command (see “Grouping Objects Together”
on page 536.)

Now that the cells have been grouped together the tab order will tab through all of the cells in the left hand
column before moving to the right hand column.

Back to Front order gives you the most control, but also takes the most work to set up. When this option is
enabled the tab order depends on the back to front layering of the data cell objects in the graphic design
mode. Use Send to Back to bring a data cell to the start of the tab order, and Bring to Front to send it to the
end of the tab order. See “Changing the Stacking Order” on page 569 for more information on these com-
mands.

For example, suppose your form contained three fields A, B, and C and you wanted to tab from field to field
in the order B › A › C. To set up this order click on field B and use Bring to Front (the form must be in graphic
design mode). Then click on field A and use Bring to Front. Finally click on field C and use Bring to Front.

Tab Order for Variables

The Form Preferences dialog (Setup menu) allows you to choose from three options — Natural, Data Sheet
Order, and Back to Front (see previous section). All three options will work fine if you editing only fields.
However, if a form allows the user to edit variables, the Data Sheet Order option will not work (because the
data sheet does not contain variables, so they have no order!) Any form that contains Text Editor SuperOb-
jects for variables should use Natural or Back to Front tab order.

Field Setup in Graphics Mode

As you are building a form, you may realize that the database needs another field for the form. You can use
the Setup menu to add new fields to the database (or modify existing field properties) without having to
leave graphic design mode. 

group  1 group  2
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To add a new field to the database from within graphic design mode, use the Add Field command in the
Setup menu. Once the field is added to the database itself, you can create new data cell or Text Editor Super-
Objects using the new field.

To modify an existing field, first use the Pointer tool to select a data cell assigned to the field you want to
modify (only data cells work — you cannot click on a Text Editor SuperObject). Then use the Field Properties
command (Setup menu) to modify the field. For more information on setting up fields see “Field Properties”
on page 215.
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Word Processor SuperObject

The Word Processing SuperObject™ allows you to include a complete word processor as part of a form. The
word processor allows you to mix different fonts, sizes, styles (16 different styles) and colors in a single para-
graph. Left, Right, and First Line margins may be set up separately for each paragraph, and you may set up
left justified, right justified, center justified and decimal tabs with optional tab leaders. The merge option
allows you to merge information from the database (or complete formulas) into the word processing text. The
word processor SuperObject also includes most of the options available with the Text Editor SuperObject,
including borders and a vertical scroll bar.

Creating and Working With Word Processor SuperObjects

The Word Processor SuperObject tool is not in the default tool palette, so you’ll need to use the Tool Palette
dialog to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the Word
Processing SuperObject.
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When you release the mouse, the Word Processor SuperObject configuration dialog will appear.

At a minimum you must enter a field name, variable or formula into the dialog. You can use the pop-up
menu to select a field. In this database we’ve created a field, called Body, to hold the word processing infor-
mation.



Page 676 Panorama Handbook
For this example we’ve also turned on the Vertical Scroll Bar and Borders options (all of the available options
are discussed in detail later in this chapter).

When the OK button is pressed the new object appears. The top portion of the object contains a ruler that
allows you to set tabs, alignment, line spacing and style.

After it has been created you can modify the location and size of a Word Processing SuperObject just like any
other object. To change any of the object attributes (scroll bars, border, formatting etc.) select the Pointer tool
and double click on the object. The configuration dialog will appear again. Make your changes and press the
OK button.

To actually use the word processor you need to switch to Data Access Mode (see “Form Modes: Data Access
vs. Graphic Design” on page 485). To learn more about how to configure the Word Processor for your specific
application see “Configuring the Word Processor” on page 696.
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Using the Word Processor

Once the word processing object is set up you can switch the form to Data Access Mode (see “Form Modes:
Data Access vs. Graphic Design” on page 485) and start using the word processor. To start editing, simply
click in the word processor object and start typing.

Whenever the word processor is active, an extra menu appears in the menu bar: the Text menu. This menu
contains the options for formatting text and controlling the word processor.
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At the top of the Text menu are five submenus: Font, Size, Styles, Fore Color, and Back Color. To change the
appearance of a section of text, start by selecting the text.

Next, choose the desired options from the Text menu.

The selected text will take on the new font, size, color or style (in this case bold).

The submenus also display the status of the selected text. If the text is all the same, a checkmark will appear
next to the font, size, or style.

the selected text is bold
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If the text contains several different styles in different parts of the text a dash will appear next to each font,
size or style that is contained within the selection. For example, the selected text in the illustration below con-
tains both bold and italic text.

Pulling down the Text menu shows all of the different styles in the current selection. (The Font and Size sub-
menus will also show all of the options used in the selection.)

The Fore Color submenu changes the color of the text.

the selected text is partially bold

… and partially italic
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For example, you can make the selected text red. You can choose any color in the 256 color palette.

The Background Color submenu works the same way, but changes the background color of the text.

The Font and Size menus work the same way as the corresponding menus for other text objects (see “Font”
on page 529 and “Text Size” on page 531). However, the Word Processor SuperObject allows multiple fonts
and sizes within a single object (as shown in the illustration above). In addition, the Font and Size are set
when in Data Access Mode, not Graphics Mode.

The Ruler

The ruler controls how paragraphs are formatted. The ruler allows you to set margins, tab stops, alignment,
line spacing and style.

background colorforeground color

line spacing
tab stopsalignment

left margin tab stops
right margin

style (plain/bold/italic/underline)
increase/decrease text size
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Since the ruler controls how paragraphs are formatted, the changes you make to the ruler are always applied
to entire paragraphs. If you click on a paragraph and make a change to the ruler, the change will affect the
entire paragraph. If you want to change the formatting of multiple paragraphs, select at least one character in
all of the paragraphs you want to change before adjusting the ruler.

The word processing ruler always uses the same measurement system used by the form containing the word
processor. If the form is set to inches, the word processing ruler will also work in inches. If the form is set to
centimeters, the word processing ruler will also work in centimeters. To change the measurement system,
switch into Graphics Mode (see “Form Modes: Data Access vs. Graphic Design” on page 485) and click on the
box in the upper left hand corner of the ruler (see “Rulers” on page 506), then switch back to Data Access
Mode.

To turn the ruler on or off, use the Ruler command in the Text menu (you must be in Data Access Mode and
editing the text within the object to use this command).

Here’s what the word processor looks like with the ruler turned off.
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Margins (Indents)

Each paragraph has three margins: First Line, Left, and Right.

The First Line margin is the distance from the left side of the word processing object to the beginning of the
first line in the paragraph. Drag the upper margin triangle to adjust the first line margin. The text itself will
adjust dynamically as you drag.

left margin

first line margin

right margin
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The Left margin is the distance from the left side of the word processing object to the beginning of the rest of
the lines in the paragraph. Drag the lower margin triangle to adjust the left margin.

When you drag the left margin, the first line margin also moves to maintain the same spacing between the
two margins as shown in the illustration above. It’s usually best to set the left margin first, then set the first
line margin.

The Right margin is the distance from the right side of the word processing object to the end of the each line
in the paragraph. Drag the triangle symbol to adjust the right margin.

first line margin also moves when you change the left margin



Page 684 Panorama Handbook
If the width of the word processing object changes (for example if the form adjusts when the window size is
changed or if the document is printed using a different form) the width of the paragraph may change. How-
ever, the margin from the right edge will not change.

In addition to setting the margins with the ruler you can also set them numerically using the Paragraph Set-
tings dialog. You can open this dialog from the Text menu or by double clicking anywhere in the ruler (except
on a button or tab stop).

Simply enter the numeric values for each indent and press OK to change the paragraph formatting.

right margin stays constanttext width adjusts in sync with object width
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Tab Stops

The word processor supports four types of tabs: left, center, right, and decimal tabs. There are four buttons
in the ruler for selecting the type of tab you want to create.

If there are no tab stops at all Panorama automatically creates 3 tab stops per inch, as shown below. To create
a new tab stop, first select the type of tab stop by clicking on one of the four tab stop buttons.

To create a tab stop, click anywhere in the tab stop area (just below the ruler itself).

decimal tab stop

right justified tab stop
centered tab stop

left justified tab stop

tab stop area

click to select left justified tab stop

click to create tab stop
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You can click additional times to create additional tab stops. Tab stops may be created in any order (not just
left to right).

To move a tab stop, simply drag it to a new position.
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To delete a tab stop, drag it out of the tab area (either above or below).

The tab stop disappears and the columns shift into their new positions.

This illustration shows the use of a centered tab.



Page 688 Panorama Handbook
This illustration shows the use of a right justified tab.

And finally, a decimal tab stop, so named because the decimal points line up no matter how many digits are
to the left or the right.
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For precise tab adjustments you can use the Tab Settings dialog. You can open this dialog three ways: 1) by
double clicking on a tab stop, 2) by holding down the Command key (Mac) or Control key (PC) and clicking
on a tab stop, or 3) using the Tab Settings command in the Text menu (in which case it will operate on the last
tab that you adjusted). This dialog allows you to set the precise position of the tab, the type of tab (this is the
only way you can change the type of an existing tab) and the tab leader.

The tab leader is a character that will automatically repeat to fill the space leading up to the tab. The tab
leader helps draw the eye across the page. Common tab leaders include periods (shown below), dashes, and
asterisks (but you may use any single character you want). Use the Tab Settings dialog to set the tab leader
character. In this example the tab leader has been set to a period.
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When you adjust a tab stop (either by dragging or with the Tab Settings dialog) don’t forget that only
selected text is affected by the change. Be sure to select the text you want to adjust before changing the tab.

The most common mistake is to click on the text instead of selecting it. In that case, only the line clicked on
will change. Be sure you have selected all of the text containing the tab stops you want to modify.

Alignment

For each paragraph, the alignment can be left flush, centered, right flush, or full (left and right flush). The
four buttons on the left side of the ruler control the horizontal alignment of the text. For example to center
one or more lines first select the lines, then click on the center button.

tab stops in unselected text are not affected changes in the ruler

left and right justified

right justified
centered

left justified (ragged right margin)
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Line Spacing

The spacing between each pair of lines is called the leading. (This is an old word going back to movable type
days, when an actual piece of lead was inserted between each pair of lines.) The word processor normally
sets the spacing for you automatically. However, you can adjust this spacing for unusual effects (double
spaced text, for example). To increase the spacing between lines, press the button on the left.

To decrease the spacing between lines, press the button on the right.

You can also adjust the spacing with the Leading setting in the Paragraph Settings dialog.

click to increase spacing between lines

click to decrease spacing between lines
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This setting specifies the amount of extra spacing desired between each line. For example, to add 6 extra
points between each line, set the leading value to 6. (This value must be 0 or greater.)

Styles

The Panorama word processor supports twenty different styles of text. Most of these styles are self explana-
tory, but a few unusual styles require some additional explanation.

The Underline style can be modified with four different options: Double Underline, Word Underline, Dot-
ted Underline, and Overline.

You can combine these options to produce 16 different underline styles, for example Double Word Dotted
Underline.

The Overline option draws the line above the text, instead of underneath.
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The Condensed and Extended styles change the letter spacing between the characters. The letters themselves
do not change size. The condensed style pushes the letters closer together, while extended spreads them
apart.

The Hidden Text style creates text that only appears when you are actually editing the document.

When the document is not being edited (only displayed or printed) the hidden text disappears.

When you re-edit the document (by clicking on it), the hidden text re-appears.

To remind you that this text is hidden, Panorama draws a dotted line through the text. Tip: If you have a line
of hidden text and you want the entire line to disappear without leaving a blank line, make sure that the car-
riage return at the end of the line is part of the selection before selecting the Hidden Text style.

The Strikeout style draws a line through the middle of the text.

condensed extended

when editing text, hidden text appears with a dotted line through it



Page 694 Panorama Handbook
The Small Caps style draws lower case letters as miniature upper case letters.

The All Caps style draws all text in UPPER CASE even if it was entered in lower case. The text is not actually
modified, so you can cancel this style later to display the text normally. The All Lower Case style draws all
text in lower case even if it was entered in UPPER CASE. Like the all caps style, the text is not actually modi-
fied, so you can cancel this style later to display the text normally.

See “Merging Data into Word Processing Documents” on page 707 for a description of Formula Merge, the
final style option.

Selecting Text

The word processor allows you to select text by clicking, dragging, double clicking (to select a word), and tri-
ple clicking (to select a line). You can also select text by holding down the Shift key and using the arrow keys
(hold down the Shift and Option(Mac)/Alt(PC) keys to select a word at a time).

To select non-contiguous selections, hold down the Shift key and the Command key (Mac) or Control key
(PC) while you drag each selection (or double or triple click). Once you have multiple non-contiguous selec-
tions, you can change the appearance of all of the selections at once with the font, size, style, and color sub-
menus.

small caps style
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To select a rectangular area on the Macintosh, hold down the Control key while you drag over the area you
want to select. On the PC you can do this by holding down the right mouse button as you drag.

This option is especially handy for selecting one or more columns from a table. Once the columns are
selected, you can change the appearance with the font, size, style, and color sub-menus.
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Configuring the Word Processor

The word processor can serve many uses — to store correspondence, to generate custom mail merge “bulk
mail,” to create catalogs, etc. Different applications require different setups. The following sections explain
the different configuration options that are available.

Word Processor Document Storage Strategies

Traditional word processors (Microsoft Word, WordPerfect, Nisus, etc.) store each word processing document
in a separate self contained disk file. In Panorama word processing documents are not self-contained but part
of a database. Panorama gives you flexibility in choosing how the document is related to the database.

In Panorama the word processor can be used in two basic ways. The first way is to use it to create and orga-
nize a collection of documents. For example you might have a correspondence database that keeps all your
letters and memos organized. When the word processor is used this way you will usually have one docu-
ment for every record in your database. In addition to the documents themselves, the database might contain
additional information like the date the letter was written, the subject, who it was written to, etc. Here is an
example of a correspondence database that contains three records and three separate documents (pieces of
correspondence.
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The second way to use the word processor is as a template. When used this way there is a single document
for the entire database. Panorama will combine this “template” document with information from the data-
base to produce the final documents. For example, you can use this technique to send customized “form” let-
ters to a group of people in your database.

The Panorama word processor allows documents to be stored in three different places: 1) in a database field,
2) in a variable, or 3) in a disk file (see illustration below). Which one of these you choose will depend on sev-
eral factors, including whether you need a collection of documents or a template, the number of documents
involved, the amount of memory on your machine and whether or not the documents need to be searchable.
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Storing a Collection of Documents

If you need to store a collection of documents the simplest approach is to store the documents in a database
field. You’ll need to set up a text field specifically for the word processor. In the database below a field name
Body has been created for this purpose (the actual name isn’t important, you can pick any name you like).

As you can see, the field you set up for the word processor is visible in the data sheet, and you can even dou-
ble click on the field in the data sheet to edit it. However, you should not do this. If you scroll to the end of the
Input Box you will see the special formatting information used to keep track of the font, style and other spe-
cial word processing information. If you edit the field in the data sheet you will corrupt this information and
the field will no longer format properly when used in the word processor.

word processing field

word processor formatting information

Do Not Edit Word Processor Fields in the Data Sheet!
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The correct way to display and edit this field is to create a form with a Word Processor SuperObject (see “Cre-
ating and Working With Word Processor SuperObjects” on page 673).

Storing the documents in a field is simple, but if you have a lot of documents (thousands or tens of thou-
sands) these documents can consume a lot of memory. This isn’t as much of a problem as it used to be, but if
it does become a problem Panorama has an alternative — you can store the documents in separate disk files.
If you do this you’ll still need a field for the word processor, but instead of holding the entire document this
field will only contain the name of the file that actually contains the document.

Here is a typical data sheet for a database with word processing documents stored in external files. 
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The DocumentID field contains a link to the external document. You must set up a formula in the configura-
tion dialog that creates the actual name of the external file from the value in this field. In this example we
have set up a formula that tells Panorama that the document is stored in the Documents subfolder (a folder
within the folder containing the database). (On PC systems .pwp will automatically added to the end of each
file name if no other extension is supplied, for example Document_1.pwp.)

The DocumentID field must contain a unique value for each record, and that value must be a legal file name.
In some cases you may be able to use data already in your database, for example the customer name. In this
particular example file the unique value is created by a procedure each time a new record is created. See
“.NewRecord” on page 386 of Formulas & Programing to learn about the automatic .NewRecord procedure,
which is triggered whenever a new record is added to a database. The uniqueid( function is described in
“UNIQUEID(” on page 5870 of the Panorama Reference.

When a new record is added to the database, the .NewRecord procedure automatically assigns it a new Doc-
ument ID.

As soon as you start typing into the word processing document Panorama automatically creates the new file
on the disk.

new document id
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Storing the word processing documents allows you to build a large collection of documents without creating
a huge memory hogging database. On the other hand, since the documents are not part of the Panorama
database, they cannot be searched with the Find/Select command (see “The Find/Select Dialog” on
page 336).

Searching for Text Within a Collection of Documents

If the documents are stored in a field (see previous section) you can perform normal database operations on
them, including searching for text within the documents. However, word processor documents combine text
with style information, as you can easily see if you edit a field containing a word processor document with
the data sheet (or with an ordinary data cell in a form).

Remember, you should not edit any part of a word processing document with the data sheet or a data cell.
Editing a word processing document this way will cause the document to lose its style information. Always
use a word processing object to edit word processing documents.

Sometimes you may want to use the text contained in the word processor in a formula. For example, you may
want to count the number of letters or words in a document, or search the document to see if it contains a
particular word or phrase. To use the text in a formula, use the documenttext( function. This function has
one parameter, a word processing document. The result is the text of the document with all of the style infor-
mation removed. For example, suppose your database has a field called Letter that contains word processing
documents. You can use the formula shown below with the Formula Find/Select command (see “The Find/
Select Dialog” on page 336) to select all records with documents containing the word Yosemite.

select documenttext(Letter) contains "Yosemite"

Here is another example that calculates the number of words contained in a letter.

message "This letter contains "+str(arraysize(documenttext(Letter)," ")+" words."

The word processor can also work with standard text. If you give the word processor standard text with no
style information, it will use the default font, size, indents, tabs and line spacing until you specify otherwise.

word processor formatting information
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Setting up Storage for a Template Document

If you need a mail-merge template document the simplest approach is to store the document in a separate
disk file.

As soon as you begin typing into the word processor Panorama will automatically create a file named Letter
Template (or Letter Template.pwp on PC systems). The file will be created in the same folder as the database.

An alternate method is to store the document in a variable. A permanent variable is recommended so that the
document will be saved automatically when the database is saved (see “Long Life Variables” on page 249 of
Formulas & Programing). Here is a procedure that creates a permanent variable named LetterTemplate (see
“Writing a Procedure from Scratch” on page 216 of Formulas & Programing to learn how to create procedures).
You only need to run this procedure once to create the permanent variable (that’s why it’s called permanent!).

Once the permanent variable has been created you can go ahead and create the Word Processing SuperObject
(see “Creating and Working With Word Processor SuperObjects” on page 673). Select the Variable option, and
enter the name of the permanent variable you have created.

When you press the OK button your Word Processor SuperObject is ready to go. The document will be stored
in the permanent variable, which is automatically saved as part of the database each time you use the Save
command.
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Setting up Storage for Multiple Template Documents

The techniques described in the previous section are fine if you want to use a single mail-merge template. In
this section we’ll show how to set up multiple mail-merge templates for a single database. For example, you
might have different “form” letters that you want to send out at different times — to welcome a new cus-
tomer, to announce a sale, or to ask about a missed payment. Each one of these templates will be stored in a
separate file on the disk, like this.

To start with you’ll need to create a permanent variable. However, instead of using this variable to store the
entire template document we’ll only use it to store the name of the current template document. Here is a pro-
cedure that can create the permanent variable for us. Be sure to run this procedure at least once before you
continue with the next step.
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The form for this example requires two editing objects. First, you’ll need a Text Editor SuperObject that will
allow the name of the current template to be changed (see “Creating and Modifying Text Editor SuperOb-
jects” on page 639). Of course a Word Processing SuperObject is also necessary. The text is stored as a File on
disk, with a formula that tells Panorama to look in the folder Templates and to that the permanent variable
CurrentTemplate contains the file name. (You’ll need to create the Templates folder if it doesn’t already exist.
It should be in the same folder as the database itself.)
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Once these objects are set up you can switch to Data Access Mode and start building templates. Start by
entering the name of the new template.

After you have entered the name of the new template, click on the word processor. Panorama will immedi-
ately create the new, blank template, which you can start filling in.

If you look on the hard disk you’ll see that the new template has been created.

enter name of new template

new document file
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At any time if you want to re-use a previous template, just type the name of that template into the Text Editor
SuperObject. As soon as you press the Enter key, the previous template is saved and the requested template is
loaded in.

This simple example requires you to type in the name of the template you want to use. A more advanced
database could use a pop-up menu (see “Pop-Up Menus” on page 860) or a scrolling list (see “List SuperOb-
jects” on page 879) in combination with the listfiles( function (see “Disk Files and Folders” on page 165
of Formulas & Programing) to select the template.

type the name of the template you want to use

the requested template appears when you press the Enter key
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Merging Data into Word Processing Documents

Just as with an auto-wrap text object, Panorama can merge the result of a formula into the middle of a word
processor document. The auto-wrap text editor does it with special characters around the formula (see “Dis-
playing Formulas in Auto-Wrap Text” on page 602). The word processor does it with a special style, the For-
mula Merge style.

Let’s start with a simple example: 2+2. We’ll type this formula in twice, the first time using the Plain style.
The second time we’ll select the text and apply the Formula Merge style. Notice the box that appears around
the formula.
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When the Enter key is pressed, the display changes. The second formula is now replaced by the result of the
formula: 4.

Any valid Panorama formula may be used. To merge in a data field, just type in the name of that field and
apply the Formula Merge style.

When the Enter key is pressed, the actual data appears.

formulas
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Click on the word processor to see the formulas again.

The previous example used three formulas, but it could be rewritten to use a single formula.

Since this formula wraps over two lines it looks like two formulas, but it is really one, as you can see by mak-
ing the window wider.
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The Text menu contains two commands that can help you build formulas. The Insert Field submenu types in
a field name and automatically turns on the Formula Merge style. For example, you can be typing in regular
text, like this.

When you want to merge in a field, simply choose it from the menu.

Panorama automatically inserts the field and selects the Formula Merge style.
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When you use the Insert Field menu you need to be careful not to insert two fields right next to each other. If
you do, the two field names will merge together.

Since there is no field named CityState, this will produce an error when you press the Enter key.

If you need the two fields to be adjacent to each other with no punctuation in between, you must use the +
operator to make a valid formula.

use + to join two fields together in the formula



Page 712 Panorama Handbook
A more common solution is to put a space or other punctuation in between the fields. However, watch out!
The punctuation character must not have the Formula Merge style selected.

To make sure that the punctuation does not have the Formula Merge style selected, select the character and
choose Plain from the style menu.

wrong!

correct
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Here’s a tricky problem. This looks like two fields in two separate formulas, which should be just fine.

However, when Enter is pressed, an error message is displayed.

The problem is that it really is just a single formula, because the line break character has the Formula Merge
style set. To fix this problem, select the line break character (as shown below) and un-check the Formula
Merge style.
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To insert a complete formula into the document, use the Insert Formula command in the Text menu. A dialog
box appears allowing you to enter a formula.

Type the formula into the dialog. You can use the Fields and Functions menus to help you enter the formula.
When you press OK, the formula will appear in the document, and it will already be in the Formula Merge
style.

This particular formula extracts the first name from the Name field (to produce, for example, Dear Mary).
The formula may use any field or function available in Panorama, including lookups to grab data from other
databases. See “Using Formulas to Display Text” on page 621 to learn about some useful formulas for dis-
playing text.

Forcing Merge Data to Update When Moving From Record to Record

Mail merge documents are usually printed. If you display the document on the screen, you may think that it
is broken because the merged data will not update as you move from record to record.

If displaying the merged data is important to you (as opposed to simply printing it) one solution is to overlay
a Text Display SuperObject just underneath the Word Processor SuperObject. If it is configured in the way
described below, the Text Display SuperObject will update whenever you move to a record. The Word Pro-
cessing SuperObject will go along for the ride.
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Start with the Word Processing SuperObject. Make sure it is positioned where you want it. Then select the
Text Display tool and create a Text Display SuperObject on top. The new object should cover the entire Word
Processor SuperObject except for the scroll bar.

The Text Display formula should be any text field followed by the text funnel [2,1]. This text funnel tells
Panorama to take the field and extract the text from character 2 to character 1. Since character 2 is after char-
acter 1, the result is nothing, nada, zip. So our new Text Display SuperObject won’t display anything, but it
will try! In the process it will force the Word Processor SuperObject to update also.

There is one more step to complete this mini-project. Select the Text Display SuperObject and use the Send To
Back command to move it behind the word processor (see “Changing the Stacking Order” on page 569).
That’s it. Now go to Data Access Mode and see that the data merged in the word processor updates as Pan-
orama moves from record to record.
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Word Processor Options

The SuperObject™ Word Processor Properties dialog is divided into several sections.

Document Storage: This section of the dialog specifies whether the document will be stored in a field, vari-
able, or separate file that will be edited by this object. See “Storing a Collection of Documents” on page 698
and “Setting up Storage for a Template Document” on page 702 for more information about setting up these
options.

Scroll Bars: This section controls whether the vertical scroll bar is displayed, and whether space is reserved
for a grow box in the lower right hand corner of the object. The word processor object does not support a hor-
izontal scroll bar. Instead, the margins automatically adjust to the width of the object. 

Wrap at End of Line: If text is too long to fit on a single line, it will usually “wrap” around to the next line.
However, if this checkbox is turned off, the text will not wrap. Instead, the text will be continue off the right
edge. 

Non-White Background: We recommend that you use this option if the Word Processor object is over a color
(non-white) background. If this option is turned on, Panorama will temporarily display a white background
behind the text while it is being edited. (If you don’t use this option, you’ll find that portions of the back-
ground will turn white as you edit anyway. The result is ugly and possibly confusing, so that’s why we rec-
ommend you use the Non-White Background option.)
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Terminate When: This section controls which keys indicate that you have finished editing this item of text.
The Enter key always indicates you are finished editing. You may also specify that the Return, Tab, Up
Arrow, or Down Arrow keys terminate editing. Usually these options will be left disabled so that these keys
may be typed into your word processing documents.

Borders: This section controls any borders that are displayed around the document. You may separately con-
trol the top, bottom, left and right borders, or click on the word Borders to turn all four on or off at once. If the
Shadow option is checked a drop shadow will appear. If the 3D option is checked a “three dimensional” bor-
der will appear around the object. The 3D border effect works best with a light gray background. (Note: You
can control the background color for the entire form with the Form Preferences command in the Setup menu,
see “Form Background Colors” on page 582.)

Update Variable Every Key: This option only works when the document is stored in a variable, not in a field
or disk file. If this option is enabled, the Word Processor will update the value of the variable after every key
is pressed. This is especially handy when the Word Processor is set up to trigger a procedure after every key
or most keys (see next section).

Overflow: This option is used in conjunction with an overflow tile for printing documents that are more than
one page long. See “Printing Multiple Page Documents” on page 724 for more information about this option.

Procedure: This section specifies what procedure is associated with this Word Processor object, and when
that procedure will be triggered. To select or change the procedure associated with this object, use the pop-up
menu. To disable the procedure, clear the checkbox.

There are three choices for triggering a procedure: Every Key, Most Keys, and Termination. The Termination
option simply means that the procedure will be triggered when the user signals that he or she has finished
editing the document by pressing the Enter, Return, Tab, Up Arrow, or Down Arrow keys. (Note: If the Word
Processor is associated with a field, a procedure may be triggered even if no procedure is assigned in the
Word Processor dialog. If the field has a procedure assigned to it in the design sheet, it will be triggered (see
“Automatically Triggering a Procedure” on page 314). If there is no Termination procedure and no design
sheet procedure, the .ModifyRecord procedure [if any] will be triggered. See “.ModifyRecord” on page 383
of Formulas & Programing.)

If the Every Key option is checked, the procedure will be triggered every time the user presses a key. For
example, you might use this option if you wanted to count the user’s keystrokes.

If the Most Keys option is checked, the procedure will be triggered after every key when the user types
slowly, but will not be triggered for each key when the user types several characters quickly in a row. The
procedure will not be triggered until the user pauses in his or her typing. This option often works as well as
the Every Key option but usually appears much smoother and faster to the user because the procedure is not
being triggered as frequently while the user types. Possible applications for the Most Keys option include
counting the characters or words being edited, performing a calculation (metric conversion, for example),
checking spelling, etc.

Auto Caps: This section only appears if the Word Processor is associated with a variable or file on disk. Use
the pop-up menu to control automatic capitalization of the text as it is entered. You can force the text to all
upper case (ABC), word caps (Abc), or capitalization of the first letter in each sentence. If the Word Processor
is associated with a field, the Word Processor will use the Auto Caps setting for that field (set in the design
sheet or the Field Preferences dialog.) 

Use Field Attributes: This section only appears if the Word Processor is associated with a variable or file on
disk. You can use this if you would like the Word Processor to use the attributes assigned to one of the fields
in your database. If you select a field with the pop-up menu, the Word Processor will use that field’s settings
for Input Pattern, Range, Clairvoyance, Space Bar Tab and Duplicates. Of course if the Word Processor  is
associated with a field, the Word Processor will always use the attributes for that field (set in the design sheet
or the Field Preferences dialog.)
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Default Font and Text Size for New Documents

When you create a new document, the font, size, indents, tabs and line spacing are all set to default values.
The default values for the font and text size are set by setting the font and size of the object in graphics mode.
For example, if you want new documents to default to 14 point Palatino, go to graphics mode, select the word
processor object, and select Palatino from the Font submenu and 14 from the Size submenu (or use the
Graphic Control Strip, see “Font” on page 529).

To set the default indents, tabs and line spacing, first set up these properties the way you want them (using
the ruler). Once the indents, tabs and line spacing are set up, open the Paragraph Settings dialog (in the Text
menu). Check the Default Settings checkbox, then press the OK button.

Note: If a document consists entirely of text using the default settings (no font changes, style changes, indent
changes, etc.), Panorama will save only the text without any style information. This makes the document
much smaller. If you later change the default settings, this document will reflect the new defaults the next
time it is displayed or opened for editing.
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Printing Word Processor Documents

The primary use for the word processor is usually to create printed documents — letters, memos, correspon-
dence etc. In this section we will cover some tips for printing these documents.

Normally when a document is printed you won’t want any extra doo-dads — no ruler, no borders, no scroll
bar. When you are displaying and editing the document, however, you need these. You could change these
settings each time you want to print. A better method is to create two separate forms: one set up for editing
documents, and one for printing.

To illustrate this idea we’ll start with a Word Processor SuperObject that has been set up for editing a docu-
ment (see “Creating and Working With Word Processor SuperObjects” on page 673).

Select the object (as shown above) and use the Copy command to copy it onto the clipboard (see “Cut, Copy,
and Paste” on page 566). Then use the New Form command in the View menu to create a new form (see “Cre-
ating a New Form” on page 487), and Paste the Word Processor SuperObject into the new form. Since you’ll
probably want the printed correspondence to fill an entire page, use the Magnify tool to zoom out and make
the an 8 1/2 by 11 inch area visible (see “Magnification and Reduction” on page 579).
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Next, use the Tile tool to create a data tile that is 8 1/2 by 11 inches (see “Working with Tiles” on page 1062).
You can use the Dimensions dialog to help you set the exact dimensions (see “Viewing and Setting Exact
Object Dimensions” on page 512). (You may need to adjust these dimensions later depending on your
printer.)
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Now expand and position the Word Processor SuperObject on the data tile just as you would like the final
correspondence to appear on the printed page.
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The next step is to double click on the word processor to open the configuration dialog. Use the dialog to turn
off the borders and the scroll bar (see “Word Processor Options” on page 716).

The final step is to turn off the ruler. To do this, switch into Data Access Mode. Click on the word processor to
edit the text, then use the Text menu to disable the ruler.
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Voila! The form is now ready to print.

Edit all your documents in the original form, which still includes the ruler and scroll bar. When you need to
print switch to the new form, which prints without these extra items. If you like, you can add a procedure to
your database to automatically switch forms and print. Here’s one way this procedure could be written.

local windowOne
windowOne=info("windowname") /* remember where we came from */
goform "Print Correspondence"  /* switch windows */
printonerecord dialog   /* or print, if you want to print all selected records */
goform windowOne    /* switch back to original window */
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Printing Multiple Page Documents

The technique described in the previous section works fine for single page documents. Of course, many doc-
uments are more than one page long. In this section we will extend the example to allow the printing of mul-
tiple page documents.

Start with the form created in the previous example, and switch back to Graphic Design Mode. Double click
on the word processor. In the configuration dialog, enable the Handle Overflow option, then press OK.
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Now choose Select All Objects from the Edit menu. While holding down the Option key (Macintosh) or Alt
key (Windows), drag a copy of all the objects on the form to an empty spot (see “Drag Duplicating” on
page 561).

Now we need to turn the duplicate Data tile into an Overflow tile (see “Printing Data that Overflows a Page”
on page 1116). To do that, double click on the word Data in the middle of the drag bar at the bottom of the tile.

double click to configure tile
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This opens the tile configuration dialog (see “Working with Tiles” on page 1062).

Click on the Specialized Tiles button to open a larger dialog. This dialog has over 40 different kinds of tiles to
choose from. Pick the Overflow tile, which is activated with the button shown in the illustration below.

That’s all there is to it. The form will now automatically print as many pages as the document requires — 1, 2,
3, or 1,000! For more information on overflow printing see “Printing Data that Overflows a Page” on
page 1116.

overflow tile
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Using the Mini Correspondence Wizard

Panorama includes a pre-built database for handling general word processing chores — the Mini Correspon-
dence wizard. This database may be used for general correspondence (letters, memos, etc.) and to create mail
merge letters that are customized and sent to a group of recipients. You can use the Mini Correspondence
wizard as is or you can modify it or even take components of the wizard and include them in your own data-
bases.

Creating a New Letter

One of the most powerful features of the Mini Correspondence wizard is that using “Generic Fields” it can
be linked with other databases that contain names and addresses (see ““Generic” Fields” on page 230). For
example, suppose that you have looked up Pat Furnare using the White Pages wizard (see “White Pages” on
page 73 of Wizards & Demos). 

To write a letter to Pat, click on his entry in the White Pages window. Then choose Mini Correspondence
from the Mini Applications submenu of the Wizards menu. The wizard will open and as you if you want to
write a letter to this person.
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When you press Yes, the wizard will create a new letter with Mr. Furnare’s name and address.
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 The opening and closing sections of the letter have been created with some incomprehensible looking formu-
las — just ignore those for now and start typing in the body of the letter.

When you press the Enter key you’ll see the finished letter.
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If this is the first letter you have created you’ll probably want to customize the signature. When you enter the
signature at the top of the window the wizard will automatically change the letter itself (in fact changing any
of the fields at the top of the window will change the letter).

Printing a Letter

To print the letter choose Print This Letter… from the Letter menu. (You’ll probably also want to save the let-
ter at this point. You can use the Save command in the Letter menu or in the regular File menu. The Save
command saves all of the letters in the entire database, not just the current letter.)
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The wizard uses a form called Print to print the letter. You can customize this form by opening it with the
View menu or by choosing Edit Print Form from the Setup menu. The Print form has a data tile and overflow
tile to allow it to print multi page letters (see See “Printing Multiple Page Documents” on page 724). By edit-
ing this form you can adjust the margins and/or add your logo to the printed letter. When you are done be
sure to close the form and save the database.

overflow tile

data tile

left margin tile
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Printing a Mail Merge Letter

The wizard can also print a single letter over and over again for sending to multiple recipients — for example
we could send a personalized letter to every congressional member from California. For this example we’ll
use the 106th Congress database that is included in the Panorama example files. The first step is selecting the
members of congress from California (see “The Find/Select Dialog” on page 336).As you can see there are 54
members in the California delegation.

Now go back to the Mini Correspondence wizard, then pull down the Letter menu and create a new letter to
Barbara Boxer.
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Type in the body of the letter and press Enter. The result should look like this:

The last item in the Letter menu will print a customized letter to each selected person in the 106th Congress
database.
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The wizard will print 54 personalized letters.

Viewing a List of Letters

The Mini Correspondence wizard normally displays only one letter at a time. To see a list summarizing all of
your correspondence choose Open Correspondence List Window… from the Letter menu. This window
shows a list of the letters you have created.
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Changing the Default Greeting, Closing and Signature

To change the default greeting, closing or signature choose the corresponding command from the Setup
menu. The wizard will prompt you to enter the new text.

This change will affect all templates (see below).

Correspondence Templates

When you create a new letter the wizard uses a template to set up the heading, closing, and font. You may
choose from pre-built templates and you can also create your own templates. After you create a new letter
you can use the Template menu to change the template used for this (and subsequent) letters.

The wizard updates the letter with the new template, which in this case uses a different font and font size.
(Warning: If you change the template after you have written the letter, the body of the letter will be changed
to the template body! Be sure to change the template before you write the letter body.)
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To create your own template you should first create a new letter with one of the existing templates. Then
select all of the text and adjust the font and size (see “Styles” on page 692).

Once you have the font and size you want select the phrase <Insert Body of Letter Here>, then choose Save
Template from the Setup menu inside the window. The wizard will prompt you to enter a name for the new
template.

The new template is added to the Template menu.
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If you later decide you want to rename or delete a template use the Delete/Rename Template… command in
the Setup menu. This command opens this dialog.

To delete a template simply select it and press the Delete button. To rename a template select it and press the
Rename button. The wizard will prompt you for the new template name. When you are finished press OK to
finalize all of the changes.
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Merging Data into the Body of a Letter

In addition to setting the default font and text size the letter templates also contain all of the formulas needed
to merge the database information into the header and closing section of the letter (see “Merging Data into
Word Processing Documents” on page 707). Using the Formula Merge style you can also merge data into the
body of the letter itself (see “Merging Data into Word Processing Documents” on page 707). To merge data
into the body of the letter you must use the letteritem( function. The first parameter of this function is the
name of the item you want to merge. The possible choices are: Prefix, First, Middle, Last, Suffix, Organiza-
tion, Address, City, State, Zip or Country. The second parameter must be pRecord. This is an internal variable
used by the wizard for printing. Once you type in this function, you must set the style to Formula Merge (use
the Style menu). The example below shows how to merge the City into the body of the letter.

When you press the Enter key you’ll see the actual data merged into the body of the letter.

This technique will work correctly even if you print multiple letters using the mail merge feature.

(Advanced Note: If you are curious about the pRecord variable it is used for printing mail merge letters.
When the wizard prints a mail merge letter it temporarily saves the name and address stored in the current
record. It then scans the linked database and builds an array in each of these fields. For example, the City
field will contain an array that contains the city name for each person that will be receiving this letter. The
wizard prints each letter using the printonemultiple statement (see “Printing Data in an Array” on
page 726) and it increments the pRecord variable as it does it (1, 2, 3, etc.). If only a single letter is being
printed the formula still works because pRecord is set to 1 so the array( function simply grabs all of the text
in the field.)

formula merges City field into paragraph
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Chapter 16: Images & Movies

A Panorama form can display images and movies from a wide variety of sources. An image may be fixed (for
example a logo or background) or variable (changing from record to record - for example personnel photos or
maps associated with individual records). Variable images may be included in the database or (more com-
monly) displayed directly from files on the disk. Images that are displayed from disk are called Flash Art™.
Flash Art allows any image to be displayed according to its name.

Fixed Images

Fixed images are imported into Panorama with the Paste command. Before you use the Paste command, the
graphic picture you want to import must be placed on the clipboard. Most paint and drawing programs
allow you to select the graphic elements you want to use and then use the Copy command to place the graph-
ics on the clipboard. This illustration shows an image being transferred to the clipboard in Adobe Photoshop.
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Once the image has been transferred to the clipboard, switch to Panorama. The form you want to place the
image into must be open and in Graphic Display Mode (see “Form Modes: Data Access vs. Graphic Design”
on page 485). Then choose Paste from the Edit menu to import the image.

The image will be imported into the center of the window. Like any other object, you can move the picture by
dragging it or adjust the size by dragging the handles on the corners (or with the Dimensions or Scale dia-
logs).
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Displaying and Printing EPS Images

On Macintosh systems you can place EPS images on the clipboard when using Adobe Illustrator, Macrome-
dia Freehand and many other programs. To place an EPS image on the clipboard, hold down the Option key
while you use the Copy command.

Once the EPS image has been placed on the clipboard you can switch to Panorama and Paste it into your
form, just like any other image.

hold down
Option key
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You may notice that the image appears a bit “grainy.” You’re actually seeing a bitmap image that was created
by Illustrator when you placed the image on the clipboard. If you enlarge the image it will get even more
“jaggy.”

Although the image appears jaggy on the screen, it won’t look jaggy if you print the form on a PostScript™
printer. When printing, Panorama uses the EPS and ignores the jaggy bitmap so you get a nice clean image on
the paper.
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Tracing a Scanned Form

You can use a scanner to digitize a form and then paste the image into Panorama. The scanned image can
either be used as is, or you can use it as a template to create a form using Panorama graphic objects. (If you
trace the image using Panorama’s box and line tools, the form will print faster and with better quality.) Start
by scanning the form you want to duplicate. For example, we’ve scanned our Nutrition Information form
into Adobe PhotoShop.
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To make it easier to use this form as a template for tracing, we’ll increase the brightness, reduce the contrast,
and change the color. See the documentation for your photo editing software to learn how to do this.
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Now the image can be copied into your Panorama form. Simply Copy the image in your photo editing appli-
cation, then switch to Panorama and Paste into the form.

Move the template into position, then freeze the template with the Lock command in the Arrange Menu (see
“Locked Objects” on page 575). Once the image is locked, check the Ignore Locked Objects menu option (see
“Ignoring Locked Objects” on page 577). This option allows you to work on top of the scanned image with-
out having to worry about accidentally clicking on and dragging the scanned image.
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Now you can begin to trace over the scanned template to create Panorama objects like rectangles and text
objects.
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When the tracing is complete, the final step is to delete the scanned image you used as a template. Start by
disabling the Ignore Locked Objects option. Then click on the scanned image.

gray handles indicate locked object
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Once the object is selected, choose the Unlock command to unlock the image (see “Locked Objects” on
page 575). Once the object is unlocked you can use the Cut or Clear commands to delete the image from your
form, leaving only the new objects you have created.

Flash Art™

Panorama employs a technique called Flash Art™ to display non-fixed images. Using Flash Art you can dis-
play images that are not fixed but change depending on circumstances—for example photos of each person
in a personnel database, maps in a contact database or product photos in a catalog database.

When Flash Art displays an image, it does so by name. The actual image may be stored in the database itself
(in the Flash Art Gallery, see “The Flash Art Scrapbook (Gallery)” on page 764), or in separate disk files (see
“Displaying Images Directly From Disk Files” on page 769). You set up a formula that controls what image to
display. When the formula matches the name of an image, that image is displayed.

Panorama actually has several different types of objects for displaying images by name. The standard Flash
Art object (see ““Classic” Flash Art Objects” on page 815) has been standard from the earliest versions of Pan-
orama, and is retained for compatibility with older databases. The newer Super Flash Art object (see “Creat-
ing Super Flash Art Objects” on page 751) is more customizable (more alignment and scaling options, scroll
bars, etc.) and should usually be used for new applications. In addition, the Flash Art Push Button (see “Flash
Art™ Push Button SuperObjects™” on page 833) and Flash Art Data Button (see “Flash Art Data Button
SuperObjects™” on page 852) allow you to create custom buttons from any image.
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Creating Super Flash Art Objects

To illustrate the creation of a Super Flash Art object within a form we’ll use a database of nutritional informa-
tion for fruits. This database contains about a dozen different fruits, including the name of the fruit and the
FDA nutritional information.

We’ve also prepared a collection of photographs of fruit. Each photograph has a name, and the photo name
matches the name of the fruit in the database, from Apple to Tomato.

In this case the images are stored in the database in the Flash Art Gallery (see “The Flash Art Scrapbook (Gal-
lery)” on page 764), but they could also be stored in files on the disk (see “Displaying Images Directly From
Disk Files” on page 769). For now, don’t worry about how the images are set up, let’s just continue to see how
the images can be used in a form.
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The Super Flash Art tool is not in the default tool palette, so you’ll need to use the Tool Palette dialog to add
this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it. Notice that we’ve set up a Text Editor SuperObject
(see “Text Editor SuperObject” on page 639) to allow the name of the fruit to be displayed and edited.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the Super
Flash Art object.

When you release the mouse, the Super Flash Art configuration dialog will appear.
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At a minimum you must enter a valid formula into the dialog. In this case the formula is simply Fruit.

Since the Fruit field contains the name of each fruit, this will automatically display the image for the correct
fruit, in this case an apple.
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Notice that the apple is displayed in the upper left hand corner of the Super Flash Art object. You can also
center the image. To do this, first click on the Pointer tool, then double click on the object. This re-opens the
configuration dialog, allowing you to change the alignment.

We’ve also turned on the border for this object.

centeredupper left
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With a few adjustments the form is ready to use. As long as you have a photo with the correct name available,
the correct photo will appear for each fruit.

Using Flash Art to Display a Fixed Image

Flash art is usually used to display an image that changes, like the fruit in the previous example. However, it
can also be used to display a fixed, unchanging image like a logo or a background. Of course you can also use
a standard picture object (see “Fixed Images” on page 741) to display a fixed image, so why use Flash Art?
The primary advantage is that using Flash Art a single image can be displayed over and over again without
taking up any additional memory or disk space. Only one copy of the image is needed, which can be used
multiple times in the database (or even multiple databases).

To display a fixed, image, simply enter the name of the image into the Flash Art formula, surrounded by
quotes ("). For example, suppose you have an image named FDA Logo.
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You can display this image in any form or report by using this formula in a Flash Art or Super Flash Art
object.

You can use this logo as many times as you like within a single form or across multiple forms.

As an added bonus, if you ever need to modify the logo it only needs to be modified in one place.

Using Flash Art to Display a Smart Background

Flash Art isn’t just for displaying pictures. It can also be used to display a border or background that changes
depending on the data in the database. To illustrate this we’ll use this database of hotel listings.
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We’ve created a view-as-list form to display this data (see “View-As-List Forms” on page 899).

Our goal will be to display a yellow background if the hotel has a rating of 1 or 2 stars. The first step is to cre-
ate a yellow box. You can do this with a graphics program or with Panorama itself (“Creating a Graphic
Object” on page 494). Paste the yellow box into Panorama’s Flash Art Scrapbook (see “Adding a New Image
to the Scrapbook” on page 765) with the name YellowBox.
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Now switch to Graphics Mode and create a Super Flash Art object that exactly covers the data tile. You may
need to nudge the object precisely into place after you have created it (see “Nudging an Object (or Objects)”
on page 509 and “Nudging the Size of an Object” on page 513).

Set up the Flash Art formula so that the yellow box will be displayed only if the number of stars is 1 or 2 (in
other words, less than 3). You’ll also want to make sure that the Scale to Fit option is checked. This ensures
that the yellow box fills the entire area.
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Once the object is created, use the Send To Back command to move it behind the other objects on the data tile
(see “Changing the Stacking Order” on page 569). Finally, switch back to Data Access Mode to see the fin-
ished result. Voila! Hotels with less than 3 stars have a yellow background, while 3 stars and up have a blue
background. (The first line, the B’n B Motel, is actually blue, but is currently highlighted to indicate that it is
the current record. If you move to another record you will see that this record is actually blue also.)

The ?( function is the heart of this formula. See “The ? Function” on page 130 of Formulas & Programing to
learn more about it.
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Using Flash Art to Display a Color

In the previous example the Super Flash art object was used to display a simple color. Instead of preparing a
color object in advance, the Super Flash art object can also simply display any color you want on the fly. No
image is required - the object generates the color on it's own.

To display a color the formula must calculate a text value that starts with two percent signs in a row (%%).
This is followed by six hexadecimal characters that specify the color exactly the same way that colors are
specified in HTML. The first two hexadecimal digits specify the red component of the color (from 00 to FF),
the next two digits specify the green component, and the final two digits specify the blue component. For
example, %%FFFFFF is white, %%000000 is black, %%00FF00 is green, etc. Of course if you are displaying a
fixed color you'll need to include quotes around these values so that the formula will work correctly, in other
words "%%FFFFFF", "%%000000" and "%%00FF00" etc. Here is an example of how to set up a solid color.

In graphics mode, this object will appear as a purple box.
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Although this feature can be used to display virtually any fixed color, what makes this feature really interest-
ing is the ability to change the color on the fly. For example, you can set up a Super Flash Art object with the
formula "%%"+SuperColor. You can set this object to red with a procedure, like this:

fileglobal SuperColor
SuperColor="FF0000"
showvariables SuperColor

Later if you want to change the color to yellow this can be done on they fly with another procedure.

SuperColor="FFFF00"
showvariables SuperColor

Here is a procedure that gradually fades the object from black to blue.

local bluecolor
bluecolor=0
loop
    SuperColor="0000"+radixstr("hex",bluecolor)[-2,-1]
    showvariables SuperColor
while bluecolor<256
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Panorama customer Gary Yonaites has created a cool demo that uses the solid color feature in combination
with a Super Matrix object to create blends. This demo database, called Gradient, has been included with the
Panorama example files.

The gradient above was not created in PhotoShop or some other graphics program, but within Panorama
itself. By clicking on the check boxes and color selections you can change the gradient on the fly. Thanks
Gary!
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The Flash Art Scrapbook (Gallery)

Every Panorama database has its own Flash Art Scrapbook, a collection of images that can be displayed
within the database. (You can also display images directly from disk files without installing them in the data-
base — see “Displaying Images Directly From Disk Files” on page 769.) Use the View menu to open the
Scrapbook.

 The Flash Art Scrapbook window displays one picture at a time. The name of the picture appears in the win-
dows title bar (for example, the image in the window below is named Watermelon). You can use the Previous
Picture and Next Picture tools to flip through the pictures in the Scrapbook.

You can fill the Flash Art Scrapbook with images you want to use in the database (up to the amount of mem-
ory available in your computer). Once a picture is pasted into the Flash Art Scrapbook, it can be used over
and over again.

image name

First Image
Previous Image

Next Image
Last Image
Cut Image

Copy Image
Paste Image

Change Name of Image



Chapter 16:Images & Movies Page 765
Adding a New Image to the Scrapbook

To add a new picture to the Flash Art Scrapbook, use the Paste command or Paste tool. Before it adds the pic-
ture to the Flash Art Scrapbook, Panorama will ask you for the name of the picture.

It’s a good idea to think about image names before you start. Usually the picture names should correspond to
the data in the database. For example if the picture is a map of Oregon, you might name the picture Oregon
or OR, depending on how you have entered the state name in your database. If the picture is a photograph of
an employee named Bob, you might name the picture Bob or use Bob’s initials. Again it depends on how you
have entered the in information in the database. Keep in mind that the image names do not have to exactly
match the data in the database — but you must be able to write a formula that can convert the database infor-
mation into the image name. For example, suppose you had an employee database with fields for first, mid-
dle and last names. The images could be named according to the employees initials, for example CSL or SLE.
In the Flash Art object you would then need to use the formula

First[1,1]+Middle[1,1]+Last[1,1]

This formulas uses text funnels (see “Taking Strings Apart (Text Funnels)” on page 69 of Formulas & Program-
ing) to extract the initials from the full name, automatically displaying the correct image.
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Locating an Image in the Flash Art Scrapbook

The Find Picture command (in the Picture Menu) displays a list of all the images in the Flash Art Scrapbook 

Choose the image you want to see and press OK (or double click on the name) to see the image.
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Removing an Image from the Flash Art Scrapbook

To remove an image from the Flash Art Scrapbook, first locate the image and then use the Cut tool or choose
Cut from the Edit Menu.

Renaming an Image

To give an image a new name use the Rename Picture tool.

This tool opens a dialog box that allows you to change the name of the currently visible picture.
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Re-Arranging the Image Order

You can use the Re-Arrange Pictures command in the Picture Menu to change the order of the images within
the Flash Art Gallery.

Simply copy the images from the left to the right in the new order. Double click on an image to copy it to the
right. (Note: There’s really no reason to ever re-arrange the order of the images, since Panorama doesn’t care
what the order is. The only exception is if you have two images with the same name. In that case, Panorama
will always display the first image in the list and ignore the rest.)

Printing the Flash Art ScrapBook

You can use the Print command to print all the pictures in the Flash Art Scrapbook. Panorama will print as
many pictures per page as it can fit. 

Importing PICT Files into the Flash Art Scrapbook

Many graphic applications can save pictures as PICT files. The Import PICT command in the Picture Menu
allows you to add these files to the Flash Art Scrapbook directly, without having to go through the clipboard.

To import a single PICT file into the Flash Art Scrapbook, open the Import PICT dialog (Picture Menu), then
choose the file and press the Load button. Panorama will use the name of the PICT file as the picture name.

You can import every PICT file in a folder by pressing the Load All button. All the pictures in the folder will
be added to the Flash Art Scrapbook, using the names of the files as the names of the pictures.
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A Flash Art object can also display PICT files directly from disk without loading them into memory. This
saves memory, but is slower than displaying pictures actually loaded into the gallery. To learn how to use
PICT files directly see “Displaying Images Directly From Disk Files” on page 769.

Transferring the Flash Art Scrapbook to Another Database

You can use the Save Flash Art Scrapbook and Import Flash Art Scrapbook commands to copy the pictures
in a Flash Art Scrapbook from one database to another. The Save Flash Art Scrapbook command saves the
entire Scrapbook in a separate file. The Import Flash Art Scrapbook command imports the saved pictures
into the current Flash Art Scrapbook. 

To transfer all the pictures in database A to database B, first open the Flash Art Scrapbook in database A and
choose the Save Flash Art Scrapbook command (Picture Menu). Type in a name for the exported Flash Art
Dialog, and press Save. Now open the Flash Art Scrapbook in database B and choose the Import Flash Art
Scrapbook command. All of the pictures will be added to database B.

Displaying Images Directly From Disk Files

In addition to displaying images from the Flash Art Scrapbook, Panorama can also display images directly
from disk files. If the images are large, this can save a tremendous amount of memory. It also makes it easier
to edit the images. The downside is that if you move or copy the database to a new location you’ll have to
make sure to move or copy all of the images also. Here is a typical folder full of image files.
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To allow Panorama to display images directly from disk files you must enable the Include Pictures on Disk
option.
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Since the images are in the same folder as the database itself, only the image name is needed as the formula
(in this case the image name is in the field Fruit). All of the images have been removed from the Flash Art
Scrapbook in the database shown below (saving 782 kilobytes of memory - almost a megabyte!), so now the
images are displayed directly from the disk files.

Note: If the Flash Art Scrapbook is not empty, Panorama will look there first when trying to locate an image.
If the Flash Art Scrapbook contains an image with the correct name, it will be displayed, and Panorama will
ignore any disk file with the same name.

Displaying Images in a Different Folder (Directory)

Flash Art images don’t have to be in the same folder as the database—they can be in any folder (directory) on
your hard disk, or even on a removable media like a CD-ROM or a Zip disk. On the Macintosh, the exact
location of any file can be specified by stringing together the name of the volume (disk) and the folders, each
separated by a colon.

Alaska:Work in Progress:Ontario:Schedule.pan
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Windows systems are similar, but backslashes (\) are used instead of colons, and drive names always consist
of letters followed by a colon (A:, B:, C:, etc.).

For cross platform compatibility, Panorama also allows you to use colons when using Panorama for Win-
dows, like this:

C::Work in Progress:Ontario:Schedule.pan

A file’s location may also be specified relative to the current database. For example, suppose the current data-
base was in the Work in Progress folder. In that case you could specify the location of the Shedule.pan file by
simply leaving off left hand portion of the specification. The specification must begin with a colon or back-
slash to indicate that it is relative to the current folder and not an absolute location.

On PC systems you can specify this relative location like this:

However, keep in mind that on PC systems Panorama will accept : instead of \. Therefore, the specification

:Ontario:Schedule.pan

will work on both Windows and MacOS based computers. You should use colons if your database might ever
be used on both Macintosh and Windows computers.

C:\Work in Progress\Ontario\Schedule.pan

:Ontario:Schedule.pan

\Ontario\Schedule.pan
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To illustrate all of this with a real-world example, let’s revise the Fruit Nutrition database from the previous
section. Instead of placing all of the image files in the same folder as the database, we will move them to their
own folder, with that folder in the same folder as the database itself.
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The Fruit Photos folder is said to be nested inside the Nutrition folder, which is the folder that actually con-
tains the database. To display the photos, the formula in our Super Flash Art needs to be modified.

The new formula combines the fruit name with the folder location. For example, if the fruit name is Apricot,
the result of the formula will be :Fruit Photos:Apricot — the exact location for the image.

A similar technique can be used to specify an absolute location for the image. Suppose you have a CD-ROM
named Groceries that contains the images nested within the Produce folder within the Photos folder. The for-
mula below could be used to display the images.

On the PC the CD-ROM drive is usually D:, so this would be the formula.

The photos do not have to be in a fixed location. Using a variable (see “Variables” on page 53 and “Variables”
on page 247 of Formulas & Programing) and the folderpath( function (see “Disk Files and Folders” on
page 165 of Formulas & Programing) you can allow the folder to be moved around.

folder name

leading colon tells Panorama this is a location
relative to the current database

variable
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Elsewhere in your database you can include a procedure (see “Procedures” on page 203 of Formulas & Pro-
graming) like this to allow the database user to select the folder containing the images.

local xFile,xFolder,xType
openfiledialog xFolder,xFile,xType,""
if xFile=""

stop /* stop because the Cancel button was pressed */
endif
photoFolder=xFolder   /* update location of photos */
showvariables photoFolder   /* make sure new photos are displayed immediately */

All of the previous examples have assumed that the images are all in the same folder. However, that is not
necessary. If you wish, the folder location may be included in the database itself, allowing different images to
be in different folders. The folder location may be combined in with the image name in a single database
field, or they may be stored in separate fields and combined in the Flash Art formula. 

Displaying Non PICT Images (Enhanced Image Pack)

The standard configuration allows Panorama to display images in PICT format. This is the standard format
for images on Mac OS computers, and is easily created using graphics programs on both Macintosh and Win-
dows computers. This illustration shows how the PICT format may be selected when saving a file in Adobe
Photoshop.

The optional Enhanced Image Pack gives Panorama the ability to display a wide variety of other image for-
mats. This table lists some of the most popular image formats that can be displayed with this option.

The Enhanced Image Pack requires that Apple Quicktime 4.0 or later be installed on your computer. If
Quicktime is not already installed on your system you can download it from www.apple.com.

Image Type PC Extensions Notes

BMP .bmp Windows and OS/2 bitmap

JPEG .jpg   .jpeg JPEG compressed image

PNG .png Portable Network Graphics bitmap

TIFF .tif   .tiff Tagged Image Format

GIF .gif Common web format

PHOTOSHOP .psb Adobe Photoshop

FLASHPIX .fpx FlashPix bitmap

TARGA .targa
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Once the Enhanced Image Pack is installed on your system you can display any of these image formats by
name, just as with PICT images. This illustration shows how to display a fixed JPEG image.

Make sure you enable the Include Pictures on Disk option, as shown above. Here is the actual JPEG image
being displayed in the form.
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Of course usually the images you display will be variable, not fixed. For example, suppose the fruit images
used in the previous examples were JPEG images instead of PICT format. In that case you could display the
images using this formula.

Or, if the images were nested in a different folder you could use a formula like this (see “Displaying Images
in a Different Folder (Directory)” on page 771).

In addition to displaying images the Enhanced Image Pack can also convert an image from one format into
another (see “Converting Between Image Formats” on page 694). For more information on ordering the
Enhanced Image Pack visit our website at http://www.provue.com.

Image File Extensions in a Cross Platform Environment (MacOS and Windows)

On Windows systems all files have a three our four letter “extension” based on the type of data in the file. For
example, all Panorama databases end with .pan, all text files end with .txt, all PICT image files end with .pct
and all JPEG image files end with .jpg or .jpeg.

On Macintosh systems this extension is not necessary because the file itself contains information about what
type of data it contains. (However, for a few file types it is traditional to include the extension anyway, for
example JPEG or HTML files.)

For most databases you don’t need to worry about whether or not to use file extensions. If the database will
be used on a PC system, you use an extension, if it will be used on a Macintosh, you don’t. But what about
cross-platform databases that may be used on both platforms? Panorama is designed so that you can build a
single database that will automatically display images correctly on both platforms. Let’s see how it’s done.

As you learned earlier, Panorama uses the Flash Art formula to generate the name of the image to display
(see “Displaying Images Directly From Disk Files” on page 769). On Windows systems, this file name must
include an extension (.pct, .bmp, .jpg etc.). If it doesn’t, Panorama will automatically add .pct to the end of the
name. (Remember, .pct is the extension for PICT images, Panorama’s standard image format.) To illustrate
this, let’s go back to the fruit example we saw earlier. Here’s the formula:
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On a Macintosh system this formula will simply generate the names of the fruits: Apple, Apricot, Avocado,
etc. But on a Windows computer the Panorama will automatically add the .pct extension: Apple.pct, Apri-
cot.pct, Avocado.pct etc. Therefore the same formula will automatically work on both Macintosh and PC
computers. (If you use the Panorama Platform Converter to convert your database from Mac to PC it will
automatically add the .pct extension to all of your image files fro you, or remove the extension when moving
from PC to Mac. See “Platform Converter Wizard” on page 800 of Formulas & Programing for more informa-
tion on the Platform Converter.)

When you use Panorama on a Macintosh system it doesn’t normally add the .pct extension. However, there is
one exception. If the name of the database ends with .pan, Panorama will automatically add the .pct exten-
sion to any image file name that does not already include an extension. This allows you to create a database
that may be shared on a server between Mac and PC systems. The same database can be used on either sys-
tem with no conversion. However, this also means that when the database name ends with .pan images that
do not have any extension (for example Apple or Tomato) cannot be displayed, only images that do have
extensions (for example Apple.pct or Tomato.pct). (This restriction does not apply, however, to images in the
Flash Art Scrapbook, see “The Flash Art Scrapbook (Gallery)” on page 764.)
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Flash Art Image Drag and Drop

If you have a collection of image files on the hard drive the simplest way to get them into a database may be
to simply drag them from the Finder onto your database (Macintosh only). You can add this feature to your
existing databases or you can start with the Image Drops example database that comes with Panorama.

The Image Drops Example Database

To try out the Image Drops example start by opening the Example Launcher wizard (in the Demos submenu
of the Wizard menu). Scroll down and find Image Drops, then double click to open it.

This example initially opens with two windows — a list of images on the left and a detailed image form on
the right.



Page 780 Panorama Handbook
To add images to this database simply drag one or more image files (or even a folder that contains images)
from the Finder into the area marked DROP IMAGES HERE. (Note: If the images are JPEG, TIFF, or other non
PICT images you must have the Enhanced Image Pack installed, see “Displaying Non PICT Images
(Enhanced Image Pack)” on page 775).

After a short delay Panorama will report the number of images added to the database.

I can move from record to record to see the different images that have been added.
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Of course the images themselves haven’t been brought into the database — just the names and locations, as
we can see by opening the data sheet.

In this database the image location (path) and name are stored in a field called Image. The other fields in the
database can be used for anything you want.

Adding Drag and Drop Images to a Database

If you are starting from scratch one easy way to make an image database is to start with the example Image
Drops database. Simply open this database, use the Reveal in Finder command to locate the file on the hard
drive and make a copy for your own use. Add whatever fields, forms and procedures you need.

It’s also relatively easy to add image drag and drop to an existing database. The first step is to add a field to
the database to hold the image path and name. To illustrate this I’ll use the design sheet to add a field named
Photo to a contacts database (you can also use the Add Field command in the Setup menu).
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The next step is to add a Super Flash Art object to one or more forms in the database (see “Creating Super
Flash Art Objects” on page 751). The Formula for this object must be set to the name of the field you just set
up, in this case Photo. Make sure that the Include Pictures on Disk option is set (see “Include Pictures on
Disk” on page 789). For most photographic applications you’ll also want to set the Proportional alignment
option (see “Align” on page 797).

I’ve set up the super flash art object next to the contact information on the form.
Howe

super flash art object
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However, I’m not quite done with this object yet — I need to give it a special name. To give an object a name
select the object and choose Object Name from the Edit menu (or click on the object name area in the Graphic
Control Strip, see “Object Type/Object Name” on page 533). I’ll set the object name to DROP[hfs ]Photo
(more on this in a moment).

When I’m done selecting the object again (by clicking on it) should show the name in the Graphic Control
Strip (if that section of the strip is visible — see “The Graphic Control Strip” on page 505).

So why does the object name need to be DROP[hfs ]Photo? The name is divided into three portions.

To learn more about this topic see “Receiving Dragged Data” on page 654 of Formulas & Programing.

The final step is to set up a special procedure to handle the dropped files. This is easy, because the procedure
only needs one line of code! The procedure must be named .DropProcedure — here it is:

DROP This portion of the name tells Panorama that data can be dropped on this object

[hfs ] This portion tells Panorama what kinds of data can be dropped on this object, in this 
case files or folders (hfs stands for heiarchial file system, the original file system used by 
the Macintosh). If this section of the object name is [] then any type of data can be 
dropped on the object.

Photo This final portion is optional. If you have multiple objects in a database that can have 
items dropped on them you can use this final portion to determine what object was 
dropped on.
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Now I’m ready to drag an image from the Finder onto my form. Voila! The image appears.

Because I programmed this option with the currentrecord=oneimage option the photo appears in the current
record instead of being added to a new record. (This also means that you can only drop one image at a time
— if you drop more than one image only the first one will be used). To add an image to a different record sim-
ply move to that record and then drag the image onto the form.

DropImagesFromFinder Options

The key to image drag and drop is the DropImagesFromFinder statement. This statement takes the
dropped files and adds their name and location to the database. The operation of this statement can be cus-
tomizied with a list of options. Each option must be specified using the format optionname="value" (the-
quotes may be omitted if there is no special characters or punctuation in the value).

Option Description

field=fieldname
This option specifies what field the image paths and names should 
be placed into. If this option is omitted the image path & name will 
be placed in the current field.

type=imagetype

This option specifies a type of image that will be allowed. You may 
choose from jpeg, tiff, png, pict, bmp, pdf, gif, photoshop, mov, 
mpeg, wav, aiff, aac, mp3, and sd2. (Note that some of these are 
movie types, you can drag and drop movies in addition to still 
images.) You can explicitly specify multiple types by using multiple 
type= options, for example:

type=jpeg type=tiff type=png

You can also specify “composite” types: image for all image types, 
movie for all movie types, or sound for all sound types, or all for all 
media types (including image, movies and sound) , for example:

type=image

If no type is specified the statement defaults to all image types (but 
not movie or sound).
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By combining these options you can add dropped images to the database just about any way you want to.

currentrecord=oneimage

currentrecord=yes

currentrecord=no

If this option is oneimage the dropped image will replace the current 
image in the database. If multiple images are dropped only the first 
image will be used, any others will be ignored.

If this option is yes all dropped images will be added to the current
record only (as a carriage return delimited array). This allows multi-
ple images per record (which could be displayed with a super
matrix).

If this option is no dropped images will be added to new records at
the end of the database (unless they are duplicates and the
skipduplicate option has been set to no).

skipduplicates=yes/no If this option is yes,images that are already in the database will not 
be re-added. The default if this option is not included is yes

relativepaths=yes/no

If this option is yes, only images that are in the same folder or in sub-
folders of the database will be added. Any images in other locations 
will be ignored. Instead of storing the absolute location of the image 
(starting with the disk name) relative paths will be used. The advan-
tage of relative paths is that the database and images can be moved 
to a different location or even a different computer and the images 
will display correctly without adjustment. The disadvantage is that 
images that are not in the same folder as the database (or subfolders 
of that folder) cannot appear in the database. The default for this 
option is no.

message=yes/no If this option is yes, the statement will display an alert with the 
results (how many images added and skipped). The default is yes.

dictionary=yes/no

If this option is yes, the statement will create a fileglobal variable-
named _DropImageResults. This variable will contain a dictionary 
(see “Data Dictionaries” on page 602 of Formulas & Programing) with 
three elements: NEWIMAGES, DUPLICATEIMAGES and OUTSI-
DEIMAGES. You can use the getdictionaryvalue( function to extract 
the elements from this dictionary to do your own custom reporting 
of the results from the DropImagesFromFinder statement. For exam-
ple you could use these results to create a log of images added to the 
database.

NEWIMAGES is a carriage return delimited list of the new images 
that have been added to the database, including full paths.
DUPLICATEIMAGES is a carriage return delimited list of images 
that were dropped but were not added because they were duplicates 
of existing records.
OUTSIDEIMAGES is a carriage return delimited list of images that 
were not added because relative paths were specified and these 
images were outside of the database folder (so no relative path could 
be used).

Option Description
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Super Flash Art™ Options

The SuperObject™ Flash Art configuration dialog has numerous options for customizing each object you cre-
ate.

Formula

This section of the dialog contains the formula that calculates the image name. The formula may be up to 255
characters long (to create longer formulas, see the next paragraph). Use this formula to combine one or more
fields and/or variables into a picture name. See “Formulas” on page 19 of Formulas & Programing to learn
more about Panorama’s formula capabilities.

Formula in a Variable. If the first character of the formula is @ Panorama treats the rest of the line as a variable
name instead of a formula. This variable must contain the actual formula for calculating the image name.
Using this technique if your formula is over 255 characters (a variable may contain an unlimited number of
characters) or if the formula needs to change under different conditions. See “Variables” on page 53 of Formu-
las & Programing and “Variables” on page 247 of Formulas & Programing to learn more about variables.

Before you can use this feature you must set up a variable that contains the actual formula you want to use.
Here’s an example that set’s up a variable named PhotoFlash to display JPEG images.

fileglobal PhotoFlash
PhotoFlash={PhotoName+".jpg"}
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The Super Flash Art formula would be set up to use this variable. Remember, to use this option the first char-
acter must be the @ symbol.

Later you could change the formula to display PICT files like this.

PhotoFlash={PhotoName+".pct"}

Default

This is the name of the default image that should be displayed if Panorama cannot locate an image with the
name specified by the formula. For example, consider the Fruit database used in the previous example. Sup-
pose you encounter a new type of fruit for which you don’t have a picture? You could simply leave the image
blank. Or, you could create a default image that will be used in these situations, like this.

Now you can specify this image as the default. Notice that no quotes are needed (or allowed!). The default
image cannot be changed on the fly — it is not specified by a formula like the main image.

variable name
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Now if you add a new fruit to the database for which there is no picture, the default image, Exotic Fruit, will
be displayed.

Alt File

This option allows one database to share the images in its Flash Art Scrapbook with another database. Both
databases must be open for this to work. Usually you would use this option when you have a group of data-
bases that are always used together. All the images could be stored in a single database, saving memory. (This
option only applies to images in the Flash Art Scrapbook (see “The Flash Art Scrapbook (Gallery)” on
page 764). Images in separate disk files (see “Displaying Images Directly From Disk Files” on page 769) can
be accessed by any database at any time.)
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For example, suppose you had a Grocery database that was always used with the Fruit database created ear-
lier. A flash art object in the Grocery database can display fruit images in the Fruit database, as long as the
Fruit database is open.

Even if the database containing the images is in a different folder, you should only type in the name of the
database. Since the database must be open in memory, Panorama doesn’t need to know the location of the
database on the disk.

Include Pictures on Disk

Check this option if you want images in separate disk files to be displayed. Panorama will check the Flash Art
Scrapbook first, then check to see if there is a PICT file with the name specified by the formula. For more
information on this option see “Displaying Images Directly From Disk Files” on page 769.

Display Group of Pictures

Enabling this option allows multiple images to be displayed in one spot. The images must be designed to
overlay on top of each other. The most common application for this option is to display a map. You start with
a base map, then overlay information on top of it. The Display Group option is designed to be used with a
summary record (see “3-Step Summarizing” on page 365). It will automatically display all of the images
belonging to the data records above the summary record.
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To illustrate this option we’ll use a database with presidential election data. The database has been grouped
to total up the electoral votes for each state, and for each election.

We’ll start with a base map of the United States, as shown in the illustration below. This base map is simply a
fixed image that has been pasted into the form (see “Fixed Images” on page 741).
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To create our final map we’ll need an overlay map for each of the 50 states. The overlay map must be
designed to fit right on top of the base map. Here’s the overlay map for California.

Here’s the overlay map for Maine.

It can take a lot of work to set up the overlay maps! Once they are complete, you are ready to build a compos-
ite map — in this case showing the results of the presidential election.
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To build the composite map you need to create a Super Flash Art object directly on top of the base map. The
Super Flash Art Object must exactly match the position and size of the base map, so that the overlay maps
will line up with the base map. Here’s the configuration dialog for this Super Flash Art object. The formula
uses the ?( function to decide whether or not to display the overlay map for a particular state (see “The ?
Function” on page 130 of Formulas & Programing). If the electoral vote for the Republicans is greater than the
vote for the Democrats, the overlay is displayed (so in this case the state will be displayed in red). If the Dem-
ocrat vote is larger, the overlay is not displayed (so the state remains in white).
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It can be tricky to get the overlay Flash Art SuperObject to line up exactly with the fixed map. Here’s an easy
way to do it. Start by selecting both of the objects (see “Selecting Multiple Objects at Once” on page 502).

Now use the Align Objects command to line up the objects (see “Aligning Objects” on page 553). Start by
aligning the top and bottom…

fixed image

overlay
(flash art)



Page 794 Panorama Handbook
Then repeat the Align Objects command to line up the left and right edges.
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Now let’s see what our composite map looks like. Using the data sheet, we move to a state that was won by
the Republicans.

The formula tells Panorama to display the overlay map for this state.
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You can move from state to state, viewing the results for each state. When you get to the summary record,
however, something different happens. Here’s the summary record.

Now here’s the map. Because the Display Group of Pictures option is enabled, Panorama displays the over-
lay map for every state with a Republican victory that year. You can easily see that Gerald Ford swept the
west, while Jimmy Carter took the South.

A really powerful combination is to create multiple overlay maps with different colors and/or gray levels,
and then select the appropriate color using the formula. For example you could use different colors to indi-
cate different market penetration levels, or pollution levels, etc.

Border

If this option is enabled, Panorama will draw a 1 pixel border around the Super Flash Art object.

Drop Shadow

If this option is enabled, Panorama will draw a simulated drop shadow slightly below and to the right of the
Super Flash Art object.
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Overflow

This option is used in conjunction with an overflow tile for printing images that are more than one page high.
See “Printing Data that Overflows a Page” on page 1116 for more information on multi-page overflow print-
ing.

Scroll Bars

If you expect that the images you will be displaying may be too large to fit into the dimensions of the Super
Flash Art object, you can enable scroll bars that will allow the user to shift around and view different parts of
the picture. You can enable a Vertical scroll bar, a Horizontal scroll bar, or both.

You also have the option of leaving space for a Grow Box in the lower right hand corner of the Super Flash
Art object. The Grow Box is simply a 16 by 16 pixel box that is left empty. It’s up to you to draw an icon in this
area (if you want). If the bottom right hand corner of the Super Flash Art object is in the same position as the
bottom right hand corner of the window, you can disable the window’s normal scroll bars and use the Super
Flash Art object’s scroll bars and Grow Box instead (see “Elastic Forms” on page 922).

Align

The dimensions of the picture being displayed often do not exactly match the size of the Super Flash Art
object. This section of the dialog specifies how the picture should be adjusted if it is too large or too small for
the Super Flash Art object.

scroll bars
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The left side of this section contains nine radio buttons in a tic-tac-toe arrangement. These buttons allow the
picture to be aligned within the Super Flash Art object. The picture can be aligned with any corner, centered
on any side, or centered in the middle of the object. Wherever the object is aligned, it will be displayed actual
size; i.e. it will not be enlarged or reduced. For example, here is an image displayed in the top left corner.

Here is the same image displayed in the middle center.
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And again in the bottom right.

The Scale to Fit option will enlarge, reduce, and/or stretch the picture so that it exactly fits in the Super Flash
Art object. The picture may be distorted to make it fit, as you can see in this illustration.
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The Proportional option will enlarge or reduce the object as much as possible so that it will fit into the object,
but it will not distort the picture. In other words, it will not change the proportions of the picture. 

If the proportions of the original picture do not match the proportions of the Super Flash Art object, Pan-
orama will leave a border along the top and bottom or left and right. We’ve added a gray background to this
example so you can clearly see the borders. (The gray background is simply a solid rectangle object placed
behind the Flash Art SuperObject.)
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Depending on the aspect ration of the image (width vs. height) the borders may also be on the sides instead
of the top and bottom, like this.

Keep in mind that the Scale to Fit and Proportional options may be used to reduce an image as well as to
enlarge it. Here’s a typical reduced image that has been scaled down with the Proportional option.
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The Tile option displays the picture over and over again in a tile arrangement, starting from the upper left.
This option allows you to cover a large area with a small picture.

The only disadvantage of this technique is that if the original picture is really small there will be a perceptible
delay as the tile pattern is drawn.

Displaying Images from Resource Files

Super Flash Art normally displays images from the Flash Art Gallery or directly from disk files. However,
images can also be displayed from resource files. An image can be placed in a resource file using a program
like ResEdit or Resourcerer. Before an image can be displayed from a resource file the file must be opened
with the openresource statement. “Working with Resources” on page 433 of Formulas & Programing to
learn how to do this.

To display an image from a resource file you must use a special prefix as part of the Super Flash Art formula.
If the formula begins with //, the rest of the formula is treated as the name of the resource to be displayed.
For example, this formula would display the resource picture named Blue Sky.

"//Blue Sky"

If the formula begins with ##, the rest of the formula is treated as the number of the resource to be displayed.
For example, this formula would display the resource picture number 4387.

"##4387"
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Panorama itself includes a number of resource based images. Most of these are used by Panorama itself in
various windows and dialogs, but they are available for use in your databases also. To see a list of these
images open the Icons & Backgrounds wizard in the Form Tools submenu of the Wizard menu.

On the left is a thumbnail matrix of images. Click on any image to see an enlarged view on the right, along
with the resource number.

resource number to use in Flash Art Formula
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Here is the formula for displaying this purple to white blend:

Here’s what this image looks like in a form.

Many of these standard images can be stretched to fit different sizes. The object above is displayed with the
alignment set to top left. Changing the alignment to Scale to Fit gives a expands the blend to fit a larger area.
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Some of the standard images are elastic (see “Elastic Pictures” on page 809). This means that they can be
stretched without distortion. For example, consider this search box image (##982).

Because this image is elastic you can stretch it without distorting the corners.
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Panorama also includes several background images that are designed to be tiled, like this Brushed Metal Tile.

When displaying these background images we recommend that you set the Alignment to Tile.
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This option will display a seamless brushed metal surface no matter how large your object is.

The Icons & Backgrounds wizard normally displays all of the available images. If you want to see just a par-
ticular subset you can choose from the Category menu.

The wizard will respond by displaying the selected images.



Page 808 Panorama Handbook
Displaying Icons from Resource Files

To display an icon (ICON or CICN resource) use the prefix #*. Icon resources can be created with ResEdit or
Resourcerer. Unlike a picture, an icon definition includes a mask that allows the image to have an irregularly
shaped edge (not just rectangular). This allows the icon to display correctly on a colored background. Here is
a formula that will display ICON 3981.

"#*3981"

Displaying Form Preview Pictures

Panorama allows you to attach a special preview picture to any form (see “Form Comments” on page 732 of
Formulas & Programing). This picture can be displayed with a Super Flash Art object. To display the preview
picture for any form in the current database use a formula with the format ;;<form name>. For example,
this formula will display the preview picture for the form named Avery 4932 (if any).

";;Avery 4932"

To display the preview picture for a form in another database use a formula with the format
;;<database>:<form name>. For example, this formula will display the preview picture for the form
named Avery 4932 in the Mailing Labels database (if any).

";;Mailing Labels:Avery 4932"

The database containing the form (in this case Mailing Labels) must be open to display the picture.



Chapter 16:Images & Movies Page 809
Elastic Pictures 

Many forms require borders, buttons and widgets need to be used over and over again but with different
sizes. Any image can be stretched with the Scale to Fit option, but the result is often a distorted image. For
example, consider this bevel button, which looks good at 32 by 32 pixels.

Using the Scale to Fit option to stretch this image to 64 by 128 pixels doesn’t look good because the corners
and bevels are stretched as well.

What we would really like is for the object to stretch intelligently, with the corners and bevels remaining tight
while the interior of the object stretches, as shown below.

Panorama’s Elastic Picture feature allows you to take any PICT image and enhance it so that it can be
stretched at will without disturbing the corners and bevels. The image above was not customized in Photo-
Shop – it’s the same image displayed in Panorama using the Scale to Fit option, but after it has been enhanced
with the Elastic Picture Workshop.

(Note: Only images in Apple’s PICT format can be made elastic. Panorama takes advantage of the extensibil-
ity of the PICT format to add additional stretching information into the picture. This information cannot be
added to other formats like JPEG, TIFF or BMP, so they cannot be made elastic. Fortunately many graphics
programs can convert from these formats into the PICT format (even on the PC) so you will be able to make
any image elastic after converting it to this format.)
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Using the Elastic Picture Workshop

You’ll use the Elastic Picture Workshop wizard to add the stretching information to an image. You’ll find this
wizard in the Developer Tools submenu of the Wizard Menu.
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The first step is to open the wizard. You can either drag the image file onto the Elastic Dividers area or use the
Open Image command in the Image menu. In the example below an image named Bevel Button.pct has been
dragged onto the wizard.
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The wizard is divided into two sections. The left section, Elastic Dividers, displays the original size object.
The right section, Preview, displays a stretched version of this object. You can use the buttons along the bot-
tom of this section to control how much the image is stretched, you can also type in any stretch size you want
in the dimension box on the right.

Since the image isn’t elastic yet, the preview shows the stretched corners and bevels that we want to get rid
of. Let’s do that now.

choose from standard preview sizes

or type in any dimensions you want
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The left side of the wizard displays four light blue elastic dividers around the edges of the original image.
You can manipulate these dividers with the buttons along the left and bottom edges. The buttons along the
left hand side control the position of the top and bottom dividers, while the buttons on the bottom control the
position of the left and right dividers. The goal is to position the dividers so that the edges and bevels are
divided from the main body of the image. As you adjust the dividers into place you’ll see the edges and bev-
els in the preview magically clean up.

Tip: When you press the  or  buttons the dividers will normally move one pixel. However, if you
hold down the Shift key the dividers will move five pixels in the specified direction.

Saving the Elastic Picture

When the dividers are in place use the Save Image or Save Image As commands in the Image menu to save
the elastic image. The wizard will save an adjusted version of the picture. (Technical Note: The information
necessary to allow the image to be displayed elastically is stored in the picture itself in a PICT comment. The
image can still be edited with PhotoShop or another image editing program, but doing so will remove the
PICT comment and the image will no longer be elastic.)

The picture can also be saved directly into a resource file with the Save in Resource command. This com-
mand will prompt you to locate an existing resource file (you must create this file in another application) and
then prompt you for the resource number.

move top & bottom 
dividers to the center 
of the image.

move top & bottom 
dividers one pixel 
towards the center.

move top & bottom 
dividers one pixel 
towards the edge of 
the image..

move top & bottom 
dividers to the top 
and bottom edges of 
the image.

move top & bottom 
dividers to the bot-
tom edge of the 
image.

position of top divider.

position of bottom 
divider.

position of 
left divider.

move left & right 
dividers to the 
center of the 
image.

move left & 
right dividers 
one pixel 
towards the 
center.

move left & right 
dividers one pixel 
towards the edge 
of the image..

move left & right 
dividers to the top 
and bottom edges 
of the image.

move left & right 
dividers to the 
bottom edge of 
the image.

position of 
right divider.
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Using the Elastic Picture

To display an Elastic Picture on a form you’ll need to use the Flash Art SuperObject. Set up the options just as
you would for any other PICT file (make sure the Include Files on Disk option is checked). You’ll also want to
make sure that the  Scale to Fit option is checked. That’s all there is to it. You can also use elastic pictures with
any SuperObject that displays PICT files – Flash Art Push Buttons, Flash Art Data Buttons, etc.
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“Classic” Flash Art Objects

In addition to the Super Flash Art object described throughout most of this chapter Panorama also has a
“classic” Flash Art object. When Super Flash Art objects were added as part of Panorama 3.0, “classic” Flash
Art objects were retained for compatibility with older databases. We recommend that you use Super Flash
Art for new applications.

Using “classic” Flash Art objects is very similar to working with Super Flash Art objects. The Flash Art tool
looks like a lightbulb and is part of the standard Panorama tool palette.

To create a “classic” Flash Art object select this tool and drag the mouse across the form (see “Creating Super
Flash Art Objects” on page 751). The configuration dialog for a “classic” Flash Art object looks like this.

The options in this dialog are a subset of the options in the Super Flash Art object. See “Super Flash Art™
Options” on page 786 for a description of each option. Note: The “classic” Flash Art formula is limited to 30
characters, not 255 like the Super Flash Art version.
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Storing Images in a Field

Flash Art is the recommended method for displaying images in a Panorama database. Panorama does, how-
ever, have another method for storing and displaying images. Instead of using Flash Art you can actually set
up a Picture field and store the images directly in the database. This has many disadvantages—it uses up
gobs of memory and you have no control over the alignment or scaling of the image. Nevertheless, this has
been an option since the first version of Panorama and is retained for compatibility with databases that may
use this feature.

To store images directly in the database, the database must contain a field that is set up using the picture data
type. You can set up this data type using the Field Properties dialog (see “Setting Up a Field’s Data Type” on
page 246).

You can also set up a Picture type field with the design sheet (see “The Design Sheet” on page 212).

The Picture data type cannot be used in the data sheet—you must set up the form. Create a Data Cell object
for the picture field (see “Working with Data Cell Objects” on page 635). The Text Display Object should be
large enough to display the largest picture you want to use. For other fields you may use either Data Cells,
Text Editor SuperObjects, Text Display SuperObjects or Auto-Wrap text objects.

picture field

text and numeric fields
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Once the form is set up, switch to Data Access Mode. The text and numeric fields can be filled in using the
normal techniques (i.e. the keyboard).

Now for the picture. Start by clicking on the picture cell to select it.

The next step is to go into your graphics application (Photoshop, etc.), locate the image, and copy it onto the
clipboard.
x
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Now go back to Panorama and use the Paste command to paste the image into the database.

When a normal data cell is selected, the text in that cell switches to a negative image, with white text in a
black background. As you can see, the same thing happens with a picture data cell. When the data is selected,
the picture appears in reverse, like a photographic negative. When another data cell is selected, the normal
picture image will appear.

You cannot edit a picture by double clicking on the data cell, nor can you sort or select using a picture field or
use a picture field as part of a formula. In the data sheet the picture field appears to be blank, and Panorama
will not allow you to double click on the field.
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Displaying Movies in a Form

Panorama’s Super Flash Art object is capable of displaying movies as well as still images. To do this you must
have Apple’s QuickTime software installed on your computer. If you don’t have this software you can down-
load it from www.apple.com for either Macintosh or Windows PC systems.

The first step in displaying movies is to create some movie files.

Next, you’ll need to create a database. In this case we created a very simple database that has the artist’s
name along with the name of the movie (we’ll add the .mov extension in a moment). 

same as movie names above
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To display the movies we’ll need to create a form, and then to create a Super Flash Art object within the form
(see “Creating Super Flash Art Objects” on page 751). Unlike still images, movies always require you to spec-
ify the complete location of the file. The formula below shows how to do that (assuming that the movies are
in the same folder as the database) and also adds the .mov extension. Make sure that the Include Pictures on
Disk option is enabled, because a movie cannot be pasted into the Flash Art Scrapbook.

Switch to Data Access Mode to try out the movie. The normal QuickTime controls appear at the bottom of the
Super Flash Art object.

name of movie
(from database)

formula for
current folder

volume

play/pause
fast forward/rewind

frame advance/rewind
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To see a different movie simply move to the record for the movie you want to view.

In Graphics Mode editing a Super Flash Art object that is set up to display a movie can be a bit tricky. Even
though you are in Graphics Mode, clicking on the movie tends to activate the movie controls instead of
selecting the object. If you have difficulty, try dragging a marquee around the object instead of clicking on it
(see “Selecting Multiple Objects at Once” on page 502). Instead of double clicking on the object to open the
configuration dialog, try using the Object Properties command in the Edit menu.

Once a movie has been set up it can be controlled with a procedure as well as with the movie control strip.
The procedure can start and stop the movie, move to a specific spot within the movie, change the playback
rate and the volume. To learn how to program a movie see “Super Flash Art Commands (Including Movie
Control)” on page 690.

For those of you that can’t stand not knowing who Marty Goetz and Angelique Kidjo are, check them out at
http://www.martygoetz.com (Marty Goetz) and at http://wwwusers.imaginet.fr/~kidjo/home.html (Angeli-
que Kidjo).
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Chapter 17: Buttons & Widgets

The Industrial Revolution introduced machinery with all kinds of knobs, levers, and doo-dads. In our elec-
tronic age these have been replaced by virtual push buttons, checkboxes, “radio” buttons, pop-up menus,
scrolling lists, and other widgets. Panorama has a number of tools for incorporating these types of controls
into your forms.

Although most of the buttons and widgets discussed in this chapter can be used without programming, most
of them are often combined with Panorama procedures. Because of this, we will often reference procedures
and programming techniques throughout this chapter. Before reading this chapter you may want to skip
ahead and learn how to create and work with procedures (see “Procedures” on page 204 of Formulas & Pro-
graming) and variables (see “Variables” on page 53 of Formulas & Programing).

Push Buttons

Push buttons have one mission in life—to start something. In Panorama, clicking on a push button triggers a
procedure (see “50 Ways to Trigger a Procedure” on page 355 of Formulas & Programing). You push the button
and the program starts, simple as that. Panorama has three different types of button objects—Super Object
Push Buttons (next section), “Classic” Button Objects (see ““Classic” Push Buttons” on page 830) and Flash
Art Push Buttons (see “Flash Art™ Push Button SuperObjects™” on page 833).

Super Object Push Button

The SuperObject Push Button makes it easy to create attractive buttons that trigger procedures. Unlike Pan-
orama’s standard button tool, the SuperObject Push Button can create circular or oval buttons, and buttons
with various 3-D effects.
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The SuperObject Push Button tool is not in the default tool palette, so you’ll need to use the Tool Palette dia-
log to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the button.
\

When you release the mouse, the SuperObject Push Button configuration dialog will appear.
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Use the pop-up menu to select the procedure that will be triggered by this button. The button can trigger any
procedure in the current database. (If you haven’t created the procedure yet you can still create the button,
then go back later and choose the procedure.) 

Usually you’ll want to set up a title for the button, and a style. The title can be the same as the procedure
name or it can be different.

When you press the OK button the new button will appear in your form.

You can modify the appearance of the title with the Font and Size menus (see “Font” on page 529 and “Text
Size” on page 531). To re-open the configuration dialog you can either double click on the button or select the
button and open the dialog with the Object Properties command in the Edit menu.

Push Button Styles

There are over a dozen controls for changing the push button appearance. The primary control is the button
style.

Standard Push Button: This option displays a standard button for the current platform. The appearance of the
button will vary depending on the operating system you are using: Windows, OS X, or OS 9. The example
below is for OS X.

The appearance of a Standard Push Button can be modified using the Default Button option. When this
option is used the button appearance changes to indicate that this is the default button (the button in a dialog
that is activated automatically when the Enter key is pressed).

Remember, the Default Button option only changes the appearance of the button. You still have to program
the button to make it the default (see “Custom Dialogs” on page 489 of Formulas & Programing).



Chapter 17:Buttons & Widgets Page 827
Transparent: This option displays a transparent button. A transparent button will be completely invisible
except for the title (and you can make that invisible too with the Hide Title option).

Rectangle: This button style has square corners.

Rounded Rectangle: This is a standard two dimensional button. Panorama will display the name of the but-
ton inside the button. If you want this to look like a standard Macintosh button, you should use Chicago 12
point type.

Circle/Oval: This style has an oval border. If the button’s dimensions are square the button will be a circle.

3D Rectangle: This style looks like a 3 dimensional rectangle with beveled edges.

3D Rounded: This style looks like a 3 dimensional rounded rectangle with beveled edges on all four sides.

3D Circle/Oval: This style looks like a 3 dimensional oval with beveled edges.

Beveled Rectangle: This style looks like a 3 dimensional rectangle that is beveled on the top and bottom. This
style looks a lot like the buttons on many VCR’s and stereos.

Note: On black and white (b/w) monitors, Panorama automatically converts the 3D buttons to the corre-
sponding 2D button.
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Button Title

The button title is the title that appears on the button. This title will be centered in the middle of the button.
The procedure that is triggered by the button can find out what button was pressed with the
info("trigger") function. This function will return Button. followed by the title of the button. Using this
function you can have several buttons that trigger a single procedure. The procedure can then use the
info("trigger") function to find out which button was actually pressed. The procedure will usually use
if or case statements to decide what button was pressed, like this.

local actionDate
case info("trigger") = "Button.Mon" actionDate=date("Monday")
case info("trigger") = "Button.Tue" actionDate=date("Tuesday")
case info("trigger") = "Button.Wed" actionDate=date("Wednesday")
case info("trigger") = "Button.Thu" actionDate=date("Thursday")
case info("trigger") = "Button.Fri" actionDate=date("Friday")
endcase
select Date=actionDate

Advanced Note: In this particular case, there is an easier way to write this procedure. Instead of using case
statements for each button, this procedure simply uses a text funnel to strip out only the name of the day.

select Date=date(info("trigger")[8,-1])

You can often use a trick like this if you choose your button names carefully. See “Taking Strings Apart (Text
Funnels)” on page 69 of Formulas & Programing for more details about text funnels.

Title Positioning

Panorama attempts to center the title both vertically and horizontally within the SuperObject push button.
However, some fonts have non-standard vertical dimensions and need an adjustment to center properly. If
necessary, you can adjust the title’s vertical position with the +/- option. For example, to move the title up by
2 pixels, enter 2 (or +2) into this option. To move the title down by one pixel enter -1.

Standard Font/Size

If this option is selected the button title will always be displayed in the operating system’s standard font and
size. For example, on OS X systems the standard font is 14 point Lucinda Grande.

3D Title

If the 3D Title option is turned on, Panorama will display the title with a white shadow, giving it an “etched”
3D look. Note: This option is ignored if you have use the Standard Push Button option. Also if you display
the button on a black and white (b/w) monitor, Panorama ignores this option and displays the title normally.

Hide Title

This option hides the title. In other words, the button will be blank, even though it has a title. Use this option
if you want to place some graphics on top of the button, or to make a transparent button completely invisible.
The title will be invisible so that it will not interfere with the graphics, but the procedure can still find out the
title with the info("trigger") function.
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Click/Release

Unlike most options, Click/Release is enabled by default—you have to turn it off if you don’t want it. When
this option is enabled, the button acts like a normal button—it highlights when you press on it, then activates
(triggers a procedure) when you release the mouse.

If you decide you don’t want to activate the button you can pull the mouse away before you release.

When the Click/Release option is disabled, there is no highlighting when you press the mouse. Instead, the
procedure is triggered immediately as soon as you press the mouse. There’s no chance to back out by pulling
away from the button.

Color Options

Like other graphic objects, you can assign any color to a Push Button (see “Color” on page 526). Unlike most
other types of objects, however, you can control what portions of the button are displayed in color. (However,
if you are using the Standard Push Button style then these color options are not available.) The four options
are:

Title: If this option is checked, the title will be displayed in color, otherwise the title will be displayed in black.

Border: If this option is checked, the border will be displayed in color, otherwise the border will be displayed
in black. The option can be used with 2D or 3D buttons, like this.

Fill: This option only applies to 3D buttons. If the Fill option is checked, the body of the button will be dis-
played in color instead of gray.

This option only looks good with a few very light colors (use your judgement).

move mouse
over button press mouse release mouse over button

to trigger the procedure

move mouse
over button press mouse pull away and release if

you’ve changed your mind
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Highlight: If this option is checked, the button will highlight in color when you press on it. For 2D buttons,
Panorama simply displays the highlight color when the button is pressed (without this option the button will
turn black when pressed). 

For 3D buttons, Panorama will use the selected color instead of the dark gray it normally uses.

Note: Both 2D and 3D buttons will ignore this option if the Click/Release option is not checked.

“Classic” Push Buttons

In addition to the Super Push Button object described in the previous section Panorama also has a “classic”
Button object. When Super Push Button objects were added as part of Panorama 3.0, “classic” Push Button
objects were retained for compatibility with older databases. For most applications we recommend that you
use Super Push Button for new applications.

Using “classic” Button objects is very similar to working with Super Push Button objects. The Button tool
looks like a button and is part of the standard Panorama tool palette.

normal pressed

normal pressed
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To create a “classic” Button object select this tool and drag the mouse across the form (see “Super Object Push
Button” on page 823). The configuration dialog for a “classic” Button object looks like this.

The “classic” button object can actually create three types of buttons: push buttons (round rect, rectangle, or
transparent), data buttons (checkbox or radio button) and pop-up menus. In this section we’ll just concen-
trate on push buttons. See ““Classic” Checkbox and Radio Buttons” on page 856 and ““Classic” Pop-Up But-
tons” on page 871 to learn about the other capabilities of the “classic” button object.

At the top of the dialog is a pop-up menu that allows you to select the procedure triggered by this button.
The button can trigger any procedure in the current database. (If you haven’t created the procedure yet you
can still create the button, then go back later and choose the procedure.)

The next line is the button title. This is the title that appears centered on the button. The triggered procedure
can find out the button title with the info("trigger") function. See “Button Title” on page 828 to learn
more about this function and button titles.

The On and Off options are only used for checkboxes and radio buttons. These options will remain dim as
long as one of the push button options (round rect, rectangle, or transparent) are selected.

There are three classic push button styles: round rect, rectangle and transparent.

Rounded Rectangle: This is a standard two-dimensional button. Panorama will display the name of the but-
ton inside the button. If you want this to look like a standard Macintosh button, you should use Chicago 12
point type.
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Rectangle: This button style has square corners.

Transparent buttons are described in the next section.

Transparent Push Buttons

A transparent button is just that—transparent. It’s invisible (including the title). However, in Graphics Mode
Panorama does display a dotted line around the button to help you locate it for editing.

When you switch to Data Access Mode the button completely disappears.

Even though the button is invisible, you can still click on it and trigger the procedure if you know where it is.

transparent button
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Sometimes you may really want a button to be completely invisible—for example a secret button that only
you know about. However, it’s more common to overlay a transparent button over a graphic image, turning
the image into a button.

In Data Access Mode you can now click on the “hand button” to trigger a procedure.

The illustration above shows what happens when you click on a transparent button with the Click/Release
option turned on. If this option is turned off, the procedure will trigger immediately when the mouse is
clicked, without highlighting (reverse image) the button. See “Click/Release” on page 829.

Flash Art™ Push Button SuperObjects™

The Flash Art Push Button SuperObject™ lets you use images in the Flash Art gallery (see “The Flash Art
Scrapbook (Gallery)” on page 764) to create push buttons that trigger procedures. You can use any applica-
tion that can create PICT images to draw your button: Photoshop, Canvas, Freehand, etc. It takes more work
to create a Flash Art™ Push Button, but you have the flexibility to create any kind of button you want!

image

transparent button
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The first step in creating a Flash Art Push Button is to create two Flash Art images: the first showing the but-
ton in its “normal” (unpressed) state and the second in its “activated” (pressed) state. When the button is
clicked, Panorama will automatically switch between these two pictures as the button is pressed with the
mouse. (The two pictures should have exactly the same dimensions or you will notice a shift as the mouse is
pressed on the button.) The second picture must have the same name as the first picture, but with .DOWN
added to the end. For example, if the “normal” picture is called Download, the “activated” picture must be
called Download.DOWN.

(Note: The Flash Art Push Button will display your pictures actual size, without any scaling or resizing. If the
button you create is smaller than the picture, the picture will be cropped. If the button is larger than the pic-
ture, the picture will appear in the upper left hand corner of the button.)
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Once the pictures have been created, you are ready to create the button itself. Select the Flash Art Push But-
ton tool and drag across the form to create the button. (If the tool is not currently installed, use the Tool Pal-
ette dialog to install it — see “Customizing the Tool Palette” on page 497.)

When you release the mouse the configuration dialog will appear.

Select the procedure to be triggered and enter the title for the button (the title is not displayed but is returned
by the info("trigger") function).

Flash Art Pushbutton tool
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The Formula box is used to specify the pair of pictures displayed by this button. If you always want to use the
same two pictures, simply enter the name of the “normal” picture surrounded by quotes, for example
"Download". The formula can also be set up so that the picture used for this button changes depending on
circumstances—for example, you might want to use a different button for black and white vs. color monitors
(using the info("windowdepth") function) or a different button in the morning vs. the afternoon.

The Alt File option allows the button to display pictures stored in the Flash Art gallery of another database
(the other database must be open). Enter the name of the database here. See “Alt File” on page 788 for more
information on this option.

The Include Pictures on Disk option allows the button to display pictures that have been stored as PICT files
on the disk. Normally these files should be in the same folder as the database itself, however, you may supply
a file path as part of the Formula (see “Displaying Images Directly From Disk Files” on page 769).

The Flash Art Push Button tool allows you to make virtually any custom button you want. Here’s what our
finished button looks like in use.

When you click on the button, the second image appears. This gives you complete control over the appear-
ance and highlighting of the button.

Your imagination is the only limit to the buttons you can create.
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Data Buttons

Data buttons are buttons that have a value associated with them. The value may be stored in a database field
or in a variable (see “Variables” on page 53 and “Variables” on page 247 of Formulas & Programing). An on/off
data button is usually called a checkbox.

Data buttons may be grouped together as radio buttons. Only one button in the group may be selected at a
time.

Panorama also allows you to build a group of buttons where more than one member of the group can be
selected at a time. See “Multiple Value Button Groups” on page 845 to learn more about this option.
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Data Button SuperObjects™

The Data Button SuperObject™ tool can be used to create checkboxes and radio buttons in a variety of styles.
Unlike the “classic” button tool, this tool can work with global variables as well as fields. The SuperObject
Data Button tool is not in the default tool palette, so you’ll need to move the use the Tool Palette dialog to add
this tool to the palette if it is not already there (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the button.
\

When you release the mouse, the SuperObject Data Button configuration dialog will appear.
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At a minimum you must select a field or variable to store the value, and enter a Title. When you press OK the
new button will appear on the form.

To try out the button, switch to Data Access Mode. Since this button’s value is stored in a field we can use the
data sheet to watch the value as the button is checked and unchecked.

Clicking on the checkbox causes Panorama to fill the field or variable with the value.

If you click again to un-check the button the field or variable will become empty again. (You may wonder if
typing the value into the Data Sheet will cause the button to become checked. The answer is yes!)

when button is un-checked…
field or variable is empty

when button is checked… field or variable is filled with value
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Creating a Group of Radio Buttons

The easiest way to create radio buttons is to create a single button and then make copies. For example, sup-
pose you want to make radio buttons for shipping options — Priority Mail, UPS Next Day Air, Federal
Express, Airborne and DHL. Start by selecting the Data Button tool (see previous section) and dragging to
create the first button.
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The field or variable and title are set up exactly the same as for a checkbox. You should also enable the
“Radio” button option, and select a radio button style from the list of styles on the right hand side of the dia-
log. (Note: The visual style does not affect the operation of the button, so Panorama will happily let you cre-
ate a radio button that looks like a checkbox, or vice versa.)

Press OK to create the first radio button.
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To duplicate this button, make sure that the Pointer tool is selected and hold down the Shift key and the
Option (Mac)/Alt (PC) key while you drag the button. When you release the mouse Panorama creates a copy
of the selected object (see “Drag Duplicating” on page 561).

To make additional copies simply use the Duplicate command (see “Step and Repeat” on page 562).

Now you need to go back and change the title of each button (except the first). To change the title, simply
double click on the button, then fill in the new title.
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All the other options remain the same — only the title needs to be changed. Repeat this process for each but-
ton in the group.

If necessary, you can adjust the spacing of the buttons with the Spacing command (see “Setting Exact Dimen-
sions of Multiple Objects” on page 550 and “Adjusting Spacing Between Multiple Objects” on page 556). You
can also adjust the width of the buttons using Cluster Resize (see “Cluster Resize” on page 541).

To try out the buttons, switch to Data Access Mode. Since the button’s value is stored in a field we can use the
data sheet to watch the value as the different buttons in the group are checked. To start out, none of the but-
tons are checked and the field is empty.

When a button is checked, the corresponding value appears in the field.
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Clicking on any button causes the corresponding value to appear in the field.

The synchronization between buttons and the field also works in reverse. If you type a value into the data
sheet, the corresponding button will be activated. If none of the buttons match the value, all of the buttons
will be turned off.

The buttons can also be completely turned off by clearing the contents of the field (making it empty). 

Multiple Value Button Groups

A group of radio buttons works find as long as only one value at a time is valid. You can’t ship a package by
both Priority Mail and Federal Express, only one or the other! Some applications, however, require that mul-
tiple options be selected. For example, consider a group of buttons for selecting pizza toppings.

In this application there may be zero, one, two, or even 12 values at one time! There are two ways to create a
group of buttons like this.
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The first method is simply to create a field or variable for each option, and then create a standard checkbox
for each field. See “Data Button SuperObjects™” on page 838 to learn how to create a checkbox.

The second method allows you to combine all of the values into a single field. Just as with a group of radio
buttons, you’ll start by creating a single button and making copies (see previous section). However, instead of
enabling the “Radio” button option you’ll enable the Allow Multiple Values option. You also need to specify
what character(s) you want placed between each value. In this example, we’ve chosen a comma.

Set up the first button using the options shown above. Then make copies of the button and adjust the titles,
just as described for radio buttons in the previous section. 
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Switch to Data Access Mode to try out the group of buttons. When a single option is clicked the value
appears in the field, just as for a standard checkbox. (A Text Display SuperObject has been added to the form
to display the value of the Toppings field, see “Text Display SuperObjects™” on page 608 to learn how to cre-
ate such an object.)

When a second button is clicked, that value is added to the field.

You can keep adding as many values as you like.

If you un-check a button, that value will be removed from the field (or variable). In this case we have
removed Peppers.
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If Peppers is re-enabled, it is added to the end of the value. You cannot control the order of the options within
the field or variable.

If you un-check all of the buttons the field will become completely empty.

Like other types of buttons, the synchronization between the buttons and the field or variable works both
ways. You can type in a value or combination of values into the field or variable and the appropriate buttons
will automatically “light-up.”
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Super Data Button Options

The left hand side of the Data Button dialog controls the operation of the button, the right hand side controls
the appearance of the button.

Data

This section of the dialog specifies the field or variable associated with this button. Type the name of the field
or variable into the box (or select the field name from the pop-up menu next to the Field radio button). If the
button is associated with a variable that has not been created with a procedure, Panorama will automatically
create a global variable with this name whenever the button appears. This global variable can be used in for-
mulas and procedures just like any other global variable (see “Variables” on page 53 and “Variables” on
page 247 of Formulas & Programing).

Title

This section of the dialog specifies the title of the button. This is the title that is actually displayed on the
screen. If the value is empty (see next section) Panorama will use the title as the value.
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Value

This section of the dialog specifies the data value corresponding to this button. Each button can have a single
value, which you should type into the box next to the word Value. If you leave this box empty, Panorama will
use the Title for the data value (see previous section). This example shows how you can use a value that is dif-
ferent from the title.

Using this technique you can make a group of radio buttons for western states.

The State field will not contain the fully spelled out state names, but only the 2 letter abbreviations (AZ, CA,
NV, etc.).

Allow Multiple Values

It’s possible to group together multiple buttons associated with the same field or variable. Normally clicking
any button in the group erases the current value and replaces it with the new value (normal radio button
behavior). However, if you have the Allow Multiple Values option turned on, clicking on the button will add
the new value to the existing data in the field or variable, with the Value Separator in between.

As an example of the Allow Multiple Values option, consider pizza toppings. A pizza may have one, two,
three or more toppings, or even none at all. Using the Allow Multiple Values option, you can create a series of
checkboxes that will generate a list of toppings in a single field or variable. As the user clicks on each topping,
it will be added to the end of the list. To remove a topping from the list, click on it again. See See “Multiple
Value Button Groups” on page 845 for an example of this technique.

Value Separator

This is the text that will appear between each value in a multiple value list. Common separators include com-
mas, spaces, slashes and hyphens. The separator may be up to 6 characters long, so you can use a multi char-
acter separator like comma-space. (However, if you want to process the value with Panorama’s array
functions you should use only a single character separator. See “Text Arrays” on page 93 of Formulas & Pro-
graming for more information on these functions.
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"Radio" button

The data button normally toggles the value on and off each time you click on it. Turning on the “Radio”
button option prevents the button from toggling off. In other words, you can turn the button on, but you can’t
turn it off again. Usually this option is only used for radio button combinations, where the value will be auto-
matically turned off by clicking on another button in the group. This option prevents the user from turning
off all the buttons in the group, so there is always at least one radio button checked.

Procedure

This section of the dialog specifies the procedure that will be triggered when this button is clicked (if any).
The procedure can get information about what button was clicked by using the info("trigger") function.
Even if you don’t specify a procedure here, clicking on the button will trigger any automatic formulas and
procedures associated with the field for the button (see “Automatically Triggering a Procedure” on page 314
of Formulas & Programing).

Sample

This section of the dialog shows a sample of the button. You can select the button style from the scrolling list
on the right. Click on the sample button on the left to see what the button style will look like in both the on
and off positions.

click here to try out button select button style from this list
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The first two styles, Standard Checkbox and Standard Radio Button, are special. Data buttons created with
these styles will adjust automatically depending on what operating system is being used. In other words, the
same button will change appearance depending on whether the database is being used on Mac OS X, Mac OS
9, or Windows.

With all of the other options what you see is what you get. Here are some of the other built-in choices avail-
able. (If you need to create your own custom button, use the Flash Art Data Button, see “Flash Art Data But-
ton SuperObjects™” on page 852).

Note: Button operation is not affected by the button’s appearance. You can create a button that “looks” like a
radio button but acts like a checkbox, or visa versa.

Flash Art Data Button SuperObjects™

Flash Art Data Buttons are identical in operation to regular SuperObject Data Buttons. However, instead of
picking the button’s appearance from a list of predefined styles, you create the artwork for the button your-
self using Flash Art™. Before you attempt to use a Flash Art Data Button, you should be familiar with Flash
Art creation and usage (see “Flash Art™” on page 750).
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The first step in creating a Flash Art Data Button is to create two Flash Art pictures: the first showing the but-
ton in its “off” state and the second in its “on” state. When the button is clicked, Panorama will automatically
switch between these two pictures as the button is toggled on and off. (The two pictures should have exactly
the same dimensions or you will notice a shift as the mouse is pressed on the button.) The second picture
must have the same name as the first picture, but with .DOWN added to the end. For example, if the “off”
picture is called Box, the “on” picture must be called Box.DOWN.

If you wish, you may optionally create two additional pictures. These pictures will be displayed temporarily
when the mouse is actually pressed on the button, allowing the button to “highlight” as it is being clicked.
Two pictures are needed: one to highlight the “off” state and one to highlight the “on” state. These pictures
must have the same name as the original two pictures but with • added after the name (press Option-8 to
create the • symbol on the Macintosh, Alt-0149 on the PC). In our example these pictures would be named
Box• and Box•.DOWN. Here are four images that have been prepared for a Flash Art Data Button. They
show a box in both open and shut positions. (The images are shown enlarged to 4X in Adobe Photoshop).
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Once the pictures have been created, you are ready to create the button itself. Select the Flash Art Data But-
ton tool and drag across the form to create the button. (If the tool is not currently installed, use the Tool Pal-
ette dialog to install it, see “Customizing the Tool Palette” on page 497.) Type in the name of the base picture
for this button (enclosed by quotes) into the Formula box. In our example, you would type "Box" into the For-
mula box.

The rest of the options in the Flash Art Data Button dialog are the same as the options in the Flash Art Push
Button and Data Button dialogs. See “Super Data Button Options” on page 849 for descriptions of these
options.

The finished button looks like an open box.

When you click on the button it highlights.

Releasing the mouse causes the button to switch to a closed box.
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Click again to highlight the closed box.

And release to switch back to an open box.

This is just one example. You can use this tool to make any size and shape of data button you like.

Sticky Push Button SuperObjects™

Sticky Push Buttons look like Push Buttons (see “Super Object Push Button” on page 823), but they operate
like Data Buttons (see “Data Button SuperObjects™” on page 838). Instead of popping back up when you
release the mouse, a Sticky Push Button stays pushed in like a checkbox or radio button. Like Data Buttons,
Sticky Push Buttons are associated with a field or variable, and can be used separately or in groups (radio
sticky push buttons, anyone?) To illustrate, here is a collection of options created as regular data buttons.

Here is the exact same example, but created with Sticky Push Buttons. Notice that CNN is also selected in this
group of buttons.

These two examples operate exactly the same — the only difference is their appearance.

selected button
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The Sticky Push Button configuration dialog is a combination of the options for Push Buttons and Data But-
tons.

See “Super Object Push Button” on page 823 and “Data Button SuperObjects™” on page 838 for the details of
these options.

“Classic” Checkbox and Radio Buttons

In addition to the SuperObject data buttons described previously Panorama also has a “classic” Button object.
When SuperObject buttons were added as part of Panorama 3.0, “classic” button objects were retained for
compatibility with older databases. We recommend that you use SuperObject buttons for new applications.
SuperObject buttons have many more style options, and can also work with variables as well as fields.
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To create a checkbox or radio button, use the Button tool, which is part of the standard tool palette.

Drag the mouse across the form to specify the size and location of the button.
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When you release the mouse, the Button Dialog appears. This dialog allows you to select the type of button
you want to create.

Click on the type of button you want to create (checkbox or radio button) and select the field from the Field
pop-up menu. Next type in the button title. This is the text that will be displayed as part of the button.

Use a checkbox button when a field has only two possible values (especially if one of these values is an empty
cell). You can specify both on and off values. If you leave the on value blank Panorama will use the button
title as the on value.
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Use radio buttons when a field has three or more possible states. Each radio button has an on value. If you
leave the on value blank, the button title will be used as the on value.

If you need to change a checkbox or radio button, click on it with the Button tool to make the Button configu-
ration dialog re-appear. You can also double click on the button with the Pointer tool selected.

An easy way to create a group of radio buttons is to create the first button and then make copies of the button.
See “Creating a Group of Radio Buttons” on page 841 for an example of this technique.
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Pop-Up Menus

Radio buttons work well when there are only a few options. When you get past a dozen or so options, you’ll
probably want to use a pop-up menu or scrolling list (see “List SuperObjects” on page 879) instead. Pan-
orama has three methods for creating pop-up menus: 1) Pop-Up Menu SuperObjects, 2) “Classic” buttons,
and 3) Procedures (programming). 

Pop-Up Menu SuperObjects™

The easiest and most flexible way to create a pop-up menu is with the Pop-Up Menu SuperObject™. A Pop-
Up Menu SuperObject™ may be associated with any field or global variable. When the user makes a selec-
tion from the pop-up menu, the corresponding field or variable is automatically updated with the new value.
Because the list of menu choices is calculated with a formula, the pop-up menu can change on the fly if neces-
sary. You can also choose the menu font, color, and style (multi-column or scrolling).

The Pop-Up Menu SuperObject tool is not in the default tool palette, so you’ll need to move the use the Tool
Palette dialog to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on
page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the pop-up
menu object.

When you release the mouse, the Super Pop-Up Menu configuration dialog will appear.
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At a minimum you must select a field or variable for the pop-up menu. This field or variable will hold the
result of the pop-up selection. Press OK to create the pop-up menu object.

Switch to Data Access Mode to try out the pop-up menu.

The default pop-up menu contains ten items, A thru J. To change the items in the menu, switch back to
Graphics Mode, select the Pointer tool and double click on the pop-up object. In the formula, replace
A;B;C;D;E;F;G;H;I;J with the actual items you want to appear in the menu, with each item separated by a
semicolon.
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Press OK and switch back to Data Access Mode to try out the revised pop-up menu.

The Pop-Up Menu Formula

The menu formula calculates the list of menu choices. Each menu choice is on a separate line, separated by a
carriage return.

When the user presses on the pop-up menu button, Panorama takes the formula, calculates it, splits the result
into individual menu items (one per line), then displays the pop-up menu and allows the user to make a
selection. All this happens in the blink of an eye as the user clicks on the button.

So much for theory, now let’s take a look at some real world menu formulas. Suppose you want to create a
pop-up menu with three choices: Gold, Silver and Bronze. Keeping in mind that the ¶ symbol represents a
carriage return, the most basic formula that can be used to create this menu would be:

"Gold"+¶+"Silver"+¶+"Bronze"

To type the ¶ symbol, press Option-7 on the Macintosh and Alt-0182 on the PC. If your menu has a lot of
items it can be kind of a pain to type in this symbol over and over again. We can use Panorama’s replace(
function to make this formula easier to type (see “REPLACE(” on page 5665 of the Panorama Reference). In the
formula below, the replace( function will change the semicolons into carriage returns. This allows you to
type the menu choices with just a semicolon in between them. This option is so useful that Panorama pre-
loads this function into the menu formula.

replace("Gold;Silver;Bronze",";",¶)

The real power of the menu formula is unleashed when you use a variable or field in the formula. Since the
variable or field may be changed at any time with a procedure (or even with standard data entry), the pop-up
menu can change at any time. For example, suppose you want to create a pop-up menu of salespeople in
your company. Simply create a permanent variable (see “Long Life Variables” on page 249 of Formulas & Pro-
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graming) named SalesPeople and fill it with the name of each salesperson in your company on a separate line.
You can create a preferences form that allows you to edit the list using a Text Editor SuperObject™ (see “Text
Editor SuperObject” on page 639). When you create the pop-up menu, the menu formula will simply be
SalesPeople.

Each time you click on the pop-up menu it will display the current list of salespeople.

This list can be edited at any time simply by editing the permanent variable.

Dividing Lines in the Menu

To put a dividing line in a pop-up menu, simply create a line with the entry (-. The formula below produces a
menu of car manufacturers in three sections: US, Japanese, and German.

replace("Ford;GM;Chrysler;(-;Toyota;Nissan;Honda;Mazda;(-;Mercedes;VW;BMW",";",¶)

The dividing lines are not enabled in the menu, so the user cannot accidently choose a dividing line.

“Live” Pop-Up Menu Formulas

If the first character of the text generated by the Pop-Up Menu formula is (, Panorama will build the pop-up
menu using the same rules used for “Live Menus” in the menu bar (see “Live Menus” on page 362 of Formu-
las & Programing). This means that pop-up menus can include checked items, dimmed items, bold, italic, and
even submenus!
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If you are defining a normal pop-up menu with no submenus, the formula should start with the menu( func-
tion (see “The FileMenuBar Statement” on page 362 of Formulas & Programing). Since this is a pop-up menu
you can leave the name blank if you want to. A pop-up menu with the formula shown below could be used
to select Southern California field offices, with the main offices in bold.

Here's what this pop-up menu will look like in use. The main offices, Los Angeles and San Diego, appear in
bold.

For more details on using the menuitems( function, see “Live Menus” on page 362 of Formulas & Program-
ing.

Pop Up Submenus

To create pop-up submenus the submenus must be defined first. The last menu defined is the actual main
pop-up menu. This main menu doesn't need a name, it can simply be blank, but the submenus must have
names. Here is an example of a formula for creating a pop-up menu with three submenus:
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When you click on this pop-up menu button the main menu will spawn three submenus, like this:

For more information on setting up live submenus see “Submenus (Hierarchical Menus)” on page 370 of For-
mulas & Programing.

When an item in a submenu is selected, the pop-up SuperObject will simply be filled in with the menu item.
For example, if Jet Blue is selected, the value in the field or variable will be "Jet Blue". There is no way to
determine that this was selected from the Airlines menu.

Live menus can also be used with the PopUp statement (see “Creating a Pop-Up Menu with a Procedure” on
page 874 of Formulas & Programing). When used with this statement the resulting trigger will include both the
menu title and the menu name, for example "Airlines.Jet Blue". The PopUpByNumber statement is similar,
the trigger value will be: "Airlines.4". See the Programming Reference wizard for detailed information on
these statements.

Pop-Up Menu Options

The SuperObject™ Pop-Up menu dialog is divided into several sections.
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Data

This section of the dialog specifies the field or variable associated with the pop-up menu. Type the name of
the field or variable into the box (or select the field name from the pop-up menu next to the Field radio but-
ton). If the pop-up menu is associated with a variable that has not been created with a procedure, Panorama
will automatically create a global variable with this name whenever the form containing this object appears.
This global variable can be used in formulas and procedure just like any other global variable.

Menu Formula

This section specifies the choices listed in the actual pop-up menu. Instead of simply typing in the choices,
you enter a formula that calculates the choices. (Since the formula can use a field or variable, this allows the
menu to be changed easily on the fly.) The formula must calculate the list of choices, with each choice sepa-
rated by a carriage return. (Remember, a carriage return can be represented by the ¶ symbol (Mac: Option-7/
PC: Alt-0182) in a formula.) See “The Pop-Up Menu Formula” on page 863 for a detailed discussion of the
menu formula.

Menu Type

The Pop-Up Menu SuperObject™ supports three menu styles: Standard, Multi-Column and Combo Box.
Standard menus look and operate just like all of the other menus on your system. Multi-Column menus will
automatically split the menu into an array of two or more columns. This allows dozens or even hundreds of
options to appear on the screen at one time.
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The Chicago 12 option forces the actual pop-up menu to always appear in the standard system font, no mat-
ter what font and size are selected for the pop-up object. (On early Macintosh systems this font was Chicago
12, hence the name of the option.) If you leave this option off, the menu can be displayed in any font and size.
Just select the Pop-Up Menu SuperObject™ and choose the font and size the normal way. (Note: If you select
the Scrolling option, this option is ignored and the menu will always be displayed in Chicago 12 point type.
Only Multi-Column menus can be displayed in non-standard sizes.)

The ComboBox option makes the pop-up button look and operate like a Microsoft Windows style Combo
Box. This type of button looks best on a gray or colored background.

To use a Combo Box, simply click anywhere on the box to make a pop-down list appear, then make your
choice from the list.

click on button

then select from pop-down list
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If you would like to be able to directly edit the value (the Country in this case) you can superimpose a Text
Editor SuperObject (see “Text Editor SuperObject” on page 639) on top of the Combo Box.

Now you have a choice of editing methods. You can click or drag on the text to edit it directly, or click on the
Combo Box icon to pop-down the list of choices.

The final menu type is Mac Pop-Up/Windows Combo Box. The appearance and operation of this type
depends on the type of computer being used. On a Macintosh computer this button will look and operate like
a standard pop-up menu. On a Windows computer this button will look and operate like a Combo Box. 

Display Options

This section controls how the pop-up menu object is displayed on the form. If the Show Value checkbox is
turned on, the field or variable associated with the pop-up menu will be displayed in the object. If the Show
Triangle option is on, a small downward pointing triangle will appear on the right side of the pop-up menu.

You can only pick one of the last three options (or none). The Standard Icon option is the default choice, and
displays the standard pop-up menu graphics for the operating system being used. Here is the standard icon
for Mac OS X.

Text Editor SuperObject

Pop-Up Menu SuperObject
(set to ComboBox style)

Click or drag on text to edit directly
Click on icon to select from drop-down list
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If the Drop Shadow checkbox is on, Panorama will automatically draw a drop shadow around the edges of
the pop-up menu object. You can select whether the drop shadow is 1 or 2 pixels deep.

If you turn off all three of these options the pop-up menu will be invisible. This can be handy if you want the
pop-up menu to appear with a custom image.

Color

This section controls the color of various parts of the pop-up menu object on the form. If an option is checked,
that part will appear in the color specified for the object, otherwise that part will appear in black. (To specify
a color for an object, use the Graphics menu or the Graphic Control Strip (see “Color” on page 526). Note: The
color options only apply to multi-column menus - they are ignored for Standard menus.)

Value: If this option is checked, the field or variable value will appear in color, otherwise it will appear in
black. (This option is ignored if the Show Value option is not turned on.)

Fill: If this option is checked, the pop-up menu object will be filled with the object color. You should not check
both this option and the Value option (this makes the value invisible).

Shadow: If this option is checked, the border and drop shadow will appear in color, otherwise it will appear
in black. (This option is ignored if the Drop Shadow option is not turned on.)

Fill Color: This pop-up menu controls the background color of the pop-up menu itself. Usually, the back-
ground color is white, but you can switch it to any color you want. (Note: This option only works with Multi-
Column menus. Scrolling menus always have a white background.)

Procedure

The pop-up menu can optionally trigger a procedure whenever the user makes a selection. This procedure
can perform additional tasks that need to be done when a selection is made.

Since the pop-up menu updates a field or variable, the procedure can simply read the menu choice from that
field or variable. In addition, the procedure can find out the name of the menu object using the
info("trigger") function. The info("trigger") function will return the name of the pop-up menu
object itself (if any). If you haven’t assigned a name to this object, the default is custom (see “Object Type/
Object Name” on page 533 to learn how to assign a name to an object). If you want to have several pop-up
menus that trigger the same procedure, you should give each a unique name so that the procedure can tell
which pop-up menu was used.

Pop-Up Menu Font, Size and Dimensions

If you are using the Standard menu style Panorama will use the standard menu font and size for the operat-
ing system in use (for example 13 point Lucinda Grande on Mac OS X).

If you are using a Multi-Column menu you can use other fonts and point sizes. To get the most options in the
least space, use Geneva 9 point (Alpine 9 point on a PC). For the best performance, you should stick to simple
fonts and sizes that you actually have available in your system file (these sizes appear outlined in the Size
menu.)
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“Classic” Pop-Up Buttons

In addition to the SuperObject pop-up menu buttons described previously Panorama also has a “classic” But-
ton object that can also create pop-up menus, although with very limited options. When SuperObject buttons
were added as part of Panorama 3.0, “classic” button objects were retained for compatibility with older data-
bases. We recommend that you use SuperObject buttons for new applications. SuperObject buttons have
many more style options, and can also work with variables as well as fields.

The “classic” pop-up menu button uses the Choices field of the design sheet as the template for the menu.
The items in the menu will be the same as the choices in the list.

See “Choices” on page 259 to learn more about setting up a list of choices.

To create a classic pop-up menu button, use the Button tool, which is part of the standard tool palette.

type the list of choices into the Choices column
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Drag the mouse across the form to specify the size and location of the button.

When you release the mouse, the Button Dialog appears. This dialog allows you to select the type of button
you want to create.

Click on the type of button you want to create (pop-up menu) and select the field from the Field pop-up
menu. You can type in a button title, but it will be ignored. Press OK to create the button.
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Switch to Data Access Mode to try out the pop-up menu.

Unlike SuperObject Pop-Up Menu buttons, the “classic” button does not display the contents of the field. If
you want the field contents to appear you must add a Data Cell (see “Working with Data Cell Objects” on
page 635), Auto-Wrap Text (see “Displaying Data in Auto-Wrap Text” on page 595), or Text Display SuperOb-
ject (see “Text Display SuperObjects™” on page 608) to the form. In this example we have added a Data Cell.

If the Data Cell remains on top of the button it will interfere with clicking on the button. Use the Send to Back
command to move the Data Cell behind the button (see “Changing the Stacking Order” on page 569). Switch-
ing to Data Access Mode you can now see the field value displayed “inside” the pop-up menu.

data cell
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If this all seems like a lot of extra tedious work, it is. To avoid all this extra work use the SuperObject Pop-Up
Menu instead. 

Creating a Pop-Up Menu with a Procedure

In very rare cases you may need even more flexibility than the Pop-Up Menu SuperObject™ provides. For
even more control over your pop-up menu, you can create a pop-up menu with a standard button and with a
procedure. In this procedure, you can control what happens both before and after the pop-up menu appears.

Here’s how it works. First, the user clicks on a standard transparent button (see “Transparent Push Buttons”
on page 832). This button must have the Click/Release option turned off, so that the procedure is triggered
immediately when the mouse is clicked. Now the procedure determines the location of the mouse and makes
the pop-up menu appear at that location. The procedure pauses while the user makes a selection from the
menu. Once the selection is made, the procedure takes the choice and stores it or processes it. These are the
same steps taken by the Pop-Up Menu SuperObject™, but in this case each step must be programmed by you
as part of the procedure.

Where Will the Pop-Up Menu Appear?

The first step the procedure must take is to figure out where the pop-up menu will appear on the screen. You
must determine two numbers: 1) The distance (in pixels) from the top of the current window and, 2) The dis-
tance from the left edge of the current window. (These two numbers are known as the local co-ordinates,
because they are relative to the current (local) window. Global co-ordinates are relative to the entire screen.)

The usual choice is to make the pop-up menu appear in the same spot as the button that was pressed. You can
find out the local co-ordinates of this button using the GetLocalButton statement. You must create four
local variables to hold the four dimensions of the button (top, left, height, width).

local PopTop,PopLeft,ButtonHeight,ButtonWidth
GetLocalButton PopTop,PopLeft,ButtonHeight,ButtonWidth

For the purposes of a pop-up menu, you’re only interested in the first two values, PopTop and PopLeft.

Another option is to make the pop-up menu appear right over the current mouse location. This is especially
useful if you have created a large button where the current mouse location may be quite far from the upper
left corner of the button. To find out the current mouse location in local co-ordinates, use the GetLocalClick
statement.

local PopTop,PopLeft
GetLocalClick PopTop,PopLeft

(Note: The names of the local variables are not important. You can use any names you want as long as you are
consistent within the procedure.)

The PopUp Statement

Once the procedure has calculated where the pop-up menu should appear, it should use the PopUp statement
to actually make the menu appear and allow the user to make a choice from the menu. This statement has
five parameters:

PopUp MenuFormula, V, H, CurrentValue, NewValue

The first parameter, MenuFormula, is a formula that specifies the menu items that should appear in the pop-
up menu. This formula uses exactly the same rules that the Pop-Up Menu SuperObject menu formula uses,
so you should refer to that section (see “Menu Formula” on page 867) for details on setting up the menu for-
mula.
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Experts only: The MenuFormula can also be used to specify that a custom menu you have created with
ResEdit should be used for the pop-up menu. In this case the menu formula should result in a single number
which corresponds to the resource number for the custom menu. Using this technique, you can create a pop-
up menu with icons, or a pop-up menu that uses a non-standard menu proc (perhaps a non-text menu). (You
can also use a Live Menu Formula, see below.)

The next two parameters, V and H, specify the location where the pop-up menu should appear. Use the val-
ues you calculated with the GetLocalButton or GetLocalClick command.

The final two parameters, CurrentValue and NewValue, tie the pop-up menu to a field or variable. Cur-
rentValue specifies what item in the menu should be highlighted when the menu first appears. After the user
makes a choice, the result will be placed in NewValue. NewValue must be a variable (see “Variables” on
page 247 of Formulas & Programing). If you need this value in a field, the procedure must copy it from the
variable into the field after the PopUp command. (However, if the user pulls the mouse off the menu and
releases the mouse without making a choice, NewValue will be empty. In this case you probably want to
leave the original field alone.)

The example below shows a simple procedure for a pop-up menu that allows a medal to be selected. This
example assumes that the database contains a field named Medal.

local PopTop,PopLeft,ButtonHeight,ButtonWidth
local TempMedal
GetLocalButton PopTop,PopLeft,ButtonHeight,ButtonWidth
PopUp replace("Gold;Silver;Bronze",";",¶),PopTop,PopLeft,Medal,TempMedal
if TempMedal≠""

Medal=TempMedal
endif

The only problem with this example is that it is a lot of work, and the same effect could be achieved in a few
seconds with the Pop-Up Menu SuperObject™. Only use this technique when you need to accomplish some-
thing that absolutely cannot be done any other way (for example a non-text menu or a menu that pops up
anywhere in a large area).

The PopUpButton Statement

This statement makes it simpler to produce a pop-up menu in response to clicking on a button. Unlike the
popup statement, you don’t have to specify the pop-up menu location. The menu will automatically pop-up
over the button that was pressed. This statement should not be called unless the original procedure was trig-
gered by a button. This button must have the click/release option turned off.

The popupbutton statement has three parameters:

PopUpButton MenuFormula, CurrentValue, NewValue

These three parameters are exactly the same as the corresponding parameters described above for the popup
statement. Here is an example of how this statement can be used.

popupbutton "Red"+¶+"Green"+¶+"Blue","Red",ColorChoice

The PopUpClick Statement

This statement makes it simpler to produce a pop-up menu in response to clicking somewhere on a form.
Unlike the popup statement, you don’t have to specify the pop-up menu location. The menu will automati-
cally pop-up at the current mouse position. This statement is usually triggered by a transparent button that
covers a large area. This button must have the click/release option turned off.

The popupclick statement has three parameters:

PopUpClick MenuFormula, CurrentValue, NewValue
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These three parameters are exactly the same as the corresponding parameters described above for the popup
statement. Here is an example of how this statement can be used.

popupclick "Red"+¶+"Green"+¶+"Blue","Red",ColorChoice

The PopUpFieldChoices Statement

This statement can be used to automatically produce a pop-up menu containing a list of data values in a field.
The statement must be triggered in response to clicking on a button. When the button is clicked, the menu
will pop-up over the button. The menu will pop-up over the button that was pressed. The button must have
the click/release option turned off.

The popupfieldchoices statement has three parameters:

PopUpClick Choice, Field, InitialChoice

The Choice parameter is the name of a field or variable. When the statement is complete this field or variable
will contain the value that was chosen from the pop-up menu. If no choice was made this field or variable
will contain "".

The Field parameter is the name of the field that contains the data to be included in the pop-up menu. Pan-
orama will build a list of all of the current values in this field, and include those values in the menu.

The InitialChoice parameter is the initial value of the pop-up menu. If possible, the this value will be initially
selected when the menu appears.

This procedure is in a checkbook database:

local newCategory
popupfieldchoices newCategory,Category,""

When the button is clicked, a list of all the categories in the checkbook appears:

As new categories are added to the database they will automatically be added to the menu.

The PopUpDoubleFieldChoices Statement

This statement can be used to automatically produce a pop-up menu containing a list of data values in a field,
along with submenus for data values in a second field. The statement must be triggered in response to click-
ing on a button. When the button is clicked, the menu will pop-up over the button. The menu will pop-up
over the button that was pressed. The button must have the click/release option turned off.

The popupfieldchoices statement has four parameters:

PopUpClick Choice, Field, SubField, InitialChoice
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The Choice parameter is the name of a field or variable. When the statement is complete this field or variable
will contain the value that was chosen from the pop-up menu. If no choice was made this field or variable
will contain "".

The Field parameter is the name of the field that contains the data to be included in the primary pop-up
menu. Panorama will build a list of all of the current values in this field, and include those values in the
menu.

The SubField parameter is the name of the field that contains the data to be included in the secondary pop-up
menus. Panorama will build a list of all of the current values in this field, and include those values in the sub-
menus.

The InitialChoice parameter is the initial value of the pop-up menu. If possible, the this value will be initially
selected when the menu appears.

This procedure is in a checkbook database:

local newCategory
popupdoublefieldchoices newCategory,Category,PayTo,""

When the button is clicked, a list of all the categories in the checkbook appears, along with a submenu for
each category listing the actual payees for each category:

If there are many items in the menus and submenus there may be a delay while the menus are being calcu-
lated.

The PopUpByNumber Statement

The PopUpByNumber statement is exactly the same as PopUp except for the last two parameters. The
PopUpByNumber statement treats CurrentValue and NewValue as menu item numbers, instead of as text.
For example, if the user selects the third menu item, NewValue will be 3. This command is useful for non-text
menus, for example, a menu of color swatches.
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The PopUpStyle Statement

The PopUpStyle statement allows you to control the font, size and color of pop-up menus created with the
PopUp and PopUpByNumber statements. The PopUpStyle statement must be placed directly above the
PopUp or PopUpByNumber statement in your procedure. This statement has four parameters:

PopUpStyle Font, Size, Color, BackgroundColor

The first parameter, Font, is the font you want to use for the menu, for example "Chicago" or "Geneva".

The second parameter, Size, is the size of the text you want to use for the menu, for example 9 or 12.

The final two parameters specify the foreground and background colors for the menu, which may be created
with the rgb( or hsb( functions (see “Colors” on page 154 of Formulas & Programing). For a standard black
on white menu you can simply use empty strings for the colors: "","".

Here are a couple of examples of the PopUpStyle statement. Both set the menu to Geneva 9pt, but the sec-
ond example creates a menu with red text on a dark gray background.

PopUpStyle "Geneva",9,"",""
PopUp replace("Gold;Silver;Bronze",";",¶),PopTop,PopLeft,Medal,TempMedal

/* red text on dark gray background */
PopUpStyle "Geneva",9,rgb(65535,0,0),rgb(50000,50000,50000)
PopUp replace("Gold;Silver;Bronze",";",¶),PopTop,PopLeft,Medal,TempMedal

“Live” Pop-Up Menu Formulas

If the first character of the text generated by the menu formula is (, Panorama will build the pop-up menu
using the same rules used for “Live Menus” in the menu bar (see “Live Menus” on page 362 of Formulas &
Programing). This means that pop-up menus can include checked items, dimmed items, bold, italic, and even
submenus!

If you are defining a normal pop-up menu with no submenus, the formula should start with the menu( func-
tion (see “The FileMenuBar Statement” on page 362 of Formulas & Programing). Since this is a pop-up menu
you can leave the name blank if you want to. A pop-up menu with the formula shown below could be used
to select Southern California field offices, with the main offices in bold.

local PopTop,PopLeft,ButtonHeight,ButtonWidth
local officeChoice
GetLocalButton PopTop,PopLeft,ButtonHeight,ButtonWidth
popup menu("")+menuitems("Los Angeles¬<B;Santa Ana;San Diego¬<B;Riverside;Ventura"),

PopTop,PopLeft,"Los Angeles",officeChoice

Here's what this pop-up menu will look like. The main offices appear in bold (Los Angeles and San Diego).

For more details on using the menuitems( function, see “Live Menus” on page 362 of Formulas & Program-
ing.
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List SuperObjects

Using a List SuperObject™ it’s easy to add a scrolling list to a Panorama form or dialog. This is the same type
of scrolling list used in the standard Open and Save dialogs. The scrolling list allows a large amount of data
to be displayed in a small area. Using the scroll bars, the user can quickly locate the items they are interested
in. Each Panorama scrolling list can be filled with information from a field or variable or from an entire data-
base.

Creating List SuperObjects™

List objects are created just like any other SuperObject™. First make sure that the List tool is installed in the
tool palette (see “Customizing the Tool Palette” on page 497 if it isn’t.)

Select the List tool…
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then drag the mouse across the form in the spot where you want the text to appear.

When you release the mouse, the List configuration dialog appears.
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In some ways configuring a list is similar to configuring a pop-up menu. You need to specify a field or vari-
able to hold the result, and you need to supply a formula to generate a list of items. Each item is separated by
a carriage return. Here’s a typical configuration to display a list of state names. (To type the ¶ symbol, press
Option-7 on the Macintosh and Alt-0182 on the PC.)
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Press OK to create the List object.

To actually use the list, switch to Data Access Mode. In this mode you can use the scroll bar to slide the con-
tents of the list up and down, and click on list items to select them.
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List Options

The SuperObject™ List dialog is divided into several sections. This dialog allows you to configure the way
the text is calculated and formatted. The options in this dialog are described in the following sections.

Once the options are set, press the OK button and the List object is ready to use. If you need to change the
options later, double click on the List object to re-open the dialog.

Data

This section of the dialog specifies the field or variable associated with this list, if any. This field or variable
doesn’t contain the list itself, but only the selected value(s) within the list. Type the name of the field or vari-
able into the box (or select the field name from the pop-up menu next to the Field radio button). If the list is
associated with a variable that has not been created with a procedure, Panorama will automatically create a
global variable with this name whenever the list appears. This global variable can be used in formulas and
procedures just like any other global variable.
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When first learning how to use the List SuperObject it’s handy to include a Text Editor SuperObject on the
form to allow you to see and modify the data value (see “Text Editor SuperObject” on page 639). In this
example both the Text Editor and the List objects are displaying the same value — the field State. 

Clicking on an item fills the field with that value.
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It’s also possible to work this process in reverse. If you type a value into the Text Editor SuperObject the List
will automatically select the corresponding item in the list, if any. For example, you could type Iowa into the
field:

When you press Enter Iowa will be selected in the list.

The item must be spelled exactly the same as it appears in the list, including capitalization. Only Iowa will
work, not iowa or IOWA.

Sep

This is the separator text that will appear between each value if multiple items are selected in the list. Com-
mon separators include commas, spaces, slashes and hyphens. The separator may be up to 6 characters long.
(Note: If the separator is left blank, Panorama will use a carriage return as the separator.)
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As an example of multiple items, consider pizza toppings. A pizza may have one, two, three or more top-
pings, or even none at all. You can create a list that shows all the different pizza toppings. In this example the
separator character is a comma.

When you click on a single topping it appears in the field, just as in the previous example.
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By holding down the Command key (Mac) or the Control key (PC) you can click on and select additional
items, as shown below. The data field (or variable) will contain all of the selected items, with each item sepa-
rated by a comma (or whatever separator character you have specified.) The values will always be in the
same order as they appear in the list, no matter what order you click on them (unlike a group of radio buttons
— see “Multiple Value Button Groups” on page 845).

You can continue to select additional items if you wish. You can also de-select an item by holding down the
Command (Mac) / Control (PC) key and clicking on the selected item. Another option is to hold down the
Shift key and drag across several items to select them all.

You can use any separator character you want. If you leave the Sep option empty, Panorama will use a car-
riage return as the separator. In other words, each item will be on its own separate line.

combined values

separator character
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Database

There are two ways that Panorama can build the list of items: it can use a formula to build the list or it can
scan a database to build the list. So far all of the examples have shown building the list with a formula. If you
want the list built by scanning an entire database, select the name of the database from the pop-up menu in
this section (the database must be open). To illustrate this feature we’ll use this contact database.

Create a List SuperObject the usual way (see “Creating List SuperObjects™” on page 879). Select the database
to be scanned from the pop-up menu of open databases. In this case you’ll select the name of the current
database.
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In the formula field you must enter a formula that will be used to process each field within the database. Usu-
ally this is simply a field name, which can either be typed in or selected from the Field menu. For this first
example we’ll build a list of company names.

When you press OK the list appears, already filled in with the items scanned from the database.

If the database name ever changes, this list will stop working. Here’s how this problem can be fixed. Open
the configuration dialog again (by double clicking on the object). Click on the Database checkbox to disable
the database scanning procedure.

Now click the checkbox again to turn database scanning back on. As you can see, this enables scanning of the
current database, no matter what the name is.

This trick only works with the current database. If the list is built from another database you’ll have to make
sure that the database name doesn’t change (or if it does, you’ll have to open the configuration dialog and
adjust the name to make the list work again).

Click to turn off database scanning
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Sort Up

If this checkbox is turned on, the list of items will be sorted in ascending alphabetical order, otherwise the list
will be displayed in the order the data was scanned. For example, the list of companies built in the previous
example displays the company names in the order they appear in the database, which is definitely not alpha-
betical.

To display the list in order, enable the Sort Up option.

Here’s the alphabetized list.

The Sort Up option works both with database scanning and when the list is generated by a single formula.
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No Duplicates

If this checkbox is turned on, duplicate data items will be eliminated from the list of items. (This option is not
available if the Sort Up option is not also turned on.) For example, the list generated in the previous example
contains many duplicate company entries.

To automatically remove the duplicate items enable the No Duplicates option.

Here is the revised list, without the duplicates.

Formula

This section of the dialog contains the formula used to extract the data items from the database, field or vari-
able. See “Building the List” on page 894 for details on how this formula is used.

duplicates
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Click Action

This section of the dialog controls how multiple items in the list are selected.

Normal: This option normally allows only one item to be selected at a time. When the user clicks on an item,
it is selected and all other items are un-selected. However, if you hold down the Shift key you can drag to
select a contiguous range of items.

By holding down the Command key (Mac) or the Control key (PC) you can click on and select additional
items, as shown below.

You can continue to select additional items if you wish. You can also de-select an item by holding down the
Command (Mac) / Control (PC) key and clicking on the selected item.

One Cell Only: This option only allows one item to be selected at a time, no matter what modifier keys are
pressed.

Contiguous Cells Only: This option is similar to the Normal option, except that holding down the Command
(Mac) / Control (PC) key does not allow you to select/un-select individual items. You can, however, select
multiple items by holding down the Shift key and dragging across the items.

Extend w/o Shift: This option allows you to select a group of items simply by dragging over the items (you
don’t have to hold down the Shift key if this option is enabled).
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Grow Box

This option makes the scroll bar shorter to reserve space for a grow box in the lower right hand corner of the
object.

Usually you would only use this if the list was in the lower right hand corner of the window, or even filling
the entire window. Then you could use this option with an Auto-Grow SuperObject to create an elastic form
(see “Elastic Forms” on page 922). Here is an example of such a form in Graphics Mode…

and in Data Access Mode.

space for grow box

auto-grow superobject

list superobject
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This form will automatically adjust to different window sizes.

See “Elastic Forms” on page 922 to learn more about elastic forms. 

Thin Scroll Bars

If this option is checked the scroll bar will be narrower (11 pixels wide instead of 16 pixels).

Procedure

This pop-up menu allows you to specify a procedure that will be triggered every time the user clicks on an
item in the list.

Click/Release

This option controls when the procedure (if any) is triggered. Normally, the Click/Release option is enabled
and the procedure is triggered when you release the mouse. If the Click/Release option is disabled the proce-
dure will be triggered immediately, as soon as you click on the list. This means that you cannot hold down
the Shift key and drag to extend the selection (see “Click Action” on page 892). Turn off the Click/Release
option if you want to trigger a procedure to drag list items (see “Using Drag and Drop to Change the Order
of Items in a List” on page 712 of Formulas & Programing).

Building the List

There are two ways that Panorama can build the list of items: it can scan a single field or variable, or it can
scan an entire database. Panorama normally builds the list once when the form containing the list is first
opened. If you need to update the list or change it later, you’ll need to send the list a command with a proce-
dure (see “List SuperObject™ Commands” on page 708 of Formulas & Programing).

Scanning a single formula: If this method is selected, Panorama calculates the result of the formula, then
scans the result to separate it into individual items for the list. Each line (separated by carriage return) in the
result is treated as a separate item. This is the same method used by the Pop-Up Menu SuperObject to build a
list; see “The Pop-Up Menu Formula” on page 863 for tips and tricks for setting up this formula.
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Scanning an entire database: If this method is selected, Panorama will scan the entire specified database,
building up the list one record at a time as it scans. The formula determines what information is extracted
from each record in the database and places it in the list. For example, suppose you want to build a list of cit-
ies extracted from an address database. For this application, the formula would be simply:

For this application you would probably want to turn on the Sort Up and No Duplicates options, so that each
city will be listed only once.
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If you wanted both the city and state to appear in the list, a more complex formula could be used:

Here’s the revised list.

If you want to build a list of only part of the database, use the ?( function to select only the information you
want (see “The ? Function” on page 130 of Formulas & Programing). If a record should not be included in the
list, the result of the formula should be an empty string (""). The formula below will fill the list with cities in
California. 
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All other states will be left off the list.

“Hiding” Part of a List Item

The List SuperObject normally supplies all of the text in each line you supply to it. However it is possible to
add hidden text to each line. This hidden text will be included in the value when a list item is clicked on, but
will not be displayed. Any text after a null byte (chr(0)) will be hidden.

To illustrate this we’ll create a list that displays only the city but actually contains both the city and state.
Here’s the configuration dialog for this list.

When the list is displayed only the city names are displayed.

the state will be hidden

start of hidden text
city  will be visible
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Although the states are not displayed they are still part of the list. We can build a Text Display SuperObject to
display the selected city and state. Here is the formula to be used to display the information.

Clicking on different items in the list displays both the city and the state.

An excellent use for the hidden text information is to keep secret identifying information in the list. For exam-
ple a list of invoices might display only company names while keeping the invoice number hidden. When
you click on an invoice the procedure can extract the hidden invoice number to display the corresponding
invoice.

Maximum List Size

The List SuperObject is capable of handling lists up to a few thousand items. For large lists, you may need to
increase your scratch memory allocation. However, keep in mind that the List SuperObject is not intended to
replace Panorama’s normal database operation. The performance of the list (speed) will degrade as the size of
the list increases. Very large lists are also difficult for the user to handle. It’s usually best to keep the list size to
several hundred items or less. If necessary, you should split the list into multiple lists: for example by state,
by price, or even by starting letter (A-Z).

array( function extracts invisible data

array( function extracts the visible data
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This chapter covers some cool things you can do with forms that don’t fit into any particular category. View-
as-List forms allow you to display multiple records at a time, instead of just a single record at a time like a
normal form. Elastic Forms allow you to create forms that automatically stretch to fit any window size (see
“Elastic Forms” on page 922). Super Matrix objects allow you to quickly build repeating arrays like monthly
calendars and photo arrays (see “Super Matrix Objects” on page 939). Scroll Bar SuperObjects can be used
to create standalone scroll bars within a form (see “Scroll Bars” on page 979). Balloon Help Objects (Macin-
tosh only) allow you to add detailed help to your forms (see “Balloon Help” on page 985).

View-As-List Forms

Panorama allows you to set up blank forms as individual pages or as a continuous sheet (view-as-list). When
forms are set up as individual pages you see one record at a time. You can flip through the records just as you
would shuffle through a stack of paper forms.

A view-as-list form displays data as a continuous sheet, as shown below. Instead of flipping from record to
record, you scroll up and down through the data in a manner similar to the data sheet. However, unlike the
data sheet, a view-as-list form allows you to arrange the data any way you like, and even include graphics in
the display. On the other hand, view-as-list forms are slower than the data sheet (because of the overhead in
displaying the graphics) and they are much more work to set up.
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How View-As-List Forms Work

Panorama displays a View-As-List form by taking a collection of graphic objects and displaying them over
and over again, once for each record. For the form in the previous section the collection of graphic objects
looks like this.

As you can see, this collection of objects is just a small portion of a form. How does Panorama know which
collection of objects to include? You tell it by enclosing the objects in a special object called a tile. Panorama
has over 40 different kinds of tiles, but for now we are interested in just two types—data tiles and header
tiles.

Panorama doesn’t care what the exact location of the tile is. It simply looks to see what is contained within
the tile. For example, you could move the tile to a new position like this (see “Working with Tiles” on
page 1062).

data tile

objects inside the data tile
are displayed over and over

header tile

objects inside the header tile are displayed
at the top of the window
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In Data Access Mode this new configuration will look like this.

The height of the Data Tile controls the spacing of the records. For example, we can reduce the spacing by
reducing the height of the tile (see “Working with Tiles” on page 1062).

Here’s what this configuration looks like.
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Creating a View-As-List Form

The first step in creating a view-as-list form is to create a Data Tile. To do this, select the Tile tool.

Now drag the mouse across the form to define the location and size of the tile.
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When you release the mouse Panorama will create the tile.

As you can see, the area outside of the form turns gray. This indicates that any object placed in this area will
not be included as part of the form when in Data Access Mode.

The next step is to enable the View-As-List option in the Form Preferences dialog. You’ll find this dialog in
the Setup menu.
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Press the OK button to confirm the new preferences. Now we’re ready to start adding graphics to the form.
We’ll start by using the Line tool to add a horizontal line across the top of each record (see “Creating a
Graphic Object” on page 494).

Switch to Data Access Mode to see what this configuration looks like. The line is repeated once for each
record. (You’ll also notice that the current record is highlighted in reverse - see “Buttons on a View-As-List
Form” on page 921 for more information about this.)

current record is highlighted
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Got the idea? Now we can go back to Graphics Mode and add more objects. In this example we used auto-
wrap text objects to display two fields from the database (see “Displaying Data in Auto-Wrap Text” on
page 595). You can also use Data Cells (see “Working with Data Cell Objects” on page 635), Text Editor Super-
Objects (see “Text Editor SuperObject” on page 639), Text Display SuperObjects (see “Text Display SuperOb-
jects™” on page 608) or even Flash Art (see “Flash Art™” on page 750).

You can switch to Data Access Mode at any time to check out your work.
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The view-as-list form kind of works like the data sheet. You can select a different record by clicking on it.

Or you can use the vertical scroll bar to navigate to any location within the database.

click to select record

scroll bar
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The width of the current record’s highlighting corresponds to the width of the data cell. By changing the
width of the data cell you can change the width of the highlight.

In Data Access Mode you can see the new, revised highlight width.

Since this form doesn’t contain any Text Editor SuperObjects or Data Cells you cannot edit the data using this
form. See “Editable View-As-List Forms” on page 913 to learn how to create an editable view-as-list form.

width of data tile

width of data tile



Page 908 Panorama Handbook
Working with Tiles

Like all other graphic objects, tiles can be moved and resized with the Pointer tool. However, tiles are slightly
different than other objects. On the screen, a tile looks similar to an upside down window. Tiles are divided
into two parts: the surface and the drag bar.

Unlike other graphic objects that can be manipulated by clicking anywhere in the object, a tile is only sensi-
tive to clicks on its drag bar. To move a tile, press the mouse on the drag bar and drag the tile to the new posi-
tion. To select a tile, click on the drag bar. When the tile is selected, four handles appear around the corners of
the tile.

You can use these handles as grips to change the size of the tile (see “Changing the Size of a Single Object” on
page 513). Tiles can also be moved or resized with the Dimensions command (see “Viewing and Setting
Exact Object Dimensions” on page 512).

The surface of the tile is not sensitive to the mouse. In other words, clicking on the surface area does not select
the tile, and you cannot move the tile by dragging on the surface.

tile surface

tile drag bar

handles
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Adding a View-As-List Header

To add a header to your view-as-list form you’ll need to add a second tile. Surprisingly enough this is called
a header tile. There are two methods for creating this tile—you can create it from scratch or you can create it
from a copy of the data tile.

To create a header tile from scratch start by selecting the Tile tool.

Now drag the mouse across the form where you want the tile to appear. The header tile does not have to line
up with the data tile, although that can make it easier to visualize the final result.
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When you release the mouse a tile configuration dialog appears. This dialog allows you to select the type of
tile you are creating.

Press the Header button. When you press the button, Panorama creates the new tile.

Now you should add any graphics and text that you want to appear on the header.
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Switch to Data Access Mode to see the finished result.

Now let’s create a header tile by duplicating the data tile. Start with just the data tile.
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To duplicate the tile, hold down the Option key (Mac) or Alt key (Windows) and drag the tile (see “Drag
Duplicating” on page 561). You may also want to hold down the Shift key at the same time to make sure that
the two tiles stay in perfect alignment.

When you release the mouse your form will contain two data tiles.
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To transform the new data tile into a header tile, double click on the word Data.

This opens the tile’s configuration dialog.

Press Header to convert the data tile into a header tile.

Voila! Now you can add any graphics and text you want to add to the header, and your form will be com-
plete.

Editable View-As-List Forms

Adding data cells or Text Editor SuperObjects to the data tile makes it possible to edit the database using the
view-as-list forms. The operation of each is a bit different.

double click here to open tile configuration dialog

double clicking on sides selects all
objects inside the tile
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Here is a view-as-list form designed with Data Cells for editing. To learn how to add data cells to your form
see “Working with Data Cell Objects” on page 635.

Switch to Data Access Mode to see the list view.
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As you can see, when Data Cells are added to the form Panorama no longer highlights the entire record. Only
the current cell itself is highlighted. You can click on any visible cell to highlight it.

To edit a cell, double click on it. To learn more about editing within a cell see “Editing Data Within a Cell” on
page 272.
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Here is a form created using Text Editor SuperObjects (see “Text Editor SuperObject” on page 639).

In this case, each object was created with borders on the left, bottom and right but not on the top. Here is an
“exploded view” of these objects, along with the configuration dialog for one of the objects.
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Switch to Data Access Mode to see the finished result.

As you can see, one potential disadvantage of this technique is that nothing is highlighted, so it is very diffi-
cult to see which record is current. (If you need to be able to tell which record is highlighted, use Data Cells.)
To edit a particular item just click on it.
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You might be tempted to try placing a Text Editor SuperObject or Data Cell onto the header tile, like this.

Unfortunately, this does not work correctly. When you attempt to edit the text, the edited text appears in the
wrong position, something like this.

This problem may be corrected in a future version of Panorama, but for now you can only edit text within the
data tile.

Text Editor SuperObject

text should appear here…

but actually appears here!
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View-As-List Background Colors

A tile’s surface is normally white. However, it is possible to change the color of the tile surface to any color in
Panorama’s color palette. To change the color, start by clicking on the tile’s drag bar to select it (see “Working
with Tiles” on page 908).

Once the tile is selected you can select a new color from the Graphic Control Strip (see “Color” on page 526).
You can choose any color you want, but usually the lighter grays and pastels work best.
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When you release the mouse the tile’s surface changes to the new color. By the way, if you want to change the
tile’s surface back to white, select black (the color in the far bottom right).

Colored tiles work well with Text Editor SuperObjects. Here’s an example.

Here’s the same form in Data Access Mode.
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When you click on an item to edit it, the entire area turns white (be sure you have selected the Non-White
Background option, see “Text Editor Options” on page 643).

Colored tiles can also work with Data Cells.

Here’s what this form looks like in Data Access Mode.

Buttons on a View-As-List Form

You can place any kind of button on either the data tile or header tile of a view-as-list form — push buttons,
data buttons, pop-up menus etc. Data buttons that are placed on the data tile should be linked to fields. Data
buttons that are placed on the header tile should be linked to variables (see “Variables” on page 53 and “Vari-
ables” on page 247).
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Elastic Forms

Elastic Forms is a feature that allows a form to adjust intelligently when the window containing the form is
resized or zoomed. When the form is designed, you decide how the individual elements will expand or shift
as the form changes size. Here’s an example of a typical form.

If the window containing an ordinary form is resized, the form remains the same, in this case leaving a large
blank area.
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However, if the form is elastic the objects within the form will adjust themselves to the new size.

The best part is that once you learn how, you can turn almost any form into an elastic form in just a couple of
minutes!

Theory of Elastic Forms

The basic theory of elastic forms is simple. The form is divided into four quadrants, like this.

The upper left hand quadrant always remains fixed, no matter how large or small the window gets. The
upper right hand quadrant slides back and forth horizontally as the window size changes, while the lower
left hand quadrant slides vertically. The lower right hand quadrant slides diagonally, always sticking to the
bottom right hand corner of the window.

As Panorama adjusts the form, it doesn’t adjust entire objects. Instead it adjusts individual points (i.e. object
corners). If an object is split across multiple quadrants, that object will adjust in size as the form expands and
shrinks. If an object is not split across multiple quadrants, it will remain the same size but may slide to a new
position depending on which quadrant it is in.
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As an example consider the Text Editor SuperObject shown below. The four corners of this object are split
across the four quadrants. Point A, in the upper left quadrant, stays put. Point B, in the upper right quadrant,
slides to the right. Point C slides down, while Point D slides diagonally. The end result is that the object
expands to fill up the newly available space.

On the other hand the check number, amount and the category pop-up menu are all contained within a single
quadrant, so these objects do not change in size. The Date and Pay To fields are split across two quadrants, so
they expand in width but not in height.

As you can see, the point where these four quadrants come together is very important (see “Defining the
Quadrants” on page 925). You’ll need to pick this point carefully to create a form that expands and shrinks
the way you want it to. Usually you’ll have one primary object that will expand and shrink as the window
expands and shrinks. The quadrant meeting point should be inside this object. You may also have secondary
objects above or below this object that need to expand and shrink in width only. The quadrant meeting point
should line up with the middle of these objects. (If it is impossible to line up the quadrant meeting point with
all of the secondary objects, you can create one or more slave Auto Grow objects. Slave Auto Grow objects
allow you to create extensions that stick out of one or more quadrants (see “Non-Rectangular Quadrants” on
page 934).)

A B

C D
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Building an Elastic Form

The first step in building an elastic form is to create a regular non-elastic form. Just use Panorama’s regular
shape and user interface elements. It’s usually best to create the form in its smallest possible configuration. In
other words, any form elements that may expand and shrink should be created in their “maximum shrink”
size and shape. Once the form is created, be sure to save the database before going further.

Defining the Quadrants

Once the form is created, the next step is to divide the form into four quadrants. This is done with the Auto
Grow SuperObject™. The Auto-Grow tool is not in the default tool palette, so you’ll need to use the Tool
Palette dialog to add this tool to the palette if it is not already there (see “Customizing the Tool Palette” on
page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the auto-
grow object. The Auto Grow SuperObject should cover the lower right hand quadrant of the form (the quad-
rant that will shift down and to the right diagonally when the window expands). The upper left corner of this
Auto Grow SuperObject will determine the point where the four quadrants meet.
\

When you release the mouse, the Auto-Grow configuration dialog will appear.
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For a basic elastic form just press the OK button.

Using the mouse and the arrow keys, make sure the Auto Grow object is positioned exactly where you want
the lower right quadrant of the form to be (see “Nudging an Object (or Objects)” on page 509 and “Nudging
the Size of an Object” on page 513). Be sure to allow some space for a slight margin on the right and bottom
side of the form.

Once the Auto Grow object is set up, switch the form to Data Access Mode. At first, all you’ll notice is that the
Auto Grow object disappears.

auto-grow object
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Now change the size of the window. As soon as you change the size of the window, the form will adjust to the
new window size.

Try making the window larger or smaller, or zooming the window. The form will automatically adjust to the
new size.

If the form doesn’t quite adjust the way you wanted, set it back to the minimum size and then go into Graph-
ics Mode and adjust the auto-grow object. In extreme cases you may need to Revert To Saved to get the orig-
inal form configuration back (you did save the database before you tried your elastic form, right?).

Once the Auto Grow object is exactly positioned over the lower right quadrant of the form you can set the
minimum window size. The following discussion assumes that the form is currently in its minimum window
size configuration, with all expandable objects set to their smallest size. In other words, the bottom right hand
corner of the Auto Grow object defines the smallest possible window size.

To set this minimum size, double click on the Auto Grow object, then click on the Match This Object button.

The dialog will show the dimensions of the minimum window size. Click on the OK button to permanently
set this size.
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After the minimum window size is set, use the Send to Back command (Arrange menu) to move the Auto
Grow object underneath all of the other objects in the form (see “Changing the Stacking Order” on page 569). 

This prevents the Auto Grow object from interfering with the operation of other objects (for example but-
tons). Whether it is on top or on the bottom, the Auto Grow object will become invisible when the form is
switched from Graphics Mode to Data Access Mode.

The Auto Grow dialog also allows you to manually set the minimum window size by typing in the dimen-
sions. This is necessary if the form elements are not currently at the minimum window size. We recommend
that you avoid this if at all possible. Only edit the form when it is in its minimum size configuration.

Maximum Window Size

Panorama windows can normally be expanded to the full height and width of the computer screen (or even
across multiple monitors if your computer has them). In some cases, however, you may wish to restrict the
maximum height or width of the window. Double click on the auto-grow object to set the maximum dimen-
sions.

In this case the Maximum Height is set to 0. When the maximum is set to zero, Panorama treats it as if there is
no maximum. In other words, the vertical expansion of this window is unlimited, but the horizontal expan-
sion is limited to 450 pixels. You can set a limit on the vertical expansion (height), horizontal expansion
(width) or both.

You can set a maximum window size even if the form is not elastic. To do this, create an auto-grow object
anywhere on the form. In the configuration dialog, set the maximum dimension and also enable the Don’t
Adjust Form option. When this option is enabled Panorama does not adjust the objects in the form when the
window is resized.

If you want the window to be a fixed size (not expandable) set the minimum and maximum dimensions to
the same value.
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Removing the Window’s Scroll Bars

Form windows normally have scroll bars on the right and bottom edges of the window. When using an elas-
tic form these scroll bars really aren’t necessary because the form objects are always adjusted to fit inside the
visible area. Panorama allows you to remove the unnecessary scroll bars either manually or with a procedure.

To manually remove the scroll bars, hold down the Command key (Macintosh) or Control key (PC) while
you click on the Zoom box (in the upper right hand corner of the window).

A dialog with a miniature diagram of the monitor appears. Drag the mouse across this diagram to define a
new window position.

Now press the Options button. This opens a second dialog. Using this dialog you can enable and disable four
different window options. Normally all four of these options are enabled. In the example below the scroll
bars have been disabled.

hold down Command key
and click on Zoom (maximize) button

(on PC hold down Control key)
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Press OK twice to close both dialogs. The window will be re-displayed without the scroll bars.

Depending on the operating system you are using, the grow box in the lower right hand corner may not
appear. To make sure that it appears, open the auto-grow configuration dialog and check the Draw Grow
Icon option.

If you save the database with this window open, Panorama will remember to leave the scroll bars off when
you re-open the database. However, if you close just this window you will have to repeat this process to turn
off the scroll bars when you re-open the window.

The Window Tweak Wizard

The process described in the previous section gets rather tedious if you wind up repeatedly adding and
removing the scroll bars. A simpler method is to use the Window Tweak wizard, which you’ll find in the
Form Tools submenu of the Wizard menu. When you select this wizard it will automatically toggle the scroll
bars and tool palette from the current window (if they are currently visible they will be removed, if they are
currently disabled they will be made visible.

When you open the Window Tweak wizard a small window appears in the lower right hand corner. The but-
tons on this window allow you to perform additional “tweaks” without using the menu.

Press the Tweak button to toggle the palette and scroll bars of the window just below the Window Tweak
window. Using the checkboxes you can modify the “tweak” action to exclude the tool palette or either scroll
bar.
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To illustrate the “tweak” action we’ll use this Checkbook database. Here is the original window.

Once the form is set up and ready to go, run the Window Tweak wizard. Voila! The scroll bars and tool pal-
ette magically disappear, and the window size shrinks slightly to compensate.

When you need to get the palette and scroll bars back again, run the Window Tweak wizard again (or click
on the Tweak button). Poof! The missing items re-appear (and the window expands slightly).

Each time you run the Window Tweak wizard the scroll bars and palette will toggle on or off.
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Opening Windows with a Procedure

It’s possible to write a procedure that opens a form window with the scroll bars already disabled. Here’s such
a procedure from the Checkbook database that comes with Panorama. 

This procedure automatically opens either the Check or Deposit form, depending on the type of transaction
contained in the current record. The key statement in this procedure is setwindowrectangle. This state-
ment tells Panorama the dimensions of the new window, and also tells it not to include horizontal or vertical
scroll bars in the new window. For more information on this statement see “Specifying the New Window
Location” on page 446.

Modifying an Elastic Form

If you need to change an elastic form, we recommend that you start by resizing the window to its minimum
size. Once the window is at the minimum size, you can switch to Graphics Mode and then expand the win-
dow (if necessary). In Graphics Mode the window can be expanded without automatically adjusting the
form.)

If you change the position or size of the Auto Grow object, you must re-set the minimum window size. Sim-
ply double click on the object, then click on the Match This Object button, just as you did before. The dialog
will show the new minimum window size. Click on the OK button to permanently set this size.
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Non-Rectangular Quadrants

Sometimes it is not possible to position the intersection point of the four quadrants so that all the objects in
your form expand and shrink the way you want them too. In that case you can add “extensions” to the upper
right and/or lower left quadrants that stick out into the fixed quadrant. The area covered by these extensions
will adjust when the window is resized. These extensions are created by “slave” Auto Grow objects. These
objects are called slaves because they always follow exactly what the “master” Auto Grow object does. An
extension to the upper right hand quadrant is called a horizontal extension because it sticks out horizontally
into the fixed quadrant. This is the most common type of extension. It allows different lines of a form to
expand differently. A vertical extension sticks out from the lower left quadrant into the fixed quadrant.

Here is an example of a form that requires an extension. When this form expands we would like both the
Notes and the City fields to expand.

There’s no way to divide the form into quadrants and have both of these objects expand. Instead, an exten-
sion is needed, like this.
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To create an elastic form with an extension like this, start by creating a normal auto-grow object in the lower
right hand corner. This is the master. Then add a second auto-grow object over the area of the extension. This
second auto-grow object is a slave. Make sure that the slave object extends past the edge of the fixed quad-
rant into one or more of the movable quadrants.

Here is the configuration dialog for the slave auto-grow object shown above. A slave may be horizontal or
vertical. In this case the extension area will slide left and right so the extension is horizontal.

You can add as many slaves as necessary to your form. Once they have been added the form will adjust auto-
matically with the extensions, like this.

“master” auto-grow object

“slave” auto-grow object
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Expanding Multiple Objects Proportionally

Panorama normally adjusts each object separately, either by expanding them or sliding each object. For
example, consider the form shown below.

This form expands like this.

Sometimes, however, you may want several objects to expand or shrink proportionally as a group. For exam-
ple, if the window grows by an inch, you want four objects to grow equally by 1/4 inch. 

One way to do this is by grouping the objects (see “Grouping Objects Together” on page 536).

four objects combined
into single group
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The form adjusting mechanism treats the group as a single object. Within the group, each object will expand
or shrink proportionally as the entire group expands or shrinks. Notice that the gaps between the objects also
expand proportionally.

Another method is to use a Matrix SuperObject (see “Super Matrix Objects” on page 939). Again, as the entire
matrix expands or shrinks, the individual cells in the matrix expand or shrink proportionally. This method is
ideal for calendars (see “Building a Calendar” on page 971). If you use the Text Display SuperObject to dis-
play text, the text can automatically increase or decrease in size as the form expands and shrinks (see “Text
Display Options” on page 611).

Elastic View-As-List Forms

Starting with Panorama 4.0 it is possible to create an elastic view-as-list form. In this case the vertical position
of the auto-grow object is unimportant. The horizontal position of the object should correspond to the right
edge of the visible area. It’s easier to set this up if the data tile is aligned with the left edge of the form. In the
example below the width of the Deposit field will increase when the form is expanded.

auto-grow object
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Here’s what this form looks like in a minimum width configuration.

When the window is expanded, the form adjusts automatically.

You can also use the auto-grow object to set the minimum and maximum dimensions of the view-as-list form,
just as with a regular form.
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Super Matrix Objects

Some applications require a rectangular array (or matrix) of data, pictures, and/or pushbuttons (for example
a monthly calendar or a thumbnail artwork preview).

Such a matrix consists of a series of cells assembled into rows and columns. Of course, you can build up such
a matrix from individual objects, but the Super Matrix SuperObject™ allows the entire matrix to be built by
repeating a single template. The template may contain artwork and text that will be repeated over and over
again for each cell in the matrix. The template can use formulas to display the appropriate information in
each column and row. This system has several advantages: 1) The array can be built quickly, 2) If changes are
necessary later, they only have to be made once in the template and are automatically repeated throughout
the entire matrix, 3) It is very easy to change the number of columns or rows in the matrix, 4) The matrix and
template can be constructed to adjust automatically as the window changes size and shape.

(Note for Panorama 3 and 4 users: The Matrix Data, Scroll Bar, and Overflow options in the Super Matrix con-
figuration dialog only work for new super matrix objects that are created with Panorama V or later. If you
have an old Super Matrix object that was created with an older version of Panorama you’ll need to delete it
and create a new object to use these features.)
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The Matrix Template (and Frame Object)

Unlike most other objects, the Super Matrix is not completely self contained. For non-trivial applications, it
requires a template that tells Panorama what to draw within each matrix cell. This template consists of Pan-
orama objects enclosed within an object you designate as the frame object. We call the object a frame object
because it surrounds the objects inside, just like a picture frame. Any object that is inside the frame object will
automatically appear inside the cells of the matrix. The frame is usually placed off to the side or below, some-
where where it will not normally be visible.

To designate an object as a frame object, you must give it a unique name. To give an object a name, first select
the object (frame objects are usually rectangles, but any kind of object will work).

“frame” object

matrix

Inside the matrix the
template is repeated
over and over

surrounds the template
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Next, use the Object Name command in the Edit menu or click on the object name in the Graphic Control
Strip (along the bottom of the window). See “Object Type/Object Name” on page 533 for more details about
setting and viewing an object’s name. The name you pick is unimportant, but keep it handy, because you’ll
need it when you create the matrix itself.

If you later forget the name of the object you can use the Graphic Control Strip to remind you.

The frame object may be located anywhere on the form, and may be any size you want. Usually it is most
convenient to make it about the same size as the cells in the matrix will be. You can move the frame object
around at any time, but remember that only objects inside the frame object will appear inside the cells of the
matrix.

In some ways, the matrix frame object is similar to a report tile object. Both are used to designate a template
built up with other objects. However, there are some important differences. First of all, the tile is a special
kind of object, while any object may be designated as a matrix frame.

A more important difference is that the tile object always prints at a fixed size and proportion, no matter what
the size of your paper is. The matrix frame, however, will be squeezed and adjusted as necessary to fit into
the actual matrix cells. If the matrix cells are tall and skinny then the matrix frame and template will be
sqeezed to fit—even if in graphics mode the matrix frame appears to be short and wide.

click here to toggle view until name appearsobject name

template
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If you know the exact size your matrix cells will be, make the matrix frame the same size and you won’t have
to worry. But if the size of the matrix cells may change, you’ll have to design your matrix template to adjust
as the matrix changes size and shape. Techniques for making adjustable templates are discussed later in this
section.

Creating Super Matrix Objects

Super Matrix objects are created just like any other SuperObject™. The Super Matrix tool is not in the default
tool palette, so you’ll need to use the Tool Palette dialog to add this tool to the palette if it is not already there
(see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Once the tool is selected, drag the mouse across the form in the location where you want to create the matrix
to appear.
\

When you release the mouse, the Super Matrix configuration dialog will appear.
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For a blank matrix just fill in the number of columns and rows and press the OK button.

If you need to change the matrix options later, double click on the matrix object with the Pointer tool to re-
open the configuration dialog.

Linking with the Matrix Frame

The first option in the Super Matrix dialog is called Matrix Frame. This is the name you gave to the frame
object described earlier (see “The Matrix Template (and Frame Object)” on page 940). If you haven’t created
this object yet, don’t worry. Just type in the name you intend to use here, then later go back and create and
name the frame object and template.

As you may recall, in our example we named the frame object Sample Cell. You can double check the name
by clicking on the frame object (see “Object Type/Object Name” on page 533).

click on object

to make object name appear

click triangle to toggle between dimensions/font/object name
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Now that we’ve double checked on the name of the frame object, double click on the Super Matrix object to
open the configuration dialog. Type in the name of the frame object, Sample Cell.

When you press the OK button the frame is linked to the matrix. The objects in the template will be repeated
inside each matrix cell.

It’s possible to have more than one Super Matrix object in a single form. In this case, usually each one will
have its own matrix frame with a unique name. The unique name is important so that Panorama can tell
which frame belongs to which matrix.

Matrix Cell Borders & Background

If you turn on the Cell Borders option in the Super Matrix dialog, Panorama will display a border around
each cell in the object. You can control the color, line width, and pen pattern of the border using the Graphic
Control Strip or the Graphics menu. (If you would like a dotted border, use a diagonal stripe pen pattern.)
Panorama will adjust the borders of adjacent cells so that they overlap (instead of creating a double width
border). The amount of overlap is adjusted according to the width of the line. (Note: This overlap feature
does not work with hairlines.)

The Frame Object option controls whether or not the frame object itself is displayed as part of each matrix
cell. Usually you’ll leave this option off. However, you might want to use this option to display a background
for each cell, perhaps using a Flash Art object as the frame object. You could also display a border around
each cell using the frame object, but in this case Panorama will not make adjacent cells overlap.
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Matrix Order

Each matrix cell is numbered, starting from 1. The matrix can be drawn one of two ways: vertically or hori-
zontally. In both cases the upper left hand cell is number 1. If the matrix order is horizontal, then the cell
numbers will be consecutively numbered from left to right in each row.

If the matrix order is vertical, then the cell numbers will be consecutively numbered from top to bottom in
each column.
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Matrix Rows and Columns

The Super Matrix dialog allows you to control how many rows and columns your matrix has. You can choose
either variable sized (fixed #) or fixed size rows and columns.

For example, suppose you wanted to build a monthly calendar. In that case you would always want 7 col-
umns and 6 rows, so you should choose the fixed # of columns and fixed # of rows options.

This matrix will always have 7 columns and 6 rows, but the size of the rows and columns will change if the
matrix changes size.



Page 948 Panorama Handbook
In another application you may want to display icons in a matrix with cells that are always 36 pixels wide
and 36 pixels high (1/2 inch). To get this effect you must choose the fixed width and fixed height options.

The rows and columns will always be 36 pixels (1/2 inch) high and wide. If the overall matrix changes size,
the number of rows and columns will increase or decrease as necessary.

If the size of the matrix is not an exact multiple of the size of the individual cells there will be extra space left-
over on the right and/or bottom of the matrix. Panorama will leave this space blank. The only solution to this
problem is to make sure that the matrix height and width are an exact multiple of the height and width of
each individual cell.
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It’s possible to mix the fixed width/height and fixed # of rows/columns options in a single matrix. For exam-
ple, this matrix always has one column, but has a variable number of rows that are always 13 pixels high.

As the height of the matrix increases, more and more rows appear. Each row is always 13 characters high.

Designing a Matrix Template

Matrix templates were introduced earlier in this chapter. The next few sections explain how to create the
actual “guts” of a matrix template.

In creating matrix templates, it may help to understand how Panorama draws a matrix. First, it calculates the
exact size and location of each cell in the matrix. Then, starting from the upper left, it draws each cell. To
draw each cell, it first locates the matrix frame, and the objects inside the matrix frame. It temporarily moves
and adjusts these objects so that they fit inside the matrix cell. It then draws the cell. The process repeats for
each cell. Your job is to create graphic objects that: 1) display the appropriate information in each cell, and, 2)
will look satisfactory when adjusted to fit inside any reasonable size and shape matrix cell (as a bonus, you
get to decide what constitutes a reasonable size and shape matrix cell!).

Adjustable Size Templates

The cells in a Super Matrix object can change size and shape several ways: 1) You can change the number of
rows or columns, 2) You can change the size of the entire matrix in graphics mode, or 3) If you’ve created an
elastic form, the size of the entire matrix can automatically change when the size of the window changes.
Whenever any of these things happen, the graphics inside each matrix cell need to adjust automatically.
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The Super Matrix object has two methods it can use for adjusting the graphics you create so that they auto-
matically fit into each matrix cell. We’ll use this matrix template to illustrate both of these methods.

The standard method is Proportional. In this method, each graphic object will occupy the same relative posi-
tion in the matrix cell that it occupies inside the matrix frame object. So if, for example, a flash art object is
located in the bottom right third of the matrix frame it will also appear in the bottom right third of each cell.
It’s almost as if you drew the matrix template on a rubber sheet, and Panorama stretches the rubber sheet as
necessary to fit each cell.

A potential disadvantage of this method is that as the cell expands, everything in the cell expands with it. For
example, if each cell contained a photograph with a 9 point caption on the bottom, the caption would also
expand if the cell expanded. This may or may not be what you want to happen.
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The second method for adjusting the matrix template is called Sliding. As the matrix cell gets bigger, points in
the upper left hand corner stay put, while points toward the right and the bottom slide over and down.
Essentially, the template “explodes” as the cell gets bigger. This method is somewhat similar to Panorama’s
cluster resize feature, and is also similar to an elastic form. To control the point at which the template
“explodes,” enter the size (in pixels) of the upper left hand corner that you want to stay together in the boxes
marked v and h. V is the height of this box (stands for vertical) and h is the width (for horizontal). In some
cases, it may be more convenient to enter negative values. In this case the dimension will be measured from
the bottom right hand corner instead of the upper top.

If you use the sliding method, be careful that your matrix cells don’t get too small. If they do, your template
may “implode.” The result isn’t as horrible as it sounds, but it may look very strange and become unreadable.
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Using the sliding method you can create a variable size photograph with a fixed height caption, like this. No
matter how small or large the matrix is, the caption area will always remain the same height.

Tips for Adjustable Size Templates

The Text Display SuperObject™ is very handy for displaying text in a matrix cell (see See “Text Display
SuperObjects™” on page 608). It has flexible alignment options that allow the text to be aligned both horizon-
tally and vertically within the cell.
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Even more handy is the Scale Text Size option, which allows the text to grow and shrink as the matrix grows
and shrinks (see See “Text Display Options” on page 611). You may need to play with the lines option to get
the effect you want (as this value is increased, the text size decreases).

Both standard Flash Art™ and SuperObject™ Flash Art are also handy for displaying pictures in a matrix cell
(see See “Creating Super Flash Art Objects” on page 751). Use the Center or Scale options to automatically
display the picture attractively within each cell. For displaying photographs, the Proportional option (Super
Flash Art only) is ideal. The photograph will always be displayed in the largest possible size without distor-
tion.

Matrix Co-Ordinates and Data

Whether you are displaying text or pictures (or both), chances are you want to display something in each cell
in the matrix. To do this you’ll use one or more formulas. These formulas can either be displayed directly
(using an Auto Wrap Text object or Text Display SuperObject™) or may be incorporated into a Flash Art™
object to display a picture. Within each formula, you can choose from several different functions to identify
the cell being drawn and the appropriate data to draw in that cell.

Matrix Co-Ordinates (What cell is this?)

The info("matrixcell") function returns the cell number within the matrix, starting with 1 in the upper
left hand corner. If the matrix order is horizontal, then the cell numbers will be consecutively numbered from
left to right in each row. If the matrix order is vertical, then the cell numbers will be consecutively numbered
from top to bottom in each column. This illustration shows a matrix with an auto-wrap text object being used
to display the cell number along the bottom.
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The info("matrixcolumn") function returns the column number, starting with 1 for the left hand column
and increasing by one for each column to the right.

The info("matrixrow") function returns the row number, starting with 1 for the top row and increasing
by one for each row in the matrix.

Usually the result of these functions is not used alone, but is fed into another function. For calendars, you
would feed the cell number into calendardate( and calendarday( functions. To display items in an
array or list, you would feed the cell number into the arrayelement( or extract( functions. These func-
tions can help convert the raw cell number into the actual data that should be displayed in the cell.

Co-Ordinates and Scroll Bars

If the matrix has scroll bars, the coordinates will adjust as the scroll bars are used. If the matrix has both verti-
cal and horizontal scroll bars then the info("matrixcell") function will not return a reliable number.
Instead you should use the info("matrixrow") and info("matrixcolumn") functions to identify the
cell.

Using a Matrix to Display an Array

Starting with Panorama V there are two techniques available for displaying an array with a matrix. The first
technique is to use just the info("matrixcell") function (this technique will also work in earlier versions
of Panorama). For example, suppose that you want to display a carriage return separated array named Ele-
ments in a matrix. To do this simply use a Text Display SuperObject with this formula:

array(Elements,info(“matrixcell”),¶)

This will work, but it has some drawbacks. In this case the array is stored in a field or variable, but if it is a
more complex formula (perhaps a lookupall( function, for example) that formula must be calculated over
and over again. The matrix object has no way of detecting if the array data changes, so the matrix can’t auto-
matically redisplay the data if it changes. The matrix also can’t automatically the scroll bar(s), if any, to
account for changes in the data.
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The second technique remedies all of these drawbacks. Instead of calculating the array elements in a formula,
they are calculated by the matrix object itself. To do so you must enter the formula for the array in the matrix
configuration dialog, as well as the separator. (Note: This technique only works for new super matrix objects
that are created with Panorama V or later. If you have an old Super Matrix object that was created with an
older version of Panorama you’ll need to delete it and create a new object to use this feature.)

If the separator is left blank (as in the example above) Panorama will assume the array is carriage return sep-
arated. Otherwise you can type any single character into this box.

Once the matrix data and separator are set you can use three functions to access the data within a matrix cell.
The the info("matrixcelldata") function returns the array element corresponding to the current cell. In
our example, to display the array elements with a Text Display Superobject the formula would be simply:

info(“matrixcelldata”)

A formula can find out the entire array value with the info("matrixdata") function and the current sep-
arator value with the info("matrixseparator") function.

Using the Matrix as a Button

The Super Matrix object doesn’t just display a matrix, it also allows you to click on matrix cells and trigger a
procedure. You can select the procedure to be triggered using the Procedure pop-up menu in the Super
Matrix dialog. If you decide later that you don’t want a procedure to be triggered, simply un-check the
Procedure check box.

If the Click/Release option is checked, Panorama will highlight the matrix cell the user clicked on by invert-
ing it (black becomes white, white becomes black). The procedure will be triggered if the mouse is released
over the same matrix cell it was originally clicked on. If the Click/Release option is not checked, Panorama
will trigger the procedure immediately without highlighting the matrix cell.

What Cell Was Clicked?

The procedure can determine what cell in the matrix was clicked by using the info("matrixcell"),
info("matrixcolumn") and info("matrixrow") functions described earlier in this section. It can also
use the info("matrixcelldata") function if the Matrix Data and Separator have been set up. In addi-
tion, the info("trigger") function will return the name of the matrix object itself (if any — see “Object
Type/Object Name” on page 533). If you haven’t assigned a name to this object, the default is custom.
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Buttons Within Matrix Cells

If you place buttons (3D buttons, checkboxes, radio buttons, etc.) within a matrix template, these buttons will
be displayed in each cell of the matrix. However, these buttons will not be active and will not do anything
when you click on them.

With a bit of extra work, however, you can make buttons within a matrix cell. To illustrate this we’ll look at
the insides of the Available Servers wizard. This wizard uses a matrix with two “buttons” inside each matrix
cell — the server icon and the delete server button.

These “buttons” aren’t really buttons, but simply objects with names (see “Object Type/Object Name” on
page 533). You can use any type of object, as long as it has a name assigned. In this case both “buttons” are
actually Super Flash Art objects, one named Server Icon and one named DeleteServer. Rather than setting up
a procedure to trigger when these objects are pressed, set up a procedure that is triggered when the Matrix
object is clicked. This procedure will look something like this:

server icon delete server
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The key statement in this procedure is matrixbuttonhelper.

matrixbuttonhelper buttonlist,clickbutton,buttonrect

Given a list of objects within the matrix frame this statement will tell you which one was clicked on (if any).
Only objects that are listed will be considered, so if you add a new “button” don’t forget to add it to this list.

The third optional parameter to this statement, buttonrect, should be a variable that will hold the actual coor-
dinates of the object that was clicked on. (If no objects in the list were clicked on the variable will be set to "".)

Updating the Matrix Display

So far this discussion has assumed that the contents of the matrix never change. But appointments are
rescheduled, new photos are added to portfolios, and all these changes must be displayed as they happen. To
cause the entire matrix to update whenever the current record moves up or down check the Sync Up/Dn
option.

If you have set up the Matrix Data formula (see “Using a Matrix to Display an Array” on page 954) the matrix
will update whenever any field or variable in that formula changes. This also usually means that the Sync
Up/Dn option is not necessary.

If you want to update only a portion of the matrix you must use a procedure. To review, a procedure can send
a message to any SuperObject that has a unique object name using the SuperObject statement (see “Pro-
gram Control of SuperObjects™” on page 666 of Formulas & Programing). The format for the statement that
tells a Super Matrix to redraw some or all of the cells is:

SuperObject "matrix name","redraw","area",start,end

The first parameter, "matrix name", is the name assigned to the matrix object. (Note: To give an object a name,
first select the object, then use the Object Name command in the Edit menu or click on the object name in the
Graphic Control Strip. See “Object Type/Object Name” on page 533 for more details on object names.)

The second parameter, "redraw", tells the Super Matrix object that you want to redraw part or all of the
matrix.

The third parameter, "area", defines the area that will be redrawn. Legal options for this parameter are: "all",
"column", "row", and "cell".

The fourth and fifth parameters define the start and end of the area to be redrawn. For example, if the third
parameter was "column" and the last two parameters were 3 and 5, then columns 3 thru 5 would be redrawn.
(Note: The start and end values are ignored if the "all" area is chosen.)

The following one-line examples illustrate different ways a matrix might be updated.

; This command redisplays the entire month
SuperObject "Month","redraw","all",0,0

; This command redisplays only weekdays
SuperObject "Month","redraw","column",2,6

; This command redisplays photo 7 only. Use a similar command
; if you update a single item in a matrix.
SuperObject "Thumbnails","redraw","cell",7,7

; This command redisplays all photos after photo 12. Use a similar
; command if you insert or delete an item in the middle of a matrix.
SuperObject "Thumbnails","redraw","cell",12,9999
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A Trick for Updating the Matrix Display Automatically

(Note: The following trick is unnecessary if you are have set up the Matrix Data formula (see “Using a Matrix
to Display an Array” on page 954), but may still be used in older databases that do not use this option.) If you
simply want the entire matrix to redraw whenever a specific field changes, you can do so without writing a
procedure. Simply overlay the matrix with an auto-wrap text object (see “Displaying Data in Auto-Wrap
Text” on page 595) or text display SuperObject™ (see “Text Display SuperObjects™” on page 608) with a for-
mula that includes the field or fields you want to update. (If you use an auto-wrap text object, don’t forget
that formulas must be enclosed in { } characters.) Use text funnels to make the result of the formula invisible
(see “Taking Strings Apart (Text Funnels)” on page 69). For example, if you want to update the matrix when
the Photos field is updated, overlay the matrix with an object that contains the formula:

Photos[2,1]

The result of this text funnel will always be an empty string, so nothing is displayed. Nevertheless, Panorama
will always try to redisplay this text whenever Photos is changed, and your matrix will go along for the ride
and get updated also.

Super Matrix Case Studies

The following case studies show several examples of how super matrix objects can be used in your databases.
In addition to these examples you’ll find a number of databases that are included with Panorama that use
matrix objects: the Favorite Databases wizard, Text Import and Text Export wizard, White Pages, Fedex
Tracker, Icons & Backgrounds, Disk Permissions and more. You can examine these databases for additional
ideas on how to use matrixes.

Displaying Music Tracks

Our first simple example displays album track names. These track names are stored in the Tracks field, with a
/ character separating each element of the array.
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Instead of displaying the data in the data sheet, we’d really like to display it in a form like this. This form dis-
plays the exact same data as the data sheet above, but formatted with the use of a Super Matrix object.

Switching to Graphics Mode reveals that the album tracks are displayed with three objects: the primary super
matrix object, a rectangle object (used as the frame object) and a Text Display SuperObject.

super matrix object

rectangle object

text display superobject
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Let’s look at the settings for each of these three objects. First is the Super Matrix object (this is usually the object
we create first).

The Matrix Frame option is set to Track Frame. You can set this option to any name you like, but it must
match the name of the frame object (more on this in a minute).

The Matrix & Cell Dimensions are set to display a single column with each cell being 18 pixels high. This
height is set according to the height of the font you choose to use in the Text Display SuperObject. In the
Options section we’ve turned on a thin vertical scroll bar.

At the bottom of the dialog the Matrix Data has been configured so that this matrix will display data from the
Tracks field. The data for each field is separated by the / character (see the original data sheet above).

After the matrix object was created we made one further change - the color of the object was changed to light
gray. If you don’t do that the divider lines between each cell will be black, which we thought was too dark.

The second object is the frame rectangle. This is simply an ordinary rectangle with its name set to Track Frame
(see “Object Type/Object Name” on page 533).
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It’s not necessary for the frame rectangle to be the same size as the cells in the super matrix object, but it is
convenient. We’ve found that an easy way to do that is to initially create the rectangle on top of the matrix
object.

Using the matrix as a guide it’s easy to create the rectangle the exact size needed. Once it is created you can
move the rectangle to another location, then set the object name.

The final object is the Text Display SuperObject.

The formula controls what is displayed in each cell of the matrix. The first part of the formula

str(info("matrixcell"))+". "

displays the track number: 1., 2., 3., etc. The second part of the formula

info("matrixcelldata")

displays the actual track names that have been extracted from the Tracks statement.
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The end result is that the form displays a numbered list of the track names.

The form will update automatically when you edit the list of track names or move to a different record. If
there are more than 10 tracks on an album a thin scroll bar will automatically appear, allowing you to scroll to
see the additional tracks.

(A personal note from the ProVUE staff - the two albums above are really excellent. If you’d like to know
more about this artist see http://www.cedarmesa.com or amazon.com.)
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Displaying Olympic Results

The next example displays Olympic competition results. These track names are stored in the Results field,
with a carriage return character separating each element of the array.

This example is a bit more complicated because each element contains four subelements - the place, athlete
name, country, and time (or distance, weight etc.). We’ll use a matrix to display each of these subelements in
a separate column.
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Switching to Graphics Mode reveals a design similar to the Album tracks example, including the primary
super matrix object, and a rectangle object (used as the frame object). However, instead of just one Text Display
SuperObject there are now four (one for each subelement), and there is also a Super Flash Art object that draws
the colored background.

matrix

frame rectangle

super flash art

text display superobjects
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Here is the Matrix SuperObject configuration for this example. It’s almost identical to the previous example,
except for using an empty separator (which means that a carriage return is the separator - in other words,
each cell will display data from an individual line in the Results field).

Before looking at the Text Display SuperObjects, let’s review the format of each line in the Results field (this
data was extracted from a news web site in this format). The illustration below shows the four subelements of
each line, along with the formulas needed to extract each element from the line.

place
athlete

time

country

upper(tagdata(info("matrixcelldata"),"(",")",1))

strip(array(info("matrixcelldata"),2,")"))

tagdata(info("matrixcelldata"),". ","(",1)

firstword(info("matrixcelldata"))
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Here is the configuration dialog for the leftmost Text Display SuperObject. Notice that in addition to the for-
mula for extracting the subelement, the formula also has a prefix that uses the textdisplay( function (see
“Controlling Text Display Color and Style on the Fly” on page 619) to display the first three results (the medal
winners) in bold.

The form also has a Super Flash Art object that displays the background color for each element (see “Using
Flash Art to Display a Color” on page 761). The formula uses the array( function to pick a different color for
the first (gold - DD8855), second (silver - AAAAAA), third (bronze - FFAA77) and subsequent lines (light
blue - DDDDFF).

In data mode the results are automatically formatted into four columns.
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If the results don’t fit within a matrix the scroll bar is automatically activated.

Television Station Guide

In the previous examples the matrix array data was contained in a single field. In this example we’ll show
how a more complex formula can be used to assemble the array “on-the-fly.” Our example will display the
television stations available in a particular city. Here’s the data sheet:
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Our goal is to display the data using a matrix like this:

In graphics mode this form looks very similar to the previous example:

matrix

frame rectangle

super flash art

text display superobjects



Chapter 18:Form Goodies Page 969
The big difference in this case study is the Matrix Data. Instead of simply a field or variable this contains a
long formula.

The formula is so long that most of it is invisible. Here is the complete formula:

arraymerge(
arraymerge(
arraymerge(

lookupall(info("databasename"),"City",tvLocation,"Channel",¶),
lookupall(info("databasename"),"City",tvLocation,"Station",¶),¶,¬),
lookupall(info("databasename"),"City",tvLocation,"Network",¶),¶,¬),
lookupall(info("databasename"),"City",tvLocation,"Transmitter",¶),¶,¬)

The variable tvLocation is set by the pop-up menu at the top of the form, and will contain the name of a city
(Los Angeles, San Diego, etc.). Each of the lookupall( functions returns a carriage return separated array
with data from one field (Channel, Station, Network and Transmitter). These four arrays are combined into a
single array with the arraymerge( functions. (For detailed information on these functions see the Program-
ming Reference wizard.) The final combined array will look like this (though of course you can never see it
directly):

The four text display objects simply extract a sub-element from the matrix generated by the formula above.

The remaining object is the Super Flash Art object, which displays the alternating blue/green background.
Here is the formula that displays the colors. The result of the mod operator will be either 0 or 1 depending on
whether or not info(“matrixcell”) is even or odd.

1 for channel, 2 for station, 3 for network, 4 for transmitter location
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The final result is shown below. Whenever you select a different city with the pop-up menu the matrix re-cal-
culates the data formula and redisplays the matrix.

In this example the lookupall( functions extracted data from the current database, but they could just as
easily extract data from another database. For example, a vendor database could display a list of purchase
orders for this vendor that is extracted from a purchase order database, or a contact database could display a
list of phone calls from a phone log database. This makes the Super Matrix object an ideal way to display one-
to-many relationships between different databases.
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Building a Calendar

Our final case study uses a SuperMatrix object to build a monthly calendar. Unlike the other case studies in
this example the Matrix Data is not used. A simple calendar can be constructed in a few minutes. Start by cre-
ating a Super Matrix object.
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The object should be seven columns wide (one for each day of the week) by six rows high. Make sure that the
matrix order is horizontal and assign a name for the Matrix Frame of One Day. We’ve also set the resizing
method to Slide (see “Adjustable Size Templates” on page 949).

Next create a rectangle to serve as the matrix frame. Notice that the rectangle frame does not have to be the
same size as the cells in the matrix, though it can’t hurt either.
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Use the Object Name command to assign the name One Day to this object (see “Object Type/Object Name”
on page 533).

The next step is to add a Text Display SuperObject to display the day of the month (1, 2, 3, … 30, 31). See
“Creating and Modifying Text Display SuperObjects” on page 608 to learn how to create such an object. Use
the formula shown in the illustration below.
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When you press OK the beginnings of a calendar will appear.

The 12 pt text looks a bit big. Change the text to 9 pt. You’ll notice that nothing happens when you make this
change. To actually see the change you’ll need to force the window to redisplay. The easiest way to do that is
to scroll down a page, then scroll back. On Macintosh systems you can also click on the window minimize
icon twice. Either way, once the screen updates you’ll see the new look.

Next our calendar needs a header for the days of the week. You could create the header with separate text
objects, but we’ll create it with another matrix. Select the Matrix tool and drag to create the new matrix.

text display superobject
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This new matrix will have only one row with seven columns (one for each day of the week). Type in Day Of
Week for the matrix frame, which we will create in a moment. 
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Once the new matrix is created you may need to nudge it a bit to get it perfectly lined up with the main body
of the calendar (see “Nudging an Object (or Objects)” on page 509 and “Nudging the Size of an Object” on
page 513).

The next step is to create the second matrix frame. Start by creating a rectangle.

Set the name of the rectangle to Day Of Week (see “Object Type/Object Name” on page 533).
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The next step is to add a Text Display SuperObject to display the day of the week (Sun, Mon, Tue, …). See
“Creating and Modifying Text Display SuperObjects” on page 608 to learn how to create such an object. The
Text Display SuperObject should be created to almost fill the frame rectangle.

Use the formula shown in the illustration below to display the day of the week. You’ll also want to set the
alignment to centered, as shown below.

Depending on where your window is on the screen, you may need to scroll the form down a page and then
back to see the finished result.

Believe it or not, this entire calendar has been created with only six graphic objects — two matrixes, two rect-
angles, and two text objects.
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Scroll Bars

Scroll bars are another common user interface element, and in fact may be included as part of several other
user interface elements (text editor, flash art, lists). The Scroll Bar SuperObject™ allows you to create a scroll
bar by itself as an independent user interface element.

Scroll bars can be used two ways. One is to act as a graphical method of displaying and modifying a numeric
value. For example, you could set up a scroll bar that allowed you to display and control the Temperature
field in a database. Instead of typing in the temperature, you would simply dial it in.

The second way to use a scroll bar is to scroll something. A Scroll Bar object can be combined with other
objects (a matrix, for example) to produce a scrolling section within a form.

Scroll Bar “Theory”

A scroll bar has two arrows at the end, and a sliding “thumb” that can be positioned anywhere between the
two ends. The position of the thumb moves corresponds to the current “value” of the scroll bar. As the value
increases, the thumb moves down or to the right (depending on the direction of the scroll bar). Conversely,
moving the thumb (by dragging it) changes the current value associated with the scroll bar. This value is kept
in a field or variable.

The scroll bar value is not unlimited, but ranges between preset minimum and maximum values. The mini-
mum value corresponds to a thumb position all the way to the top (or left), while the maximum value corre-
sponds to a thumb position all the way to the bottom (or right). Values in between the minimum and
maximum represent intermediate thumb positions. Only integer values are allowed; fractional values (like
2.49) are not allowed. The minimum and maximum values may be preset to any value between 1 and 65535.
For example, if the minimum is set to 1000 and the maximum set to 2000 then the scroll bar will have 1001
possible positions. A thumb position halfway in the middle corresponds to 1500.

Each time the user presses on one of the scroll bar arrows the value will increase or decrease by one. If the
minimum and maximum are set close together (for example 1 and 10) you’ll be able to see a definite jump
each time the arrow is clicked. If the minimum and maximum are far apart (for example 1 and 1000) you may
have to click several times to see even a tiny change in the thumb position.

thumb (drag to set value)

increasing value
increasing value

increase value by one
decrease value by one

increase value by page sizedecrease value by page size
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If the user presses on the gray area above or below the thumb the scroll bar value changes by a larger, prede-
termined amount. This usually corresponds to scrolling a page at a time, instead of a line at a time. The exact
value change is set in the scroll bar’s configuration dialog.

Creating Scroll Bar SuperObjects™

Scroll Bar objects are created just like any other SuperObject™. First make sure that the Scroll Bar tool is
installed in the tool palette (see “Customizing the Tool Palette” on page 497).

Now that the tool is added to the palette you can select it.
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Next drag the mouse across the form in the spot where you want the scroll bar to appear. If you want a verti-
cal scroll bar, drag a tall skinny box; if you want a horizontal scroll bar drag a squat wide box.

When you release the mouse, the Scroll Bar configuration dialog appears.
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Select a field (must be a numeric field) or type in a global variable name (see “Variables” on page 53 and
“Variables” on page 247 of Formulas & Programing) and then press OK. The new scroll bar appears.

In this case we linked the scroll bar to a numeric field: H. We can add a Text Editor SuperObject to display the
value of that field (see “Creating and Modifying Text Editor SuperObjects” on page 639).

Now switch to Data Access Mode to try out the scroll bar. You can drag the thumb to any spot to set the value
of the H field.
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You can also move the position of the scroll bar thumb by typing in a value from 1 to 100. For example, you
could type 25 into the Text Editor SuperObject.

When you press the Enter key the scroll bar thumb will hop to the 25% position.

Scroll Bar Options

The SuperObject™ Scroll Bar dialog is divided into several sections. To re-open this dialog for a scroll bar you
have already created, select the Pointer tool and then double click on the scroll bar object.
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Data

This section of the dialog specifies the field or variable associated with this scroll bar. Type the name of the
field or variable into the box (or select the field name from the pop-up menu next to the Field checkbox). If
you choose a field, the field must be numeric with zero digits (see “Numeric Data” on page 249). If the scroll
bar is associated with a variable that has not been created with a procedure, Panorama will automatically cre-
ate a global variable with this name whenever the scroll bar appears. This global variable can be used in for-
mulas and procedures just like any other global variable.

Min

This is the minimum value for the scroll bar, which corresponds to the scroll bar thumb position at the far left
or top. The minimum value must be between 1 and 65535, and must be less than the maximum value.

Max

This is the maximum value for the scroll bar, which corresponds to the scroll bar thumb position at the far
right or bottom. The maximum value must be between 2 and 65535, and must be greater than the minimum
value. Setting the maximum value close to the minimum will produce a “grainy” scroll bar with big jumps as
you press the arrows. Setting the maximum value far from the minimum will produce a “precise” scroll bar
with tiny or even imperceptible movement as you press the arrows.

Page Up/Down

This is the amount the scroll bar value will change when the user presses on the gray area above and below
the thumb. This value must be less than the difference between the minimum and maximum values, and is
often about 1/10th of that difference.

16 Pixel

If this checkbox is turned on, Panorama will limit the scroll bar width to 16 pixels, even if the object is larger.
This is the normal size for most scroll bars. The illustration below shows a scroll bar with the 16 Pixel option
enabled. Even though the scroll bar object is 29 pixels high, the scroll bar is only 16 pixels high.

Here is the same scroll bar with the 16 Pixel option turned off.

Procedure

This section of the dialog allows you to specify a procedure that will be triggered every time the user clicks
on the scroll bar.
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Balloon Help

The Macintosh has a feature called balloon help that can help in learning how to use a program. When the
Show Balloons option is turned on (Help menu), little pop-up balloons with help messages appear as you
move the mouse across the screen.
 

Panorama allows balloon help to be added to any form. You can make any message you want pop-up over
different areas of a form.
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Creating Balloon Help Objects

Balloon help is added to a form by creating balloon help objects. You must create a separate balloon help
object for each area where you want a different balloon help message to appear. For example, if you want to
create balloon help for a button, you must create a balloon help object in the same location as the button
(either on top of or behind the button).

Balloon help objects are created in a different way than any other kind of object. First, you create a text object
with the Text tool.
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Type in the text that you want to appear in the balloon (you can edit this later).

Once the text is created, select the text object with the Pointer tool. If necessary, move and resize the object to
position it over the appropriate area of the form.
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With the auto-wrap text object selected, choose Convert/Edit Balloon Help from the Setup menu.

Panorama will convert the text object into a balloon help object, and at the same time it opens a dialog that
allows you to specify balloon help options.
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Don’t worry about the fact that the Help Text are is empty. Just leave it blank and press OK. The text object
has been converted into a balloon help object, which appears with a black line around it.

When you go to Data Access Mode the black line disappears, and the balloon help object becomes completely
invisible.

new
balloon help
object
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Turn on the Show Balloons option (Help menu) to try out your new help balloon.

If you want to change the options later, go back to Graphics Mode. Select the object and choose Convert/Edit
Balloon Help again to re-open the configuration dialog. This time the help text will appear, and you can edit
it.
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Balloon Help Options

The Balloon Help configuration dialog has four pop-up menus that allow you to specify various balloon help
options. To open this dialog for a balloon help object that has already been created select the object and then
choose Convert/Edit Balloon Help from the Setup menu. (Note: Unlike virtually every other type of Pan-
orama object, you cannot open the configuration dialog by double clicking on the object with the Pointer tool
selected. You must use the Convert/Edit Balloon Help command.)

The Type pop-up menu allows you to control whether a text or picture appears inside the balloon. If you
select Text (the default option), the balloon will display the text in the Help Text section of the dialog. If you
choose any of the resource options, the dialog will change to allow you to enter a resource ID number. The
Picture Resource option will display a picture with the specified resource ID number. The String Resource
option will display text from a STR resource. The String# Resource option will display text from a STR#
resource. The TEXT styl Resource option will display styled text (which may include bold, italic, etc.) from a
styl resource. These resources must be created with ResEdit or your favorite resource editor.

The Position pop-up menu controls where the tip of the balloon will appear. The Normal option makes the
tip appear at the current mouse location. The Center option makes the tip appear in the center of the balloon
help object.

The Tip pop-up menu controls the default position of the balloon. If possible, the computer will place the tip
at the corner of the balloon that you specify. However, if the mouse is near the edge of the screen this may be
impossible.

The Redraw pop-up menu controls how the screen is redisplayed when the balloon disappears. The Update
option will always work, but is usually slower. The BitCopy option works by saving the pixels under the bal-
loon and then replacing the exact same pixels when the balloon disappears. This option is much faster, but
won’t work if the pixels underneath might change while the balloon is visible (for example if the balloon is
over a clock). The Both option uses both methods simultaneously. I’m not sure why you would want to do
this, but Apple made this option available to us so we made it available to you.

Changing the Cursor Shape Over Different Areas

Many applications change the shape of the cursor as the mouse moves over different areas of a window. For
example, it might change to a finger when over a button, to a crosshair when over a table, and to a pointer
everywhere else. You can make the cursor change as the mouse moves over your Panorama forms by using
Balloon Help objects. The Balloon Help dialog allows you to enter the resource ID of a cursor in the Cursor ID
option. The cursor must be stored in a resource file that has been opened with the openresource statement.
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Displaying Balloon Help Text Directly on the Form

Balloon Help text can be displayed on the form itself using a special variable. When used this way the text is
visible even if the Show Balloons option is not turned on. This option also allows the balloon help text to be
displayed on PC systems (kind of like tool tips). Note: This option was added in the Panorama 4.0.2 release,
and will not work with earlier versions.

To display balloon help text directly on a form first set up balloon help objects on various locations on the
form (as described earlier in this chapter, see “Creating Balloon Help Objects” on page 986). Once the balloon
help objects are set up you’ll need to set up a Text Display Objector Auto-Wrap Text Object that displays the
variable BalloonHelpText (see “Using Formulas to Display Text” on page 621). You don’t need to create this
variable yourself, Panorama will do it for you. Here is an example of how to set up a Text Display SuperOb-
ject to display the balloon help text.

There’s nothing more to it. To see the help text simply move the mouse over a location where you have set up
balloon help.

The help text will automatically update as you move the mouse over different locations in the form. The help
text will appear whether or not the Show Balloons option is turned on, and will also appear when viewing
the form on a Windows PC system.

move mouse over 
balloon help 
location

The balloon help text automatically appears in the text object

Note: The green background in this example was created with a separate rectangle object



Chapter 19: Charts

Many databases are filled with numbers. In this chapter you’ll learn how to bring those numbers to life by
turning them into charts and graphs. Panorama can draw five different kinds of charts—Bar, Line, Area, Pie,
and Scatter.

Drawing a chart involves two steps—setting up the chart itself and preparing the database. You only have to
set up the chart once, but you usually have to prepare the database each time you want to draw the chart.
Fortunately, preparing the data is easy, and the entire process can be automated with a procedure to make it a
real “no brainer.”

Chart Data

The job of a chart is to display numeric information graphically. Before Panorama can draw a chart it needs to
know what numbers you want to draw, and what those numbers represent.

The illustration below shows a simple data sheet along with a form containing a bar chart. Each bar corre-
sponds to a record in the database. The database has 12 visible records, so this chart has 12 bars.

value field
legend field

legends

values
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Of course, most databases have hundreds or thousands or records—far too many records to chart directly
like this. Before you can draw a chart of a database with hundreds or thousands of records, you must create a
summary of the database. The chart will display the summary instead of the entire database. See “Preparing
the Database for Drawing a Chart” on page 1006 later in this chapter.

Each bar has a legend that tells what the bar represents. The chart grabs the legend from a field in the data-
base—the legend field. In the illustration above the legends come from the Month field. The legend is usually
drawn across the X (horizontal) axis of the chart.

The height of each bar shows its value. The chart grabs the value from a field in the database—the value field.
Any numeric field can be used as a value field. In the illustration above the values come from the Sales field.
The values are usually drawn along the Y (vertical) axis of the chart.

The chart doesn’t just use any random field for the legend and value—you must specify these fields using
pop-up menus. You’ll learn how to do that later in this chapter.

Tip: Remember that each legend and value comes from a separate record. When you set up your database,
make sure that the data to be charted is in separate records—not spread across a single record.

Creating a New Chart

Charts are graphic objects that are set up and manipulated with the same graphic editing tools you use to cre-
ate forms and reports (see “Graphic Design” on page 491). Be sure the form is in graphic design mode before
you try to create a chart.

To create a chart, start by selecting the Chart tool.
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Next, drag the mouse across the form to define the corners of the chart.

The new chart doesn’t look much like a chart. In fact, it looks more like a dialog!
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The buttons and pop-up menus in the dialog allow you to configure the chart. At a minimum, you must
select a legend field and at least one value field. In this case the legend field is already set to Month. Use the
pop-up menu to set the value field to Sales.

When you switch to Data Access Mode, the chart options disappear and Panorama draws the actual chart
based on the information in the legend and value fields.

You can move the chart by dragging it, or change the size by dragging one of the handles on the corners (just
like any other graphic object). When you drag the chart, be sure you press on one of the empty areas within
the chart, not on a button.

legend field

value field
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In addition to the four handles on the corners, charts have an extra handle at the intersection of the X and Y
axes. You can drag this handle to change the position of the X and Y axis within the chart. In this illustration
the extra handle is being dragged upward to leave more room for the legends.

Switching back to Data Access Mode shows that there is now enough room to display the legends without
cropping.
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Setting Up Legend and Value Fields

To set the legend field, use the pop-up menu at the bottom of the chart object.

If the chart is being designed to display summary records, the legend field is usually the field that was used
to group the database (see “STEP 1 - GROUP” on page 394). Each chart has one (and only one) legend field.

To set the value field, use the pop-up menu in the upper left corner of the chart object.

Keep in mind that the value field must contain numeric data (see “Numeric Data” on page 249).
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Setting Up Additional Value Fields

The simple bar chart shown on the previous pages displays one value per record. More complex charts can
display several values per record by adding additional bars or lines.

A chart can display up to 10 values per record. To differentiate between the values, each value field can be
given its own color and pattern.

After you specify the first value field, a second pop-up menu appears below the first value field. To add
another value field, use this pop-up menu.

You can add up to 10 value fields to a chart.

click here to add second
value field
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To remove a value field, choose Remove Field from the value field pop-up menu. However, you cannot
remove the first value field.

Chart Types

The chart dialog has eight icons representing the kinds of charts Panorama can draw, including bar charts,
line charts, area charts, pie charts, and scatter diagrams. The following section contains a brief description of
each type of chart. Select the chart type by clicking on the appropriate icon. A box will appear around your
selection.

scatter
pie

line
area

side by side bar
stacked bar
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Bar Charts

Bar charts are probably the most common type of chart. Panorama can draw bar charts with either vertical or
horizontal bars. Horizontal bars are especially useful when you have lots of data or long legends.
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If the chart has multiple value fields, the bars can appear either side-by-side or stacked. If the values are side-
by-side, they are displayed from left to right. If the values are stacked, they are displayed from bottom to top.

side by side

stacked
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Line Charts

Line charts are also popular, especially when large amounts of data need to be displayed.

See “Dressing Up Chart Appearance” on page 1014 to learn how to control the pattern, width, and color of
each line.

Area Charts

Area charts are very similar to line charts. The areas for each value are stacked on top of one another.
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Pie Charts

Pie charts display the data as slices of a pie. The size of each slice is proportional to size of each value in rela-
tion to the whole. If possible, Panorama will draw the legends around the pie.

If some of the slices are too thin, Panorama will draw a separate legend, either to the right or below the pie.
The exact location of the legend depends on the shape of the chart object.

Pie charts should only be used for showing the relationships between a few values. Most graphic designers
suggest that pie charts with more than seven slices should be avoided. Although Panorama can draw a pie
chart with dozens of slices, a bar or line chart will probably convey the message more clearly.

A pie chart can only display a single value field. Any additional value fields will be removed from the chart
when the pie chart icon is selected.
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Scatter Diagrams

Scatter diagrams plot two numeric fields against each other. Each record contains a pair of numbers (Leg-
end,Value) that Panorama uses as Cartesian (x,y) co-ordinates.

Each pair of values is normally plotted as a separate dot, but you can also connect the dots or change the dots
into symbols or pictures (see “Scatter Diagram Flash Art” on page 1038 and “Connect Dots” on page 1042).

Unlike other charts, a scatter diagram requires that both the legend and the value fields contain numeric data.
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Preparing the Database for Drawing a Chart

Most databases contain far too much raw data to chart directly, record for record. For example, this check-
book database has several hundred records. Panorama can’t draw a chart with 411 bars, and even if it could,
you wouldn’t be able to make much sense out of it.



Chapter 19:Charts Page 1007
Before the chart can be drawn from this database the data must be reduced to a few summary records. To
recap those techniques, first group (usually Group Up, see “STEP 1 - GROUP” on page 394), then calculate
(Total, Average, etc., see “STEP 2 - CALCULATE” on page 398), then use Outline Level to collapse the data-
base so only the summary records are visible (see “STEP 3 - OUTLINE” on page 406). The result is that hun-
dreds or even thousands of data records are converted into a few summary records that can be charted easily
like this. In this example the 411 data records have been summarized into nine monthly summary records.
(The tenth summary record, the grand total, is not included in the chart).

A chart will only display data from a single summary level. Before it starts drawing a chart, Panorama checks
the summary level of the first visible record in the database. It only charts information that is at the same
summary level as that first record. This means that you do not have to remove the grand total from the bot-
tom of the database—the chart will ignore it automatically. It also means that you must collapse the data in
addition to grouping it. If you do not collapse the data with the Outline Level command (see “STEP 3 - OUT-
LINE” on page 406), the chart will try to display the raw data.
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If you forget to group and collapse the database before opening the chart, Panorama will probably not be able
to display any chart at all. Instead of drawing the chart, the chart will display the message Too many data
items in chart.

Don’t panic—just go back and prepare the database. As soon as the database is collapsed, the chart will
appear.

Tip: You can also reduce the scope of a chart with the Find/Select command (see “The Find/Select Dialog” on
page 336). For example, you may only want to chart data in the current year, or transactions on the west
coast. You should perform selections like these before you group the database.

You may want to create a procedure that automatically groups, calculates, collapses, and then opens the form
window containing the chart. For information about creating procedures see “Procedures” on page 204 of
Formulas & Programing.
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Ranking (Sorting) the Chart Values

Sometimes you may want a chart to display the values in order from smallest to largest, or largest to smallest.
To display a chart this way, sort the database by value after it has been collapsed (see “Ranking Summaries”
on page 383). Click on the value field you want to sort by and choose Sort Up to display values from smallest
to largest, or Sort Down to display values from largest to smallest. Here is a chart that shows the result of
Sort Down on the value column. The months are no longer in chronological order, but in order of spending
per month from highest to lowest.

Sort Down the Debit field



Page 1010 Panorama Handbook
Pie charts are often displayed with the largest pie first (at 12 o’clock), then each smaller pie in order. Use Sort
Down to sort the collapsed database in this order.
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Charts with “Other”

Often you’ll want to display a chart with all the small values lumped together under the legend Other. The
best way to do this is with a procedure. Here is an example procedure that creates totals for the top three
checkbook categories, with all other categories lumped together into an Other category.

Running this procedure will produce summaries that look like this —
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which can be easily charted like this!

This procedure is designed to be easily adaptable to any database or situation. For example, to lump every-
thing into only 3 categories plus other you only need to change one number.
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Here’s the revised chart.

To adapt this procedure to a different database just change the field names.

By the way, it’s kind of fun to run this procedure with the chart visible. Check it out!

Restoring the Original Data

When you are done with your chart, use the Remove Summaries dialog (Sort Menu) to remove the summary
records (see “Printing Reports with Summary Information” on page 410). Simply press the Remove All
Summaries button and all the summary records will vanish.

(Remember, if the chart is still visible, the message Too many data items in chart will re-appear when the
summaries are deleted.)
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Maximum Number of Chart Points

Most bar or pie charts only display a few values. But a complex line chart or scatter diagram may display
hundreds of data values. You must tell Panorama in advance that you plan to display such a complex chart.

The complexity pop-up menu (below the chart type icons) allows you to specify one of three complexity lev-
els—simple, medium, or very complex. A simple chart takes the least amount of memory and can display up
to 50 data values—more than adequate for most applications. The table below lists the attributes of each com-
plexity level.

If memory is tight, you’ll want to use the simple chart option whenever possible. On the other hand, in
today’s world of machines with 32 mb, 64 mb, 128 mb or more memory there’s not much reason to avoid
using the more complex chart types.

Dressing Up Chart Appearance

Panorama tries to display an attractive chart automatically. However you are not stuck with the chart Pan-
orama provides. You can change the fonts, patterns, colors and many other chart attributes to suit your tastes.

Chart Font, Size, and Style

You can change the font, size, and style of the text in a chart just as you would for any text object. Simply
select the chart and choose from the Font (see “Font” on page 529), Size (see “Text Size” on page 531), and
Style (see “Text Style” on page 532) menus.

Type of Chart # of Values # of Bytes

Simple 50 2100

Medium 200 3400

Medium 500 5000

Complex 2,000 20,000

Very Complex 5,000 41,000
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Vertical Legends

Legends are normally displayed horizontally under bar, line and area charts. However, as in this example,
sometimes the legends are just too wide to fit under the bars!

The Vertical Legends check box allows the chart to display legends vertically instead of horizontally.

Adjust the fifth handle of the chart to allow enough room for the vertical legends.
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Note: If a chart uses horizontal legends, there may not be enough room on the chart for a long legend. When
this happens, the legend is not displayed. Four solutions are possible: 1) use vertical legends, 2) use shorter
legends, 3) use a smaller font size, or 4) increase the size of the chart.

Output Patterns

Panorama displays the numbers along the axis of the chart using the output pattern (see “Numeric Output
Patterns” on page 250) set up for the first value field. For example if the first value field’s output pattern is
$#.##, the chart will display a dollar sign in front of each tick mark value.

If the legend field contains numbers or dates, you can use the Output Pattern command (Text Menu) to for-
mat the legend. For example, if the chart is designed to display data grouped by month, the output pattern
could be set to mm-YY or Mon yy.

Here’s an example of a chart without any output pattern set. The database has been grouped by month, so
the chart legend shows the date of the last transaction in each month.

We can make a much better chart by selecting the chart object with the Pointer tool, choosing the Output Pat-
tern command, and setting the pattern to Mon yy.



Chapter 19:Charts Page 1017
Here’s the revised chart.

Graphic Attribute Icons

Panorama normally lets you select the graphic attributes of an object (pattern, border, color, etc.) by selecting
the object and then choosing the attributes from the Graphic Control Strip or Graphic sub-menus. A chart,
however, can have several different components that need to have separate graphic attributes. For example,
you must be able to set the attributes for each slice of a pie chart independently.

To allow you to assign different attributes to different components, the chart object contains a row of graphic
attribute icons just below the chart type buttons.

The number of graphic attribute icons available depends on the type of chart and the number of value fields.

graphic attribute icons
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For most types of charts the number of graphic attribute icons is the same as the number of value fields. The
leftmost icon is used to set the attributes for the first value field, the next icon represents the second value
field, etc.

value field #1

value field #2

value field #1

value field #2

value field #1 value field #2
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A pie chart always has 15 graphic attribute icons (although some may be invisible if the chart object is too
small). The leftmost icon is used to set the attributes of the first pie slice (12 o’clock), the second icon repre-
sents the next slice, etc. If the pie has more than 15 slices, the 16th slice will wrap back to the beginning and
use the first graphic attribute icon. The 17th slice will use the second icon, etc.

To change the graphic attributes of one of these icons, simply click on the icon to select it and then choose the
attributes from the Graphic Control Strip or the Graphic sub-menus (Fill Pattern, Line Pattern, Line Width,
Color). The icon will change to show the effect of the new attributes. Panorama draws a box around the
selected icon to show that it is active.

For example, to change the color of the third slice of a pie chart, click on the third graphic attribute icon.

slice #1

slice #2
slice #3

slice #4
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Once the icon is selected, pick the color from the Color box in the Graphic Control Strip.

When you release the mouse the icon updates to show the new color.
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Here’s the updated chart with a brown third slice.

Here is a line chart with two lines — domestic (purple) and overseas (blue) sales.
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Suppose you wanted the overseas line to be dotted instead of solid. Switch to Graphic Design mode and click
on the second graphic attribute icon.

Now choose a gray pattern from the line pattern menu.
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When you release the mouse you will see a dotted border around the graphic attribute icon.

Switch to Data Access Mode to see the revised chart.
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Let’s make one further revision. Go back to Graphic Design Mode and select the first graphic attribute icon.

Now choose a double width line from the Line Width menu.
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Here’s the result of this modification.

Grid

The Grid checkbox tells the chart to display grid lines from each tick mark.

You can also turn grids on or off by double clicking any of the chart type icons. The Grid checkbox is ignored
when displaying pie charts.
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Non-Zero Axis OK

Panorama normally displays all charts from zero. If you check the Non-Zero Axis OK option, Panorama is
allowed to display charts that don’t go all the way to zero. Here’s a normal chart that includes zero even
though the lowest value is over $20,000.

Here’s the same chart with the Non-Zero Axis OK option enabled.

As you can see, a chart with a non-zero axis can greatly exaggerate the differences between values. Because
charts that are not based on zero can be very misleading, they should be avoided if possible.
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Tick Mark Spacing

Panorama normally sets the number of tick marks automatically depending on the data values and the chart
size. You can override the automatic tick mark spacing using the two pop-up menus near the bottom of the
chart object.

Here’s what this chart looks like with automatic tick marks and set to 12 tick marks.

automatic tick marks

12 tick marks
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Chart Preview

You can see the effect of a change in chart setup by switching from Graphic Mode to Data Access Mode. You
can also preview the chart by clicking on the preview flap in the lower left hand corner of the chart object.
The preview flap is the small triangle that looks like a turned up page corner.

Click the preview flap to flip to a preview of the chart.

Click the preview flap again to flip back to the chart dialog. You can flip back and forth as many times as you
like.

preview flap
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Chart preview is especially handy when you want to draw graphics on the chart itself. For example, you may
want to draw a line to a data point to highlight the point. Chart preview lets you see the chart while you
draw objects on top of it. Of course if the data changes, these objects may no longer be in the correct position!

Copying a Chart to Another Application

Chart preview is also useful for copying a chart to a separate graphics or page layout program. To copy a
chart to the clipboard, first preview the chart, then select the chart object and use the Copy command. You
can then paste the chart into another program (as a picture).
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Graphic Embellishments (Titles, Legends, Drop Shadows, etc.)

Since a chart object is part of a form, you can use Panorama’s graphic tools to spruce up the form any way
you wish. You can add a title to a form with the Text tool. Since charts are transparent, you can add a back-
drop by putting a gray or colored rectangle behind the chart. You can even create a complete legend for the
chart showing which pattern or color corresponds to which data value.

Adding a drop shadow to a chart requires two rectangles. First create a white or light colored rectangle over
the chart (see “Creating a Graphic Object” on page 494).
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Use Send to Back to move the rectangle behind the chart (see “Changing the Stacking Order” on page 569).

Next, duplicate this rectangle (see “Duplicate” on page 561) and change it to a dark color (see “Color” on
page 526).
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Use Send to Back to move this new rectangle behind everything else. Voila! A drop shadow!

If necessary, move the shadow into position behind the chart, using the arrow keys if necessary for fine
adjustments (see “Nudging an Object (or Objects)” on page 509). (The white or light colored rectangle is
needed because the chart is transparent. This rectangle blocks the shadow rectangle below it.)

Chart Flash Art

Charts are usually displayed using solid patterns and colors. With a little extra effort, you can create a truly
unusual charts by using Flash Art to draw the values in a bar, area, or scatter chart.
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Before you can use Flash Art in a chart, you must build up a scrapbook of one or more Flash Art pictures.
Each Flash Art picture is identified by a name. For instructions on building a Flash Art Scrapbook, see “The
Flash Art Scrapbook (Gallery)” on page 764. The image used for the chart above was created in Adobe Photo-
shop and consists of a series of pineapples stacked on top of each other.
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To use Flash Art instead of a standard pattern or color, double click on one of the graphic attribute icons (see
“Graphic Attribute Icons” on page 1017).

Double clicking on a graphic attribute icon opens a dialog for setting up the Flash Art options.Type in the
name of the Flash Art picture you want to use (up to 28 characters).

double click
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When you click OK, the icon will display a tiny flash art light bulb.

Switch to Data Access Mode (or preview) to see the Flash Art picture in the chart.

light bulb
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The Flash Art dialog allows you to specify whether you want to scale or crop the picture to fit in each bar of a
bar chart. Here’s an example of the same chart using the Scale option.

If the picture is cropped, you can specify whether it should be cropped from the center or from either end.
Here’s an example that is cropped from the bottom instead of the top. Notice how the tops of the pineapples
are cut off.

Flash Art cannot be used in line or pie charts.

Using Flash Art for Color or Blends

Beyond the obvious application of pict-o-grams, Flash Art can also be used to display charts using graphic
effects that cannot normally be created with Panorama. For example, Panorama is normally limited to 256
colors, but using Flash Art you can use any color available on your system. Simply create a swatch of the
color in a color paint or draw program, then copy the swatch into the Flash Art Scrapbook. Once the color
swatch is in the scrapbook, it can be used in a chart.
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You can also use a program like PhotoShop to create a blend, then paste the blend into the Flash Art Scrap-
book.

Once the blend is in the scrapbook, it can be used in a chart. This chart was created using the Scale option, but
you can also get nice effects using the Crop option.
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Scatter Diagram Flash Art

Scatter diagrams don’t have to be just a collection of dots. You can spruce up scatter diagrams with Flash Art,
and by playing connect the dots. (See “Scatter Diagrams” on page 1005 for basic information about scatter
diagrams.)

To use a Flash Art picture instead of a simple dot, start by creating an image you want to use, then paste that
image into the Flash Art Scrapbook (see “Adding a New Image to the Scrapbook” on page 765).

Next double click the graphic attributes icon and set up the Flash Art option (see “Chart Flash Art” on
page 1032).
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Now Panorama will draw the scatter diagram using red triangles.

It’s possible to create a scatter diagram in which different points are represented with different images. To
create a chart like this, start by adding an extra field to the database that contains the name of the image asso-
ciated with each point. In this example a field named Data Type has been added (see “Adding New Fields”
on page 198).



Page 1040 Panorama Handbook
The next step is to add the images to the Flash Art Scrapbook (see “Adding a New Image to the Scrapbook”
on page 765).

Next double click on the graphic attribute icon for the chart (see “Chart Flash Art” on page 1032).

double click
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Enter the name of that field surrounded by the « » chevron characters. On the Macintosh these characters are
produced by typing Option-\ and Shift-Option-\. On PC systems these characters are produced by typing
Alt-0171 and Alt-0187.

(Note: Although the example may make it appear as if you could enter an entire formula, only a field name is
allowed.)

When the chart is displayed it shows the appropriate symbol for each point.
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Connect Dots

To draw a line between the dots in a scatter diagram, check the Connect Dots option. The Connect Dots
option only affects scatter diagrams. All other chart types ignore this option.

When a chart is connecting the dots, the order of each point is very important. If the points are out of order,
the result can be a mess.

normal

connect dots
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The points can be re-arranged into order by Sorting the X value, and then using Sort Within on the Y value
(see “Sorting By More Than One Field” on page 324). (This assumes, of course, that you don’t want the lines
to be scrambled up.)

If the chart uses different Flash Art symbols for different dots (see “Scatter Diagram Flash Art” on page 1038),
Panorama will only draw a line between points that are the same shape.

To make sure that all points of each symbol are connected together, sort the database by the type of symbol.
You may also want to Sort Within by the X and Y values.

Printing a Chart

A chart can be printed just like any other graphic element. A simple way to print a chart is to place it on a
data tile and use the Print One Record tool to print it (see “Print One Record” on page 1058). (If you use the
Print command you will get many identical copies of the chart—one for each visible record.)
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Another method is to place the chart on the First Page Header tile (see “First Page Header Tile” on
page 1105).
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This allows you to combine the chart with a listing of the data on the same page. Here’s what the final printed
page looks like.
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Chapter 20: Printing Basics

Since we haven’t quite arrived at the age of the totally paperless office, printing is still an important function
of any computer program—including Panorama. This chapter covers the basics of printing. In the next chap-
ter you’ll learn how to design and use custom reports.

Printing Different Views

You can print any of Panorama’s six kinds of views—data sheet, design sheet, flash art gallery, form, crosstab,
or procedure. To print a view, you must make it visible in the top window. Use the View Menu if the view
you want to print is not currently visible and on top (see “Switching Between Views” on page 168).

Once the view is visible in the top window, use the Print command in the File Menu to print the contents of
the view.

Printing the Data Sheet

Panorama prints the data sheet exactly as it appears on the screen. If the data sheet is too wide to fit on the
page, Panorama will print extra pages until all the columns are printed.

You can get more data sheet columns on a page several ways. One method is to use the Page Setup dialog to
switch to a wide paper orientation (sideways or landscape), or to reduce the printout to a smaller size (Mac-
intosh only). You can also use a smaller font.

You can also print the design sheet or a crosstab sheet. These views will also print extra pages if they contain
more columns than will fit on a single page.
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Printing Data Sheet Headers & Footers

The Headers/Footers dialog (File Menu) sets up headers and footers for the data sheet, design sheet, or any
crosstab. (You can set up separate headers and footers for each of these windows.)

The Headers/Footers dialog allows you to position headers and footers in four locations on the printed page:
top left, top center, top right, and bottom center.
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If you want to create a header or footer that is more than one line high, just press the Return key and type in
the additional lines, like this.

When printed this header will look like this.

You can insert special codes into the header/footer text to print the page number, date, and time. Here’s an
example of how to insert the page number (the printed result is shown above). On the Macintosh the « »
chevron characters are produced by typing Option-\ and Shift-Option-\. On PC systems these characters
are produced by typing Alt-0171 and Alt-0187.

The table below lists some of the special codes that can be inserted into a header or footer:

Description Code Example

Page Number «page #» 1

Date «date:mm/dd/yy» 3/7/02

Date «date:Month ddnth, yyyy» April 8th, 2003

Time {timepattern(now(),"hh:mm:ss am/pm"} 2:23:12 PM

Database Name {info("databasename")} Hotels
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As the last two entries in this table show, you can actually insert any formula into a header or footer by sur-
rounding the formula with { and }. Here’s an example that uses two formulas to display the database name
and number of records in the footer.

Here’s what the finished footer looks like. See “Formulas” on page 19 of Formulas & Programing to learn more
about formulas.

The four buttons just below the header/footer area will insert the most common codes into a header or footer
for you. For example, suppose you wanted the top center header to show the time and date the database was
printed, like this: Printed on May 23rd, 2000 at 4:21 PM. Start by opening the Headers/Footers dialog. Type
Printed on into the Top Center header.

Now press the Month dd, YYYY button. Panorama will insert the code for you.
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Next type in at and press the hh:mm:ss button.

Now press OK, and print or preview the data sheet. The top of the printed page will look like this:

Printing a Form

When you ask Panorama to print a data sheet, it prints an exact line-for-line replica—with one line for every
visible record in the database. But when a form view is printed it would not be practical to print the entire
form for every record. Instead, Panorama lets you specify what part of the form should be printed where on
the report. To do this you use special graphic objects called report tiles. Each report tile defines a section of
the form that is to be included in a printed report. By combining several tiles you can create a complex report
with headers, footers, subtitles, summaries, etc. Report tiles and their applications are covered in detail in the
following chapter, see “Custom Reports” on page 1061.
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If you ask Panorama to print a form that has no report tiles, it will simply print the upper left hand corner of
the form (8" by 10"), one record per page. In other words if your database contains 187 visible records, Pan-
orama will print 187 pages. For most reports you will want to use report tiles so that more than one record is
printed per page.

Preparing Data For Printing

Before you print the database, you may want to prepare it for printing. If you want the data printed in a cer-
tain order (for example alphabetical by name), you must sort the database before you print it (see “Sorting”
on page 323). If you want to print only a portion of the database (for example, only zip codes in California),
you must use the Find/Select command to make the rest of the database invisible (see “Searching and Select-
ing” on page 331). If you want to print subtotals or other summary information, you must group and total the
database before printing (see “Summaries and Outlines” on page 365).

If you are going to print a report often, you may want to create a procedures to automatically prepare the
data before printing. For example, here is a procedure that groups the database by month and by day, calcu-
lates the totals, then opens the form Monthly Statements and prints the database.

For more information on procedures see “Procedures” on page 203 of Formulas & Programing.
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The Page Setup Dialog

The Page Setup command in the File Menu displays a dialog that allows you to specify several printing
options. The exact options available depend on the operating system and what kind of printer you are using,
but in general you can control the page size, orientation (tall or wide), and print reduction factor. Here is a
typical Page Setup dialog.

Each form view has its own separate page setup. The page setup is remembered as part of the form. For
example, a single database can have an invoice that is printed using the tall orientation, and a report that is
printed using the wide orientation (sideways). You don’t have to remember to switch the page setup when
you switch forms—Panorama will do it for you. Incidentally, be sure to save the file after you change the
page setup. If you save the file, Panorama will remember the page setup the next time the file is opened.
(However, not all print options are saved as part of the database. The exact options that are saved vary from
printer to printer.)



Page 1054 Panorama Handbook
Fractional Fonts

The Fractional Fonts option is in the Form Preferences dialog (Setup Menu).

If this option is checked, Panorama will print using the most accurate character spacing. This option should
only be checked when you are printing using a Postscript or TrueType font (which these days, is almost
always true).
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The Print Dialog

The Print command also displays a dialog box allowing you to choose printing options. You can choose
which pages to print, how many copies to print, and whether you want to manually feed the paper. The exact
options will depend on the operating system and printer you are using. Here is a typical Print option dialog.

For the exact details on the operation of this dialog see the documentation that came with your printer.
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Print Preview

The Print Preview command (File Menu) allows you to see what a report will look like without using any
paper. This command opens a new window called Print Preview.

The preview window normally fills the entire screen, but you can change the size and location of the preview
window after it is opened using the grow box and drag bar. Only one preview window can be open at a time,
and all other Panorama windows are disabled when the preview window is open. You can still see the other
windows, but you cannot bring them to the front or click on them.

The image of the printed page is reduced so that the entire page fits in the window. To expand the image to
full size, click on the magnifying glass tool.
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Each time you click on this tool, the window toggles between reduce to fit and 100% magnification, like this.

When the preview is magnified to 100%, you can use the scroll bars to shift to different locations within the
page. You can also use the mouse to push the preview to a different spot. Simply press the mouse (which
looks like a hand, see illustration above) on the preview window, then drag the image to a new location.

To preview the next page, click on the Next Page tool.
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To copy an image of the page to the clipboard, use the Copy Page tool.

Once the image is on the clipboard, you can copy it into a graphic or page layout program.

Print One Record

The Print command normally prints every visible record in a database. If you want to print just one record,
use the Print One Record tool at the bottom of the tool palette.

This tool only appears in the tool palette of form windows. It is not available for any other view (data sheet,
design sheet, etc.).



Chapter 20:Printing Basics Page 1059
Setting up Default Printers

Panorama normally prints on whatever printer is currently selected in the operating system. If you are using
Mac OS X you can also specify a default printer to be used with any form (this feature only works in the form
view). When a default printer is set up Panorama will automatically switch to that printer when printing a
form. For example you may want to print checks, envelopes or labels using a special printer. To configure this
use the Default Printer wizard (in the Preferences submenu of the Wizard menu). Start by opening the data-
base you want to set up, then open the wizard. The wizard will list all of the forms in the database.

Suppose you want to set up the Mini Check form so that it always defaults to printing on a specific printer, no
matter what printer is currently selected. Simply click on the appropriate pop-up menu and choose the
printer.
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Whenever you print this form the printer will automatically be set to the printer you have specified. (Of
course you can always use the pop-up menu in the Print dialog to change the printer at the last minute.

To turn off the default printer selection simply choose the empty option from the pop-up menu.

Zap Page Setup Wizard

Panorama stores page setup and print configuration information for the data sheet and for each form in each
database. Normally you don’t have to worry about this, but occasionally this information will become cor-
rupted (we believe this is caused by problems with printer drivers) and Panorama will fail to print. The cor-
rupted information cannot be recovered but you can zap it and start over. To do this open the Zap Page Setup
wizard.

The wizard lists each entity (data sheet or form) that has page setup information. You can zap the settings for
individual forms separately, or simply zap all of the page setup information for the entire database. Once you
zap you’ll need to use the Page Setup dialog to re-configure the settings for each item.

data sheet

form name



Chapter 21: Custom Reports

Panorama has a very flexible system for printing custom reports. Panorama assembles each report page by
taking pre-defined components from your form and sliding them into position on the page. Because the
report components fit together like floor tiles, these components are called report tiles. Each tile in the form
corresponds to a section of real estate on the printed page.

A form for generating a report may contain only a single report tile, or it may contain dozens of tiles. Pan-
orama checks for the presence of each type of tile as it is building the report, and if found, uses the tile to
build one section of the report. The size and shape of the tiles determines the overall layout of the report.

Report tiles are graphic objects that are part of a form. Here is an example of a typical form that contains three
report tiles—top margin tile, left margin tile, and data tile. (This form also contains a Text Display SuperOb-
ject that has been placed on top of the data tile—more on that later.)

You can manipulate report tiles just as you would any other graphic object—drag, nudge, copy, etc. (see
“Graphic Design” on page 491). Each form can be used to generate a unique report. Since a database can con-
tain an unlimited number of different forms you can also have an unlimited number of custom reports. To
print a particular custom report simply open the appropriate form (see “Switching Between Views” on
page 168) and print. (You may also want to prepare the data before you print by sorting, selecting, and/or
summarizing the data. See “Sorting” on page 323, “Searching and Selecting” on page 331, and “Summaries
and Outlines” on page 365).

top margin tile

left margin tile

data tile

text display superobject
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Working with Tiles

To create a new tile, start by selecting the Tile tool.

Next, drag the mouse across the form in the spot where you want to place the new tile. Any empty spot will
do. The position of a tile on the form does not affect how it is printed—only the size and shape.
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When you release the mouse, Panorama creates the new tile. If this is the first tile on the form, Panorama
automatically creates a data tile (see “Data Tiles” on page 1076). Later, Panorama will give you a choice.

When you add the first tile to the form (the data tile), the background (outside the tile) will turn gray, as
shown above. Only graphics or text that are on top of a tile will be printed — any graphics or text in the gray
area will not be printed.

On the screen, a tile looks sort of like an upside down window. Tiles are divided into two parts: the surface
and the drag bar. The surface is the actual printed area of the tile.

tile surface

tile drag bar

type of tile
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Unlike other graphic objects that can be manipulated by clicking anywhere in the object, a tile is only sensi-
tive to clicks on its drag bar. If you click and/or drag on the surface of a tile, the object is not selected and
does not move. Instead, a selection marquee appears, just as if you had dragged on an empty spot in the form
(see “Selecting Multiple Objects at Once” on page 502).

To move a tile, press the mouse on the drag bar and drag the tile to the new position.
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When you release the mouse, the tile moves to the new position, just as with dragging any other kind of
object.

To select a tile, click on the drag bar. When the tile is selected, four handles appear around the corners of the
tile, as shown above. You can use these grips to change the size of the tile, again, just like any other kind of
object.



Page 1066 Panorama Handbook
Release the mouse to see the new size.

Tiles can also be moved or resized with the Dimensions command (see “Viewing and Setting Exact Object
Dimensions” on page 512) and by nudging with the arrow keys (see “Nudging an Object (or Objects)” on
page 509 and “Nudging the Size of an Object” on page 513). Note: When using the Dimensions command
the dimensions are for the surface of the tile only, not including the drag bar along the bottom of the tile.

As mentioned above, the surface of the tile is not sensitive to the mouse. In other words, clicking on the sur-
face area does not select the tile, and you cannot move the tile by dragging on the surface. However, you can
place objects on top of the tile and move or select them.

In fact, as you will see later, most tiles must have other objects placed on top of them to build a complete
report.
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If a report tile has one or more objects placed on top of it, double clicking on the tile’s drag bar will select both
the tile and all of the objects on top of the tile. This is convenient if you want to move or copy the tile and the
objects to a new position or to a different form.

However, double clicking on the type of tile does not select the objects.

double click drag bar to select tile and all objects on the tile

double click here to open the tile configuration dialog
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Instead it opens the tile configuration dialog, allowing you to change the type of a tile. Depending on the
number and type of tiles that are already on your form you may get the simple dialog shown here:

or the more complex dialog shown here (the Specialized Tile dialog).

To change the tile’s type simply pick the appropriate button, or press Cancel to keep the same type.
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Creating Additional Tiles

A minimum report contains at least a data tile. Many reports will contain additional tiles. To create an addi-
tional tile, start by selecting the Tile tool.

Next, drag the mouse across an empty (gray) spot on the form. Remember, the exact position of the tile is not
important, only the size and shape.
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When you release the mouse the tile configuration dialog appears. Since this form currently has only one tile,
the simple version of the configuration dialog will appear.

To create a Header tile, Footer tile, or Left Margin tile simply press the appropriate button. To create any
other type of tile press the Specialized Tiles button, which makes the “long” version of the tile configuration
dialog appear.
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The multitude of choices in this dialog will be discussed later. For now we’ll simply press the Header button
to create a header tile.

Creating A New Tile By Duplicating

Another way to create a new tile is by duplicating an existing tile. For example, suppose you started with a
data tile like this an wished to create a matching header tile.
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To duplicate this tile, hold down the Option key (Macintosh) or Alt key (PC), then click on the tile’s drag bar
and drag it (see “Drag Duplicating” on page 561). You may also want to hold down the Shift key to keep the
new tile perfectly aligned with the original.

When you release the mouse a second data tile will appear.
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To change the type of the new tile, double click on the type of tile.

This opens the tile configuration dialog.

double click here to open configuration dialog
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Press Header to switch the type of the new tile.

You may want to increase the height of the header tile. Here’s one way to do that. Start by clicking on the
drag bar to select the tile.
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Now drag one of the handles to set the new size. Hold down the Shift key if you want to keep the width con-
stant.

When you release the mouse button the tile snaps to the new height.

Of course the tile can also be moved or resized with the Dimensions command (see “Viewing and Setting
Exact Object Dimensions” on page 512) and by nudging with the arrow keys (see “Nudging an Object (or
Objects)” on page 509 and “Nudging the Size of an Object” on page 513).
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Tiles In Action

Panorama has many different types of tiles. Each type of tile has its own rules that tell Panorama where the
tile should be printed on the page. For example, a header tile is always printed at the top of the page. You can
make the header bigger or smaller, add fancy graphics, even move it to a different spot in the form window—
but no matter what you do, the header will always print at the top of the page.

Panorama’s basic rules for printing tiles are simple. First it prints the header (if any) at the top of the page,
then the footer at the bottom of the page. The space left in the middle is available for data. Panorama starts in
the upper left hand corner and prints a column of data—one data tile at a time. Once Panorama reaches the
bottom, it checks to see if it should print another column. If another column is needed, Panorama goes back
to the top and prints it.

More complex reports can have variations on this basic theme. Panorama has many different specialized
types of tiles for automatically creating almost any report format. But the basic idea is the same—each tile
slides into place on the page according to its rules.

A form should contain no more than one tile of each type. If a form contains two header tiles, for example,
Panorama will not know which one to print at the top of the page. If you attempt to print using a form that
has duplicate tiles, Panorama will display an alert.

Data Tiles

The data tile is the cornerstone of every custom report. Because the data tile is used to print each data record,
the size and shape of the data tile has a major impact on the overall look of the report. For instance, if you
want to print labels, the data tile should be the same size and shape as a single label plus the gaps between
the labels, like this.
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When you print this form it will look like this.

This illustration shows how Panorama stacked the tiles together to create the report shown above. In this
illustration, the tiles, which are actually invisible, are shown in light blue. As you can see, Panorama slides
the tile surfaces together as closely as possible. (The tile drag bars are not counted as part of the tile when the
report is printed.)
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Simply changing the size or shape of the data tile can completely change the printed report.

The only change is that the data tile (and the text object on it) has been made wider. Now Panorama can only
stack two data tiles side by side.
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Once again here is an illustration that shows how Panorama fits the invisible tiles together to make the fin-
ished report.

To make a columnar report with one line per record, make the data tile as wide as the page and one line high,
like this.

Here’s the finished report printed from this tile.
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This data tile is too wide to stack side-by-side, so Panorama simply stacks them vertically.

At the other extreme you can make the data tile very large so that only one or two records will be printed per
page. This form is designed to print two postcards per page.
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Here’s what the postcards look like when printed on an 8.5 x 11 inch page.
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Just as with the other reports, Panorama prints this one by stacking the data tiles as close together as possible.
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If the data tile is large enough Panorama will only print one record per page. Common applications include
invoices, statements, tax returns, and form letters like the one shown here.
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Here’s the printed result of this form. Panorama will print one complete page for each selected record in the
database, each with a customized letter. (Or, if you wish, you can use the Print One Record tool to print a sin-
gle letter. See “Print One Record” on page 1058)

By the way, it’s also possible to print multi-page letters. See “Printing Data that Overflows a Page” on
page 1116.
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Margins

If a form doesn’t contain any margin tiles (like the examples in the previous section) Panorama will automat-
ically start printing as far up and to the left as possible on the current printer. In this case the exact margins
will depend on the printer and on the Page Setup options you have chosen.

Top Margin Tile

The top margin tile allows you to modify the distance from the top of the page to the top of the first tile
printed. Unlike most other tiles where both dimensions are important, Panorama only cares about the height
of the top margin tile. If the report contains a top margin tile, the height of that tile becomes the top margin of
the report.

To create a top margin, start by selecting the Tile tool.

Drag the mouse over an empty spot on the form. You don’t need to worry about the width, but the height of
this object will become the height of the top margin. Of course you can adjust the dimensions later.
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When you release the mouse the tile configuration dialog appears. If the small configuration dialog appears
(as shown below) then click on the Specialized Tiles button.

The Top Margin button is near the top of the dialog.

Press this button to create the new tile.
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When it’s printed, this report will look like this.

This illustration shows how Panorama assembles the report using the top margin and data tiles. The top mar-
gin is always the top tile on the page, with any other tiles stacked below it.

Unlike other tiles, Panorama will not print text or graphics that are placed on the surface of the top margin
tile. The top margin tile has only one purpose—to set the top margin.

If the height of the top margin tile is less than the minimum printer margin the text may be cut off. 

Left Margin Tile

Panorama normally prints the header, footer, and data tiles with the smallest possible left margin, usually
about 1⁄4 inch. (The actual minimum left margin depends on the type of printer you are using, and on the
current Page Setup.)

You can use the left margin tile to change the left margin. Unlike other tiles where both dimensions are
important, Panorama only cares about the width of the left margin tile. If the report contains a left margin tile,
the width of that tile becomes the left margin of the report.
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To create a left margin, start by selecting the Tile tool.

Drag the mouse over an empty spot on the form. You don’t need to worry about the height, but the width of
this object will become the width of the left margin. Of course you can adjust the dimensions later.

When you release the mouse the tile configuration dialog appears. If the small configuration dialog appears
(as shown below) then click on the Left Margin button.
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If the large configuration dialog appears press the Left Margin button, which is near the top of the dialog.

Since the Left Margin tile is often quite narrow, Panorama simply displays a triangle in the tile’s drag bar.

When it’s printed, this report will look like this.
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This illustration shows how Panorama assembles the report using the top margin and data tiles. The top mar-
gin is always the top tile on the page, with any other tiles stacked below it.

Unlike other tiles, Panorama will not print text or graphics that are placed on the surface of the left margin
tile. The left margin tile has only one purpose—to set the left margin.

Right Margin Tile

The right margin tile is rarely used. Panorama normally tries to use the entire printed area of the page, right
up to the minimum right margin. The usual right margin is about 1⁄4 inch, but like the left margin, it can vary
depending on the type of printer you are using and the current Page Setup.

You can use the right margin tile to set a larger right margin. Like the left margin, Panorama only cares about
the width of the right margin tile. If the report contains a right margin tile, the width of that tile becomes the
right margin of the report. However, there is one exception—if your right margin tile is less than the mini-
mum width, the report will ignore the tile and use the minimum right margin.

Increasing the right margin has two effects. First, when you are using automatic multiple columns (see “Con-
trolling the Number of Columns” on page 1139), increasing the right margin can reduce the number of col-
umns printed. Panorama will stop printing columns when the right margin is reached. However, it is usually
simpler not to use a right margin and instead set the number of columns explicitly using the Report Prefer-
ences dialog (see “Controlling the Number of Columns” on page 1139).

The right margin also affects the position of the center and right header/footer tiles (see “Designing Headers
and Footers For Changing Page Sizes” on page 1109). The centered tiles will be centered between the left and
right margins, while right flush tiles will be flush against the right margin.

The right margin does not have any effect on normal header/footer tiles, or on the first column of data tiles.
For example, suppose that the header tile is wider than the space between the left and right margins. The
header will overlap and print in the right margin area.

Unlike other tiles, Panorama will not print text or graphics that are placed on the surface of the right margin
tile. The right margin tile has only one purpose—to set the right margin.

Bottom Margin

Panorama does not have a special tile for setting the bottom margin. Instead, you should include space for
the bottom margin in the footer tile (see “Footer Tile” on page 1099).
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Headers and Footers

Many reports have headers at the top of each page and footers at the bottom. As you might guess, headers
and footers are set up with report tiles!

Header Tile

The header tile is printed at the top left of each page. The header can be used to print the report title, page
number (see “Page Numbers” on page 1100), date (see “Printing the Current Date and Time” on page 1103) or
anything else you want.

To create a header, start by selecting the Tile tool, just as with any other tile. Drag the mouse over an empty
spot on the form, leaving the proper amount of space for the header you want to create. Usually the header is
approximately the entire width of the page. (Of course you can adjust the dimensions later.) The header tile
can be in any empty spot on the form. In this example we are creating the header tile below the data tile, even
though the header will eventually print above the data.

When you release the mouse the tile configuration dialog appears. If the small configuration dialog appears
(as shown below) then click on the Header button.
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If the large configuration dialog appears press the Header button, in the Top of Page section.

Here’s the new tile.

A blank header tile isn’t much use, so we’ll add some text and graphics to the header.
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When it’s printed, this report will look like this.

This illustration shows how Panorama assembles the report using the margin, header and data tiles.
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Creating a Header Tile by Duplicating the Data Tile

An alternate way to create the header tile is to duplicate the data tile (see “Drag Duplicating” on page 561).
This makes it easy to line up items between the two tiles. Start with just a data tile.

To duplicate the tile, hold down the Option key (Mac) or Alt key (Windows) and drag the tile (see “Drag
Duplicating” on page 561). You probably also want to hold down the Shift key at the same time to make sure
that the two tiles stay in perfect alignment.
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When you release the mouse your form will contain two data tiles.

Grab one of the handles to adjust the height of the new tile.
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To convert the new tile from a data tile into a header tile, double click on the word Data.

This opens the tile configuration dialog.

double click here to open tile configuration dialog

double clicking on sides selects all
objects inside the tile
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Press the Header button to convert the tile.

Now we can add graphics and text to the header. Anything placed on the header will line up vertically with
objects in the same position on the data tile.
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Here’s the printed report.

Once again Panorama builds these reports by sliding the tile’s into place.

You can also build a header using the Table Header tile. See “Table Header and Table Footer Tiles” on
page 1135.
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Footer Tile

The footer tile is printed at the bottom left of each page. The footer can be used to print the report title, page
number (see “Page Numbers” on page 1100), date (see “Printing the Current Date and Time” on page 1103) or
anything else you want.

You can create a footer with the Tile tool (see “Header Tile” on page 1091) or by duplicating another tile (see
“Creating a Header Tile by Duplicating the Data Tile” on page 1094). In this example the footer was created
by drag duplicating the data tile (see “Drag Duplicating” on page 561).

Here’s what the bottom of this page looks like.
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Notice that there is a gap between the bottom of the last line of data and the footer tile. This is because the
Panorama always aligns the footer with the bottom of the page. The footer is printed as close to the bottom of
the page as possible.

If you want to create a footer that is right below the data tiles with no gap, use the Table Footer tile (see
“Table Header and Table Footer Tiles” on page 1135).

Page Numbers

Panorama can automatically calculate and print a page number on each page of your report. One technique
for printing the page number is to use an auto-wrap text object (see “Displaying Data in Auto-Wrap Text” on
page 595). The page number is merged into the text by typing «page#» into the object. (On a Macintosh the «
chevron is Option-\ and the » chevron is Shift-Option-\. On Windows systems the « chevron is Alt-0171
and the » chevron is Alt-0187.) The illustration below shows how to print page numbers on the upper right
hand corner of a report. Notice that the text object has been set to right justify (Style Menu) so that the page
number will be flush with the right edge of the report.

gap

bottom
of page

data tiles
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Here is what the first three pages of this report look like.

If you want the page number to start with a page number other than one you must use the
info("pagenumber") function. You can either merge this function into an auto-wrap text object (see “Dis-
playing Formulas in Auto-Wrap Text” on page 602) or use a Text Display SuperObject (see “Text Display
SuperObjects™” on page 608). The example below shows how to create a report with page numbers starting
at 25.
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Here’s the printed report, with page numbering beginning at 25.

To center the page number at the bottom of each page, place an auto-wrap text or Text Display SuperObject in
the center of the footer tile. To make sure that the page number is centered, the text object should be centered
within the footer tile. You also need to check the center justify option in the Style Menu.

You may want to display each page number in relation to the total number of pages in the report—for
instance Page 2 of 5. Panorama cannot automatically calculate the total number of pages in a report, but you
can find out this number manually with the Preview command (see “Print Preview” on page 1056). Use the
Next Page tool in the preview window to count the number of pages, then edit the title to display the correct
number.
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The examples shown have all assumed that odd and even pages are identical. It is also possible to make odd
and even pages mirror images, so that the page number always prints on the outside (on the right for odd
pages and on the left for even pages). See “Even and Odd Page Layout” on page 1164 to learn how to set this
up.

Printing the Current Date and Time

Panorama can automatically print the current date and time on each page of your report. One technique for
printing the date is to use an auto-wrap text object (see “Displaying Data in Auto-Wrap Text” on page 595).
The page number is merged into the text by typing «date:pattern» into the object. (On a Macintosh the « chev-
ron is Option-\ and the » chevron is Shift-Option-\. On Windows systems the « chevron is Alt-0171 and the
» chevron is Alt-0187.) Don’t actually type in the word pattern, instead choose one of the patterns from the
table below.

The illustration below shows how to print the current date in the upper left hand corner of a report.

Pattern Example

mm/dd/yy 3/9/04

MM/DD/YY 03/09/04

mm-dd-yyyy 3-9-2004

dd-MON-yy 9-MAR-04

dd-Month-yy 9-March-04

Month dd, yyyy March 9, 2004

Month ddnth, yyyy March 9th, 2004

DayOfWeek, Month dd Thursday, March 9
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Here’s the top of the first page of this report.

To include the current time in a printed report you must use the now() and timepattern( functions. You
can either merge these function into an auto-wrap text object (see “Displaying Formulas in Auto-Wrap Text”
on page 602) or use a Text Display SuperObject (see “Text Display SuperObjects™” on page 608). The exam-
ple below prints both the date and time using a formula.



Chapter 21:Custom Reports Page 1105
Here is the printed report.

You can actually merge in any formula you want into the header and/or footer.

First Page Header Tile

Panorama normally prints the header tile (or tiles) at the top of each page (see above). However, if the report
includes a first page header tile, that tile will be printed at the top of the first page. All subsequent pages will
print using the normal header tile (or tiles). Here is an example of a form that contains both a first page
header and a regular header that will print on the second, third, and any additional pages.
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Here are the first two pages of the printed report generated by this form. The first page includes the First
Page Header, while the second (and subsequent pages) use the regular Header tile.

The First Page Header tile can also be used to create a title page for the report. To do this simply enlarge the
First Page Header tile until it is large enough to cover an entire page. In that case Panorama will print only
that tile on the first page. The regular report will begin on the second page.
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BackDrop Tile

The backdrop tile can be used to print an overall graphic design on each page of the report. The backdrop tile
actually overlays all of the other tiles on the page. For example, the backdrop tile could be used to print the
word “Confidential” across each page of the report or to print a border around the page. Here’s an example
of a backdrop tile.
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The contents of the Backdrop tile will print on top of every page in the report.
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Designing Headers and Footers For Changing Page Sizes

Most reports are designed for a specific page size. It is possible, however, to design headers and footers that
automatically adjust for different page sizes. The key is to divide the header and footer into three compo-
nents: left flush, centered, and right flush. Here is a report with three headers.

On a standard 8 1/2 by 11 page this report will look like this.
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If you print this report on a different size page (or switch from portrait to landscape orientation or use a dif-
ferent page reduction factor) the titles will adjust automatically.

You don’t need to use this technique unless you think that the page size may change. If the page size is fixed,
just use the regular header and footer tiles.
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The QuickReport Dialog

When you create a new form, Panorama gives you the option of creating a blank form or automatically creat-
ing a label or report.

The QuickReport button opens a dialog that can do most or all of the work of setting up a report for you. The
QuickReport dialog allows you to automatically create a tabular report.

On the left is a list of all the fields in the database. On the right is a list of the fields that will be included in the
report. In the dialog the report fields are listed from top to bottom, in the actual report they will be printed
from left to right. To set up the report, copy the fields you want to include in the report from the list of fields
on the left to the report list on the right.
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The easiest way to copy a field from the left to the right is to double click on the field name. Double clicking
on a field name adds the field to the end of the list on the right. If a field name on the right is already selected,
then double clicking on a field name on the left replaces that field. The Add button works the same as double
clicking.

To insert a field into the middle of the list on the right, first select a field on the right, then select a field on the
left. Press the Insert button to insert the new field into the list on the right.

To delete a field from the list on the right, select the field and press the Remove button. You can also delete a
field from the list on the right by double clicking on it.

If you want to use a non-standard page size, you should use the Page Setup button to set it up. Be sure to set
up the page size before you press the OK button. This lets QuickReport know how wide the page will be.

Press the OK button to generate the actual report. Panorama will generate all the tiles and cells needed for
the report.

You can use this report as is, or you can use it as a starting point and modify it to suit your needs.
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The QuickReport dialog also creates header and footer tiles. You can specify the height of the header and
footer by specifying the top and bottom margins (in either inches or centimeters).

The QuickReport dialog can place page numbers and/or the date and time on the header and footer tiles. To
set up the page numbers and date/time, press the Set Up Titles button. This button opens a small dialog
with 16 checkboxes.
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These checkboxes allows you to place any combination of page number, date, and time in up to four positions
on the page: top left, top center, top right, and bottom center. Here is the form generated with the options
shown above.

To learn more about printing the page number and date see “Page Numbers” on page 1100 and “Printing the
Current Date and Time” on page 1103.

Printing Multiple Page Records

If the data tile is made large enough to fill the entire page then Panorama will print only one record per page.
In some cases, a single page is not enough. For example, you may need to print an invoice, statement or tax
return with several pages per record. Panorama can print up to 10 pages for each record.

To print a multiple page form you will need to create multiple data tiles. These additional data tiles are cre-
ated with the Specialized Tile configuration dialog. 

The tile’s for additional pages can be identified by the page number in the drag bar of the tile.

standard
data tile overflow page tile

second page data tile
third page data tile

fourth page data tile
fifth page data tile
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When you create a data tile for an additional page it should be large enough to fill the entire sheet of paper,
just like the first data tile. When a form contains data tiles for multiple records Panorama will ignore any
header or footer tiles. Only the margins and data tiles will be printed. This illustration shows a form for
simultaneously printing an invoice and packing slip. (Sorry — had to reduce this image to make both pages
fit!)

When you print this form, both pages will print automatically for each record printed. If you use the Print
One Record tool (see “Print One Record” on page 1058) Panorama will automatically print the current
invoice and packing slip. If you use the regular Print command Panorama will print an invoice and packing
slip for each selected record.

Selectively Printing Multiple Pages per Record

Panorama allows up to 9 pages to be printed per record using data tiles 1 through 9. However, you do not
have to print all tiles for each record, you can print them selectively using a formula on the form. For exam-
ple, you can easily ask Panorama to print pages 1, 2, and 5 for one record and 1 and 4 for another record (page
one, the primary data tile, always prints). You could use this feature to selectively print an envelope, to print
only selected portions of a tax return, to print one or two page invoices, etc.

To control which extra data tiles get printed, you must use the extrapages(<pagelist>) function (see
“EXTRAPAGES(” on page 5213 of the Panorama Reference). This function must be put in a formula in an auto
wrap text object somewhere on the main data tile. For example if you want to print pages 1, 2, and 5 you
would need to use the formula

{extrapages("25")}
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Usually you would use a field or variable to selectively control which pages print instead of a fixed string. To
illustrate this let’s modify the invoice example from the previous section. This form would always print both
an invoice and a packing slip. By adding an extrapages( function we can modify the form so that a pack-
ing slip is not printed if the shipping method is Will Call.

The extrapages( function may be placed anywhere on the primary Data tile. The function has no result, so
it won’t cause anything to be printed. In this case if the shipping method is Priority Mail, FedEx, UPS, or any-
thing except Will Call the ?( function will produce "2" and the second page (the packing list) will print. If the
shipping method is Will Call the ?( function will produce "" and the packing list will not print.

Printing Data that Overflows a Page

With some restrictions, Panorama allows a report to print data records that won’t fit on a single page. For
example, this feature could be used to print a multiple page letter. If the letter doesn’t fit on the first page it
spills over onto multiple pages using the data overflow tile.

To print data in a single record that doesn’t fit on a single page, the data must meet the following criteria:

1) The data must be contained in a single graphic object.

2) The graphic object must be an auto-wrap text object, Word Processor SuperObject, or Super Flash Art object.

To print data that overflows a page you’ll need two tiles: a data tile and an overflow tile. The overflow tile is
labeled (…) in the Specialized tile configuration dialog.

extrapages( formula may be placed anywhere on primary Data tile

standard data tile overflow page tile
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Usually the best way to create a form with an overflow tile is to start with a single page form like this.
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Double click the tile drag bar to select the tile and all the objects on it (see “Working with Tiles” on
page 1062). Then duplicate these objects by holding down the Option key (Macintosh) or Alt key (PC), and
clicking on the tile’s drag bar and dragging it (see “Drag Duplicating” on page 561). You may also want to
hold down the Shift key to keep the new tile perfectly aligned with the original. The result is two data tiles,
like this.

Double click on the title of the second data tile to change it to an overflow tile.
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Now adjust the graphics on the overflow tile to the format you want for the second, third, and succeeding
pages. If you are using auto-wrap text to display the text you’ll need to type in the overflow() function as
shown in the illustration below.
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That’s all there is too it! When you print a record that contains more than one page of data, Panorama will
automatically print as many additional pages as is necessary to display all of the data. The blue arrow shows
how the text overflows from one page to the next.
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Printing overflow pages with the Word Processor SuperObject (see “Printing Word Processor Documents” on
page 719) is almost the same as with the auto-wrap text object. Instead of two auto-wrap text objects, you
have two Word Processor SuperObjects.

Both of these Word Processor objects should be configured exactly the same, and both must have the Handle
Overflow option turned on.

Identical Word Processor SuperObjects
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Just as with the auto-wrap text objects, the text wraps from one page to the next.

In the same way you can also wrap a tall image from page to page with the Super Flash Art object (see “Flash
Art™” on page 750). This only works for images taller than a page - it does not work for images that are
wider than a page.



Chapter 21:Custom Reports Page 1123
Variable Height Records

In most reports each record is evenly spaced down the page. In some databases, however, the amount of data
in each record may vary dramatically. For example, a database of catalog items may contain a description
field whose contents vary dramatically. Some descriptions may be only a few words long, while others are
several hundred words long. When a database like this is printed with a fixed height per record there will be
large gaps between some of the records. For example, consider this form designed for printing a catalog of
books.
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Since this form is designed to print the longest possible description, it will leave gaps when printing shorter
book descriptions.

To print this type of database without leaving these large gaps between the records the report must be
printed with variable height records. Contrary to what you might think at first, creating a report with vari-
able height records does not involve using a special report tile. Instead, you design the report for the mini-
mum possible size (in this case a one line description) and tell Panorama which objects may need to expand
to accommodate extra data. As the report prints, Panorama will automatically expand these objects, and also
adjust any other objects that may need to make room.

gap

gap



Chapter 21:Custom Reports Page 1125
Here is a revised version of our book catalog form that is designed to print the minimum possible amount —
a one line description.

Of course when this report is printed it isn’t what we want at all - only the first line of each description is
printed. (On the other hand, we have gotten rid of the gaps between the records!)



Page 1126 Panorama Handbook
To fix this problem we need to select the Description object and make it Expandable.

The Description object is the only object that needs to be made expandable. You don’t need to make anything
else expandable, including the Data tile. (On the other hand, it doesn’t hurt anything to make the Data tile
expandable. Since the Data tile doesn’t contain any data itself it cannot expand on its own. When a data cell
(or other variable height object) expands, the tile it is placed on expands automatically. Although you can
make any type of object variable height, it only makes sense for objects that can contain variable height
data—data cells, auto-wrap text, and flash art.)
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Now that the Description object is expandable we get a very nice printed report that even Goldilock’s could
love — each record is not too long, not too short, but just right.
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It’s possible to place two or more expandable objects side-by-side in a form. This report contains two expand-
able objects: a Flash Art SuperObject and a Data Cell.

When you place expandable objects side-by-side, it’s important to make sure that the bottom edges of the
expandable objects are perfectly aligned. You can make sure they are aligned properly with the Align
Objects command (see “Aligning Objects” on page 553). When the objects are perfectly aligned Panorama
will adjust the form for the largest object. In this example either the Flash Art or the text may be larger — the
form will be adjusted for whichever is larger.

expandable

image is larger

text is larger
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Any graphic element below an expandable object will shift downward as the expandable object expands.
Any graphic element surrounding a variable height object will expand as that object expands. For instance, if
a variable height cell has a box around it, the box will expand automatically as the cell expands. You don’t
need to check the Expandable option for the box.

Stacking Variable Height Objects

In the previous section expandable objects were arranged side by side. You can also stack variable height
items vertically.

expandable
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As each cell expands, it shifts the material below it, including any other expandable objects.

You can arrange expandable objects horizontally or vertically, but not both horizontally and vertically in the
same report. The result of such a combination is usually unpredictable.

The Expand/Shrink Option

Expandable cells can grow to accommodate large amounts of data, but they can never get smaller. The
Expand/Shrink option allows variable height objects to both grow and shrink as the data changes. If there is
no data at all the object will shrink to nothing and disappear! In fact, this ability to make an object disappear
completely is the main advantage of this option. If you don’t need the object to disappear completely we rec-
ommend using the Expandable option.

Expand/Shrink objects can be stacked vertically in a column, but they should never be placed side by side.
When expand/shrink objects are placed side by side they fight each other and the result is unpredictable. In
fact, you must be careful when placing an Expand/Shrink object next to anything else. You may find that an
object placed next to an Expand/Shrink object also disappears, which is probably not what you had
intended.



Chapter 21:Custom Reports Page 1131
Mixing Variable Height Objects With Other Graphics

When variable height objects are mixed with other objects, the variable height objects can force the other
objects to move or change size. The illustration below shows this effect. On the left is a variable height data
cell. The illustration shows how four other graphic objects are affected by the variable height object.

When a variable height object expands or shrinks, everything in the area below the object (shown in gray) is
affected. How the other objects are affected depends on their location relative to the gray area.

Object A is completely above the gray area. It isn’t affected by the variable height data cell.

Object B touches the gray area, so it expands and shrinks in step with the variable height object.

Object C straddles the gray area, so it also expands and shrinks. If it shrinks too much it will disappear com-
pletely! (Of course that could be exactly what you want.)

Object D is completely in the gray area, so it slides up and down as the variable height object expands and
contracts. It does not change size, however.

If there is more than one variable height object, the effect is cumulative. Panorama starts with the first vari-
able height object (closest to the back) and works its way toward the front. For each variable height object the
new height is calculated and all the other objects are adjusted. 

These rules apply to other variable height objects as well as fixed height objects. If a second variable height
object is partly or completely below another variable height object, it will be adjusted when the original vari-
able height object expands or shrinks. You can use these rules to predict how unusual combinations of vari-
able height objects will interact.

variable
height

A

B

C

D



Page 1132 Panorama Handbook
Printing Multiple Column Reports

If the data tile is less than half the width of the page Panorama can print a two column report. If the data tile
is less than 1/3 of the page width Panorama can print a three column report. Multiple column reports can be
used to print mailing labels, or to print multiple column catalogs, lists, and directories.

For example, the data tile on this form is just about 1/3 page.

When you print this form it will look like this.
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Here’s another report where the Data tile is just less than half of the page width.

Panorama will print a two-up report, like this.
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Across or Down?

When printing a multiple column report Panorama normally prints the entire first column, then goes back to
the top of the second column, prints the entire column, goes to the top of the third column and prints it and
on and on for all of the columns in the report.

If you want Panorama to print the data row by row instead of column by column, open the Report Prefer-
ences dialog (in the Setup menu) and switch to Across instead of Down.

Here is the exact same report but with the Across option enabled.

The Across option is often the way you’ll want to print mailing labels, and is automatically enabled when
you create labels with the QuickLabel dialog (see “The QuickLabel Dialog” on page 1169).
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Table Header and Table Footer Tiles

The Table Header and Table Footer tiles allow you to print a header and/or footer at the top and bottom of
each column in a multiple column report. Unlike the regular header and footer tiles (see “Header Tile” on
page 1091 and “Footer Tile” on page 1099) which are only printed once per page, the Table Header and Table
Footer tiles are printed once for each column. You can combine the Table Header/Footer tiles with regular
Header/Footer tiles if you wish, using the regular Header/Footer tiles for page numbers and overall page
titles while using the Table Header/Footer tiles to create headers for each column.

Here is an example of a form with a table header.

When the form is printed, the table header appears at the top of each column.
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This illustration shows how Panorama assembles the Table Header and Data tiles into two columns.

Here’s a modified version of the same report that includes both Table Header and Table Footer tiles.



Chapter 21:Custom Reports Page 1137
This form uses the Table Footer tile to print a bottom border below each column.



Page 1138 Panorama Handbook
Notice that unlike the regular Footer tile (see “Footer Tile” on page 1099) there is no gap between the last data
tile and the column footer tile. (In this example the second column is shorter than the first because there
weren’t enough data records to fill the entire page. The height of each column will always be the same except
for the last column on the last page.)

However, if the form does contain a regular Footer tile there may be a gap between the bottom of the Table
Footer tile and the top of the Footer tile. Here’s an example showing a report with both a Table Footer and a
regular Footer tile. The regular Footer tile is being used to print the page number (see “Page Numbers” on
page 1100).

Usually table header and footer tiles are combined with the normal header and footer tiles for printing the
report title, date, and page numbers.
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Controlling the Number of Columns

Panorama normally packs in as many columns as it can based on the width of the data tile. However, you can
override the number of columns with the Report Preferences dialog in the Setup menu.

Picking 1, 2, 3, or 4 forces the number of columns. Panorama will use the number of columns you specify
even if the columns won’t fit on the page. This is usually useful when the number of columns you want to fit
almost fits on the page, but not quite. There’s no point in printing four columns when only three will fit — the
extra column will simply be invisible. Pick Auto to let Panorama choose the number of columns based on the
width of the data tile.
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Spacer Tile

The spacer tile is rarely used. Panorama normally packs the data tiles as close to each other as possible. The
spacer tile allows you to spread the data tiles apart. When printing a multiple column report, Panorama will
spread the columns apart by the width of the spacer tile. Vertically, each data tile will be spread apart by the
height of the spacer. Horizontally, each data tile will be spread apart by the width of the spacer. Here’s an
example of a form with a spacer tile.

When the form is printed, Panorama inserts the Spacer tile in between the Data tiles. Notice, however, that
there are no spacer tiles to the right of the last column. This slightly reduces the overall width of the report,
possibly allowing you to sqeeze in that extra column.

For most reports, this same spreading effect can be obtained by increasing the size of the data tile. If you are
using automatic multiple columns however, increasing the size of the data tile doesn’t always work, because
it may force the last column into the right margin. If that happens, Panorama won’t print the final column.
The spacer tile allows you to spread the columns apart while still printing the maximum number of columns.
Remember, the only time you may need the spacer tile is when you are printing reports with automatic mul-
tiple columns. You can also force the number of columns with the Report Preferences dialog (see previous
section).

spacer tile
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Printing Summary Information

In the chapter “Summaries and Outlines” on page 365 you learned how to take a database and group it into
categories and then summarize those categories. The summary information (totals, averages, etc.) appears in
temporary new summary records that temporarily become part of the database, like this.

summary records
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In an ordinary report these summary records are printed just like any other record – in other words, they are
printed with the data tile. Here’s an example of a typical form with a data tile.

Here’s a page from the printout, with the summary records circled in red. As you can see, the summary
records are formatted exactly the same way as the regular data records.
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If you want the summary records to print differently from regular data records you’ll need to add additional
summary report tiles to your database (described in the next section). The use of these specialized tiles is
strictly optional. If the report does not contain any summary tiles, Panorama will print summary records as if
they were ordinary data records. For many reports this is just fine. If, however, you choose to use the special-
ized summary tiles, you can independently control how each summary level will be printed.

Summary Tiles

A summary tile works just like a data tile, except that the summary tile is used only when Panorama prints a
summary record. Since a database may have up to 7 levels of summary records, a report may contain up to 7
summary tiles. For example, you could use summary tiles to print the data in 12 point Helvetica, subtotals
(level 1) in 14 point and the grand total (level 2) in 18 point. Summary tiles are created with the Specialized
Tile configuration dialog.

When Panorama is about to print a summary record, it checks to see if the report has a summary tile for that
level. If it does, that summary tile will be placed in the report instead of the data tile. If there is no corre-
sponding summary tile, Panorama will look for summary tiles corresponding to a lower summary level. If it
finds such a tile, Panorama will use it to print the summary record. If Panorama doesn’t find a lower level
summary tile, it gives up and uses the data tile to print the summary record.

level one summary

level two summary
level three summary level four summary

level five summary
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The easiest way to create summary tiles is dragging to make a copy of the data tile (see “Drag Duplicating”
on page 561). Once the new tile is created, you can double click on the tile’s name to open the configuration
dialog and convert it from a data tile into the appropriate level summary tile. Here is an example of a report
with two summary tiles - one for subtotals and one for the grand total.
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Here is one page from the report that is printed by this form (assuming that the database has already been
grouped by the Category field (see “STEP 1 - GROUP” on page 394) and totaled by the Amount field (see
“STEP 2 - CALCULATE” on page 398).
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The last page of this report contains both level 1 (subtotal) and level 2 (in this case, grand total) summaries.

This illustration shows how the report tiles at the end of this report are put together. Data records are printed
with the Data tile, level 1 (subtotal) summary records are printed with the Summary (1) tile, and level 2
(grand total) summary records are printed with the Summary (2) tile.
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Printing Summaries Without Data

Sometimes you may want to print only summary records without printing any data records. The preferred
technique for doing this is to use the Outline Level dialog to collapse the database before printing (see “STEP
3 - OUTLINE” on page 406). Another method is to create a zero-height data tile, as shown in this example.

zero
height
data
tile
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The easiest way to make sure that the height of the Data tile is exactly zero is to use the Dimensions dialog
(see “Viewing and Setting Exact Object Dimensions” on page 512). When this form is printed all of the data
records are invisible because of the zero height Data tile and all you see are the summaries.

Remember that all reports must have a data tile, even if (as in this case) it is not actually visible in the printed
report.

Printing Data Grouped by Month, Quarter or Year

When a database has been grouped by month, quarter or year, the dates should usually be formatted differ-
ently at each summary level. At the raw data level the entire date should be printed, while on the summary
tiles only the month, quarter, or year should be printed.

To format a Data Cell object to display only the month, quarter, or year, select the date cell object and choose
the Output Pattern command in the Text Menu (see “Data Cell Custom Output Patterns” on page 638). This
command sets the output pattern for just the individual selected object. The pattern for a month summary
could be Month yyyy, Mon-yy or mm-yy. For a quarter summary use qqqyy or Qtr “Qtr” yy. For a year use yy
or yyyy. For more information about date output patterns see “Date Output Patterns” on page 255.

To print only the month, quarter or year with an auto-wrap or Text Display object use the datepattern(
function (see “Converting Between Dates and Text” on page 107 of Formulas & Programing) with one of the
patterns mentioned in the previous paragraph.
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Here’s an example that uses Text Display SuperObjects to display the date.
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To prepare this report for printing you must Group Up by Quarter on the Date field (see “Grouping by Week,
Month, Quarter, or Year” on page 395) then Group Up by Month, then Total the Debit field (see “Total” on
page 398). Here is a procedure that will prep the database for you (see “Procedures” on page 203 of Formulas
& Programing).

Here is the printed report.
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Group Headers

Panorama normally prints a header at the top of each report page. The Group Header tiles allow an individ-
ual header to be printed at the top of each group in the report. (Of course, the database must already be
arranged into groups.) The Group Header tile can be used to print a title at the top of each group and also to
provide extra spacing between groups. Here’s an example of a report with a group header. This example
assumes that the database has been grouped by the PayTo field.

PayTo field

Date field Ck # field Debit field
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When it’s printed, this report looks like this.
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This illustration shows how Panorama assembles the tiles to create the final report. At the beginning of each
group it prints the group header, then the data tiles. At the end of the group it prints the summary tile.

Sometimes two groups start at the same spot. For example, in a database grouped by State and City, the start
of the California group may also be the start of the Alameda group. In this case the higher level wins, and
Panorama will print the group header for California. Because of this, the higher level summary headers
should include any graphics or data needed for each lower level, as shown in this illustration.

Header

Group Header (1)

Data

Summary (1)

Group Header (1

Data

Summary (1)

Group Header (1

Data

Summary (1)

City field is printed on both Group Header (1) and Group Header (2)
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Here’s the finished report,

Here’s how Panorama assembles the tiles to create this report.

Group Header (2)

Data Summary (1)

Group Header (1)
Data

Summary (1)

Group Header (1)
Data Summary (1)

Group Header (1)
Data Summary (1)

Group Header (1)
Data Summary (1)

Group Header (1)
Data Summary (1)

Group Header (1)
Data

Summary (1)
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Group Sidebars

The Group Sidebar tile allows you to print a “header” beside each group (either to the left or to the right)
instead of above the group. The group sidebar tile is unusual because when it is printed, it will actually over-
lap the data tiles that follow. It is up to you to design the graphics on the group sidebar and data tiles so that
they don’t interfere with each other. In other words, all the text and graphics on the group sidebar tile should
be to the left with the text and graphics on the data tile to the right, or vice versa.

Here is a report with two Group Sidebar tiles. The report is designed to be printed after the database has been
grouped by State and then by City.
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Here is the printed report. Notice that at the beginning of each state and city the sidebar prints next to the
data. The sidebar is actually overlaying the data (and in the case of the state, the other sidebar) but because of
the way the graphics are laid out the sidebars don’t interfere with each other or with the data.
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Here’s how Panorama assembles the tiles to create this report. Because of the overlapping tiles this can be a
bit confusing, so the Data tiles have been omitted from this illustration. The Group Sidebar(2) tiles are shown
in green, and the Group Sidebar(1) tiles are shown in blue.

Tip: Although the group sidebar will overlap the data tiles when the report is printed, they must not overlap
on the form window.

from Group Sidebar(2) tile
from Group Sidebar(1) tile

from Data tile
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You can add images to a group sidebar using Flash Art. This report is exactly the same as the previous exam-
ple except for the addition of the Super Flash Art image displaying the state flag (see See “Flash Art™” on
page 750).
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Here is the printed report.

Notice that for the state of Florida the sidebar is actually taller than the data records. In that case Panorama
will leave a gap between the last data record in a group and the first data record of the next group.
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Keeping a Group Together on a Column or Page

If you wish, Panorama can automatically make sure that groups are not divided across column or page
boundaries. This can make a report easier to read and much more attractive. (Of course it can only do this for
groups that are small enough to fit on a single column or page.) This feature is called widow/orphan control
and is available in the Report Preferences dialog in the Setup menu.

Select the largest group level you want to keep together on a column or page (or both).
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For example, consider the report shown below. The group of records for Advertiser’s Mailing Service is split
across two columns.
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To prevent this from happening, open the Report Preferences dialog and check the box as shown below.

Panorama will automatically push the group to the next column so that it is no longer split in the middle.

If the checkbox in the Page row had been checked Panorama would only have made sure that a group wasn’t
split across a page - it wouldn’t worry about group’s split across a column like this.
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Starting a Group on a New Column or Page

If you wish, Panorama can automatically skip to a new column or a new page at the beginning of each new
group. To do this, choose Report Preferences from the Setup Menu, then choose the summary levels that trig-
gers skipping to a new column or page.

Here’s what the first few pages of this report looks like. Only one group is printed per page.
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Even and Odd Page Layout

Panorama allows you to format the even and odd pages of a report differently. For example you could change
the margins from even to odd pages to create a wide gutter in the middle, or flip the titles so the page number
is always on the outside.

To set up these amazing feats, Panorama allows you to set up two sets of tiles: even page tiles and odd page
tiles. When you create a tile with the Specialized Tile dialog, you can use the Side menu to select whether
the tile is for even or odd pages. (The Side menu only appears when this dialog is open.)
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You can recognize an even tile on a form by the ◊ symbol in front of the tile name.

It’s not necessary to create a complete duplicate set of both even and odd tiles. You only need to create even
tiles for tiles that are actually different from the odd tiles. For example, suppose you want the left margin to
be different on even and odd sides, but everything else is the same. In that case you would create an odd data
tile, header tiles, etc. along with both an odd and even left margin tile.

tile for even pages (2, 4, 6, ...) tile for odd pages (1, 3, 5, ...)

Page number on left side for even pages Page number on right side for odd pages

extra margin (gutter) in middle for binding
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Special Paper Options

The Special Paper Options dialog (Setup Menu) allows Panorama to print reports with multiple page images
on a single physical sheet of paper. After the report is printed you can cut up the individual pages…usually
so that they can be inserted in an organizer notebook. It also allows a report to be printed double sided (you
must print one side, then turn the paper over and feed it back into the printer to print the second side). Note:
You must turn off background printing to use the double sided option.

The left side of the Special Paper Options dialog displays a list of paper formats.

The default format, Standard Paper, prints normally on the entire page. The other options split the physical
paper into two or more separate subpages. The area on the right shows a preview of how the paper will be
split into separate pages. If necessary, you should use the Page Setup dialog to adjust the paper orientation
(portrait vs. landscape) to make sure that all of the subpages fit on the paper.

If you select a format with two or more subpages, Panorama will print a separate report page on each sub-
page. For example, if you use the DayRunner 5.5" x 8.5" format (two subpages per sheet), Panorama will print
report pages 1 and 2 on the first sheet, report pages 3 and 4 on the second sheet, etc. You must design your
report so that each report page fits on a subpage.
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The report below is designed to print using the DayRunner 3.75" x 6.75" option.

This option will cause 3 DayRunner pages to print on one, real page, like this.
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After the report is printed you can cut apart the individual pages, punch holes, and install them in a DayRun-
ner style binder. (You can also purchase paper that is pre-perfed to be split apart this way.)

The bottom of the Special Paper Options dialog has two additional options: 2-sided and Borders. If you
select the 2-sided option, Panorama will use a special procedure for printing the report on both sides of the
paper. First, it will print all the odd pages (1, 3, 5, 7, etc.). Then it stops printing and displays a dialog request-
ing that you flip the paper over and re-insert the paper into the printer. When you press the OK button, Pan-
orama will print the even pages (2, 4, 6, 8, etc.). If the report is printed using multiple subpages, Panorama
will adjust the positions as it prints the even pages to make sure that page 2 is on the back of page 1, page 4
on the back of page 3, etc. (Warning: The 2-sided option does not work properly if background spooling is on.
You must turn off background spooling before printing a 2-sided report.)

The Borders option makes Panorama print a border around each subpage. If you are not printing on pre-per-
fed paper, you can use this border to help you cut apart the individual subpages. The border can also be use-
ful to see where the subpages are when you use Print Preview.
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Two of the most common jobs for a database program are printing mailing labels and form letters. Mailing
labels can be tricky because the printing must line up with the pre-cut labels. This chapter describes tips and
techniques that can help take the “trial and error” out of printing labels and form letters.

Label Fundamentals

Labels are printed using report tiles in a form (see “Custom Reports” on page 1061 for an introduction to
report tiles). Many labels only require a single tile: the data tile (see “Data Tiles” on page 1076). This tile
should be the same size as the size of the label plus the gap between labels. In some cases you may also need
margin tiles, see “Top Margin Tile” on page 1085 and “Left Margin Tile” on page 1087. 

To actually print the names and addresses you will usually use an auto-wrap text object (“Displaying Data in
Auto-Wrap Text” on page 595) or a Text Display SuperObject (see “Text Display SuperObjects™” on
page 608). Either of these types of objects allow data, text, and punctuation to be mixed in the label.

The QuickLabel Dialog

When you create a new form, Panorama gives you the option of creating a blank form or automatically creat-
ing a label or report.

The QuickLabel button opens a dialog that can do most or all of the work of setting up a label for you. To use
the QuickLabel dialog, select New Form from the View Menu (see “Switching Between Views” on page 168),
give the new form a name, and then click on the QuickLabel button.
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The QuickLabel dialog is really a two part dialog. The first part allows you to define the dimensions of the
label. The dialog shows a picture of a label with dimensions around it. You can enter the dimensions manu-
ally, or you can pick a pre-defined label size using the pop-up menus inside the label. The top pop-up menu
allows you to choose from popular label sizes. The bottom pop-up menu allows you to choose whether the
label should be printed 1, 2, 3, or 4 up.

The most popular style of label is Avery 5160, which prints 30 labels on a sheet (10 rows by 3 columns).
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The second part of the dialog allows you to specify the data that will be printed on each label (usually name
and address). The left side of the dialog lists all the database fields, while the right hand side contains an
image of the actual label.

To copy a field into the label, double click on the field name. Double clicking types the field name into the
area on the right, surrounded by « » characters.

To add a space or punctuation, simply press the appropriate key. To start a new line, press the Return key. 

You can also edit the text in the label like any other text—click to create an insertion point, drag to select one
or more characters, or type to enter new text.

¥ key

¥ key

˙ key

˙ key

˙ key, key
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When the content of the label is finished, press the OK button. The dialog will automatically create one or
more tiles and an auto-wrap text object.

The label is now finished and can be printed or modified further. Here’s what the printed labels look like.

Printing Labels on Sheets

Labels come in two styles — sheets and rolls. Most of today’s laser and inkjet printers work well with sheets,
so we’ll discuss those first. To learn about printing roll labels see “Printing Roll Labels” on page 1173.

Some sheets contain labels that go right up to the edge of the sheet. Depending on your printer you may not
be able to print all the way to the edge. You may be able to use the Page Setup command to make it possible
to print closer to the edge of the sheet. Consult the documentation that came with your printer to find out if
this is possible.

The height of the data tile should equal the distance from the top of one label to the top of the next label,
while the width of the label should equal the distance from the left edge of one label to the left edge of the
next label.



Chapter 22:Labels Page 1173
Printing 3 by 10 1” Labels (Avery 5160)

The most common type of label sheet contains 30 1” high labels in 3 columns of 10 labels (Avery 5160). The
Avery 5160 labels are spaced 1” vertically and 2.75” horizontally. There is a 1⁄2 inch top margin above the
labels, and a 0.18 inch left margin.

You can use the QuickLabel dialog to set up the tiles for this type of label (see “The QuickLabel Dialog” on
page 1169). If the edges of the labels are cut off when you print, use the Page Setup dialog to adjust your
printer settings to allow Panorama to print as close to the edge of the sheet as possible. Consult the documen-
tation that came with your printer to find out how to set the printer margins (if possible).

Aligning Labels on the Sheet

If the names and addresses are not properly aligned on the labels, you can create Left Margin and Top Margin
tiles. (The QuickLabel dialog automatically creates these tiles for you.) To shift the text up or down, change
the height of the Top Margin tile (see “Top Margin Tile” on page 1085). To shift the text left or right change
the width of the Left Margin tile (see “Left Margin Tile” on page 1087). You can make precision adjustments
to the size of a tile with the Dimensions dialog (see “Viewing and Setting Exact Object Dimensions” on
page 512).

Note: If you do not specify a left or top margin, Panorama will use the default printer margins.

Printer Inaccuracy and Vertical Creep

If you try to print very small labels (less than 1⁄2 inch high), or if you try to print to the very edge of each label
(for example a border around the label), you may run into problems due to printer inaccuracy. Due to
mechanical tolerances, most printers are only accurate to about 1⁄8 inch over a full 11 inch page. Even if the
labels line up properly at the top of the sheet, they may gradually creep out of place towards the bottom of
the page. Unfortunately this problem is difficult to correct.

You may be able to reduce or eliminate the creep by adjusting for the inaccuracy in your printer. To try to
compensate for this problem you can adjust the height of the data tile in 1/8th pixel increments. To do this,
use the Form Preferences dialog to reduce the nudge increment to 1⁄8th pixel, then use the up/down arrows
to nudge the size of the tile. Remember this adjustment may be different for different printers, or may even
change for the same printer at different times.

A simpler solution is to not print anything less than 1⁄8th inch from the edge of a label. These leaves enough
tolerance for the inaccuracy of the printer.

Printing Roll Labels

Roll labels can be much more difficult to set up than sheet fed labels, and on some printers you may not be
able to get roll labels to print correctly at all.

Before you read this section we have a confession to make. Printers that can print roll labels are very rare
these days, and here at ProVUE we have not used such a printer for at least a decade. We also rarely get tech
support calls on this topic. The material below was written primarily for the Apple ImageWriter printer, a
printer that has not been available for many years, so this material is pretty out of date. However, we decided
to include it since we do not have any more recent experience with roll feed labels.

Printing on 1-up 1” Roll Labels

The most common type of roll label contains labels spaced 1 inch from label to label (usually the label itself is
15⁄16 inch, with a 1⁄16 inch gap between the labels). To print 1 inch labels, use the QuickLabel dialog to set up
the report tiles. The data tile should be exactly 1 inch high, and as wide as the label. Choose 1-up from the
pop-up menu. If your printer has an option for turning off gaps between pages use the Page Setup dialog to
make sure that gaps are disabled. If you printer always prints a gap between labels you won’t be able to print
roll labels on that printer.
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Printing Non 1” 1-up Labels

There are two basic methods for printing roll labels. The first method is to set up a custom page size and treat
each label as a separate page. The second method is to use a normal page size and print several labels per
page. For example, you could print eleven 1 inch high labels on a normal 81⁄2 by 11 page. Each of these meth-
ods has advantages and disadvantages.

Using Custom Page Size to Print Labels

To print 1-up labels using a custom page size, start by creating a data tile the same width as the label. Make
the height of the tile equal to the distance from the top of one label to the top of the next. For instance if the
labels are 1 15⁄16 inch high with a 1⁄16 inch gap between labels, make the tile 2 inches high.

Once the data tile is set up choose the Page Setup command from the File Menu. Click the Custom Labels
button.  Custom Labels tells Panorama to automatically set the paper size to the same dimensions as the data
tile. Warning: If you ever change the size of the data tile, you must go back to the Page Setup command and
re-set the paper size to Custom Labels. Otherwise Panorama will continue to use the old custom label size.

Remember that for most labels you will also have to set the No Gaps Between Pages option to eliminate the
top and bottom margins.

You should only use a custom page size if you need to print on an odd size label. Custom page sizes are only
available for the Apple ImageWriter printer—they are not available for non-Apple printers.

Using Standard Page Sizes to Print Labels

The most common label size is 1 inch high (1 inch from the top of one label to the top of the next). Since 11 of
these labels are an exact fit on a standard 11 inch high paper size, you can avoid the use of custom page size
to print these labels. This can help reduce problems with labels peeling off inside the printer that can occur
when custom page sizes are used with the No Gaps Between Pages option.

Using a standard page size to print labels is easy—just set up the data tile and print. Remember that the
height of the data tile should equal the distance from the top of one label to the top of the next. For 1-up labels
the tile should be the same width as the label.

You can print using a standard page size even if the labels don’t fit evenly on the page. For instance, you can
get almost nine 1 1⁄4 inch high labels onto a standard page, but not quite. However, if you set the No Gaps
Between Pages option Panorama will compensate, automatically printing labels that are split over the page
break. The only problem will be that before printing begins, the Macintosh will automatically skip over the
first 11 inch page. This wastes labels and throws the labels out of alignment. One solution to this problem is to
start with a single blank sheet of paper in the printer. Let the printer skip over this page, then feed in the roll
of labels and continue printing. Of course another solution is to use a custom page size. This only wastes one
label but runs an increased risk of label jamming.

2, 3, and 4-Up Roll Labels

Panorama can print multiple column labels, but we don’t recommend doing this with adhesive backed labels
in an ImageWriter printer. As each label is printed the printer platen will rock back and forth. We’ve found
that with multiple column adhesive labels this almost always results in labels peeling off inside the printer.
At a minimum you should watch the printer carefully during printing to prevent a minor problem from turn-
ing into a catastrophe. You can also reduce the problem quite a bit by using Best or Faster print quality
instead of Draft.

You can print multiple column labels simply by using the Report Preferences dialog to select the number of
columns (from 1 to 4). If you are using the Custom Labels page size you should set up the number of columns
before you use Page Setup to set the page size to Custom Labels.
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4-Up Cheshire Labels

To print 4-up Cheshire labels, use the QuickLabel dialog and select 4-up Cheshire from the pop-up menu.
Once the form is set up, use the Report Preferences dialog to set the Across option, so the labels will print
across the page instead of down. Don’t forget to use the Page Setup dialog to set the No Gaps Between Pages
option. When you print the labels, we recommend using Best or Faster print quality instead of Draft.

Selecting Font and Print Quality

When you are printing labels using an ImageWriter, the choice of font and print quality can have a major
impact on print speed. For maximum speed, use Draft quality with Monaco 10 point text. It looks funny on
the screen, but prints several times faster than any other font because it matches the ImageWriter’s built in
font.

Of course if the label contains any graphics, it must be printed using Best or Faster quality. Using Best or
Faster quality can also reduce the amount of forward/back platen motion when printing multiple column
labels.
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